Copyright Notice

Notice
Document information is subject to change without notice by Siemens Switzerland Ltd. Companies, names, and various data used in examples are fictitious unless otherwise noted. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Siemens Switzerland Ltd.
All software described in this document is furnished under a license agreement and may be used or copied only in accordance with license terms.
For further information, contact your nearest Siemens Switzerland Ltd. representative.

Credits
Desigo, Desigo CC, Cerberus DMS, Cerberus PRO, and Sinteso are registered trademarks of Siemens Switzerland Ltd.
Other product or company names mentioned herein may be the trademarks of their respective owners.
Edition: 2019-11-01
Document ID: A6V10415471_en_a_40

© Siemens Switzerland Ltd, 2019
# Table of Contents

1 Getting Started.......................................................................................... 7
   1.1 User Interface Basics........................................................................... 7
      1.1.1 Standard UI Client..................................................................... 7
   1.2 Basic Procedures.................................................................................. 16
      1.2.1 Standard UI Client.................................................................... 16

2 Operating Step-by-Step......................................................................... 22
   2.1 System Manager ............................................................................... 22
      2.1.1 Working with System Manager................................................ 22
      2.1.2 System Browser....................................................................... 28
      2.1.3 Textual Viewer......................................................................... 30
      2.1.4 Operation.................................................................................. 31
      2.1.5 Related Items.......................................................................... 32
   2.2 Graphics Viewer ............................................................................... 33
      2.2.1 Displaying Graphics and Properties....................................... 33
      2.2.2 Navigating in the Graphics Viewer......................................... 34
      2.2.3 Selecting Objects in the Graphics Viewer............................... 35
      2.2.4 Working with the Point Centered Display Mode.................... 36
      2.2.5 Zooming in the Graphics Viewer............................................. 37
      2.2.6 Additional Graphics Viewer Procedures................................. 37
   2.3 Alarms ............................................................................................... 40
      2.3.1 Handling Events from Event List............................................. 40
      2.3.2 Handling an Event with Investigative Treatment.................... 44
      2.3.3 Handling Events with Assisted Treatment.............................. 47
      2.3.4 Handling Recurrences of an Event......................................... 56
      2.3.5 Customizing the Columns in Event List.................................. 57
      2.3.6 Filtering Event List.................................................................. 58
      2.3.7 Printing the Whole Event List................................................. 62
      2.3.8 Changing the Sorting of Events.............................................. 62
      2.3.9 Handling Alarm Suppression for System Objects................... 62
   2.4 Scheduling ....................................................................................... 65
      2.4.1 Creating a BACnet Schedule.................................................... 65
      2.4.2 Creating a Management Station Schedule.............................. 67
      2.4.3 Additional Scheduling Procedures......................................... 68
   2.5 Reports ............................................................................................. 75
      2.5.1 Printing a Standard Report....................................................... 75
      2.5.2 Running a Customized Report................................................ 78
      2.5.3 Additional Report Procedures................................................. 81
      2.5.4 Examples of Reports Configurations..................................... 102
   2.6 Trends ............................................................................................... 116
      2.6.1 Creating an Online Trend........................................................ 116
      2.6.2 Additional Trends Procedures............................................... 117
   2.7 Log Viewer ....................................................................................... 139
      2.7.1 Configuring and Printing the Log View Details....................... 139
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.6.5</td>
<td>Predicted Trends</td>
<td>309</td>
</tr>
<tr>
<td>3.6.6</td>
<td>Trend Data Storage</td>
<td>309</td>
</tr>
<tr>
<td>3.7</td>
<td>Log Viewer</td>
<td>311</td>
</tr>
<tr>
<td>3.7.1</td>
<td>Overview of Log Viewer</td>
<td>311</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Log Viewer Workspace</td>
<td>314</td>
</tr>
<tr>
<td>3.8</td>
<td>Address Book</td>
<td>326</td>
</tr>
<tr>
<td>3.8.1</td>
<td>Overview of Address Book</td>
<td>326</td>
</tr>
<tr>
<td>3.9</td>
<td>Remote Notifications</td>
<td>330</td>
</tr>
<tr>
<td>3.9.1</td>
<td>Overview of Remote Notifications</td>
<td>330</td>
</tr>
<tr>
<td>3.9.2</td>
<td>RENO Messages</td>
<td>331</td>
</tr>
<tr>
<td>3.9.3</td>
<td>New Remote Notification in the Secondary Pane</td>
<td>338</td>
</tr>
<tr>
<td>3.10</td>
<td>Documents</td>
<td>340</td>
</tr>
<tr>
<td>3.11</td>
<td>Other Applications</td>
<td>340</td>
</tr>
<tr>
<td>3.11.1</td>
<td>Web Applications</td>
<td>340</td>
</tr>
<tr>
<td>3.11.2</td>
<td>Validation</td>
<td>347</td>
</tr>
</tbody>
</table>
1 Getting Started

1.1 User Interface Basics
This section provides an overview of the Desigo CC user interface. For related procedures, see Basic Procedures [16].

1.1.1 Standard UI Client
This section provides a quick reference guide to the main elements of the Desigo CC user interface. For procedures, see Basic Procedures.

1.1.1.1 Overview of the Standard UI Client
This section provides an overview of the main elements of the Desigo CC user interface.

Main Screen Layout in Danger Management Profiles

1 Event bar Provides a compact view of the events in the system, where each event displays as a button along the left-hand side.

2 Event Detail bar Present in some configurations only. Highlights the most critical event in the system.

3 Summary bar The main point of entry to all the functions of the software. It may be collapsed in which case you must click the down icon on the top right to display it.
### Getting Started

#### User Interface Basics

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Work area</td>
<td>Large central portion of the screen below the Summary bar. The window displayed here will vary depending on the system function that is being used. It will typically contain the Event List or System Manager window. It can also display the Investigative or Assisted Treatment windows, the system help, and external documents or applications.</td>
</tr>
</tbody>
</table>

---

### Main Screen Layout in Building Automation Profiles

1. **Summary bar**
   - The main point of entry to all the functions of the software. It may be collapsed and you must click the **down** icon on the top right to display it.

2. **Work area**
   - Large central portion of the screen below the Summary bar. The window displayed here will vary depending on what system function is being used. It will typically contain the System Manager window. It can also display the Event List, or Investigative or Assisted Treatment windows, the system help and external documents or applications.

### Multi-Pane Windows

The system screen can display many windows, some of which are made up of multiple panes, divided by splitters. A window can contain up to four panes. Each pane houses a functional component of Desigo CC (such as a browser for navigating and selecting system objects, a viewer for displaying site floor plans or tools for inspecting the properties of objects).
Getting Started
User Interface Basics

1 Selection pane (vertically along the left). Also referred to as Navigation pane.

2 Primary pane (to the right of the Selection pane).

3 Secondary pane (opens when required, alongside the Primary pane).

4 Contextual pane (underneath the Primary and Secondary panes, divided into two parts).

5 Status bar (along the bottom of the window). This bar displays status/update messages (Ready, Default loaded successfully, and so on).

**Pane and Window Controls**

You can arrange panes of a window in different layouts or interact with a window and its panes in various ways. These include:

- Click the icons on the window title bar top to minimize, restore down, or maximize the window.
- Click the icons on the window title bar to quickly switch between the available preset layouts:
  - Selection, Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - Selection, Primary, and Contextual panes
  - Selection and Primary panes
  - Primary, and Contextual panes. The Secondary pane displays only if it is already open.
  - Primary pane only
- Resize the panes in a layout by dragging the splitters, or expand/collapse a pane by clicking the button on the splitter.
• Click the icon to lock the window layout . When the layout is locked, clicking one of the layout icons will not have any effect; this means that you cannot change the current layout, and resize, expand, or collapse the panes of the window.

• Normally, the Secondary pane opens on demand, when you make a selection that requires it. When the Secondary pane opens, it takes up half the space that would otherwise be allotted to the Primary pane.

• You can prevent the Secondary pane from opening by clicking the pushpin icon and locking the Primary pane. When the Primary pane is locked, any selections (such as Related Items) that would normally display in the Secondary pane are instead redirected to the Primary pane.

Primary Selection Workflow
The following graphic shows the typical workflow for navigating the system:

1. Select a view (1) in System Browser, in the Selection pane, such as Application View.
   ⇨ The selected view displays in the System Browser tree.

2. Navigate the tree and select the object (2) you want to work with.
   ⇨ The information about the selected object displays in the Textual Viewer (3), in the Primary pane.
   ⇨ The properties of the selected object display in the Operation tab (4), in the Contextual pane.
   ⇨ Links to additional resources associated with the selected object display in the Related Items tab (5), in the Contextual pane.

3. Click a related item link (5), such as New Remote Notification, to open that resource in the Secondary pane.
   ⇨ The selected related item displays in the Secondary pane (6).

4. If necessary, click the icon (7) to display the navigation bar (8) with icons for moving back and forth between the most recent screens in the Primary pane and going back to the favorite location.

Object Association Workflow
The following graphic shows the typical workflow for manual selection and drag-and-drop, in order to associate two objects:
1. Select a view (1) in System Browser, in the Selection pane, for example Application View.
   - The selected view displays in the System Browser tree.

2. Navigate the tree to select the object (2) you want to work with, for example Activity Log.

3. Select Manual Navigation (3), to freeze the Primary pane, for example Reports > Activity Log.

4. Drag and drop the selected object (4), for example Address Book, to the reports area.

1.1.1.2 Summary Bar

The Summary bar is located along the top of the system screen, and is the main point of entry to all the functions of Desigo CC.

By default, it displays collapsed to a slim bar, and it has a series of indicators that provide an overview of the alarms and events in the system, grouped by category followed by the operator menu, a system integrity indicator, and the filter icon.

When the slim bar is expanded, on the left, the Summary bar displays the event lamps, grouped by category, while on the right, it has buttons for starting multiple System Manager windows, opening/closing Event List, and controlling the audio alert.

Depending on the profile it displays a specific set of event lamps, the Event Detail bar that highlights the most critical event in the system and allows you to open or close the Event List window and control the audio alert.

Figure 1: Collapsed (Slim) Summary Bar

Figure 2: Expanded Summary Bar
<table>
<thead>
<tr>
<th></th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Company logo</td>
<td>When you move your cursor on the logo, a tooltip tells you: Click to open the About Page. The About page displays information about the Desigo CC software. For instructions, see Display the About Page [20].</td>
</tr>
<tr>
<td>2</td>
<td>Event lamps</td>
<td>Summarizes the events in the system, grouped by categories. You can click an event lamp, to open Event List filtered by that category. For background information, see the Event List [209] and event lamps [207] reference sections.</td>
</tr>
<tr>
<td>3</td>
<td>Client name</td>
<td>Indicates the computer name on a server, client, or FEP station. NOTE: If you use a web client, the client name does not display.</td>
</tr>
<tr>
<td>4</td>
<td>Logged user</td>
<td>Indicates the full name of the person logged onto the system. It also provides a tooltip with the user's most important information (for example, full name, account name, language, and so on). If the user's full name is not available, user name displays instead.</td>
</tr>
<tr>
<td>5</td>
<td>Date and time</td>
<td>• Indicates the system date and time. • Displays the Windows calendar when clicked.</td>
</tr>
<tr>
<td>6</td>
<td>System menu</td>
<td>From here, the operator can access other functions. For background information, see the reference [14] section.</td>
</tr>
<tr>
<td>7</td>
<td>System integrity indicator</td>
<td>Displays the status of the network connection to the server. For background information, see the reference [13] section.</td>
</tr>
<tr>
<td>8</td>
<td>Expand/collapse</td>
<td>Expands or collapses the Summary bar. For instructions, see Expand or Collapse the Summary Bar [19].</td>
</tr>
<tr>
<td>9</td>
<td>Event filter</td>
<td>Lets you filter the events in Event List. For instructions, see Filtering Event List [58].</td>
</tr>
<tr>
<td>10</td>
<td>Open/close Event List</td>
<td>Shows/hides or expands/collapses the Event List window. For instructions, see Open Event List [40]. This icon is disabled during Investigative/Assisted Treatment.</td>
</tr>
<tr>
<td>11</td>
<td>Start a new System Manager</td>
<td>Click to open multiple System Manager windows. For instructions, see Working with System Manager [22].</td>
</tr>
<tr>
<td>12</td>
<td>Audio Alert</td>
<td>Click to silence/unsilence the sound emitted by the management station to notify you of events. For instructions, see the reference [13] section.</td>
</tr>
<tr>
<td>13</td>
<td>Show/hide Event Detail bar</td>
<td>Shows/hides the Event Detail bar (available only in some configurations). For instructions, see Show or Hide the Event Detail Bar [19]. Depending on the Client Profile this icon may or may not be available.</td>
</tr>
</tbody>
</table>
1.1.1.3 License Mode Indication in Summary Bar

When the Desigo CC client application is running normally, with a valid and sufficient license available on the server, you will not see any special indication on the user interface.

Otherwise, the Summary bar changes color and displays a message to indicate the following special situations, along with the time remaining (days, hours, minutes, or seconds) that you can continue running the Desigo CC client application.

- **Demo** mode (green): There is no valid license available on the server. You can run the Desigo CC client application continuously for only 30 minutes.
- **Courtesy** mode (orange): The license on the server is valid but insufficient. You can run the Desigo CC client application continuously for only 30 days.
- **Engineering** license (blue): The Desigo CC client is running, for a limited duration, with a special license used by authorized technicians to set up and configure the system.

The license mode (color and text) is also visible when the Summary bar is collapsed.

1.1.1.4 System Integrity Indicator

The system integrity indicator, located on the Summary bar, indicates the network connection and system status. Its color and animation reflect the connection status, as follows:

- **Green and animated.** Network connection with the server is active and the system is healthy (that is, server running properly).
- **Red and animated.** Network connection with the server is active but at least one system component is not active on the server (that is, server not running properly).
  
  **NOTE:** If a client disconnects from the server, this issue is visually indicated on the Summary bar by pink background, and **Client Disconnected** text in red. An error message informs you that the connection to the server has been lost and will be restored when possible.
- **Red and not animated.** Network connection with the server is inactive.

A tooltip displays when you move your cursor over the indicator, and provides network connection and system status information.

1.1.1.5 Audio Alert

The audio alert is the sound emitted by a client station to notify the operator of events in Desigo CC. (If a site has multiple client stations, each one will emit its own audio alert.)

When a new event occurs, the client station emits an audio alert that continues for as long as that event remains unprocessed (that is, unacknowledged by the operator). If there are multiple incoming events, the audio alert continues to sound for as long as any of them remain unprocessed.

An icon on the Summary bar indicates the status of the audio alert. You can click this icon to temporarily silence the audio alert. Only in some profiles, you can also completely disable the audio alert. (A tooltip displays when you move the cursor over the icon, indicating which actions are available to you.)

The specific audio alert sound can vary depending on the type of event and is configuration-dependent. In case of multiple events, the audio alert sound will be...
the one for the most important (severe) event, irrespective of any filters or sorting you may have applied to Event List.
For related procedures, see Temporarily Mute the Audio Alert [→ 19] and Permanently Silence the Audio Alert [→ 19].

Audio Alert Resound
The audio alert ceases when the incoming events have been acknowledged and it will resume after 24 hours if a previously-acknowledged event has still not been fully processed (closed) by then. Depending on the Client Profile, a warning message also displays on the Summary bar, for example, 24 hours Trouble resound: click here to silence. The operator can click this text to silence the audio alert.

Audio Alert Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The system has detected a new event, or there are still events in the unprocessed state. You can temporarily silence or permanently turn off the audio alert. Depending on the Client Profile this functionality may or may not be available to you.</td>
</tr>
<tr>
<td>Muted</td>
<td>You temporarily silenced the audio alert. After 24 hours the system will automatically re-activate the sound (audio alert reminder).</td>
</tr>
<tr>
<td>Disabled</td>
<td>You completely disabled the audio alert. This means it is permanently turned off, and the system will not emit any sound when new events occur. Depending on the Client Profile this status may or may not be available to you.</td>
</tr>
</tbody>
</table>

1.1.1.6 System Menu
The Menu located on the Summary bar [→ 11] provides several items for you to carry out different tasks.

<table>
<thead>
<tr>
<th>Help</th>
<th>Launches online Help.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>Opens a new System Manager window. See Create Additional System Manager Windows [→ 22].</td>
</tr>
<tr>
<td>Operator</td>
<td>Performs the following tasks:</td>
</tr>
<tr>
<td></td>
<td>• Switchover. See Do an Operator Switchover [→ 18].</td>
</tr>
<tr>
<td></td>
<td>• Change User password. See Change Your Password [→ 18].</td>
</tr>
<tr>
<td></td>
<td>NOTE: This option is not available if you are logged on as Windows user. Also, a message prompts you if you enter an invalid password.</td>
</tr>
<tr>
<td>About Page</td>
<td>See Display the About Page [→ 20].</td>
</tr>
</tbody>
</table>
1.1.1.7 Printouts

In Operating mode, Desigo CC allows you to use any configured printer to print out application data:

- From the system menu on the Summary bar [➙ 11]. For instructions, see Print from System Menu [➙ 20].
- Directly from with system applications such as Event List, Reports, and so on. For instructions, see, for example, Printing the Whole Event List [➙ 62].

**Printouts Selection Dialog Box**

The Printouts Selection dialog box displays when you print from the system menu. It lets you select system application printouts.

**Print Preview Dialog Box**

The Print Preview dialog box displays when you print from the system menu, or from an application. It lets you adjust the various printer options (margins, orientation, scaling and so on) before launching the print job.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in</td>
<td>Provides a close-up view of the printout. Keep clicking it to continue zooming in.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Reduces the view of the printout. Keep clicking it to continue zooming out.</td>
</tr>
<tr>
<td>Actual size</td>
<td>Fits the printout into the whole preview page.</td>
</tr>
<tr>
<td>Fit width</td>
<td>Fits the printout into the preview page’s width.</td>
</tr>
<tr>
<td>One page</td>
<td>Displays the printout one page per sheet.</td>
</tr>
<tr>
<td>Two pages</td>
<td>Displays the printout two pages per sheet.</td>
</tr>
</tbody>
</table>

1) These commands affect only the print preview, and not the printout.

**NOTE:**

The color option depends on the selected printer. If the Color printing check box displays dimmed and cleared, the selected printer cannot print color. If this check box displays dimmed and selected, the selected printer can print only color. Even when you can select to print color (or black and white), the printout may not correspond to the color option selected because of the printer drivers.
1.2 Basic Procedures
This section contains procedures for getting started with Desigo CC. For background information, see User Interface Basics [7].

1.2.1 Standard UI Client
This section contains procedures for getting started with Desigo CC. For background information, see User Interface Basics.

1.2.1.1 Starting and Exiting the System
This section provides instructions for starting and exiting Desigo CC. Select the appropriate procedure depending on the type of client you are working on. For background information, see System Menu [14].

Launch an Installed Client
Do this procedure to start Desigo CC on a computer where the Desigo CC software is installed as a normal Windows application.

1. Start Desigo CC from the Windows Start button or by clicking the icon on the desktop.
   ➢ The logon dialog box displays. You can log on to the system as a Desigo CC user or Windows user.
2. Enter your username and password.
3. Select the domain.
4. Click Logon.

Launch a Web Client
Do this procedure to start Desigo CC as a browser-based application, on a computer that was configured to operate as a web client.

▷ The authentication certificate was previously installed on the computer.

1. Launch Microsoft Internet Explorer.
2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).
   **NOTE:** If you do not have this information, please contact your system administrator.
   ➢ The Desigo CC page opens in the browser, and the Desigo CC tab contents display.
3. Click the Desigo CC tab, and select the Web Client thumbnail.
   ➢ The logon dialog box displays in the browser.
4. Enter your username and password.
5. Select the domain.
6. Click Logon.

Launch a Windows App Client
You want to start Desigo CC from a computer configured to operate as a Windows app client, where the client software is downloaded and installed on demand from a browser.

▷ The authentication certificate was previously installed on the computer.
1. Launch the Microsoft Internet Explorer.
2. In the address bar of the browser, enter the name of the computer where the Desigo CC Web Server resides (for example, //ITP0990c/).
   **NOTE:** If you do not have this information, contact your system administrator.
   - The Desigo CC page opens in the browser, and the Desigo CC tab contents display.
3. Click the **Windows App Client** thumbnail.
   - The installation of Desigo CC starts. When completed, the logon dialog box displays.
4. Enter your username and password.
5. Select the domain.
6. Click **Logon**.

**NOTE:**
Each time you launch Desigo CC as a Windows app client, a search for system updates is performed. If a new version of the software is available on the web server, you can choose to update it or continue using the previous version.

---

### End Your Work Session

You want to quit the Desigo CC application.

- In the Summary bar, select **Menu > Exit**.
  - You are logged off and Desigo CC shuts down. If you were running Desigo CC as a browser-based web client, the logon dialog box displays on the screen.

### Interrupt Auto-Logoff

You are working on a Desigo CC station and your user group was configured for auto-logoff after a period of operator inactivity.

- The logoff message box displays the time remaining before the automatic logoff.
- To stop the logoff, move the cursor or press any key on the keyboard.
  - The auto-logoff is interrupted.

### Access a Closed-Mode Client

In closed-mode stations, when the computer is powered up Desigo CC starts automatically with the GMSDefaultUser logged on. To log on, you must log off the GMSDefaultUser and then log on with your own credentials.

1. In the Summary bar, select **Menu > Logoff**.
   - A message box informs you that Desigo CC will be closed and you will be logged on.
2. Click **OK**.
   - GMSDefaultUser is logged off. The initialization splash screen displays for a few seconds. The logon dialog box displays.
3. Enter your username and password.
4. Select the domain.
5. Click **Logon**.
   - Desigo CC restarts in closed mode with your credentials.
Exit a Closed-Mode Session
In closed-mode stations, you cannot shut down Desigo CC. You can only log off to end your session, after which the GMSDefaultUser is automatically logged on.

1. In the Summary bar, select Menu > Logoff.  
   ➤ A message box informs you that Desigo CC will be closed and the GMSDefaultUser will be logged on.
2. Click OK.  
   ➤ You are logged off. Desigo CC starts in closed mode and the GMSDefaultUser is automatically logged on.

Change Your Password
You are logged on as Desigo CC user, and the option to change the user’s password is available in the system menu.

1. In the Summary bar, select Menu > Operator > Change User Password.  
   ➤ The password change window appears.
2. Enter the old password and new password.
3. Confirm password.
4. Click Change Password.  
   ➤ A message informs you that the changes have been successfully saved.

Do an Operator Switchover
You want to log onto a Desigo CC station to take over from the currently logged-on operator.
NOTE: You can carry out this task only if the option to do the operator switchover is available in the system menu.

1. In the Summary bar, select Menu > Operator > Switchover.  
   ➤ The Switchover window displays.
2. Enter the current user password, your username, password, and domain.
3. Click Logon.  
   ➤ The current user is logged off from Desigo CC. The system splash screen displays, then Desigo CC restarts with your user credentials.

1.2.1.2 Working with the System Screen
This section provides instructions for interacting with the main elements of the Desigo CC system screen that are common to all applications. For background information, see the Standard UI Client [7] section.

Switch Between Active Windows
You have two or more active windows (for example, System Manager and Event List), and you want to bring a different one to the foreground on the system screen.

1. In the Summary bar, select Menu > Active Tasks.  
2. From the thumbnail preview of the active windows, select the one you want to bring to the foreground.  
   ➤ The selected window displays on the screen.
Expand or Collapse the Summary Bar

- The Summary bar displays collapsed.

1. In the Summary bar, click down ▼ on the top right or an event indicator.
   - The Summary bar expands.
2. The Summary bar displays expanded.

1. In the Summary bar, click up ▲ on the top right.
   - The Summary bar collapses.

Show or Hide the Event Detail Bar

Depending on the client profile, you can show or hide the Event Detail bar.

Show the Event Detail Bar

- The Event Detail bar is not visible and the command to show it is available on the Summary bar.

1. In the Summary bar, click down ▼.
   - The Event Detail bar displays below the Summary bar.

Hide the Event Detail Bar

- The Event Detail bar is visible, and the command to hide it is available on the Summary bar.

1. In the Summary bar, click up ▲.
   - The Event Detail bar is hidden.

Temporarily Mute the Audio Alert

- The audio alert buzzer on a Desigo CC station is sounding, and you want to mute it temporarily.

1. In the Summary bar, click Audio Alert  
   - The icon changes to muted and the sound stops, even if there are still unacknowledged events. Muting applies only to the pre-existing events: the audio alert will still sound for any new events that come in.

1. To manually unmute the audio alert, click Audio Alert  again.

Permanently Silence the Audio Alert

Depending on the client profile, you can permanently disable the audio alert buzzer on a Desigo CC station, so that it does not sound even if new events come in.

1. In the Summary bar, right-click Audio Alert  
   - The icon changes to disabled  

1. To manually re-enable the audio alert, right-click Audio Alert  again.
Silence the Audio Alert Resound

- The audio alert resumes after 24 hours because a previously-acknowledged event has still not been fully processed (closed) by then.
- A message also displays on the Summary bar. For example, 24 hours Trouble resound: click here to silence.
  - Click the text of the message to silence the audio alert resound.

Display the About Page

- You want to view system information such as the Desigo CC version.
  1. In the Summary bar, select Menu > About Page or click the company logo.
     - The `About` dialog box displays, and shows general information about the software.
  2. *(Optional)* If you work on an installed client station, click System Info.
     - The `System Information` window displays detailed information about the client computer.
  3. Click OK.

Move a System Window to a Second Monitor

When an additional monitor is available, you can move any system window, such as, System Manager, Investigative/Assisted Treatment, Help or Event List (in some client profiles only), from the default monitor to a second monitor. The Summary bar cannot be moved.

- Desigo CC is running as an installed client or Windows pp client on a computer connected to two monitors.
- You want to move a window from the default monitor to the second monitor. For example, you want to move the System Manager window.
  1. Click `Restore Down` in the window.
     - The window restores down, you can move it to another monitor, and the icon changes to `Maximize`.
  2. Drag the window from the default monitor to the second monitor, and click `Maximize`.
     - The window displays on the second monitor. If you minimize the window that displays on the second monitor, the corresponding icon displays in the Windows taskbar of the default monitor. If you maximize the window again, it displays on the monitor where you previously minimized it.

Print from the System Menu

- A printer was previously configured on the Desigo CC server.
  1. In the Summary bar, select Menu > Print.
     - The `Printouts selection` dialog box displays.
  2. *(Optional)* In the `Printouts selection` dialog box, do the following:
     - Clear the check boxes that correspond to the system application printouts you do not want to generate.
     - Click Move up or Move down to change the printout order.
  3. Click Preview.
  4. *(Optional)* In the `Print Preview` dialog box, do the following:
     - Use the zoom icon on the toolbar to zoom in/out and check the output. These toolbar controls only affect the preview, not the printout itself.
- Adjust **Margins** (default is 50 pixels).
- Select the desired **Orientation** (default is Landscape).
- Select the **Printer** and **Paper** size.
- Adjust **Scaling** (default is Fit to page) and, if available, **color option**.

5. Click **Print and Close**.

⇒ The printout is sent to the selected printer.
2 Operating Step-by-Step

2.1 System Manager
This section provides instructions for using the main panes of the System Manager window. For background information, see the reference [➙ 171] section.

2.1.1 Working with System Manager
This section provides instructions for System Manager common tasks. For background information, see Overview of System Manager [➙ 171].

Open System Manager
▷ The System Manager window is not visible.
1. In the Summary bar, select Menu > Active Tasks.
2. From the thumbnail preview of the active windows, select System Manager to bring it to the foreground.

Create Additional System Manager Windows
You can create additional System Manager windows, for example to use on multiple monitors, or to investigate/supervise different aspects of the building control site.
- Do one of the following:
  - From the Desigo CC system menu, select Applications > Start new System Manager.
  - From the expanded Summary bar, click System Manager to open a new System Manager window.

▷ A new System Manager window, labeled System Manager (2), is created. You can switch between it and other windows from the Windows taskbar or from Active tasks on the system menu.
You can repeat these steps to create further System Manager windows, which will successively be labeled System Manager (3), System Manager(4), and so forth.

Close Additional System Manager Windows
1. From the system menu, or from the Windows taskbar, display the window that you want to close, for example, System Manager (2).
2. Click Close in the title bar.

NOTE: You can only close additional System Manager windows in this way. The primary System Manager window (the one labeled System Manager) can only be minimized by clicking Minimize in its title bar.
Change the Pane Layout of System Manager
You can adjust or customize the arrangement of the panes in the System Manager window.

1. In the System Manager window header, if the lock pane layout icon is active (undimmed), click it so that it becomes dimmed. Otherwise the pane layout cannot be changed.

2. To switch between the available preset layouts, click the icons in the title bar:
   - Selection, Primary, and Contextual panes. Secondary pane will open when required.
   - Selection and Primary pane, and the left part of the Contextual pane.
   - Selection and Primary pane.
   - Primary and Contextual pane. Secondary pane will open when required.
   - Primary pane only.
   
   NOTE: Even if the selected layout includes the Secondary pane, the Secondary pane only displays when you make a selection that requires it, and provided the Primary pane is not locked. See Allow or Prevent Opening of the Secondary Pane [➙ 23].

3. To resize the panes in the current layout, drag the splitter (the dividing line) between them.

4. To expand/collapse a pane, click the button on the splitter. (Click the button again to re-expand a collapsed pane).

5. To close the Secondary pane, click Close in its pane header.

6. To prevent the current layout from being changed, click the lock pane layout icon in the title bar (so that it is undimmed). This disables the function that lets you switch between the preset layouts so that panes can no longer be resized, expanded, collapsed, or closed.

Allow or Prevent Opening of the Secondary Pane
Normally, the Secondary pane opens on demand, when you make a selection that requires it. When the Secondary pane opens, it takes up half the space that would otherwise be allotted to the Primary pane. You can prevent the Secondary pane from opening, so that the Primary pane will always occupy its full width.

1. To prevent the Secondary pane from opening, click the pushpin icon in the Primary pane header so that it is in the locked position.

   The Primary pane is locked to full width, and the Secondary pane will not open. Any selections (such as Related Items) that would normally display in the Secondary pane are instead redirected to the Primary pane.

1. To allow the Secondary pane to open again, click the pushpin icon in the Primary pane header so that it is in the unlocked position.

   The Primary pane width is unlocked, and will resize to accommodate the Secondary pane when a selection is made that displays in the Secondary pane.
Set How Objects are Labeled in System Manager
You can define whether objects in System Manager are labeled with just a name, just a description, or both. For background information, see the reference [178] section.

1. In System Browser, click the Display Mode drop-down list.
2. Select how you want the objects to be labeled:
   - Show Description: example Air Handler Unit 1
   - Show Description [Name]: example Air Handler Unit 1 [AHU]
   - Show Name: example AHU1
   - Show Name [Description]: example AHU1 [Air Handler Unit 1]

$\Rightarrow$ The objects are labeled in the selected way in the System Browser tree, and also throughout the other panes in System Manager.

NOTE: The choice you make here persists across sessions and is specific to the user. It also determines whether you can search for objects in the system tree by name or by description.

Set How Selections Propagate to Other Panes
You can set whether the Primary and Contextual panes will automatically refresh whenever you make a selection in System Browser.

- To disable automatic propagation, select the Manual navigation check box.
  $\Rightarrow$ The next time you click on an object in the tree, the Primary and Contextual panes will not be automatically updated, and you will have to do this manually. See Manually Propagate a Selection to Other Panes [24].
- To enable automatic propagation, deselect the Manual navigation check box.
  $\Rightarrow$ The next time you select an object in the tree, the Primary and Contextual panes will automatically refresh to reflect the new selection.

Manually Propagate a Selection to Other Panes
$\Rightarrow$ You made a selection in System Browser with Manual navigation checked, so that the Primary and Contextual panes were not automatically refreshed. You now want to manually propagate this selection.

- To propagate this selection to the Primary and Contextual panes, do one of the following in System Browser:
  - Click the Send button.
  - Right-click on the selection in the tree, and select Send to the Primary Pane.
  - (Only for an individual object) Double-click the object.

$\Rightarrow$ The Primary and Contextual panes of System Manager update with content relevant to the selected objects.

1. To propagate this selection to the Secondary pane, do the following:
   a. In the System Manager header, check that the current pane layout includes the Secondary pane: or
   b. In the Primary pane header, check that the pushpin icon is in the unlocked position , so that opening of the Secondary pane is allowed.
   c. In System Browser, right-click on the selection in the tree, and select Send to the Secondary Pane.
Send a Selection to the Secondary Pane

You can work with a system object in the Secondary pane so that the current contents of the Primary and Contextual panes will not be changed.

1. In the System Manager window header, check that the current pane layout includes the Secondary pane: or .

2. In the Primary pane header, check that the pushpin icon is in the unlocked position , so that opening of the Secondary pane is allowed.

3. In System Browser, navigate to the object that you want to work with.
   **NOTE:** Select the Manual navigation check box if you do not want the Primary and Contextual panes to refresh while you are doing this.

4. Right-click the object in the tree and select Send to the Secondary Pane.
   ⊳ The content pertaining to the selected object displays only in the Secondary pane, whereas the content of the Primary and Contextual panes is not changed.

Select an Object in System Browser

1. In System Browser, from the Views drop-down list, select the view (Application View, Management View, or some other custom-configured view) you want to work with.
   ⊳ The System Browser tree updates to display the selected view.

2. Browse the objects in the System Browser tree as you would the folders in a computer. An arrow icon indicates a folder or parent object that contains other objects inside it:
   – Click the side arrow icon alongside a collapsed node to expand the node and view its children.
   – Click the down arrow icon alongside an expanded node to collapse it again and hide its children.

3. Select the object you want to work with by clicking its label in the System Browser tree.
   ⊳ The selected object displays highlighted in the tree. If the Manual navigation check box is deselected, the Primary and Contextual panes of System Manager are automatically updated to reflect the new selection.

4. If the Manual navigation check box is selected, do one of the following to manually propagate the selection to the Primary and Contextual panes:
   – Double-click the object.
   – Click the Send button.
   – Right-click the selected object and select Send to the Primary Pane.

Select Multiple Objects in System Browser

1. In System Browser, select the view (Application View, Management View, or some other custom-configured view) you want to work with.
   ⊳ The System Browser tree updates to display the selected view.

2. Do one of the following to find the set of objects you want to select:
   – Navigate to the desired objects in the System Browser tree. Click to expand a collapsed node and view its children, or click to collapse an expanded node and hide its children.
- Run a search by name/description and other criteria such as discipline, type, and so forth. See Searching for Objects [➙ 28].

3. From the System Browser tree, or from the list of search results, select the objects as follows:
- To select multiple non-contiguous objects, press and hold the CTRL key while clicking the objects.
- To select multiple contiguous objects, press and hold the SHIFT key while clicking the first and the last object in the range.
  The selected objects display highlighted in the tree. If the Manual navigation check box is deselected, the Primary and Contextual panes of System Manager are automatically updated to reflect the new selection.

4. If the Manual navigation check box was selected, do one of the following to propagate the selection:
- Click the Send button or right-click the selection and select Send to the Primary pane.
  The Primary and Contextual panes of System Manager refresh to reflect the new selection.
- Right-click the selection and select Send to the Secondary pane.
  The Secondary pane of System Manager refreshes to reflect the new selection. The Primary and Contextual panes remain unchanged.

Browse and Select Objects with the Navigation Bar
You can use the Navigation bar’s breadcrumb trail to move around the system tree and select objects. This allows you to make selections even with System Manager layouts that do not include the Selection pane. For background information, see Navigation Bar [➙ 176].

1. If the Navigation bar is not already visible, click Open navigation bar in the System Manager window header.
  The Navigation bar displays along the top of the System Manager window, directly underneath the title bar. The breadcrumb trail shows the full path of your current selection in the system tree. Whenever the current primary selection is changed, the breadcrumb trail refreshes to reflect the new position in the system path.

2. To begin browsing the tree, click an arrow icon alongside a path element.
  A drop-down list displays of all the items directly beneath it in the system tree. (For example, clicking the arrow icon to the right of Applications displays a drop-down list that includes Documents, Graphics, Address Book, and so on.)

3. Click an item in the drop-down list (for example, Documents) to make it the new selection.
  System Browser, the Primary pane, and the Contextual pane all update to reflect the new selection.
  NOTE: The selection made here propagates to the other panes even if you selected Manual navigation in System Browser.

4. Continue moving around the tree in this way until you reach the object you are interested in.
  NOTE: From the breadcrumb trail, you can only make single selections that go to the Primary and Contextual panes. To send a selection to the Secondary pane, or to make multiple selections, you must use System Browser.
Revisit Recent Selections from the Navigation Bar

The Navigation bar provides a browser-like history of recent selections so that you can easily revisit objects previously displayed in the Primary pane. For background information, see Navigation Bar [→ 176].

1. Click Open navigation bar in the System Manager header.
2. To jump to a specific, previously-visited selection:
   a. Click or press CTRL+H to view the selection history. As a result, a drop-down list of your 20 most recent Primary-pane selections (in descending order from newest to oldest) displays. The one currently displayed in the Primary pane is highlighted with a checkmark.
   b. Click the name of the selection in the list that you want to revisit. The selection displays again in the Primary pane. The Contextual pane, System Browser, and the Navigation bar also refresh accordingly.
3. To move sequentially through the history list of recent selections:
   – Click the Back or Forward buttons, or use the ALT+Left or ALT+Right keyboard shortcuts.

Set a Favorite Location in System Manager

You can bookmark a particular selection as your favorite location, so that it displays as the initial location whenever you open System Manager and that you can easily access by clicking Favorite location in the Navigation bar. For background information, see Navigation Bar [→ 176].

1. Select the object you want to set as the favorite location, so that it displays in the Primary pane.
2. If the Navigation bar is not already visible, click Open navigation bar in the System Manager header.
3. In the Navigation bar, click and hold Favorite location for 2 seconds. A status message indicates that the new favorite location is set and stored in your user profile.
4. To jump to the favorite location at any time, click Favorite location in the Navigation bar or press the ALT+Home keys. The favorite location displays in the Primary pane. The Contextual pane, System Browser, and the Navigation bar all refresh accordingly.

Revisit Recent Selections from Recently Viewed

The Recently Viewed feature lets you return to a previously visited view in the Primary pane. For background information, see Recently Viewed [→ 177].

1. In the Selection pane, click the Recently Viewed tab. Recently Viewed displays a list of the recently visited views in the Primary pane.
2. Do the following:
   – Click the Links/Thumbnails button to switch between displaying the recent items as snapshots or text links.
Chain of Thought:

1. The document describes the operating steps for System Browser tasks.
2. It provides instructions for selecting views, searching for objects, filtering searches, and saving searches.
3. Each task is broken down into sub-sections with detailed steps.

The selected view displays in the Primary pane, and a new recently visited view item is created and displays in Recently Viewed.

2.1.2 System Browser

This section provides step-by-step instructions for System Browser tasks. For background information, see the reference [178] section.

2.1.2.1 Selecting Views

1. From the Views list box, click the drop-down arrow.
2. From the list of available views, select the view you want to display.

2.1.2.2 Searching for Objects

1. In the Search list box, enter the name of the object you want to search for. You can use wildcarding when performing a search.
2. Click the Search icon.

2.1.2.3 Filtering Searches

1. You want to filter a search to limit the results that your search returns, and you have already entered text in the Search list box.
2. Click the Filter icon.
3. In the Type field, click the drop-down arrow and select the object type and subtypes you want to filter by.
4. In the Discipline field, click the drop-down arrow and select the discipline and subdisciplines you want to filter by.
5. In the Other field, click the drop-down arrow and select the settings you want to filter by.
6. In the Alias field, enter the case-sensitive alias you want to filter by.
7. If you want to limit your search to the currently selected node in the tree, select the Search within selection check box.
8. Click Search to begin the search.
   ▶ The search results display in the tree area.

2.1.2.4 Saving Searches

▶ You have performed a search using the appropriate filtering criteria as needed.
1. Click Save Search.
2. In the Save Search field, type a name for your search.
3. Click Save.
   ▶ The system saves the search filtering criteria but not the location in the tree at the time of the save.
2.1.2.5 Choosing a Display Mode
1. In System Browser, click the Display Mode drop-down list.
2. Select the mode you want for displaying objects.
   The object displays in the new mode throughout the various panes in System Manager.

2.1.2.6 Making a Manually Selected Object the New Primary Selection
   The Manual Navigation box is checked, with one or more objects selected.
   Do one of the following:
   - Right-click and select Send to the Primary Pane.
   - Click the Send button.
   - Double-click the object.

   **NOTE:**
   Double-clicking works only when selecting a single object.

2.1.2.7 Operating Multiple Objects
Multiple objects can be commanded or engineered using multi-select.
To select a number of non-adjacent objects:
1. Select the first object using the mouse.
2. Press the CTRL key and hold it.
3. Select all other desired objects using the mouse.
To select a range of adjacent objects:
1. Select the beginning of your range of objects using the mouse.
2. Press the SHIFT key and hold it.
3. Select the end of your range of objects using the mouse.

   **NOTE:**
   Limitations for selected objects are 250 items for commanding.

Commanding Multiple Objects in the Operation Tab
   The objects must be of the same object type, such as analog input. If different object types are selected, in the Operation tab, the message No properties (different properties) displays.
1. In System Browser, select Management View.
2. Select the objects you want to change.
3. In the Operation tab, select the properties that you want to command.
   If the properties have different values, they are displayed with an asterisk (*) but can be commanded.
4. *(Optional)* Click the icon to display detailed information about the selected data points.

5. Do one of the following:
   - Change the value and click **Send** or **Change**.
   - Click a command button to execute the respective function.
   
   ➞ Only objects properties that have been changed will be logged in the Activity Log database.

### 2.1.3 Textual Viewer

This section provides step-by-step instructions for Textual Viewer. For background information, see the reference [➙ 182] section.

#### 2.1.3.1 Customizing Columns

ขา System Manager is in Operating mode.

1. In Textual Viewer, right-click one of the following:
   - Column heading
   - Row
   - Scroll bar within the Primary pane

2. Select **Customize columns**.
   
   ➞ The **Customize Columns** dialog box displays.

3. Do one of the following:
   - To remove columns from the Visible list, select one or more headings, and then click the active arrow to move the headings.
   - To add columns to the Visible list, select one or more headings from the Available list, and then click the active arrow to move the headings.

4. Use the **Move up** and **Move down** buttons to arrange the order of the columns.

5. Click **OK**.

#### 2.1.3.2 Making a New Primary Selection

ขา System Manager is in Operating mode.

 vX Textual Viewer displays more than one object, and you would like to make one of those objects the new primary selection.
2.1.3.3 Rearranging Columns

- System Manager is in **Operating** mode.
- **Textual Viewer** is open, and you would like to rearrange the order of the columns.

1. Select the column you want to move.
2. Drag-and-drop the column onto the desired location.

2.1.3.4 Sorting Objects

- System Manager is in **Operating** mode.
- You have more than one object displaying in **Textual Viewer**, and you would like to sort them.

1. In the column you want to sort, click the column heading.
2. Do one of the following:
   - If the column is arranged in alphabetical order and you want to arrange it in reverse alphabetical order, select the column heading. When the up arrow displays, click the column heading again.
   - If the column is in reverse alphabetical order and you want to arrange it in alphabetical order, select the column heading.

- The column sorts itself in either an ascending or descending alphabetical order, depending on the order prior to selecting the drop-down arrow.

2.1.4 Operation

This section provides step-by-step instructions for Operation tasks. For background information, see the reference [ ➔ 184] section.

2.1.4.1 Commanding Properties

- You have selected the object whose properties you want to command.

1. Click the **Operation** tab.
   - The tab displays properties of the object, their states, and all commands available for the properties.
2. Click the command button that displays the command you want to execute.
   - If the command does not have arguments associated with it, the command is sent and the status displays.
   - If the command button has arguments associated with it, go to the next step.
3. Complete the required fields.
4. Click **Send**.
   - The system displays the status of the command.
2.1.4.2 Commanding Properties for Multiple Objects

You want to simultaneously command properties for multiple objects of the same type.

1. In System Browser, navigate to the locations containing the objects you want to select, and then select them.
2. Click the Operation tab.
3. Click the triangular symbol in the lower-right-hand corner on the icon next to the property you want to command.
   - The table row expands to show multiple instances of the property—one for each of the objects selected.
4. Do one of the following:
   - In the top row of the property, enter the value for the property, and then click Change.
   - In the top row of the property, click the button that represents the action you want to take, for example, Command, Release, Change, Out of Svc, Enable or Ack All. If the action has additional fields, complete them, and then click Send.
   - The system displays the status of the command.

2.1.5 Related Items

This section provides step-by-step instructions for working with related items. For background information, see the reference [189] section.

2.1.5.1 Viewing a Related Item

You have selected an object with related items.

- From Related Items, click the item you would like to view—for example, click a New Report, a Schedule, a PDF file, or a URL.
- The management station opens the representation for the selected item in the Secondary Pane (or in the Primary pane if the Primary pane splitting is locked).

2.1.5.2 Viewing Links

You have selected an object with related items displayed as icons.

- From Related Items, click the Links button.
- The related items display in Links view.

2.1.5.3 Viewing Icons

You have selected an object with Related Items displayed as links.

- From Related Items, click the Icons button.
- The related items display in the Icons view.

2.1.5.4 Grouping Items in the List

You have selected an object with Related Items displayed in a flat list.

- From Related Items, click the Group button.
- All related items are grouped according to type—for example, Report, Graphic, Schedule, etc.
2.1.5.5 Ungrouping Items in the List
- You have selected an object with Related Items displayed in Groups view.
- From Related Items, click the Ungroup button.
- All items are ungrouped.

2.1.5.6 Creating a New Object
- You have selected an object with links displaying in Related Items.
- From Related Items, click the type of object you would like to create—for example, New Report.
- The management station opens a new object type in the Secondary pane.

2.2 Graphics Viewer
This section provides additional step-by-step instructions for common tasks related to viewing graphics.
For related background information, see the reference section.

2.2.1 Displaying Graphics and Properties
Select the topic related to your task:

Display and Hide a Coverage Area
- A graphic is displayed in the Graphics Viewer and you want to display the coverage area for the cameras or any monitoring device on the graphic. The coverage area shows the objects on your graphic that are within the viewing or monitoring range of a camera or device.
- System Manager is in Operating mode.
1. In System Browser, select Application View.
2. Select Applications > Graphics.
3. Click Coverage Area.
   - All configured coverage areas on the graphic display.
4. To view the data points from all the objects in the coverage area that are monitored by the camera or device, move your cursor over the coverage area.
   - The tooltip displays a list of monitored objects.
5. To hide the coverage area, click Coverage Area.
   - The coverage area is toggled to hide the coverage area from displaying on the graphic.

Display Object Properties
- You have an object in the System Browser and you want to display the associated properties.
- You have manually displayed the Status and Commands window for an object on a graphic.
- A graphic has an object in an off normal state and the associated Status and Commands window has automatically displayed.
- From System Browser, you have selected the object you want to command.
1. From the Status and Commands window, navigate the property you want to command. If there are more than four properties displayed in the window, you may have to scroll to locate the property.
   ➤ The system displays a list of the object’s properties, their current state, value, status, and all commands available to you for this object, based on your system privileges and the configuration settings for the object.

2. Complete the required fields and click the associated command button that displays the command you want to execute.
   ➤ Depending on the command type, the command is sent, updated, or acknowledged and the status displays.

3. Observe the status of the command.

2.2.2 Navigating in the Graphics Viewer
Select the topic related to your task:

Navigate to the Graphics Library Browser
➤ System Manager is in Operating mode.
1. In System Browser, select Management View.
2. Select Project > System Settings > Libraries.
3. Click any of your graphic symbol folders.
   ➤ The Graphics Library Browser displays.

Navigate to a Linked Element
If configured, an element on a graphic can be used as direct navigation to an internal or external link.
➤ You have an element on a graphic that if selected links to an internal or external element.
1. (Optional) Move your cursor over the element to display the tooltip and view the linked path and descriptive text about the linked element.
2. Click or double-click the element.
   ➤ If the link is an internal link, the linked item becomes the primary selection.
   ➤ If the link is external, the document, website, or application displays.

Navigate to a Depth or Layer in a Graphic
➤ You want to view a specific depth associated with a graphic, and, optionally, filter the view of the depth by its associated layers.
➤ System Manager is in Operating mode.
1. In System Browser, select Application View.
2. Select Applications > Graphics > [graphic].
3. Click DepthsNavigation View and select the depth you want to view.
   ➤ The Graphic and the Navigation View displays a list of all layers associated with the depth.
4. (Optional) Select the Discipline radial button, and from the drop-down menu select a discipline, or select <All> to view all layers.
   - The graphic updates and only displays the layers associated with the selected discipline.
   - The list of layers in the Navigation View is grayed-out, and only the layers associated with the selected depth are check-marked.

5. (Optional) Select the Layers radial button, and from the list of layers check-mark each layer you want to include in the graphic view, or uncheck a layer to remove it from view. As you make your selections the graphic view is automatically updated.
   - The graphic is updated.

Drag-and-Drop an Object Property to the Graphics Editor

Referenced properties of an object or Symbol on a graphic in the Graphics Viewer can easily be dragged over to another graphic in the Graphics Editor or any other view or pane in that accepts a drag source.

NOTE:
To select multiple objects, nodes, or properties, click CTRL and then click each item you want to drag over to the Graphics Editor.

1. Hover over an element or symbol in the Graphics Viewer. A red border displays around the highlighted object.
2. Click and drag.
   - The cursor changes to 
3. Release the mouse button when the cursor changes to over the intended drop target.
   - The data from the object is copied to the area or field.

2.2.3 Selecting Objects in the Graphics Viewer

NOTE 1: When you select a graphics object from System Browser, the Graphics Viewer displays the representative graphic. The selected object is considered the primary selection. The object also displays in the Property Viewer.
NOTE 2: If you click another object in the graphic, that object becomes the secondary selection. As a result, Property Viewer changes its display to correspond to the new selection. System Browser, however, still displays the original, primary selection to show your starting point.
NOTE 3: Double-clicking another object on the graphic makes that object the new primary selection in the Graphics Viewer and System Browser, while the object remains the secondary selection in the Property Viewer.
1. In System Browser, select Application View.

2. Select Applications > Graphics > [graphic object].
   ➤ Graphics Viewer displays the graphic object.

**Select Objects within Graphics Viewer**

- You have a graphic open, and you would like to view the properties of an object on the graphic.

- System Manager is in Operating mode.

1. In System Browser, select Application View.

2. Select Applications > Graphics > [graphic].

3. Click the object. You can also select multiple objects by holding down the CTRL key while clicking on more than one object.
   ➤ The object becomes the focus, and the object properties display in Property Viewer.

### 2.2.4 Working with the Point Centered Display Mode

Select the topic related to your task:

**Enable Point Centered Display Mode**

- System Manager is in Operating mode.

1. In System Browser, select Application View.

2. Select Applications > Graphics.

3. Select the point object.

4. Click Point Centered Display mode and select one of the following options:
   - Point: Point Centered Display mode is enabled for the point object to display in the center of the pane or canvas.
   - Group – Point Centered Display mode is enabled for point objects to display in the center of the pane or canvas.
   ➤ A checkmark displays next to the selected mode and the Point Centered Display mode is set on the canvas.

**Disable Point Centered Display Mode**

- System Manager is in Engineering mode.

1. In System Browser, select Application View.

2. Select Application > Graphics.

3. Click Point Centered Display mode.

4. Select None.
   ➤ Point Centered Display mode is disabled.
### 2.2.5 Zooming in the Graphics Viewer

Select the topic related to your task:

**Center and Zoom with the Aerial View**

- You have a graphic open and would like to display the Aerial View.
- System Manager is in **Operating** mode.

1. In System Browser, select Application View.
2. Select **Applications > Graphics** > [graphic].
3. Click **Aerial View**.
   - The Aerial View displays.
4. Do one of the following:
   - Click a specific area to adjust the view. The clicked area is the center.
   - Click and drag the mouse to draw a rectangle around the specific area of the graphic you want to focus on.
   - The graphic is resized and refocused around the area you clicked or drew.

**Zoom into a Graphic using Options from the Toolbar**

The zoom factor of a graphic can be changed using one of the following methods:

1. In System Browser, select Application View.
2. Select **Applications > Graphics** > [graphic].
3. You have the following zoom options available to you:
   - Click **Default View 100%** to display the active graphic at 100% magnification.
   - Click **Scale to fit** so that the entire graphic and all the objects on the graphic are visible.
   - Click **Zoom In (+20)** or **Zoom Out (-20)** to zoom in or out, accordingly, by a factor of 20% with each click of the icon.
   - Click **Zoom View** and from the Zoom View pane, click and drag the **Zoom Slider** to either increase or decrease magnification of the active elements.
   - Click **Zoom** to select from a list of pre-defined zoom factors.
   - Click **Zoom Real** to zoom in and out, using your mouse wheel.

### 2.2.6 Additional Graphics Viewer Procedures

This section provides additional step-by-step instructions for common tasks related to viewing graphics.

Select the topic related to your task:

**Command a Property in the Graphics Viewer**

- You have a graphic open in Graphics Viewer, and you want to command the properties of an object in the graphic.
1. Right-click the object, and select **Status and Commands**.
   - The system displays a list of the object’s properties, their current state, value, status, and all commands available to you for this object, based on your system privileges and the configuration settings for the object.
   - If you select multiple properties to command, the selected properties display an icon with a triangular Symbol in the lower right-hand corner.

2. If you selected multiple properties in the step above, click the triangular symbol on the icon next to the property you want to command. Otherwise, proceed to Step 3.
   - The table row of the property expands to show multiple instances of the property—one for each of the objects selected.

3. Click the command button that displays the command you want to execute.
   - If the command does not have arguments associated with it, the command is sent and the status displays.

4. *(Optional)* If the command button has arguments associated with it, proceed to Step 5.

5. *(Optional)* Complete the required fields if any are associated with the command.

6. Click **Send**.
   - The system displays the status of the command.

### Create a Graphics Sub-Folder

You want to create a Graphics sub-folder in System Browser and in your project’s Graphics folder.

- System Manager is in **Engineering** mode.
- The **Graphics Editor** is displayed in the in the **Graphics** tab of the work area.

1. In System Browser, select **Application View**.

2. Select **Application > Graphics** or an existing sub-folder as the location for your new graphics folder.

3. Click **New** and select **New Folder**.

4. In the **Create New Folder** dialog box, type a name for the new folder.

5. Click **OK**.
   - The folder is available in System Browser.

### Delete a Graphic Object

You want to delete a graphic item, a graphic or a folder, from the **Graphics** folder.

**NOTE:**
You can only delete an empty folder, not a folder that contains any graphical objects.

- System Manager is in **Engineering** mode.
- The Graphics Editor is displayed.

1. In System Browser, select **Application View**.

2. Select **Applications > Graphics > [graphic or graphic folder]**.
3. Click **Delete**.
   ⚫ A confirmation message displays.

4. Click **Yes**.
   ⚫ The graphic item is deleted.

**Edit a Graphic**

<table>
<thead>
<tr>
<th><strong>NOTICE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
</tr>
<tr>
<td>In order to complete this procedure, you must have the appropriate access rights to for the Graphics Editor.</td>
</tr>
</tbody>
</table>

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Applications > Graphics > [graphic]**.
3. Click **Edit**.
   ⚫ The Graphics Editor displays.
4. Make modifications to the graphic.
5. Click **Save As**.
6. In the **Save As** dialog box, do the following:
   - Select a destination folder.
   - Enter a name.
   - Click **Save**.
   ⚫ The edited graphic is saved.

**Print from the Graphics Viewer**

- System Manager is in **Operating** mode.
1. In System Browser, select **Application View**.
2. Select **Applications > Graphics > [graphic]**.
3. Do one of the following.
   - Click **Print**.
     - In the **Print** dialog box, select the printer.
     - Select **Print**.
   - Click **Page setup**.
     - In the **Page setup** window, configure the settings as necessary
     - Click **Print**.
     - In the **Print** dialog box, select the printer.
     - Select **Print**.
   ⚫ The graphic is printed.

**Related Topics**
For background information, see Graphics Editor Reference. [⇒ 192]
2.3 Alarms

This section provides instructions for common tasks related to event handling in Desigo CC. For background information, see the reference section.

2.3.1 Handling Events from Event List

The Event List window is your main starting point for dealing with events. From here you can get information about an event or its source, directly send event-handling commands, and initiate investigative or assisted treatment.

![Event List Workspace](Figure 3: Event List Workspace)

Silence the Station Audio Alert

▷ An audio alert is active on your Desigo CC station.

1. On the right-hand side of the Summary bar, click .

▷ The audio alert is silenced .

Open Event List

▷ The Event List window is not visible.

1. On the right-hand side of the Summary bar, click Open Event List .

▷ Event List displays in the main work area of Desigo CC.
Select an Event in the List
- Click the row of the event that you want to handle.

**NOTE:** In some Client Profiles, you can start sending commands directly without clicking on the event first to select it. In that case you can skip this step. Also, in some configurations, certain types of events autoselect when they occur, in which case you will not have to do this step.

* The event is selected, and its event descriptor becomes highlighted:
  - The **In process by** field updates to indicate you are currently handling this event.
  - If any other event was previously selected, it is automatically deselected (suspended).

Select Multiple Events in the List
1. To perform a multiple selection, do one or more of the following:
   - Press **CTRL+A** to select all the events in the list.
   - Hold **CTRL** and click the event buttons one-by-one, to add events to the selection.
   - Hold **SHIFT** and click the first and last event buttons of a range to add a contiguous set of events to the selection.

2. To remove an event from the selection, press **CTRL** and click its event button.
3. To deselect all the events in the selection, click the event button of any one of the selected events.

* A group of events is selected, and their event descriptors display highlighted. Any commands you issue will be sent to all the events for which that command is available.

Send Event Handling Commands
From the event descriptor, use the icons in the **Commands** column to send any commands as they become available. The commands you must send will vary depending on configuration. A typical sequence may include:

1. Click ✅ to acknowledge the event.
2. After acknowledging the event, if the event caused a field panel to sound an audible alarm in the site, click 📣 to silence the panel, or click 🔊 to turn it back.
3. If any remote notification is configured for that event, click 📻 to start remote notifications or ⏰ to stop them.
4. Click ⏰ to reset the event.
5. Click ✗ to close the event.
Check the Event Status

When no further commands are available, use the Event Status and Suggested Action columns to determine the next action you need to take. A typical sequence may include:

1. Event Status = Waiting for condition:
   - Suggested Action = Complete operating procedure. No further commands are available because you must first complete at least the mandatory steps of the operating procedure.
   a. In the Information column, click Open related treatment to open the assisted treatment window.
   b. Complete the operating procedure [→ 48].
   - Suggested Action = Wait for condition. The event cannot be reset until the event source is back to normal.
   a. You must correct the situation that caused the event or wait for the Source Status to return to Quiet, before you can send the remaining commands.

2. Event Status = Closed. You finished handling this event, and the event is ready to be cleared from the list. Click the event button again to deselect the event. It will then be removed from Event List.

Get More Information About the Event

You can do one or more of the following to get more information about an event or its source.

- View the inline information text:
  a. In the Information column, click Show information text.
  b. Any technical information available for that event displays. The text provided in the Message text column is also repeated here.
  c. Click the icon again to hide the information.

- Open the Contextual pane without leaving Event List:
  a. In the Event List header, click the two-pane layout icon.
  b. The Operation, Extended Operation, and Detailed Log tabs display at the bottom of the window. From here you can:
     - Inspect the properties of the point that issued the event.
     - View and execute any commands/actions available for that object.
     - View a detailed log of the event currently being handled.
  c. When you are finished, to hide the Contextual pane, click the splitter button, or click the single-pane layout icon.
• Jump to the event source in System Manager:
  a. In the **Source** column, click the name of the event source.
  b. System Manager opens with the event source automatically selected in System Browser.
  c. Use **Textual Viewer** or **Graphics Viewer** to view details about the point that issued the event.
  d. Use the **Operation** tab to view the properties of that object, and any commands available for it.
  e. To go back to Event List, click **Open Event List** in the Summary bar.

---

**Log an Event Note in the History Database**
You can optionally log a note about the event in the history database.

1. In the **Information** column, click **Log an event note**.

2. In the **Note Editor** dialog box, enter the text of the note, and click **OK**.
   - The note is stored in the History Database. If you selected multiple events, this note will be logged as applying to all those events. You can generate a report (Activity Log or Event Detail Log) to print any logged event notes.

---

**Interrupt Handling of an Event**
You can interrupt the handling of an event at any time, for example, because a more important event has come in that you want to deal with right away.

- To interrupt handling of an event, do one of the following:
  - Click the event button again.
  - Select a different event in the list.

   - The event is deselected and no longer appears highlighted. Its **Event Status** remains as it was when you interrupted handling the event. You can resume handling this event at any time by selecting it again.
Finish Handling an Event
When you have finished handling an event its Event Status changes to Closed. Depending on configuration, the event may be automatically cleared from the list. Otherwise:

- Click the event button again to deselect the event and clear it from the list.

2.3.2 Handling an Event with Investigative Treatment
The investigative treatment window lets you send event-handling commands while using System Manager to inspect the event source.

Start Investigative Treatment

▷ An event button without the icon is available in Event List, or in the Event Detail bar.

**NOTE:** If the icon is present you must instead handle the event with assisted treatment. See Handling Events with Assisted Treatment [46].

- Do one of the following:
  - If the event is not yet selected, depending on the Client Profile, single-click or double-click the event button.
  - If the event is already selected, in the Information column, click Opens related treatment.

▷ The Investigative Treatment window opens. This is a window like System Manager, with the event descriptor along the top, and the object that caused the event already selected in System Browser. In Event List, the event button
for that event is replaced by a blank placeholder to indicate it is under investigative treatment.

**Send Event Handling Commands**
From the event descriptor, use the icons in the **Commands** column to send any commands as they become available. The commands you must send will vary depending on configuration. A typical sequence may include:

1. Click ☑️ to acknowledge the event.
2. After acknowledging the event, if the event caused a field panel to sound an audible alarm in the site, click 🔊 to silence the panel, or click 🎨 to turn it back.
3. If any remote notification is configured for that event, click 📣 to start remote notifications or 🎯 to stop them.
4. Click ✗ to reset the event.
5. Click ✗ to close the event.

<table>
<thead>
<tr>
<th>Trouble OUT (Fault)</th>
<th>NIC_Xnet @ address...</th>
<th>01:001:000:000.0 Node Not Inhibited...</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Station reachable</th>
<th>FEP1_Reachable</th>
<th>Station reachabale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station reachable</td>
<td>FEP1_Reachable</td>
<td>Station reachabale</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comark driver running (F4)</th>
<th>Comark Driver On F4</th>
<th>Comark Driver Running (Started)</th>
</tr>
</thead>
</table>

**Check the Event Status**
When no further commands are available, use the **Event Status** column to determine the next action you need to take. A typical sequence may include:

1. **Event Status** = Waiting for condition: The event cannot be reset until the event source is back to normal.
   - You must correct the situation that caused the event or wait for the **Source Status** to return to Quiet, before you can send the remaining commands.
2. **Event Status** = Closed. You finished handling this event, and the event is ready to be cleared from the list.
   - Click the event button again to deselect the event.
   - The **Investigative Treatment** window closes, and the event is removed from Event List.

**Switch Between Investigative Treatment and Event List**
You can switch back to check Event List, and handle other events from there, without interrupting the investigative treatment currently in progress.

- The **Investigative Treatment** window displays in the foreground.

1. In the Summary bar, do one of the following:
   - Click **Open Event List**.
   - Select **Menu > Active Tasks > Event List**.
   - Event List displays. The event that you are currently handling in investigative treatment is indicated by a blank placeholder in place of the event button. The **Investigative Treatment** window is moved to the background but not closed.
2. *(Optional)* If required, you can select other events in Event List, and send event-handling commands from there. You cannot select the event that is currently in investigative treatment.

3. To return to investigative treatment, in the Summary bar, do one of the following:
   - Click **Close Event List**.
   - Select **Menu > Active Tasks > Investigative Treatment**.
   
   The **Investigative Treatment** window returns to the foreground and you can resume the handling of the event from there.

### Interrupt Investigative Treatment of an Event

You can interrupt the investigative treatment of an event at any time, and then either finish the handling of the event from Event List or resume investigative treatment later.

- To interrupt investigative treatment of an event, do one of the following:
  - In the **Investigative Treatment** window, click the event button in the event descriptor along the top.
  - In Event List or the Event Detail bar, click the blank placeholder that displays in the position of the event button.

  The **Investigative Treatment** window closes. In Event List, the event is deselected, and the event button displays again instead of the blank placeholder. The **Event Status** remains as it was when you interrupted handling the event.

**NOTE:**
You can only have one event in assisted or investigative treatment at any given time. If you want to start assisted or investigative treatment of another event, this will interrupt any assisted/investigative treatment currently in progress. However, you can later resume the interrupted treatment from where you left off.

### Finish Investigative Treatment of an Event

When you have sent all the required commands and finished handling the event, the **Event Status** changes to **Closed** and the **Suggested Action** is **Suspend the event**.

- Do one of the following:
  - In the **Investigative Treatment** window, click the event button in the event descriptor along the top.
  - In Event List or the Event Detail bar, click the blank placeholder that displays in the position of the event button.

  The **Investigative Treatment** window closes, and the event is cleared from Event List.
2.3.3 Handling Events with Assisted Treatment

Assisted treatment provides a guided step-by-step procedure for handling an event. The icon on an event button indicates that an assisted treatment procedure is available for that event.

![Figure 5: Example of an Assisted Treatment Window](image)

![Figure 6: Example of Event Button with Assisted Treatment Available](image)

**Start Assisted Treatment**

- An event button with the icon is available in Event List, or in the Event Detail bar.
- Do one of the following:
  - If the event is not yet selected, depending on the Client Profile, single-click or double-click the event button.
  - If the event is already selected, in the Information column, click Opens related treatment.
- The Assisted Treatment window opens. It displays the descriptor of the event that you are handling along the top, and below it a sequence of steps you must follow to handle that event. In Event List, the event button for that event is replaced by a blank placeholder to indicate it is under assisted treatment.
- If assisted or investigative treatment of any other event was in progress, it is interrupted. You can only have one event in assisted or investigative treatment at any given time.
Send Event Handling Commands
From the event descriptor, use the icons in the Commands column to send any commands as they become available. The commands you must send will vary depending on configuration. A typical sequence may include:

1. Click ☑ to acknowledge the event.
2. After acknowledging the event, if the event caused a field panel to sound an audible alarm in the site, click ☑ to silence the panel, or click ☑ to turn it back.
3. If any remote notification is configured for that event, click ☑ to start remote notifications or ☑ to stop them.
4. Click ☑ to reset the event.
5. Click ☑ to close the event.

Check the Event Status
When no further commands are available, use the Event Status and Suggested Action columns to determine the next action you need to take. A typical sequence may include:

1. Event Status = Waiting for condition:
   - Suggested Action = Complete operating procedure. No further commands are available because you must first complete at least the mandatory steps of the operating procedure. See Complete the Operating Procedure, below.
   - Suggested Action = Wait for condition. The event cannot be reset until the event source is back to normal. You must correct the situation that caused the event or wait for the Source Status to return to Quiet, before you can send the remaining commands.

2. Event Status = Closed. You finished handling this event, and the event is ready to be cleared from the list.
   a. Click the event button again to deselect the event.
      ✤ The Assisted Treatment window closes, and the event is removed from Event List.
Complete the Operating Procedure

The **Steps** pane on the left lists the tasks to perform to handle the event.

Mandatory steps are marked with an exclamation mark . The step currently being executed is marked with a triangle .

![Diagram of Operating Procedure Steps]

**Figure 7: Operating Procedure Steps**

1. Click on the step you want to execute.

   **NOTE:** When you move your mouse over a step, if the pointer turns into a hand it means you can execute that step. If the step is not available, this is usually because a preceding mandatory step needs to be completed first. In this case, try another step.

   - The step expands and is marked to indicate that it is being executed.

   Information and tools for performing that step display in the **Default** tab. For example, if you selected a document step, the document that you must read will display.

2. Perform the tasks required for the selected step. For detailed instructions, see:

   - Executing a Document Step in Assisted Treatment [→ 51]
   - Executing a Graphic Step in Assisted Treatment [→ 52]
   - Executing a Remote Notification Step in Assisted Treatment [→ 53]
   - Executing a Report Step in Assisted Treatment [→ 54]
   - Executing a Treatment Form Step in Assisted Treatment [→ 54]
   - Executing an Alarm Printout Step in Assisted Treatment [→ 55]

   - When you complete the tasks required by the step, the check box alongside the step turns white , indicating that you can check it off. If the check box is gray , it means you cannot check off the step because you have not performed all the actions required to complete the step.
3. Check off the step by clicking the white check box. This marks it as complete.

   A checkmark displays in place of the check box to indicate the step was completed. An execution status icon underneath it indicates its outcome: success / failure / or in progress.

   **NOTE:** If you see a step that has been automatically checked off, this means it was automatically executed by the system (either immediately when the event occurred, when you initiated event handling, or depending on configuration).

4. Repeat the preceding actions until you have completed at least all the mandatory procedure steps. Also complete any non-mandatory steps you want to perform.

5. Some steps are repeatable, and in that case, you can select and repeat them, even if they are already checked off. For example, you might want to consult the document in the document step again.

6. Once you have completed the operating procedure, send any further commands that become available to finish handling the event. See Send Event Handling Commands, above.

**Open the Contextual Pane**

You can use the Contextual pane to access properties and commands of an event source without leaving the treatment window.

1. To open the Contextual pane, do one of the following:

   - In the window header, click the three-pane, four-pane, or five-pane layout icon.
   - Click the splitter button at the bottom of the window.

   The Operation, Extended Operation, Detailed Log and Related Items tabs display at the bottom of the window. Information, properties, and commands of the selected event display. From here you can:
   - Inspect the properties of the object that issued the event.
   - View and execute any commands/actions available for that object.
   - View a detailed log of the event currently being handled.
   - Access related items in the Secondary pane.

2. When you are finished, to hide the Contextual pane, do one of the following:

   - Click the splitter button again.
   - In the window header, click the single-pane or the two-pane layout icon.

**Switch Between Assisted Treatment and Event List**

You can switch back to check Event List, and handle other events from there, without interrupting the assisted treatment currently in progress.

The Assisted Treatment window displays in the foreground.

1. In the Summary bar, do one of the following:

   - Click Open Event List.
   - Select Menu > Active Tasks > Event List.

   Event List displays. The event that you are currently handling in assisted treatment is indicated by a blank placeholder in place of the event button.
The Assisted Treatment window is moved to the background but not closed.

2. *(Optional)* If required, you can select other events in Event List, and send event-handling commands from there. You cannot select the event that is currently in assisted treatment.

3. To return to assisted treatment, in the Summary bar, do one of the following:
   - Click Close Event List.
   - Select Menu > Active Tasks > Assisted Treatment.
   - The Assisted Treatment window returns to the foreground and you can resume the procedure where you left off.

**Interrupt Assisted Treatment of an Event**

You can interrupt assisted treatment of an event at any time, and later resume the operating procedure from where you left off.

- To interrupt assisted treatment of an event, do one of the following:
  - In the Assisted Treatment window, click the event button in the event descriptor along the top.
  - In Event List or the Event Detail bar, click the blank placeholder that displays in the position of the event button.
  - The Assisted Treatment window closes. In Event List, the event is deselected, and the event button displays again instead of the blank placeholder. The Event Status remains as it was when you interrupted handling the event. When you start assisted treatment of this event again, the procedure will resume from where you left off.

**NOTE:**

You can only have one event in assisted or investigative treatment at any given time. If you want to start assisted or investigative treatment of another event, this will interrupt any assisted/investigative treatment currently in progress. However, you can later resume the interrupted treatment from where you left off.

**Finish Assisted Treatment of an Event**

When you have sent all the required event-handling commands and completed at least the mandatory steps of the operating procedure, the Event Status changes to Closed, and the Suggested Action is Suspend the event.

- Do one of the following:
  - In the Assisted Treatment window, click the event button in the event descriptor along the top.
  - In Event List or the Event Detail bar, click the blank placeholder that displays in the position of the event button.
  - The Assisted Treatment window closes, and the event is cleared from Event List.
2.3.3.1 Executing a Document Step in Assisted Treatment

You are in the Assisted Treatment window and the operating procedure includes a document step that you want to do.

1. From the Steps list, select the [document step].
   - The contents of the document display in the Default tab.
2. Read the document carefully and follow any instructions.
3. Click Backward or Forward to move through any other documents included in this step.

NOTE: If a PDF file displays, you can also use the incorporated controls to zoom in, zoom out, print or download the document.

2.3.3.2 Executing a Graphic Step in Assisted Treatment

You are in the Assisted Treatment window and the operating procedure includes a graphic step that you want to do. For background information about the Desigo CC graphics feature, see the reference section.
2.3.3.3 Executing a Remote Notification Step in Assisted Treatment

You are in the Assisted Treatment window and the operating procedure includes a remote notification step that you must execute manually.

1. From the Steps list, select the Remote Notification step.
   - The Message Status list displays in the Default tab. For background information see the reference [➙ 331] section.

2. Depending on the type of remote notification, the following commands may become available in the Message Status toolbar:
   - Start RENO procedure. Click to manually start the remote notification or to re-send the remote notification.
   - Stop RENO procedure. Click to abort the remote notification.
   - Stop RENO procedure escalation. Click to stop the escalation of the remote notification for the selected recipient group.

3. (Optional) Select a recipient in the Message Status area to view the text of the message sent in the Message area.

4. Wait for the system to finish sending the notification. Depending on the outcome, the steps status becomes one of the following:
   - Successful, and the remote notification message status is Completed. You can check off the step.
   - Failed, and the remote notification message status is Aborted, Partially failed or No Response. You can check off the step.
- Failed, and the remote notification message status is Failed. You cannot check off the step.

2.3.3.4 Executing a Report Step in Assisted Treatment

You are in the Assisted Treatment window, and the operating procedure includes a report step that you must manually execute. For background information about the Desigo CC reporting feature, see the reference section.

![Figure 11: Report Step](image)

1. From the Steps checklist, select the [report step].
   - The preconfigured report displays in the Default tab. A new report is generated each time that you select this step.

2. If the report contains form controls (for example, editable fields or drop-down lists), specify the necessary information and click **Save User Input**.

3. Click **Send to Output**.
   - The report is routed to a file, email, or printer, depending on its configured output destination.
   - When you generate an alarm printout, a report, or an event-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: `C:\GMSProjects\[Customer project]\data\Reporting\Reports`.
   - When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or event-handling form) is saved in the following location: `C:\GMSProjects\[Customer project]\shared\attachments`. The Activity Log report includes a link to these attachments.

2.3.3.5 Executing a Treatment Form Step in Assisted Treatment

You are in the Assisted Treatment window, and the operating procedure includes a treatment form step that you must manually execute. For background information about the Desigo CC reporting feature, see the reference section.
From the Steps checklist, select the [treatment form step].

- The form that you must complete displays in the Default tab.

2. Complete the form, using the provided controls (for example, editable fields or drop-down lists) to specify the necessary information.

3. Click Save User Input.

4. Click Send to Output.

- The completed form is routed to a file, email, or printer, depending on its configured output destination.

- When you generate an alarm printout, a report, or an event-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: C:\GMSProjects\[Customer project]\data\Reporting\Reports.

- When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or event-handling form) is saved in the following location: C:\GMSProjects\[Customer project]\shared\attachments. The Activity Log report includes a link to these attachments.

### 2.3.3.6 Executing an Alarm Printout Step in Assisted Treatment

- You are in the Assisted Treatment window, and the operating procedure includes an alarm printout step that you must manually execute. For background information about the Desigo CC reporting feature, see the reference section.
1. From the **Steps** checklist, select the [alarm printout step].
   - The preconfigured alarm report displays in the **Default** tab. When you select this step for the first time, a new report is generated. On subsequent selection, the same report is reloaded.

2. If the report contains form controls (for example, editable fields or drop-down lists), specify the necessary information and click **Save User Input**.

3. Click **Send to Output**.
   - The report is routed to a file, email, or printer, depending on its configured output destination.
   - When you generate an alarm printout, a report, or an event-handling form using a virtual printer (for example, a PDF printer), the output files are saved in the following location: `C:\GMSProjects\[Customer project]\data\Reporting\Reports`.
   - When you complete an assisted procedure of an event, any attachment (such as, alarm printout, report or event-handling form) is saved in the following location: `C:\GMSProjects\[Customer project]\shared\attachments`. The Activity Log report includes a link to these attachments.

### 2.3.4 Handling Recurrences of an Event

A recurring event occurs when the same event source repeatedly generates the same condition, for example because it repeatedly switches between the **Active** and **Quiet** states. In some Client Profiles, recurring events are grouped together under a parent event, which acts as a container for them. The parent event has a **Counter** field in its descriptor that indicates the total number of occurrences. For background information, see the reference [➙ 225] section.

#### Expand or Hide Recurrences of a Parent Event

- The **Counter** column in the event descriptor of an event contains a number, which means it is a parent recurring event.

1. To expand the individual recurrences, in Event List, click inside the **Counter** column of the parent event.

   **NOTE:** Although the **Counter** column is also visible in the Event Detail bar, Investigative Treatment, and Assisted Treatment windows, you can only expand the individual recurrences of an event within Event List.

   - All the recurrences of this event display underneath the parent event. The recurrences have smaller event buttons than the parent event and are sorted most recent on top.

   **NOTE:** While the recurrences are expanded like this you cannot filter Event List. However, you can first filter Event List and then expand the recurrences.

2. To hide the recurrences, click inside the **Counter** column of the parent event again.

#### Handle all Recurrences Together from a Parent Event

You can handle all the recurrences of an event at the same time by selecting the parent event and sending event-handling commands from there. You can do this from Event List, but also from the Event Detail bar, and from the Investigative Treatment or Assisted Treatment windows.

- The **Counter** column in the event descriptor of an event contains a number, which means it is a parent recurring event.

1. Select the parent recurring event by clicking its event button.

   **NOTE:** You can also use the CTRL and/or SHIFT keys to select multiple events—such as a selection can only include parent events. You cannot, for
example, select a parent event and an individual child recurrence belonging to a different parent event.

2. Send event-handling commands \[\rightarrow 47\] from the parent descriptor in the normal way.

   - Each command you send from the parent is sent to all the child recurrences as well. For example, if you acknowledge the parent event, all its recurrences are acknowledged as well.

**Handle Individual Recurrences Separately**
You can handle one or more individual recurrences of an event separately, rather than handling them all at the same time from the parent event.

1. In Event List, click inside the **Counter** column of the event you want to handle to expand its recurrences.

   - The child recurrences display under the parent event. Note that the topmost child recurrence always corresponds to the parent event.

2. Select the child recurrence that you want to handle by clicking its event button. You can also use the CTRL and/or SHIFT keys to select multiple child recurrences, but they must all belong to the same parent event.

3. Send event-handling commands \[\rightarrow 47\] from the child recurrence descriptor in the normal way.

   - Each command will only be sent to the selected child recurrence.

4. When you finish handling an individual child recurrence (typically, after you send a **Reset** or **Close** command), it will be cleared from the list when you deselect it.

   **NOTE:** Since the topmost child recurrence corresponds to the parent event, any commands you send to it will also affect the parent event. If the topmost child recurrence is cleared from the list, the next most recent child recurrence in the set becomes the topmost one, and the details of the parent event will refresh to show its data.

### 2.3.5 Customizing the Columns in Event List
You can customize what columns display in Event List, change their order, or resize them.

**NOTE:**
- Any changes you make to the columns in Event List will also apply to the Event Detail bar and to the **Investigative Treatment** and **Assisted Treatment** windows.
- Changes to column settings will be automatically saved when you exit the Desigo CC client application, and so will persist across sessions.
- Column settings are also specific to the user profile. This means that different users can have different column settings.
- Depending on the Client Profile, there are some columns that cannot be moved, resized, or removed.

**Move or Resize a Column Directly in Event List**

1. To resize a column, drag the edge of its column header in Event List to the desired width.

2. To move a column to a different position, drag-and-drop its column header in Event List to the desired position.
Add, Remove, or Rearrange Columns in Event List

1. Right-click the column headers in Event List and select Customize columns.
   - The Customize columns dialog box displays.
2. Do one or more of the following:
   - To add a column to Event List, select it in the Available columns list and click Add.
   - To remove a column from Event List, select it in the Visible columns list and click Remove.
   - To reposition a column, select it in the Visible columns list and click Move up or Move down.
3. Click OK.
   - Event List displays with the columns as you have customized them.

Restore the Default Column Settings in Event List

You previously resized, moved, or added/removed columns in Event List and now you want to restore the default settings.
1. Right-click a column header in Event List.
2. Select Restore column layout.
   - Event List displays with the columns back to their default settings.

2.3.6 Filtering Event List
You can filter the list of events, for example, so that it only shows events belonging to a certain category (such as Fault), or events for which a specific command (such as Acknowledge) is available.

Filter by Category with Event Lamps

The Summary bar contains at least one event lamp (category) for which there are events.
1. In the Summary bar, click the event lamp whose events you want to view.
   - Event List displays a filtered list containing only the events belonging to the category of that event lamp. The event lamp you clicked changes color to indicate a filter is active. The color of the filter icon changes to red. The Event List header displays the currently applied filter.
2. Click the same event lamp again to remove the category filter.
Apply a Simple Filter

- You want to filter Event List by a single criterion, for example, category, date/time, discipline, or source status.

1. In the Summary bar, click the filter icon.

2. Select what you want to filter by (for example, Event Status), and then click the criterion you want to apply (for example, Unprocessed).

- Event List is filtered to show only the events that match the criterion. The color of the filter icon changes to red. The Event List header displays the currently applied filter.

1. To remove the filter, click and select Remove Filter.

NOTE: This type of filter only applies one criterion at a time. If you repeat the above steps to select a different criterion (for example, Source Status=Active, or Date and Time=Last hour) the previously applied filter will be cleared. To apply multiple criteria, see Apply Advanced Filter [59], below.

Apply an Advanced Filter

- You want to filter Event List by multiple criteria simultaneously.

1. In the Summary bar, click filter and select Advanced Filter.

- The Advanced Filter dialog box displays.

2. If you want to filter by category, discipline, event status, and/or source status:
   a. Select the check box for the criterion you want to apply (for example, Category) then select one or more values. For example, Life Safety and Fault.
   b. Repeat the preceding step for any other criteria you want to apply. For example, Discipline.

3. Use the drop-down lists to specify any other filter criteria you want to apply:
   - Location/Designation: Enter some part of the System-Browser path or designation of the event source. For example, Management System.Clients.
   - Name/Description: Enter some part of the name or description of the event source. For example, Main Server.
   - System (available only for distributed systems).
   - Date and Time: Filter based on when the events occurred. For example, yesterday or last quarter hour.
   - Tag: Set whether you want to selectively show or hide tagged events.
   - Maintenance: Set whether to see only Maintenance or only Genuine events.
   - Show hidden events: Set whether to show events that were hidden owing to the internal logic of field panels.

4. Click OK.

- The list of events is filtered accordingly, and you can check what criteria you applied in the Event List header.

5. If required, proceed to: Save an Event List Filter for Future Use [59], below.
Save an Event List Filter for Future Use

▷ You applied a filter to Event List and want to save it for future reuse.

1. In the Summary bar, click the filter icon ▼ and select Advanced Filter.
   - The Advanced Filter dialog box opens, displaying the currently applied filter criteria.

2. Do the following:
   a. (Optional) Specify any filter criteria.
   b. In the Filter name field, enter a name.
   c. Click Save.
   - The filter is saved. Filters that you save in this way are user-specific and will not be visible to other users of the system.

3. To reuse the filter, proceed to Apply a Previously Saved Event List Filter [⇒ 60], below.

Apply a Previously Saved Event List Filter

▷ You previously saved an Event List filter for future use [⇒ 59].

1. In the Summary bar, click the filter icon ▼ and select Advanced Filter.

2. In the Advanced Filter dialog box, do the following:
   a. From the Saved filters drop-down list, select the filter you want to apply.
   b. Click Apply.
   - Event List is filtered.

Modify or Delete a Saved Event List Filter

▷ You previously saved an Event List filter for future use [⇒ 59].

1. In the Summary bar, click the filter icon ▼ and select Advanced Filter.

2. In the Advanced Filter dialog box, select the filter you want to apply from the Saved filters drop-down list.
   - To modify the filter, change the filter criteria and click Update.
   - To delete the filter, click Delete.

Remove All Filters from Event List

▷ You want to remove all the filters currently applied to Event List.

1. In the Summary bar, click the filter icon ▼ and select Remove Filter.
   - Event List displays an unfiltered list, containing all the events. The color of the filter icon changes to gray ▼.

Autoremove Filters When a New Event Comes In

When you apply filters to Event List, it means you will not see any new incoming events that do not match the current filter criteria. To avoid missing events, you can configure the system to automatically remove all filters whenever a new event comes in.

To enable autoremove:

1. Click the filter icon ▼, and select Autoremove on New Events (if it is not already selected: a checkmark indicates that the option is already active).
   - When new events come in any applied filters will be automatically removed.
To disable autoremove:

1. Click the filter icon and deselect Autoremove on New Events.

- Any applied filters will persist even if new events come in.

**Manually Tag Events in Event List**

Event List includes a column that lets you manually tag individual events. You can then use filters to selectively show or hide events you have tagged in this way. Any tags you apply are valid only during the current client session. When you restart the client application, Event List defaults back to all events untagged.

- The Tag column displays in Event List. See Customizing the Columns in Event List [57].

1. Move your cursor in the Tag column of an event.

2. Click the tag icon that displays on mouseover.

- The event is now tagged and marked with .

3. To untag the event, click again.

4. To selectively show/hide the tagged events, proceed to Apply or Remove a Tag Filter [61].

**NOTES:**

- You can also use CTRL or SHIFT to select multiple events to tag or untag them all together with a single click.
- In case of recurrent events, tagging/untagging a parent affects all its child recurrences. You can also separately tag/untag an individual child recurrence.
- When a tagged event changes its state, it is automatically untagged.

**Apply or Remove a Tag Filter**

Note that applying a tag filter will not remove any other filters you have applied. Filter by tag works in combination with the other filter criteria. For example, if you filter by Category=Fault and then apply a tag filter to hide tagged events, you will only see events belonging to the Fault category that are not tagged.

- You previously tagged some events in Event List, and now you want to selectively hide or show the tagged events.

1. To apply a tag filter, do one of the following:

   - Click the filter icon, select Filter by Tag, and click either Hide tagged events or Show tagged events only. (A check mark displays next to whichever option is currently selected).

   - Click the filter icon and click Advanced Filter. In the dialog box, from the Tag drop-down list, select either Hide tagged events or Show tagged events only.

- The list of events is filtered accordingly. Applying a tag filter does not remove any other filters you have applied. Filter by tag works in combination with the other filter criteria. You can check the currently applied filter criteria in the Event List header.

2. To remove a tag filter, do one of the following:

   - Click the filter icon, select Filter by Tag, and clear both check boxes to show both tagged and untagged events.
– Click the filter icon and click Advanced Filter. In the dialog box, from the Tag drop-down list, select Show both tagged and untagged events.

The list of events will no longer be filtered by tags, but any other filters you applied will remain still active. Check the Event List header to see them.

2.3.7 Printing the Whole Event List
1. In Event List, right-click and select Print Event List.
2. (Optional) Modify the settings in the Print Preview dialog box.
3. Click Print and Close.

The printout is sent to the selected printer. A message box informs you if the print operation fails. For background information, see the reference §15 section.

2.3.8 Changing the Sorting of Events
Depending on the Client Profile, you may be able to sort the events by Category, Event Status, Date/Time, and IN/OUT. For background information, see the reference §225 section.

1. Click the column header you want to sort by. For example, Date/Time.

The selected sorting is applied. An up/down arrow in the column header indicates ascending/descending order. No arrow indicates default sort order.
– Click the same column header again to invert the sorting order.
– Click the same column header a third time to remove the sorting.

2. Click another column header to sort by a different criterion. For example, Event Status.

2.3.9 Handling Alarm Suppression for System Objects
When alarm suppression is enabled for an object or subtree, any related events do not display on the management station. All consequences of such events on the management station, as for example reactions, remote notifications, and so on, are suppressed as well. However, value and status changes of the affected objects are still updated and logged in the history.

Figure 14: Alarm Suppression Concept
Alarms Transmission to Fire Department

The alarm suppression feature disables the display of events concerning the affected object or subtree. The alarm functionality (for example, the fire detection system) is not affected. Consequently, any incoming alarms are still transmitted to the fire department.

To block the alarm transmission to the fire department, you must exclude the fire detection by disabling the area, zone, or fire detector on the panel as follows:

- In System Browser, select the fire object.
- In the Operation tab, next to the property Mode, click Disable.

**Prerequisites:**

- You are authorized to handle alarm suppression.
- One or more system objects support the alarm suppression feature.

**NOTE:** Due to some restrictions depending on specific countries regulations, in some configurations the alarm suppression feature can be disabled. In such cases, the alarm suppression indicator does not display on the Summary bar, and executing the following procedures has no effect.

Enable Alarm Suppression for an Object

1. In System Browser, select the system object for which you want to enable alarm suppression.
2. Click the Extended Operation tab.
3. Next to the Alarm Suppression property, click Enable.

**NOTE 1:** If the selected object is in alarm when you enable alarm suppression, its events remain visible in the Summary bar and Event List. Alarm suppression will activate on the next events that occur.

**NOTE 2:** The following error message displays if the alarm suppression feature is not available for your configuration: Enable failed.

Enable Alarm Suppression for an Object Subtree

1. In System Browser, select the system object for which you want to enable alarm suppression.
2. Click the Extended Operation tab.
3. Next to the Alarm Suppression property, click Enable All.

**NOTE 1:** If any object in the subtree is in alarm when you enable the alarm suppression, its events remain visible in the Summary bar and Event List. The alarm suppression will activate on the next events that occur.

**NOTE 2:** The following error message displays if the alarm suppression feature is not available for your configuration: Enable failed.
Disable Alarm Suppression for an Object

1. In System Browser, select the system object with alarm suppression enabled.
2. Click the **Extended Operation** tab.
3. Next to the **Alarm Suppression** property, click **Disable**.
   - Alarm suppression is disabled for the selected object.
   - **NOTE**: If the object is in alarm when you disable alarm suppression its events display in the Summary bar and Event List.

Disable Alarm Suppression for an Object Subtree

1. In System Browser, select the system object with alarm suppression enabled also for its subtree.
2. Click the **Extended Operation** tab.
3. Next to the **Alarm Suppression** property, click **Disable All**.
   - Alarm suppression is disabled for the selected object and the subtree to which it belongs.
   - **NOTE**: If any object in the subtree is in alarm when you disable alarm suppression its events display in the Summary bar and Event List.

Retrieve the List of System Objects Affected by Alarm Suppression

You can retrieve the list of objects affected by alarm suppression using the System Browser filter or generating a report.

**Method 1: Filter Objects in System Browser**

1. In System Browser, click **.**
2. Open the **Other** combo box and select **Alarm Suppression**.

   ![System Browser](image)

3. Click **Search**.
   - The results display the **item found** area.
Method 2: Generate a Report

1. In System Browser, select Application View.
2. Select Applications > Reports > Status.
3. In the Default tab, click Import.
4. In the Open dialog box, do the following:
   b. Click Open.
5. Click OK.
   ➥ The alarm suppression report template displays in the Default tab.
7. Click Run.
   ➥ The list of objects affected by alarm suppression displays in the report template.

2.4 Scheduling
This section provides instructions for using the Schedules of Desigo CC. For background information, see the reference section.

2.4.1 Creating a BACnet Schedule
Scenario: You need to create a weekly occupancy schedule in a field panel that controls when the lights turn on and off for a school building. You also want to create a holiday calendar that is used as an exception to the schedule, so that the lights will stay off during the holiday break, when the building will be vacant.

Reference: For background information, see BACnet Schedules [227].

Workflow diagram:
Prerequisites:
- System Browser is in Application View.

Steps:

1 – Create Schedule Entries

You have created a BACnet schedule containing a data point that you want the weekly occupancy schedule to control. It is available in Schedules > BACnet Schedules in the System Browser.

1. Select Applications > Schedules > BACnet Schedules > [BACnet schedule].
2. Select the Schedule Entries tab and click New to add a new entry.
3. Specify the time from when you want to start executing the schedule, for example, 6:00:00 AM, and select the Default check box.

   **NOTE:** Leaving an entry set to Default means the schedule will command all objects to the Schedule Default.

4. Click New to add a second entry.
5. Specify the end time to stop the schedule execution, for example, 6:00:00 PM, and change the Default check box to OFF.
6. Click Save .

   ➤ The system saves the schedule settings.

2 – Create a Holiday Calendar and Add Entries

1. From the Scheduler toolbar, click New .
2. Click New BACnet Calendar.
3. In the Calendar Entries section, click New.
4. In the Calendar Time Period section, select the Date range option and specify the start and end dates for the calendar in the Start date and End Date fields.
5. Enter a name and the field device on which you want to save the calendar and click Save .

   ➤ The system adds the calendar to the BACnet Calendars node in the Application view.

3 – Create an Exception

1. In System Browser, select Applications > Schedules > BACnet Schedules > [BACnet schedule].
2. Navigate to the Day/Week view, right-click the BACnet schedule and select Add Exception.
3. In the Exception Period section, select Calendar.
4. From the Calendar drop-down list, select the HolidayBreak calendar.
5. In the Exception Times section, delete one of the two entries.
6. In the remaining entry, enter 6:00:00 AM.

7. Clear the None check box.
   **NOTE:** Creating an entry with the default check box checked returns control to the weekly schedule. For example, you might want to override the schedule for one hour at 1 P.M., so you create an entry at 1 P.M. with the override value. Then, you create an entry at 2 P.M. with None checked. Control will return to the weekly schedule at 2 P.M.

8. Select OFF from the drop-down list.
   ▶ The system creates an exception.

### 2.4.2 Creating a Management Station Schedule

**Scenario:** You need to create a management station schedule on the Desigo CC server and define an exception to the schedule for a specific time period.

In this scenario, we have defined an exception for a specific time period. You can also create a calendar and set it as an exception [➡ 73] to the schedule. This ensures that you do not have to specify the time periods for multiple schedules and can use the same calendar for all schedules (if the time period is the same).

**Reference:** For background information, see Management Station Schedules [➡ 230].

**Workflow diagram:**

Prerequisites:
- System Browser is in Application View.

**Steps:**

1. **Setup the Type and Time Period of the Schedule**
   ▶ You have created a Management Station schedule [➡ 72] containing a data point that you want the management station schedule to control. It is available in Schedules > Management Station Schedules in the System Browser.

   1. Select Applications > Schedules > Management Station Schedules > [Management Station Schedule].

   2. Click the Setup tab and perform the following steps:
      - In the Sub-Type drop down list, select Weekly or Daily to create a weekly management station schedule [➡ 231] or a daily management station schedule [➡ 234].
      - From the Start date drop-down list, select the start date for the schedule. Selecting the Any date check box defaults to the current date.
      - From the End date drop-down list, select the end date for the schedule. Selecting the Any date check box defaults to an infinite date.
      - For every linked object, map values to the ScheduleActive/Inactive state in the Output values section. In case of daily schedules the Output values section is located in the Schedule Entries section.
The management station schedule of the selected type is created and a time period is assigned to the schedule.

2 – Create Schedule Entries

1. Select Applications > Schedules > Management Station Schedules > [Management Station Schedule]

2. Perform either of the following steps to add a new schedule entry.
   - Navigate to the Day/Week view, right-click, and select Add Weekly Entry.
   - Click New in the Schedule Entries tab.
   **NOTE:** In case of weekly schedules, the Output values section is located in the Setup tab.

3. Specify the time from when you want to start executing the schedule.

4. Click Save to save the schedule entries.

  ➤ The weekly schedule entry is created.

3 – Add an Exception with Entries

1. Select Applications > Schedules > Management Station Schedules > [Management Station Schedule]

2. Perform either of the following steps to add an exception.
   - In the Day/Week view, right-click on the day from which you want to add an exception and select Add Exception.
   - Click New in the Exceptions tab.

3. Select the Date exception type and define the time period when the exception shall be active.

4. In the Exception Times section, define the periods and the related schedules states for the days in the defined period (that will override the definitions of the weekly schedule). The exception periods are marked in red color.

5. In the Active Values section map the Exception active value to a value of the linked Outputs.

6. Click Save.

   **NOTE:** Before the exception block can appear in the daily or weekly view, you must create at least one Time and Value pair, and one of the values must be ON.

  ➤ An exception period is now defined for the management station schedule.

Next, you can configure an Organization Mode as the Output of a schedule.

2.4.3 Additional Scheduling Procedures

Select the following for additional information on BACnet schedules, Management Station schedules, and Timeline Viewer.

2.4.3.1 BACnet Schedules

Select any of the procedures for information on BACnet Schedules, Calendars, Commands, Weekly Schedules, and Exceptions.

For background information, see BACnet Schedules reference ➤ 227.

**Prerequisites:**
- System Browser is in Application View.
Create a BACnet Schedule and Associate a Data Point to it

- System Manager is in Operating mode.
1. Select the Manual navigation check box.
2. Select Applications > Schedules > BACnet Schedules.
3. Click New ✗ and select New BACnet Schedule.
4. Navigate to the Management View and select the field panel that contains the data point you want the schedule to control, drag-and-drop the data point to the Outputs tab.
   NOTE: For this example, a binary output has been selected with two states (OCC, UNOCC) to represent lighting for a building when it is occupied or unoccupied.
5. In the Setup tab, select the default value, the text group (making sure that the group matches labels with the expected values), the start and end dates, and the priority. The system adds the point to the schedule.
6. Click Save.
   ➡️ The BACnet schedule displays in System Browser.

Create a New Schedule from an Existing One

Perform the following steps to create a new BACnet or Management Station schedule from an existing one.

1. Select either of the following:
   BACnet Schedules – Applications > Schedules > BACnet Schedules
   Management Station Schedules – Applications > Schedules > Management Station Schedules
2. Open an existing schedule and perform the required modifications to it.
3. Click Save As.
4. In the Save Object As dialog box, specify a name for the schedule and the field panel you want this schedule to be associated with. Click OK.
   ➡️ The schedule is saved with a new name.

Delete a Schedule

Perform the following steps to delete a BACnet or Management Station schedule.

1. Select either of the following:
   BACnet Schedules – Applications > Schedules > BACnet Schedules
   Management Station Schedules – Applications > Schedules > Management Station Schedules
2. Open the schedule you want to delete and click Delete.

Create a New Calendar from an Existing One

Perform the following procedure to create a new BACnet or Management Station calendar from an existing one.

1. Select either of the following:
   BACnet Schedules – Applications > Schedules > BACnet Calendars
   Management Station Schedules – Applications > Schedules > Management Station Calendars
2. Open the existing calendar and perform the required modifications.
Operating Step-by-Step
Scheduling

3. Click **Save As**.

4. In the **Save Object As** dialog box, specify a name and the field panel you want this calendar associated with and click **OK**.

   ➤ The calendar is saved with a new name.

**Delete a Calendar**

Perform the following steps to delete a BACnet or Management Station calendar.

1. Select either of the following:
   - BACnet Schedules – **Applications > Schedules > BACnet Calendars**
   - Management Station Schedules – **Applications > Schedules > Management Station Calendars**

2. Open the calendar you want to delete and click **Delete**.

**Modify a BACnet Calendar**

1. Select **Applications > Schedules > BACnet Calendars**.

2. Open the calendar you want to update.

3. To modify start dates, end dates, or recurrence settings, select a calendar entry from the **Calendar Entries** section, and select the settings you want.

   **NOTE:** If you use wildcards for date ranges (the **Advanced** check box), make sure to read your vendor’s field panel documentation since the implementation of this feature is vendor-specific.

4. To delete a calendar entry, click the **Delete** icon associated with the entry.

   **NOTE:** Do not click the **Delete** icon from the Scheduler toolbar, or you will delete the entire calendar.

5. To add a calendar entry, click **New** and select the settings you want.

6. Click **Save**.

**Add a Command**

1. In System Browser, select **Application View**.

2. Select **Application View > Schedules > BACnet Commands**.

3. From the **Text Group** drop-down list, select the text group you want associated with this command.

4. In the **Command Table Action List**, click **New**.

5. Highlight the text in the new action list, and enter a name.

6. From System Browser, drag-and-drop the desired object to the action list. The details of the point display in the **Command Table Action List**.

7. Complete the resulting fields and click **Save**.

8. Enter a name for the command in the **Name** field and from the **Field device** drop-down list, select the panel you want this command associated with.

9. Click **OK**.

**Modify a Command**

1. Select **Applications > Schedules > BACnet Commands**.

2. Open the command you want to modify.
3. Make the required updates to the Text Group and to the values displayed in the Command Table Action List.

4. Click Save.

Create a Weekly BACnet Schedule Entry
1. Select Applications > Schedules > BACnet Schedules.
2. Open the schedule to which you want to add a new weekly schedule entry.
3. Navigate to the Day/Week view, right click and select Add Weekly Entry.
4. Click the Schedule Entries tab and enter values into the relevant fields.
5. Click Save.

Delete a Weekly BACnet Schedule Entry
1. Select Applications > Schedules > BACnet Schedules.
2. Open the schedule with the weekly schedule entry you want to delete.
3. In the Day/Week view, click the weekly schedule that contains the entry you want to delete.
   The details display in the Schedule Entries tab.
4. In the Schedule Entries tab, locate the entry you want to delete and click Delete.
   NOTE: You cannot delete the entry for the beginning and end of day. You can delete default entries at other times, as long as there are still entries at beginning and end of day. You can also replace the entry at beginning or end of day with a non-default entry.
5. Click Save.

Modify a Weekly BACnet Schedule Entry
1. Select Applications > Schedules > BACnet Schedules.
2. Open the schedule you want to modify.
3. Select the weekly schedule you want to modify.
   NOTE: Weekly schedules are highlighted with a blue bar on the left side of the entry.
4. In the Schedule Entries tab, modify the Time and Value fields.
5. Click Save.

Add a BACnet Exception with Entries
1. Select Applications > Schedules > BACnet Schedules.
2. Open the schedule to which you want to add an exception.
3. Right-click inside the schedule in the Day/Week view and click Add Exception.
4. Click the Exceptions tab and enter the details for the exception.
5. Click Save.
6. To add new exception entries click the Exception Times expander and click New.
7. Enter values into the **Time** and **Value** fields.

8. Click **Save**.

**Delete a BACnet Exception and Entries**

1. Select **Applications > Schedules > BACnet Schedules**.
2. Open the schedule whose exception is to be deleted.
   - The details of the schedule display in the **Day/Week** view.
3. Right-click the exception you want to delete.
   - **NOTE:** Exceptions are highlighted with a red bar on the left side of the entry.
4. Do one of the following:
   - Select **Delete Exception** to delete an exception.
   - Select **Delete Exception Entry** to delete an exception entry.
5. Click **Save**.

**Modify a BACnet Exception and Entries**

1. Select **Applications > Schedules > BACnet Schedules**.
2. Open the schedule whose exception is to be modified.
   - The details of the schedule display in the **Day/Week** view.
3. Click the exception or exception entry you want to modify.
   - The details of the selected exception or its entry display in the **Exceptions** tab.
4. Modify the fields in the **Exceptions** tab as needed.
   - **NOTE:** If you use wildcards for date ranges (the **Advanced** check box), refer to your vendor’s documentation since the implementation of this feature is vendor-specific.
5. Click **Save**.

### 2.4.3.2 Management Station Schedule

Select any of the procedures for information on Management Station Schedules, Calendars, Schedule Entries, and Exceptions.

For background information, see Management Station Schedules reference [230].

**Prerequisites:**
- System Browser is in Application View.

**Create a Management Station Schedule and Link a Data Point to it**

- System Manager is in **Operating** mode.
1. Select the **Manual navigation** check box.
2. Select **Applications > Schedules > Management Station Schedules**.
3. Navigate to the **Management View** and select the field panel that contains the data point you want the schedule to control, drag-and-drop the data point to the **Outputs** tab.
   - The system adds the point to the schedule.
4. Click **Save**.
   - The Management Station schedule displays in System Browser.
Modify a Weekly Management Station Schedule Entry

1. Select Applications > Schedules > Management Station Schedules.
2. Open the schedule you want to modify.
3. In the Day/Week view, click the weekly schedule you want to modify. Schedules are highlighted with a blue bar on the side of the entry.
4. In the Schedule Entries tab, modify the Time and Value fields as needed. NOTE: You can also drag the blocks up and down in the daily and weekly views to adjust the time. For more information, see Management Station Schedule Workspace.
5. Click Save .

Delete a Weekly Management Station Schedule Entry

1. Select Applications > Schedules > Management Station Schedules.
2. Open the schedule with the weekly schedule entry you want to delete.
3. In the Day/Week view, click the weekly schedule that contains the entry you want to delete. The details display in the Schedule Entries tab.
4. Locate the entry you want to delete.
5. Click Delete . NOTE: You cannot delete default values.
6. Click Save .

Create a Management Station Calendar and Add Entries

1. Select Applications > Schedules > Management Station Calendars.
2. In the Calendar Entries section, click New.
3. Enter the details of the calendar entries.
4. Click Save .
5. Enter the name and description for the calendar. The management station calendar is created with the entries and displays in the System Browser. You can now set this calendar as an exception by selecting the Calendar option in the Exceptions section and specifying its name.

Modify a Management Station Calendar

1. Select Applications > Schedules > Management Station Calendars.
2. Open the calendar you want to update.
3. To modify start dates, end dates, or recurrence settings, select a calendar entry from the Calendar Entries section, and select the settings you want.
4. To delete a calendar entry, click Delete . NOTE: Do not click the Delete from the Scheduler toolbar, or you will delete the entire calendar.
5. Click Save .
Delete a Management Station Exception and Entries

1. Select Applications > Schedules > Management Station Schedules.
2. Open the schedule with the exception you want to delete.
   - The details of the schedule display in the Day/Week view.
3. Right-click the exception you want to delete.
   - NOTE: Exceptions are highlighted with a red bar on the left side of the entry.
4. Do one of the following:
   - To delete the exception, select Delete Exception.
   - To delete an exception entry, select Delete Exception Entry.
5. Click Save.

Modify a Management Station Exception and Entries

1. Select Applications > Schedules > Management Station Schedules.
2. Open the schedule with the exception you want to modify.
   - The details of the schedule display in the Day/Week view.
3. Click the exception or exception entry you want to modify.
   - Exceptions are highlighted with a red bar on the left side of the entry. The details of the selected exception or its entry display in the Exceptions tab.
4. In Exceptions tab, modify the fields as required.
5. Click Save.

2.4.3.3 Timeline Viewer

Select any of the procedures for information on timeline viewer. For background information, see timeline viewer reference [237].

Add a Schedule to the Timeline Viewer

- Timeline Viewer is open and displaying one or more schedules.
1. In System Browser, select the Manual navigation check box.
2. Navigate to the schedule you want to add.
3. Drag-and-drop the schedule into the Timeline Viewer.
   - The system adds the schedule to the timeline viewer.

Bring the Current Day into View

- Using the Time Range scrollbar, you have scrolled away from the current day and would like to return to it quickly.
1. Click Show Today.
   - NOTE: Clicking the Show Today icon does not affect any preset time period you have chosen.

Change the Preset Time Span

1. Click Preset time spans.
2. Select the time span you want to display in the viewer.
   - The timeline viewer displays the new selection.
Zoom In and Zoom Out
- You want to decrease or increase the viewable span of the timeline.

1. Click Zoom In or Zoom Out.

   NOTE: Each time you click the icon, the timeline decreases or increases to the next preset time period.

2.5 Reports
This section provides instructions for using the Reports of Desigo CC. For background information, see the reference section.

2.5.1 Printing a Standard Report

Scenario: You want to run a Standard report, view it as a PDF/XLS and then print it.

Reference: For background information, see Reports reference.

Workflow diagram:

1. Verify Report Templates
2. Run a Report
3. View a Report
4. Print a Report

Prerequisites:
- For viewing a report in Excel, Microsoft Excel 2007 or later is installed on your system.
- The report templates are imported in a folder within the Reports application in System Browser.

Steps:

1 – Verify the Standard Report Templates
1. In System Browser, select Application View.
2. Select Application View > Applications > Reports.
3. Expand the folder where the report templates are imported.
   - The standard reporting templates are available.

2 – Run a Report
You can run a report using either of the following options:

Option 1: Using Toolbar Icons Run/Run As…
- You have selected a report definition that you want to run and the report definition displays in Edit mode.
- Do one of the following:
  - Click Run to run the report definition according to your login language.
- Click **Run As** to run the report definition according to the selected language.

  Localized data is retrieved and loaded in the cells of a table/plot in the report.

  The report execution status displays in the **Report Management** section below the report definition. On successful report execution, the generated report displays in **Run** mode.

**Option 2: Using The Related Items Tab**

1. Select an object from System Browser. This object is set as the name filter for the report definition you want to execute.

2. In the **Related Items** tab, select an icon/link for the report definition. For example, **Object Status**. Do not select an icon/link for **New Report** as this opens a new report definition.

  The selected report displays in the **Secondary** pane in **Run** mode. The selected object is set as the name filter for the tables and plots present in the report. If the selected report in the **Related Items** tab is a related report for the selected System Browser object, then data is retrieved according to the name filters set for report elements. However, if the selected report in the **Related Items** tab is a **Show in Related Items** report, the name filter configured for all the reporting elements in the generated report is replaced by the path of the selected object in System Browser.

  After running a report definition, should you decide to change some definition parameters, click **Edit** to toggle from **Run** mode to **Edit** mode in order to make your configuration changes.

  The report execution status displays in the **Report Management** section. On successful report execution, the generated report displays information related to the selected object.
3 – View a Report

You can view a report as a PDF output or as an Excel output.

**Option 1: Viewing a Report Definition as a PDF**

1. For viewing a report definition as a PDF, click **Create and view PDF**.

   The PDF file opens in the PDF viewer. When a PDF document exceeds the page limit of 500 pages, it splits into two documents. You can save, print, zoom in, and zoom out of the PDF file.
Option 2: Viewing a Report Definition in the Excel format

1. For viewing a report definition in the Excel format without a template, click **Create and view Excel**.
   - An Excel file is created and stored under the following temporary path: `[Drive]\Users\[UserID]\AppData\Local\Temp\temp\GMS`. A dialog box displays, asking you if you want to save a permanent copy of this file.

4 – Print a Report

- You are viewing a report as PDF or Excel.
1. Proceed as follows:
   - For a PDF file, click **Print**.
   - For a file that displays in Excel format, you have to print from the Microsoft menu.
   - The **Print** dialog box displays.
2. Select the configured printer and click **Print**.
   - The report is printed.

2.5.2 Running a Customized Report

**Scenario**: You want to configure a customized report based on a Standard report and configure the filters, output, and set it to run automatically.

**Reference**: For background information, see Reports reference.

**Workflow diagram**:
Prerequisites:
- For configuring the report output as an email, you have configured the mail server or have verified that it has been configured.
- Email addresses are configured in address book.
- For configuring the report output to the printer, ensure that one or more local printers are configured.

Steps:

1 – Select a Standard Report for Configuration
1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Select a standard report to be customized.
   ▲ The report definition displays.

2 – Configure Report Parameters
▲ You have selected the report which you want to customize.
1. Click the Home tab and add the following elements to your report as needed:
   - Tables [➙ 85]: A table is a grouping of data in rows and columns.
   - Plots [➙ 86]: A plot displays data in a graphical view.
   - Labels [➙ 87]: Labels allow you to type text that can be displayed in a report.
   - Keywords [➙ 86]: Keywords are pre-defined templates added to a report definition. They are replaced with actual data in Run mode.
   - Logos [➙ 87]: A logo is a graphic or symbol that is added to a report.
   - Form Controls [➙ 88]: Form Controls are controls that you can edit in Run mode.
   ▲ The report definition is configured with the elements you added.
2. Click the Layout tab and configure the layout for your report by setting the following parameters as needed:
   - Orientation [➙ 89]
   - Page Size [➙ 89]
   - Margins [➙ 89]
   - Headers and Footers [➙ 90]
   - Auto Scaling [➙ 90]
   ▲ The report definition is configured with the specified layout options.
3. From the Layout tab, format the elements of the report for an enhanced appearance by setting the following as needed:
   - Adjusting Positions of Elements [➙ 91]
   - Customizing Fonts [➙ 91]
   - Applying Color [➙ 91]
4. Save the report definition by clicking Save.
   ▲ The report definition is customized as per the specified parameters.

3 – Apply Filters to Condense the Displayed Output
▲ You have selected and configured the report to which you want to apply filters.
1. Click the Filter tab and apply the following filters as needed:
   - Name Filter [➙ 94]: Enables you to filter the data on the basis of object names displayed in the report.
   - Condition Filter [➙ 95]: Displays data that matches the specified filter condition.
Operating Step-by-Step
Reports

- Time Filter [➡ 95]: Displays data that matches with the specified date/time value.
- Row Filter [➡ 96]: Displays the number of rows specified.
- Graphics Filter [➡ 96]: Displays the graphics and viewports of the object that is passed as the name filter to the report.

2. Save the report definition by clicking **Save**.
   ⊳ The report is configured according to the specified filters.

4 – Configure Report Output
   ⊳ You have a configured report that has the required elements, filters, and layout. You now want to set a destination to route the report output.

1. Click the **Settings** tab and in the **Report Output** group box click **Dialog Launcher**.
   ⊳ The **Report Output Definition** dialog box displays.

2. Configure the destination (File [➡ 96], Email [➡ 97], or Printer [➡ 98]) to which you want to route the report output as well as specify the file format (PDF, XLS, CSV, or XML) in which the report output can be generated.
   ⊳ The report output is configured to either a file, email, or printer.

5 – Configure Automatic Report Execution
   ⊳ There is at least one report definition available under **System Browser > Reports**, for which a Report Output Definition is configured.

1. *(To run the report automatically from the Extended Operations tab)* Select the report definition from System Browser and from the **Extended Operations** tab, click **Execute**.

2. *(To run reports automatically from macros, reactions, or graphics)* Select either of the following options:
   - Macro [➡ 99]
   - Reactions [➡ 100]
   - Graphics [➡ 100]
   ⊳ The report executes in the background when triggered. There is no visual indication that the report is being generated. On successful execution, the report is routed to the destination configured in the Report Output Definition such as email, printer, or folder.

**NOTE:**
If you have not configured the destination in the Report Output Definition, the report is routed to the path specified in the **Location** supervised folder under
Management System > Servers > Main Server > Report Manager > Report Default Folder. This path must be the relative path of the project and not the full path. For example, if the report is to be routed to [Drive]:\GMSProjects\[Customer Project]\data\Reporting\Reports, the following relative path must be specified in the Location field, data\Reporting\Reports.

### 2.5.3 Additional Report Procedures
Select any of the procedures for additional information on Reports.

#### 2.5.3.1 Managing Report Definitions and Folders
This section provides information on organizing and working with report definitions.

**Export a Report Definition**

1. In System Browser, select Application View.
2. Select Applications > Reports > Report Definitions or the folders containing report definitions. You can export multiple report definitions or multiple folders; however, you cannot export a report definition and a folder at the same time.
3. Click Export.
4. In the Browse for Folder dialog box, select a destination.
5. Click OK.

A confirmation message displays and the report definitions or folders are exported to the selected location.

**NOTE:**
If the report definition has a name filter that contains a wild card in the system name, then the system name is not removed during export. However, if the system name does not contain a wild card character, then during export the system name is removed from the name filter.

**Import a Report Definition**

1. In System Browser, select Application View.
2. Select Applications > Reports > [reports folder].
3. Click Import.

The Open dialog box displays.
4. Browse for the folder where the exported .xml files or logo files were created and saved after exporting a report definition. If you import a report definition with the same name that already exists under the folder selected for import, the existing report definitions with the same names are overwritten.

5. Select single or multiple .xml and any associated logo files (.jpeg, .gif, .png, and so on).
   - Use the CTRL key to select multiple files.
   - If you import logo files, these are stored at the default logo storage location: [drive]\GMSProjects\[project\]data\Reporting\Logos.
   - If you do not select associated logo files while importing, then the imported report definition displays a No Parking symbol in place of a logo.

6. Click Open.
   ↠ On successful import, the selected report definitions are imported in the selected folder in System Browser.

NOTE:
You can import pre-configured report definitions and associated logo files under \GMSMainProject\Data\Reporting.

Create and Delete Reports Folders
Creating Reports folders in System Browser allows you to organize report definitions.

1. In System Browser, select Applications > Reports or one of its subfolders.
   ↠ Reports displays.

2. Do one of the following:
   - To create a new reports folder:
     a. Click New .
     b. Select New Folder .
     c. In the New Object dialog box, enter a name and description.
     d. Click OK.
   ↠ The new reports folder is saved.
   - To delete a reports folder:
     a. Select the folder you want to delete.
     b. Click Delete .
   ↠ The reports folder is deleted.

Save a Report Definition as the Default Template
1. In System Browser, select Application View.

2. Select Applications > Reports.
   ↠ Reports displays.

3. Click New and select New Report , or open an existing report definition.

4. (Optional) Configure or modify the report definition.

5. Click Save as default . When you save an existing report definition as a default template, a message displays informing you all elements are removed.
from the report definition; Text (Labels), Keywords, and Logos remain in the header/footer section.

- The report definition is saved as a default template.

**NOTE:**
There can only be one default template. You can create a new one or use the one provided by the system. When you create a new template, the existing default template is overwritten.

---

### Create a New Report Definition

1. In System Browser, select **Application View**.
2. Select **Application View > Applications > Reports**.
   - **Reports** displays.
3. Click **New** and select **New Report**.
   - A new report definition opens.

### Create a New Report Definition from an Existing One

- You have made modifications to an existing report definition and want to save it as a new report definition.
- The modified report definition displays.

1. Click **Save As**.
2. In the **Save Object As** dialog box, select the destination folder in which to save the report definition.
   a. Enter a name and definition.
   b. Click **OK** to confirm.
- The report definition is saved.

### Delete a Report Definition

- At least one report definition is available under **System Browser > Reports**.

1. In System Browser, select **Application View**.
2. Select **Applications > Reports > Report Definitions > [report definition]**.
3. Click **Delete**.
   - A confirmation message displays.
4. Click **OK**.
   - The selected report definition is deleted.

- If a report definition is deleted, but a report snapshot related to this definition exists in the **Report Management** section, you can do the following:
  - Display the report data by selecting this report snapshot.
  - Generate PDF/Excel documents using this snapshot.
  - Run this report and generate additional snapshots. You can switch back to **Edit** mode, make changes in the report definition, and save and create a new report definition at the specified location in System Browser.
  - Delete the snapshot using the **Delete** button available in the **Report Management** section.
Abort a Running Report Definition

1. In System Browser, select Application View.
2. Select Applications > Reports.
3. Click Stop.
   - A report is populated with the data gathered before the report execution was stopped.

**NOTE:**
You can stop creating a PDF or XLS document in the same way.

Viewing a Report Definition in the Excel format with a Template

1. Click Create and view Excel.
   - An Excel file is created and stored at the following temporary location on your machine: [Drive]:\Users\[UserID]\AppData\Local\Temp\temp\GMS. A dialog box displays asking you to save a copy of this file on your machine, open the file from the temporary location, or cancel the procedure to open or save the file.
2. Open the Excel file by clicking Open in the dialog box.
   **NOTE:** If you are opening the file from the temporary location, you must first ensure that you save a copy of this file at a different location on your machine and proceed with the further steps on the saved copy.
3. Open the worksheet with the table information in the saved copy of the Excel file and select a row with data.
4. From the Insert menu, select the PivotTable option.
   - The Create PivotTable dialog box displays.
5. Select the Select a table or range option and specify the table details.
6. Select the New Worksheet option in the Choose where you want the PivotTable report to be placed section and click OK.
   - A new worksheet is added to the Excel document with the PivotTable options.
7. From the PivotTable Field List, select the columns to be added to the PivotTable.
   - The selected columns are added to the worksheet.
8. *(Optional)* Re-organize the columns as per your requirement in the Drag fields between areas below section in the PivotTable Field List.
   - Any changes you make in this section reflect in the worksheet.
9. Select any row from the PivotTable, right-click, and then select PivotTable Options.
   - The PivotTable Options dialog box displays.
10. Select the Data tab.
11. In the PivotTable Data section, clear the Save source data with file check box and select the Refresh data when opening the file check box.
12. Click OK.
13. Delete all the sheets in the Excel document, except the sheet having the PivotTable configuration.
   - The saved Excel document is a template that contains the PivotTable.

15. Select the report definition you created.

16. From the Extended Operation tab, specify the path of the template in the Excel Output Template field and click Set. By default, the Excel Output Template field does not display in the Extended Operation tab. In order to display this field, you must select the DL3 display level check box for the Template Path property in the report definition Object Model.
   **NOTE:** The template path is the path of the Server machine. A Process Monitor User must have access to the folder in which the template file is present for the PivotTable to display.

17. Run the report.
   - The generated report displays in the Run mode.

18. Click Create and view Excel.

19. Click Open.
   - The Excel document displays. The first worksheet displays information on the PivotTable and the details of other tables in the Report display in the other sheets.

2.5.3.2 Configuring Report Parameters
You can customize your report definition by performing the following activities:
- Adding elements such as tables, plots, keywords, and so on.
- Configuring the layout of the report by setting the orientation, page size, margins, headers and footers.
- Formatting the report elements for an enhanced appearance by applying color, adjusting positions of the elements, and so on.

Insert Tables

- You have selected an existing report definition in System Browser > Reports or you have created a report definition and now want to configure it.

1. Click the Home tab.

2. Perform either of the steps to insert a table. Ensure that you are not inserting the table in the header/footer section of the report definition:
   - From the Insert group box on the Home tab, click the Table group box, select a table, such as Objects, Active Events or Activities, and drag-and-drop it in the report definition.
     The cursor shape changes and indicates the selected table name.
   - Right-click the report definition and from the Insert Table option, select the table type.
   - Drag-and-drop the desired system object from System Browser onto the report definition. The Name filter of the inserted table is set to the dropped system object.
   - The table is added to the report definition with its default columns.

3. Right-click the table and select Select Columns to add new columns or remove displayed columns.
   - The Select Columns dialog box displays. The layout and content of this dialog box varies according to the type of table selected.

4. Select the check box preceding each column to add it to the table. In case of a property, you must first expand it, and then check the columns.
   **NOTE:** For an Objects table: Select the object related to the Objects table from
the **Type** drop-down list. The columns related to the object type selected are filtered and displayed in the **Available Columns** list. If you select a column that belongs to a property, then the column is added in the **Property** column format, such as **High Limit.ActivityLog**. The checked columns are added to the **Selected Columns** list.

5. Click **OK**. The columns are added to the table in order of their presence in the **Selected Columns** list.

6. *(Optional)* You can re-order the columns by selecting a column in the **Selected Columns** list and clicking **Move Up** or **Move Down**. To remove a column, select a column and click **Remove**. To delete a table from the report definition, right-click the table and press the **Delete** key. The table is added with the required columns.

**Insert Plots**

▷ You have selected an existing report definition in **System Browser > Reports** or you have created a report definition and now want to configure it.

1. Click the **Home** tab.

2. Do one of the following:

   – From the **Insert** group box, click the **Plot** group box, and select any plot (Trends, Graphics), and drag-and-drop it onto the selected report definition. **NOTE:** The cursor changes and indicates the selected plot name.

   – Right-click the report definition and select the required type of plot from the **Insert Plot** option.

   – Drag-and-drop the desired **Trend View Definition/Graphics View Port** from System Browser onto the report definition. The Name filter of the inserted plot is set to the dropped Trend View Definition or Graphics View Port.

   ▷ The plot placeholder is added to the report definition. By default, the plot is left-aligned.

   **NOTE:** In **Run** mode, this plot image is replaced by the actual data retrieved from the Report service.

   **NOTE:** You cannot insert a plot in the header/footer section and cannot apply font types, size, and color on a plot.

**Insert Keywords**

▷ You have selected an existing report definition in **System Browser > Reports** or you have created a report definition and now want to configure it.

1. Click the **Home** tab.

2. Do one of the following:

   – From the **Insert** group box, select a keyword from the **Keyword** group box and drag-and-drop it in the header/footer section or anywhere in the report definition.

   – In the report definition, place the cursor where you want to insert the keyword, right-click and select the required keyword from the **Insert Keyword** option.

   – From the **Insert** group box, insert a blank text and then do one of the following:
- Select a keyword from the **Keyword** group box and drag-and-drop it onto the blank text.
- Right-click the blank text and select the required keyword from the **Insert Keyword** option.

ℹ️ The keyword is inserted.

### NOTE:
To delete a keyword, you must delete the label containing that keyword.

## Insert Labels
▶ You have selected an existing report definition in **System Browser > Reports** or you have created a report definition and now want to configure it.

1. Do one of the following:
   - Click the **Home** tab.
   - Select **Insert > Text > Blank**. Drag-and-drop it either in the report definition or in the header or footer section.
   - Right-click the report definition or the header or footer section where you want to insert the text label, and select the **Insert Label** option.

ℹ️ A blank label is inserted.

2. Type the desired text.

ℹ️ The label is added with the desired text. If no text or keyword is added to a label in **Edit** mode, then a blank label displays in **Run** mode.

## Insert Logos
▶ You have selected an existing report definition in **System Browser > Reports** or you have created a report definition and now want to configure it.

1. Click the **Home** tab.

2. From the **Insert** group box, click the **Logo** group box and select **Manage Logo**.

ℹ️ The **Manage Logo** dialog box displays.

3. Click **Browse**.

4. Select an image file, preferably in the format: .bmp, .jpeg, .png, or .gif. You must ensure that the size of the image file does not exceed 1MB.

5. Click **Open**.

ℹ️ The **Select logo to upload** field displays the file path. You cannot edit this field. The image file name is saved as the logo name.

6. Click **Upload**.

ℹ️ The image is added to the **Available Logos** list and the logo file is saved under: [drive]\GMSProjects\[project]\data\Reporting\Logos. You can now proceed to inserting a logo.

7. Perform either of the following steps to insert a logo.
   - From the **Insert** group box, click the **Logo** group box and select a logo, and then drag-and-drop it on the report definition where you want to insert it.
   - In the report definition, place the cursor where you want to insert the logo, right-click and select the required logo from the **Insert Logo** option.

ℹ️ The logo is inserted in the report definition.
NOTE 1:
You can change the position of the logo in the report definition by using the Move buttons (up ⬆️, down ⬇️, top ⬆️, bottom ⬇️) in the Placement group box of the Layout tab, or by right-clicking a logo in the report definition, and selecting Move.

NOTE 3:
To delete a logo, click the logo and press the Delete key. You delete a logo from the source directory using the Manage Logo command in the Logo group box. When a logo is deleted from the source directory, the no parking symbol displays in the report definition (in place of the logo) with a tooltip that displays Logo is deleted or renamed from the source directory. Any subsequent execution of the report definition does not display anything in the PDF or XLS.

Insert Form Controls
You can add the following form controls to your report from the Home tab.

Editable Field
Do one of the following:
- From the Insert group box, click the Form Controls group box, select the Editable Field control and drag-and-drop it in the report definition or in the header/footer section.
- Right-click the report definition or the header/footer section, where you want to insert the editable field, and then select the Insert Editable Field option.

The editable field is added.

NOTE:
To insert the editable field in the header/footer section of a report definition, delete any existing label.

Custom Text Selection Control
1. Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Custom Text Selection control and drag-and-drop it in the report definition or in the header/footer section.
   - Right-click the report definition or the header/footer section, where you want to insert the Custom Text Selection control, and then select Insert Custom Text Selection.

The Custom Text Selection control is added.

2. To add, modify, or delete the control entries, perform the following steps:
   - To add new entries, enter text in the control and click Add ☑️.
   - To modify existing entries, modify the text and click Update 🖋️.
   - To delete the entries, select the entry to be deleted and click Delete ✗️.
Text Group Selection Control
1. Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Text Group Selection control, and drag-and-drop it in the report definition or in the header/footer section.
   - Right-click the report definition or the header/footer section, where you want to insert the Text Group Selection control, and then select Insert Text Group Selection.
   ⊳ The Text Group Selection control is added.
2. To add a text group to the control, navigate to the Libraries node in System Browser and drag-and-drop a text group node to the Text Group Selection control.
   ⊳ The text group is added to the Text Group Selection control. The name of the text group displays on the control. If you want to view the complete hierarchy of the text group, move your cursor over it. The hierarchy displays in a tool tip.

Comments table
● Do one of the following:
   - From the Insert group box on the Home tab, click the Form Controls group box, select the Comments table and drag-and-drop it onto the report definition.
   - Right-click the report definition and select Insert Comments Table.
   ⊳ The Comments table with a single row is added to the report definition.

Set Orientation
1. Click the Layout tab.
   ⊳ The Page Setup group box displays.
2. Click the Orientation menu.
   ⊳ The Portrait and Landscape submenu displays.
3. Select Landscape or Portrait. By default, Landscape is selected.
   ⊳ The report’s orientation changes based on your selection.

Set Page Size
1. Click the Layout tab.
   ⊳ The Page Setup group box displays.
2. Click the Page Size menu.
   **NOTE:** Selecting the More Sizes option displays the width and height (in cm or inch – location dependent) of the selected page size. These fields are read-only.
3. Select the page size of your choice.
   ⊳ The page size of the report definition changes accordingly.

Set Page Margins
1. Click the Layout tab.
   ⊳ The Page Setup group box displays.
2. Click the Margin menu.
   ⊳ A list of preconfigured margins display such as Normal, Narrow, Moderate, Wide, and More Margins. You can specify the top, bottom, left and right
Operating Step-by-Step
Reports

Margins of a page as well as the header and footer margins by selecting the More Margins option.

3. Select the margin of your choice.
   ➡️ The margin of the report changes.

**NOTE 1:**
In the Page Setup dialog box, all fields in the Margins section accept only integer and floating point values.

**NOTE 2:**
A negative value entered highlights the text field in red. Placing the cursor over the field displays a tooltip informing you that one or more margins are set outside the printable area of the page.

**NOTE 3:**
If the difference between the top margin and header margin is zero or a negative value, then the header height is set to a default value of 5 units (mm or inch – location dependent).

Set Headers/Footers
The header and footer are positioned at the top and bottom of the page and provide information about the page, such as page number, page title, date/time, and so on. You can also add logos in the header section of the report and customize the width of the header to accommodate an image or logo of a large size.

1. Click the Layout tab.
   ➡️ The Page Setup group box displays.

2. Click Dialog Launcher.
   ➡️ The Page Setup dialog box opens.

3. Select the Show header or Show footer check boxes to display the header or footer on a page. To hide the header/footer, uncheck these boxes. You can also define the top header and bottom footer margins by changing the top margin and bottom margin values respectively.
   - To modify the width of the header/footer, select the header/footer, and thereafter drag the separator to the desired width. Alternatively, you can also modify the width by specifying the percentage in the Percentage Span field in the Header/Footer group box. If you specify 100 in one of the fields, the values in the other 2 fields will be 0.

**NOTE:**
By default, the Show header and Show footer check boxes are selected and the margin from top and bottom are set to 1 unit (cm or inch – location dependent).

Set Auto Scaling

1. Click the Layout tab.
   ➡️ The Scaling group box displays.

2. Select the Auto scaling check box. By default, the auto scaling mechanism is enabled.
Adjust Positions of Report Elements

1. Select a report element in a report definition.
   ⇨ The menus in the Position group box become available.

2. You can adjust the position of the report element by doing one of the following:
   – Use the Position group box.
   – Click Dialog Launcher or right-click and select Position to open the Position dialog box.

3. To set the alignment, click the required alignment type.

4. To set the indentation, enter values in the Left or Right field (for left and right Indentation respectively). If center alignment is selected, then both these fields are unavailable.

5. To set the spacing, type values in the Before and After fields.

6. To set the width, first select the Width check box and enter the value in the Width field.

7. To set the height, first select the Height check box and enter the value in the Height field. The height option is unavailable for labels.

8. Click OK.

NOTE 1:
All fields in the Position group box and Position dialog box accept only integer and floating point values.

NOTE 2:
A negative value entered highlights the text field in red. Placing the cursor over this field informs you that the value must be greater than or equal to 0.

NOTE 3:
For logos and plots, the width-height aspect ratio is maintained, so that if you change one the other gets adjusted automatically as per the aspect ratio. While inserting logos the original aspect ratio of the image is maintained.

Customize Fonts

1. Select a label or a table in a report definition.

2. Click the Layout tab.
   ⇨ The Font group box displays.

3. Do one of the following to apply a font, font style, or font size.
   – Click the drop-down arrow in the Font group box.
   – Right-click the report element, and select Font.
   ⇨ The Font dialog box displays.

4. Select the font type, font size, and font style as desired.

5. *(Optional)* Select the Underline check box to apply it to the label. The Underline option is unavailable when you select a table in the report definition.

6. Click OK.

Apply Color

1. Select a label or a table in a report definition.

2. Click Color.

3. Do one of the following:
Operating Step-by-Step
Reports

- Select a predefined color (in square boxes).
- Click the More Color option and select a custom color in the More Color dialog box.

4. Click OK.

2.5.3.3 Working with Report Tables
You can perform the following operations on tables in reports.

Customize a Column Header
You can customize the column heading in tables as per your requirement using the Select Columns dialog box. These customized headings appear in the report definition and also in the generated report output. In case of Trends table, in addition to customizing the column headings, you can also customize the column header for the trended objects hierarchy from the Trended Objects tab in the Select Columns dialog box.

Perform the following steps to customize a column header.

- You have added the table whose column headers are to be customized to the report definition.
- You have selected the columns to be displayed in the table.

1. Select the table in the report definition.
2. Right click and select Select Columns.
   - The Select Columns dialog box displays.
3. In the Selected Columns section, select the column whose header is to be customized.
4. Double-click the column header or press F2 to enter a new column header.
   - The modified column header displays in the table in the report definition.

NOTE: When you modify a column header for the first time, the same name displays as the header in all the languages configured in your system. On subsequent edits, the name is updated for only the default language in which you are currently logged in.

Sort a Column
- You have added a table with multiple columns to a report definition.

- Do one of the following:
  - To sort a column data in ascending order, click the column header of a table.
  - To change the sort order to descending, click the same column header again.
  - To sort the data on multiple columns, press CTRL and click the column headers.
    - The data is sorted, and a priority is assigned to the columns if sorting is done on more than one column.

NOTE: Remove the priority of the prioritized columns for multiple sorted columns by single clicking any column header.

Work with the Comments Table in Run Mode
- The report displays in Run mode and has a comments table.

- Perform either of the following activities to add, modify, or delete entries from the table.
  - Adding a new entry: Enter the comments in the Comments column and press ENTER. Press ALT + ENTER to add a new line. The Creation date,
User and Management Station columns are automatically filled in with their respective read-only values.

- **Modifying an entry:** Click Edit next to the row with your comments to make it editable. Perform the required updates and press ENTER to update the comments. You can edit only your own comments.

- **Deleting an entry:** Click Delete next to the row with your comments.

**Select Rows in Tables**
- Select a single or multiple rows in a reports table in the Run mode.
  - The information of the object or objects in the selected row or rows displays in the Extended Operation tab. Additionally, any related items of the objects also display in the Related Items tab. In Trends tables, you can select only a one cell and the information of the object in the selected cell displays in the Extended Operation tab.

**View Data of Deleted Objects**
You can view the data related to deleted objects from the Orphans, Orphan Activities, Orphan Events, and Orphan Trends tables. This data relates to the activity records, event records, or trend records of deleted objects.

To view these tables, you must enable the View Orphan Logs application right from the Security node in the Management View.

In order to view the data of such objects, perform the following steps:

1. Create a new report definition and add the **Orphans** table to it.
2. Add a condition filter to this table and set the value of the **Orphan Type** column to either of the following:
   a. Objects
   b. Trends
3. Run the report definition.
   - The details of all the deleted objects displays.
4. Generate an Excel or PDF output by clicking **Create and view Excel** or **Create and view PDF**.

5. Depending on the type of data (Objects or Trends) to be displayed for the deleted objects, perform the following steps:
   a. To view activity related information of deleted objects, insert the **Orphan Activities** table.
   b. To view the event related information of deleted objects, insert the **Orphan Events** table.
   c. To view the trended information of deleted objects, insert the **Orphan Trends** table.

6. Navigate to the location where you have saved the Excel or PDF file, and then copy the **Object Identifier** of the deleted object whose data should display.

7. Add a condition filter to either the Orphan Activities, Orphan Events, or Orphan Trends tables and set the value of the **Object Identifier** column to the value you copied from the generated Excel or PDF file.

8. Run the report definition.
   ➤ The details of the deleted objects display depending on the value of the specified **Object Identifier**.

### 2.5.3.4 Applying Filters

You can apply the following types of filters to condense the displayed data in a report.

**Prerequisites:**
- System Browser is in **Application View**.
- **Applications > Reports** is selected.
- The report to which you want to apply the filter is selected.

**Name Filter**

1. Select a table or plot in the report definition.

2. Do one of the following:
   - Click **Dialog Launcher** in the **Name Filter** group box.
   - Right-click the selected table or plot and select **Name Filter** from **Filters**.
   - Double-click inside the **Name Filter** group box.
   - The **Name Filter** dialog box displays.

3. Select the **Name** or **Description**. The default selection is **Name**. The selection is the same as in the **Display Mode List Box** in System Browser.

4. To set the Name filter, do one of the following:
   - In the **Name Filter** text box, type the complete path of the object for which you want to apply the Name filter according to System Browser Name. For example:
     **NOTE:** Adding a ".,*" at the end of the name or selecting the **Children** check box enables the children option. For a plot, you can apply only one Name filter and the **Children** check box is unavailable.
   - Drag-and-drop a System Browser object onto the selected table or plot and the Name filter is set to the hierarchy of the dropped object. You can view and modify it using the **Name filter** dialog box.
     **NOTE:** When you drag-and-drop an object for the first time onto a table, the...
default filter *:* is replaced by the hierarchy of the dragged and dropped object.

5. Click New.
   ➯ The Name filter is added to the Name Filter list.

6. Click OK.
   ➯ The Name filter is added to the Name Filter group box.

NOTE:
You can apply multiple Name filters on all tables except for a Trends table. For BACnet tables, applying multiple Name filters is possible, but the Children check box is unavailable.

Condition Filter
1. Select a table in the report to which you want to apply the condition filter.

2. Do one of the following:
   – Click Dialog Launcher in the Condition Filter group box.
   – Right-click the selected table and select Condition Filter from Filters.
   – Double-click inside the Condition Filter group box.
     ➯ The Condition Filter dialog box displays.

3. Select a column from the Available columns list.
   NOTE: For Objects Table: A Type drop-down list displays. Select an object from the list and click the Load button to populate the Available columns list.
     ➯ The operators and values associated with the selected column display in the Operator and Values list.

4. Select the required Operator and Value from the respective lists. If values are not displayed for the selected column, type in the value.
   NOTE: You have to specify time related values in a 24-hour clock format. For example, to specify the Source Time as 2.00 PM, type 14.00.
   ➯ Use AND, OR, () to form the Filter expression.

5. (Optional) For Objects table only, specify the acceptable age of the data on which the filter is applied by selecting the Read data from field system older than option.
   ➯ The value entered is compared with the age of the data in the cache. If the data in the cache is older than the value entered, it is retrieved from the field system; otherwise data from the cache is used for filtering.

6. Click Add.
   ➯ The filter expression formed displays in the Filter expression field.

7. Click OK.
   ➯ The filter expression is displayed in the Condition Filter group box.

Time Filter
1. Select a table in the report to which you want to apply the time filter.

2. Do one of the following:
   – Click Dialog Launcher in the Time Filter group box.
   – Right-click the selected table and select Time Filter from Filters.
   – Double-click inside the Time Filter group box.
     ➯ The Time Filter dialog box displays.
3. For Events and Event Details table only, select the column on which you want to apply the time filter from the Select Column drop-down list.

4. Select the appropriate values for Date/Time type: Exact, Custom, or Relative.

5. Click OK.
   - NOTE: By default, the Unlimited option is selected.
   - The Time filter is added in the Time Filter group box.

Graphics Filter
1. Select the report to which you want to apply the graphics filter.

2. Assign the name filter of the object whose graphics and view ports you want to display in the report output.

3. Select the All Related Graphics check box from the Graphics group box in the Filter tab.
   - All the graphics and viewports related to the object display in Run mode.

Row Filter
1. Select the report to which you want to apply the row filter.

2. Click the Filter tab and thereafter select the Row filter check box.

3. Enter the desired number of rows to be displayed in the report output.
   - The configured number of rows are displayed for the table in Run mode.

2.5.3.5 Configuring a Report Output
You can configure the report output to a file, email, or a printer.

Prerequisites:
- System Browser is in Application View.

Configure Report Output as a File
1. Select Applications > Reports.

2. Click the Settings tab.

3. From the Report Output group box, click Dialog Launcher .
   - The Report Output Definition dialog box displays.

4. Select File as the destination type in the Destination types list.

5. Click Configure Folders.
   - The Report Output Folders Configuration dialog box displays.

6. In the Folder Alias field, type a name for the Report Output folder.

7. Click Browse to select a destination folder.
   - The selected destination path displays in the Folder Path field.

8. (Optional) In the Folder Description field, type the folder description.

9. Click New.
   - The output folder is added to the List of Folders for the Report Output section.

10. Click Close.
    - The configured output folders display in the File drop-down list of the Report Output Definition dialog box.
11. Select the required report format (PDF, XLS, CSV, or XML) in the Report format list.

12. Select File in the Destination types list.

13. From the File drop-down list, select the destination folder where you want to save the file.
   - The File drop-down list displays all the report output folders that you have configured.

14. Select Enter custom file name to add the file name. The default option is Use report name as file name.

15. Do one of the following:
   - Select the Append date/time to file name check box to add the date and time to the file name when saved.
     NOTE: The Create new/overwrite existing file and Append data options become unavailable when you select the Append date/time to file name check box.
   - Select the Append data option button to append data in the same folder but creating new document with incremental number.
   - Select Create new/overwrite existing file to create a new file or overwrite the existing file with the same file name.

16. Click New.
   - The selected format, destination, and file name are added to the Output Definition list.

17. Click OK.

Configure Report Output as an Email
   - You have selected the required format (PDF, XLS, or CSV) in the Report format list in the Report Output Definition dialog box. (Refer steps 1 to 5 in Configuring Report Output as a File [→ 96])
   - You have configured contact list using the address book.

1. Select Email in the Destination types list.

2. Click Select Contacts.
   - The Email Contacts dialog box displays all the configured contacts.
     NOTE: If there is a change in the configured email address of a recipient in the Address Book, it is automatically reflected in the Report Output group
3. Select the required contacts by selecting the check box preceding each contact.

4. Click OK.
   ➤ The selected contacts are displayed in the Destination field in the Report Output Definition dialog box. A semicolon (;) separates multiple contacts.

5. In the Report Output Definition dialog box, do one of the following:
   - Select All documents in one email.
   - Select Document(s) per mail and configure the number of documents to be sent.
     The default option is one document per email.

6. Select the Enter custom file name option to add the file name. The default is Use report name as file name.

7. Select the Append date/time to file name check box to add the date and time to the file name when saved.

8. Click Add.
   ➤ The selected format, destination, and file name are added to the Output Definition list.

9. Click OK.
   ➤ The configured Report Output Definitions display in the Report Output group box.

**Configure Report Output as a Printer**

▷ You have selected the required format (PDF, XLS, or CSV) in the Report format list in the Report Output Definition dialog box. (Refer steps 1 to 5 in Configuring Report Output as a File [→ 96])

▷ You have configured the server printer for printing reports.

1. Select PDF in the Report format list.
   NOTE: The destination type printer is not available for XLS or CSV printing.

2. Select Printer in the Destination types list.

3. Select the required printer from Printer drop-down list. If server printer is not configured the Printer drop-down list is empty.

4. Select the option to print either All or First number of pages.
   NOTE 1: By default, the first 100 pages are printed. You can edit the default and add the number of pages to be printed.
   NOTE 2: Content that is printed depends on the sorting you applied on the table.

5. Click Add.
   ➤ The selected format and destination are added to the Output Definition list.

6. Click OK.
   ➤ The configured Report Output Definitions display in the Report Output group box.
   When executed, the file is sent to the configured printer for printing.
2.5.3.6 Configuring Automatic Report Execution

You can schedule automatic report execution through macros, reactions, and graphics.

Automatic Report Execution through a Macro

- System Manager is in Engineering mode.
- You have configured the destination (file, email, or printer) to which you want to route the report output.

1. In System Browser, select Application View.
2. Select Applications > Logics > Macros.
   - The Macro tab displays.
3. Drag-and-drop the report definition from System Browser into the Macro tab. This will cause a new row to be created.
4. In the Property field, select Last Run and select Execute in the Command field.
5. Click Save As to save the macro.
   - The macro is saved and displays below the Macros node.
6. Select the saved macro from System Browser.
   - The details of the macro display in the Macro tab.
7. Click the Extended Operation tab and ensure that the Operational Status property is enabled. Thereafter, click the Execute button next to the Activity Status property.
   - The macro executes and the report is generated and routed to the configured destination.
Operating Step-by-Step
Reports

Automatic Report Execution through Reactions

- System Manager is in **Engineering** mode.
- You have configured the destination (file, email, or printer) to which you want to route the report output.

1. In System Browser, select **Application View**.
2. Select **Applications > Logics > Reactions**.
   - The **Reaction Editor** tab displays.
3. In the **Reaction Editor** tab, open the **Output** expander.
4. From the **Output** expander, open the **Action** expander.
5. Drag-and-drop the report definition from System Browser into the empty area inside the **Action** expander. This will cause a new row to be created.
6. In the **Property** field, select **Last Run** and select **Execute** in the **Command** field.
7. Expand the **Triggers** expander and thereafter expand the **Time and Organization Mode** expander.
8. Specify the date and time when you want to execute the reaction.
9. Click **Save As** to save the reaction.
   - The reaction executes at the specified date and time and the report is generated and routed to the configured destination.

Automatic Report Execution through Graphics

- System Manager is in **Operating** mode.
- You have configured the destination (File, Email, or Printer) to which you want to route the report output.
1. In System Browser, select Application View.
2. Select Applications > Graphics.
3. Click Edit .
   ➞ The Graphics application displays in Edit mode.
4. Click New and select New Graphic.
5. Click the Options tab and select the Command option.
6. In System Browser, expand the Reports folder and drag-and-drop the report definition to be executed to the window labeled Untitled in the Graphics editor.
7. Click Save.
   ➞ The graphic is stored below the Graphics folder.
8. Select the saved graphic.
   ➞ The graphic displays in the run mode.
9. Hover your mouse pointer over the graphic.
   ➞ The pointer changes to a hand shape and a tool tip displays with the name of the associated report.
10. Click the graphic.
    ➞ If the execution is successful, the message "Command successful" displays in the status bar at the bottom of the screen. The generated report output is routed to the configured destination.
Print Automatically Generated Reports

1. Select Applications > Reports.
2. Click the Settings tab.
3. From the Report Output group box, click Dialog Launcher.
   ➤ The Report Output Definition dialog box displays.
4. In the Report format list, select PDF.
5. In the Destination types list, select Printer and specify the other printer details.
6. Click Add.
   ➤ The selected format and destination are added to the Output Definition list.
7. Click OK.
   ➤ The configured Report Output Definitions display.

2.5.4 Examples of Reports Configurations
This section provides examples on configuring reports.

2.5.4.1 Configuring an Objects Report

Scenario: You want to configure an object’s report to fetch the details of BACnet Analog Output objects having Current Priority as 16.

1. Create a new report definition with the objects table inserted.
   ➤ The Objects table is inserted with the following default set of columns—Object Description, Object Designation, Function, Discipline, Type, Subtype, Main Value.
2. Right-click the table and select Select Columns.
   ➤ The Select Columns dialog box displays.
3. In the **Type filter** field, enter the object type description.  
   - The **Type** drop-down list displays the object types.

4. On the **Type** drop-down list, select the object type.

5. Click **Load**.  
   - The columns are listed in the **Available columns** list.

6. Select the property and/or attribute to display as columns in the table.  
   - The list of selected columns displays in the **Selected Columns** list.  
     - **NOTE:** To remove columns that you do not want displayed in the table, click ❌.

7. Click **OK**.  
   - The **Objects** table displays.

8. Configure a name filter for your report by dragging-and-dropping the required objects from System Browser to the **Objects** table in the report definition. In order to get the desired results, you must assign the objects for which columns are configured in your report.

9. **(Optional)** Configure a **Condition filter** for your report.

10. Right-click the **Objects** table, point to **Filters** and select **Condition Filter**.  
    - The **Condition Filter** dialog box displays.
11. Perform the following steps to apply the Condition filter:
   a. Enter BACnet in the Type filter field to display all BACnet related objects in the Type drop-down list.
   b. Select the BACnet Analog Output Object from the Type drop-down list.
   c. Click the Load button. All the common columns and columns specific to the selected object display in the Available columns list.
   d. Select the column on which you want to add the condition filter. In this case, select [Current_Priority].
   e. Select = in the Operator list.
   f. In the Values text field, enter "Priority - 16".
   g. Click Add.
   h. Click OK.
   ✤ The Condition filter is added to the table.

12. Run the report to view the data.
   ✤ If you have applied the condition filter, the details of all analog output objects with Current Priority set to 16 display. If no Condition filter is specified, then the details of all the analog output objects display.

13. Save the report definition if the configuration of columns and name filter is sufficient.
   NOTE: You can enhance the report configuration at any time in the future by
adding/removing columns or by setting additional objects as name filter or by removing existing objects from the name filter.

### 2.5.4.2 Configuring an Activities Report

**Scenario:** You want to create an activities report to determine the number of times the Present Value property of an Analog Input object has exceeded 100 in the last 24 hours.

- You have set the AL attribute for the Present Value property of the Analog Input object in the Properties expander in the Object Configurator.
- Ensure that a report with the Activities table with the following default set of columns—Source Time, Object Description, Object Designation, Action, Log Type, Previous Value, Value, Status, User Name, Management Station, Message Text, and Attachment is available.

1. *(Optional)* Add any extra columns to the table from the **Select Columns** dialog box. To display this dialog box, right-click the table and select **Select Columns**.

2. Drag-and-drop the analog input object whose value you want monitored, to the Activities table. This object acts as the name filter.

3. Right-click the **Activities** table and select **Filters > Condition Filter**.
   - The **Condition Filter** dialog box displays.

4. Perform the following steps to apply the condition filter:
   a. Select **Value** from the **Available Columns** list.
   b. Select **>** from the **Operators** list.
   c. Enter 100 in the **Values** text field.
   d. Click **Add**. The expression displays in the **Filter Expression** field.
   e. Click **OK**.

   - The Condition filter is added to the table.

**NOTE:** When you are creating a Condition filter, the syntax of the property values depends on the data type of the property. For more information, see Condition Filter Syntax in Condition Filter.
5. Specify the time period by adding the Time filter to the report definition. Perform the following steps to add the Time filter.
   a. Right-click the Activities table, point to Filters and select Time Filter. The Time Filter dialog box displays.
   b. Select the Relative option.
   c. Select the Last or Current Period option, depending on the data requirement for the last 24-hour period or current 24-hour period. For more information regarding setting the time period, see Time Filter. In this example, since data is required for the last 24-hours, you must select Last and specify 24-hours.
   d. Click OK.
6. Run the report to view the data.

   The report displays the data for analog input object where value is greater than 100 in the last 24-hours.

7. (Optional) Click Save.

### 2.5.4.3 Viewing Event Details using Assisted Treatment

**Scenario:** You want to create an event details report that displays the details of a particular event using Assisted Treatment.

- A template for operating procedures is available and the Operational Status property for the template is set to **Enabled**.
- An Alarm step is added to the operating procedure template and an Event Details report is associated with the step. The step is configured as per the required settings.
- You have configured the report output destination. For information, see Configure Report Output.

1. Double-click the event in the Event bar.

   The Event Details report displays in Assisted Treatment. Information related to the event time, category, cause, ID, object description and designation displays in the report.
2. Click before the event entry.
   ➞ Additional information related to the event such as Time, Action, User Name, Management Station, Attachment, Value, and Previous Value display as child records.

3. Perform the required steps to treat the event from the Contextual pane.

4. Click Send to Output ➤
   ➞ The report is routed to the configured destination.

2.5.4.4 Viewing Event Details for Specific Events Using Reports

Scenario: You want to create an event details report that displays all events of type Fault or Life Safety on an Analog Output object for a 24-hour period.

➤ Ensure that a report containing the Event Details table with the following default set of columns — Event Time, Event Category, Event Cause, Event ID, Object Description, and Object Designation is available.
Operating Step-by-Step Reports

1. **(Optional) Add any extra columns to the parent table from the Parent tab in the Select Columns dialog box. You can add the extra columns to the child table from the Child tab. To display this dialog box, you must right-click the table and select Select Columns.**

2. From System Browser, drag-and-drop the analog output object (For example, Analog Output 1) whose event details are to be monitored to the Event Details table. This object acts as the name filter.

3. Right-click the Event Details table, point to Filters and select Condition Filter.
   - The Condition Filter dialog box displays.

4. Perform the following steps to apply the Condition filter:
   - a. From the Available Columns list, select Event Category.
   - b. From the Operators list, select =.
   - c. From the Values list, select Fault, press CTRL, and then select Life Safety.
   - d. Click Add. The expression displays in the Filter Expression field.
   - e. Click OK.

   ➤ The Condition filter is added to the table.

**NOTE:** When you are creating a Condition filter, the syntax of the property values depends on the data type of the property.

5. Specify the time period by adding the Time filter to the report definition.
   Perform the following steps to add the Time filter.
   - a. Right-click the Event Details table, point to Filters and select Time Filter. The Time Filter dialog box displays.
   - b. Select Relative.
   - c. Select either the Last or Current Period option, depending on the data...
requirement for the last 24 hour period or current 24 hour period. For more information regarding setting the time period, see Time Filter. In this case, as we want the data for the current 24-hour period, select Current Period and specify 24 hours.

d. Click OK.

6. Run the report to view the data.

   ☑ The report displays the details of any Fault or Life Safety events that occurred on the Analog Output 1 object in the current 24-hour period.

7. Save the report definition if the data matches your requirements.

   NOTE: You can enhance the report configuration at any time in the future by adding/removing columns or by setting additional objects as name filter, removing existing objects from the name filter, or by modifying the Condition filter, Time filter criteria.

2.5.4.5 Viewing Event Details using Investigative Treatment

Scenario: You want to create an event details report that displays the details of a particular event using Investigative Treatment.

▷ Operating procedure templates (if present) are disabled.
▷ Ensure that a report containing the Event Details table is available and the Show in Related Items check box is selected for this report or the HQ_EventDetailsLog report is imported.
1. Double-click the event in the Event bar.
   ➞ The event details display in the Related Items tab.

![Image of Event Details](image)

2. Perform the required steps to treat the event.
3. Select the report containing the Event Details table from the Related Items tab.
   ➞ The report executes in the Secondary pane and the information related to the event time, category, cause, ID, object description, and designation displays in the report.

![Image of Report Details](image)

4. Click **+** before the event entry.
   ➞ Information related to the event treatment such as Time, Action, User Name, Management Station, Attachment, Value, and Previous Value display as child records.

![Image of Event Details with Child Records](image)

### 2.5.4.6 Configuring a Trends Plot

**Scenario:** You want to track the change of value of an Analog Input object graphically over a period of 10 years using a trends plot.

- You have created a Trend View Definition with the Analog Input object.

1. Create a new report definition with a Trends Plot inserted.
   ➞ A Trends Plot is inserted in the report definition.
2. From System Browser, drag-and-drop the Trend View Definition to the Trends Plot. This acts as a name filter to the plot.

3. Specify the time period by adding a Time filter to the plot. Perform the following steps to add the Time filter:
   a. Right-click the Trends Plot, point to Filters and select Time Filter.
   b. In the Time Filter dialog box, select the Relative option.
   c. Select the Last or Current Period option, depending on the data requirement for the last 10 hours or current 10 hours. In this case, we will obtain the data for the current 10 hours by selecting Current Period and specifying 10 hours.
   d. Click OK.
4. Run the report to view the data.

   The report displays the graphical representation of the data for the current 10 hour period.
5. Save the report definition.
   **NOTE:** You can enhance the report configuration at any time, in the future, by changing the Name and Time filters.

### 2.5.4.7 Configuring a Report Using In Operator

**Scenario:** You want to configure a report that displays the data for some objects and you want to view the data for only those objects that are linked to a graphic.

Ensure that you have configured an Objects report that displays the data of some objects.

1. From the **Select Columns** dialog box select the **Related Items Type** column.
   - The Objects report displays with the **Related Items Type** column added to it.

2. Perform the following steps to add a Condition filter with the In operator:
   a. From the **Condition Filter** dialog box, select **Related Items Type** in the **Available Columns** list.
   b. Select **In (→)** from the **Operators** list.
   c. In the **Values** text field, type **Graphics**.
   d. Click **Add**.
   - The Condition filter is added to the table and displays in the **Filter Expression** field below the **Add** button.
3. Click OK.

4. Run the report.

   The generated report displays the data for only those objects that have a graphic linked to them.
2.6 Trends

This section provides instructions for using the Trends of Desigo CC. For background information, see the reference section.

2.6.1 Creating an Online Trend

Scenario: You want to view the data in a trend view definition, configure it, and print the contents.

Reference: For background information, see the reference section.

Workflow diagram:

Steps:

1 – Configure the Trend View Definition

You have created a trend view definition and it is present in the Trends folder in the System Browser.

- Configure the trend view definition by performing the following activities:
  - Define Chart Properties [→ 117]
  - Define the Axis Properties [→ 118]
  - Position the legend [→ 118]
  - Define the Line Properties [→ 118]
  - Display Markers [→ 119]
  - Display Measured Values [→ 119]
  - Display Quality Attributes [→ 120]
  - Position the Y-Axis [→ 120]
  - Edit background or line colors [→ 121]
  - Show or Hide Columns [→ 121]

The trend view definition is configured as per the specified settings.
2 – Analyze the Trend Data

- Specify the time range for which you want to display the data displayed in the trend view from the following:
  - Select the time range from the time range scrollbar [→ 124]
  - Select the time range from a list of predefined time ranges [→ 126]
  - Select an absolute time range [→ 124]
  - Select a relative time range from the current date [→ 126]
  - Select a relative time range from the start date [→ 125]
  - Select a relative time range from the stop date [→ 126]

▷ The trend data displays as per the specified time range.

3 – Print the Trend View

▷ You must define the Print in color setting in advance if you want to print in color.

1. Select the time range to print using the time range scrollbar. The time range displayed on the screen is printed.

2. Click Print .

3. Select or clear the Fit to page check box. Select the corresponding option in the toolbar if Fit to page is not selected.

4. Define print properties for:
   - Margins (top, bottom, left and right).
   - Printer.
   - Orientation (portrait or landscape).
   - Paper size.

5. Click Print and Close to print, or click Close.

▷ The trend data is printed in the form of a chart or a table as displayed in the trend view. You can also print the trend data from Reports. For more information, see Printing Trend Data from Reports [→ 129].

2.6.2 Additional Trends Procedures

Select any of the procedures for additional information on Trends.

2.6.2.1 Additional Trend View Definition Procedures

You can configure the Trend View Definition by performing any of the following procedures:

Define Chart Properties

1. Click Properties .

2. Click the Chart Properties tab.

3. In the Configure group box, do the following:
   - From the Grid drop-down list, select the corresponding background grid for the Trend View.
   - From the Background drop-down list, select the corresponding background color for the trend view or click More color to define a customized color.

4. In the Titles group box, do the following:
   - Complete the Name field for your Trend View.
   - Complete the Title field for the left Trend View border.
   - Complete the Title field for the right Trend View border.
5. Click Save.
   - The edited properties are saved to the Trend database.

**Define the Axis Properties**
1. Click Properties.
2. Click the Axis Properties tab.
3. Enter a title for the Left axis property, Right axis property, and X-axis property.
4. Click Save.
   - The edited properties display in the Trend View.

**Position the legend**
1. Click Properties.
2. Click the Legend Properties tab.
3. Select the appropriate position (top, bottom, left, right) from the Legend drop-down list.
4. Click Save.
   - The legend is positioned as selected in the current Trend View.

**Define the Line Properties**
1. Select the series for editing from the legend for the Trend View.
2. Click Properties.
3. Click the Series Properties tab.
4. Select Visible and enable it.
5. Select the appropriate type from the Series line type drop-down list.
6. Select the appropriate style from the Series line style drop-down list.
7. Select the appropriate color from the Series stroke color drop-down list.
8. Select the appropriate line thickness from the Series stroke thickness drop-down list.
9. Click Save.
   - The edited properties are saved for the particular Trend View to the Trend database.

<table>
<thead>
<tr>
<th>Line Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line type</td>
</tr>
<tr>
<td><img src="image1" alt="Line Types" /></td>
</tr>
</tbody>
</table>
NOTE: Do not select a thick line if you want to display the Trend curve with a marker. The marker will disappear behind a thick line.

Display Markers

Markers allow you to further emphasize the measurement time using a symbol.

- The Show quality icons property must be selected.
- 1. Select the series for editing from the legend for the Trend View.
- 2. Click Properties.
- 3. Click the Series Properties tab.
- 4. Select the Show markers check box.
  - Select the corresponding type from the Marker style drop-down list.
  - Select the appropriate size from the Marker size drop-down list.
- 5. Click Save.
  - The edited properties are saved to the Trend database.
- 6. Click Stop.
  - The markers display on the trend view.

NOTE: Be careful not to select too thick a line if you want to display markers. The marker disappears behind a thick line. You can see the markers only when you stop the trend view.

Display Measured Values

You want to display the measured value for the data point. Measured values display only when you stop the Trend View.

- The Show quality icons property must be selected.
- 1. Select the series for editing from the legend for the Trend View.
- 2. Click Properties.
- 3. Click the Series Properties tab.
- 4. Select the Show Values check box.
5. Click **Save**.
   - The current measured values are updated in the chart each time the measured value of a data point changes.

6. Click **Stop**.
   - The measured values display on the Trend View.

**NOTE:**
Measured values display on top of one another when the changes to the measured values occur in quick succession or the selected time range is too large. Since the measured values are no longer readable, select a smaller time range or switch off the labels.

**Display Quality Attributes**
You want to display the quality attribute for the data point at the time of the measured value.

1. Select the series for editing from the legend for the Trend View.
2. Click **Properties**.
3. Click the **Series Properties** tab.
4. Select the **Show quality icons** check box.
5. Click **Save**.
6. Click **Stop**.
   - Interventions or states that are not normal display with the corresponding quality attribute, for example, 🚨 (see Quality Attributes).

**NOTE:**
The quality attributes are hidden when you re-click **Run** and the trend series is updated. You must select **Advanced display if chart stopped** in the **Chart Properties** tab (acts on all series) if you want to display quality attributes during update. If there are too many symbols, the update to the Trend View can take some time.

With the reduced display ⏎, not all quality attributes can display. In order to display all quality attributes, limit the time period.

**Position the Y-Axis**
1. Select the series for editing from the legend for the Trend View.
2. Click **Properties**.
3. Click the **Series Properties** tab.
4. In the drop-down list, select Y-axis position.  
5. Click Save.  

The Y-axis displays either on the left or right side of the chart.

**NOTE:**  
The position is set and cannot be changed for digital and multistate data types.

---

**Edit Background or Line Colors**  
1. Click Properties.  
2. Do one of the following:  
   – Click the Chart Properties tab to change the background color.  
   – Click the Series Properties tab to change the line color for a series.  
3. Then select the appropriate series from the legend.  
4. Select the Colors drop-down list.  
5. Select one or the predefined colors or click More colors.  
6. Select the color:  
   – Click the predefined color pattern (small squares) or drag the slider (right-click) until you reach the desired color. Click the large square for color selection.  
   – Click the Color Picker and drag the cursor to the desired location on the screen.  
7. Click Save.  

The edited color properties are assumed.

---

**Show or Hide Columns in the Legend**  
The Trend View is open.  
1. Right-click the legend header.  
2. Perform either of the following steps:  
   – To hide a column select the Hide this column menu option.  
   – To show additional columns in the legend, position your mouse pointer over the Visible columns menu option and select the desired column from the list. The selected column is added to the legend view.

**NOTE:**  
Changes to the legend view are not saved to the Trend View Definition.

---

**Re-position Columns in the Legend**  
1. Click and hold down the left mouse button on the column header.  
2. Move the column to the desired location and release the mouse button.  
3. Point to the separator line and adapt the column width.  
4. Click Save.
Create a Trend View Definition

1. In System Browser, select **Application View**.
2. Select **Trends > Trend View Definitions**.
   - The Trend application opens.
3. Click **New ➔ New Trend ➔**.
4. In System Browser, select **Management View**.
5. Select **Project > Field Networks > [network type] > Hardware > [device]**.
6. In System Browser, select the corresponding data point (do not click the data point). In order to add multiple data points to the Trend View at the same time, select the **Manual navigation** check box and select the points.
7. Drag-and-drop to the selected data point to the Trend application.
   **NOTES:**
   - Data trending continues as long as the VL attribute for the data point is enabled (see Object Configurator).
   - To display a change of value on a binary value, an additional dotted zero line is displayed at State 1 or One.
8. Click **Save ➔**.
   - An online Trendlog object is created for each data point in **Application View > Trends > Online Log Objects**. The Trend View Definition displays below the Trend View Definitions folder.

Create a Trend View Definition from Online or Offline Trend Log Objects

1. In System Browser, select **Application View**.
2. Select **Applications > Trends**.
3. Click **New ➔ and then ➔ New Trend ➔**.
4. Select one of the following:
   - An offline trend log object from the **Offline Log Objects** folder.
   - An online trend log object from the **Online Log Objects** folder.
5. Drag-and-drop the object to the Trend View.
6. Repeat Steps 3 through 5 to add more objects to the Trend View.
7. Change the Trend View properties and the properties for each series. For more information, see Configuring Trend View Definition ➔ 117.
8. Click **Save ➔**.

Create a Trend View Definition from Related Items

1. Navigate to the **Related Items** tab and select **New Trend**
   - Trend View opens a secondary view.
2. Change the Trend View properties and the properties for each series. For more information, see Configuring Trend View Definition ➔ 117.
3. Click **Save ➔**.
Create and Delete Trend View Folders

1. In System Browser, select Applications > Trends.
   ➡ Trends displays.

2. Select Trend View Definitions.

3. Do one of the following:
   - To create a new Trends folder:
     a. Click New
     b. Select New Folder
     c. In the New Object dialog box, enter a name and description.
     d. Click OK.
   ➡ The new Trends folder is saved. You can create additional sub-folders as needed. However, it is recommend saving Trend Views in a structured manner by building topology or electrical and mechanical installations.
   - To delete a Trends folder:
     a. Select the folder you want to delete.
     b. Click Delete
   ➡ The Trends folder is deleted.

Delete a Trend View

▷ A Trend View is open or a Trend View is selected via System Browser.

1. In System Browser, select Application View.

2. Select Applications > Trends > Trend View Definitions > [Trend View Definition].

3. Click Delete
   ➡ The Trend View is permanently deleted from the Trend View Definitions folder. The Trendlog objects in the Trend View are not deleted. No recorded data is lost.

Save a Trend View Definition as a Default Template

A Trend View Definition normally is customized only once in a project. This ensures that all Trend Views that are created look the same. For more information on user defaults, see the User Default table.

1. In System Browser, select Application View.

2. Select Applications > Trends.

3. Click New > New Trend
   ➡ The Trend application opens.

4. Click Properties

5. Select the Chart Properties and edit the Trend View properties. For more information, see Configuring Trend View Definition [117].
   NOTE: Only the grid and background properties are part of the user default.

6. Click Save as user default
   ➡ These settings now apply to all new Trend Views. You can, however, adapt the Trend View Definition as needed.
### 2.6.2.2 Analyzing Trend Data

You can analyze the date and time for which you want to display the trend data performing the following activities:

#### Select the Time Range using the Time Range Scrollbar

You want to define the visible time range as well as the corresponding time window for a Trend View.

- You are in an active Trend View.

1. In the Trend View, navigate to the left or right slider (dark grey area) of the time range slider.
   - The shape of the mouse pointer changes and the tooltip displays.

2. Drag the Time Range slider to the left or right until you have reached the desired time range.
   - The time range continuously displays.
   - The Trend View displays the selected time range.

3. Navigate to the Time Range slider (light grey area).

4. Drag it to the desired time/data range.
   - The time range is displayed with the corresponding data period in the Trend View.

#### Repeat Functions

- Click the Time Range scrollbar to the left or right of the Time Range slider. The Time Range slider moves in the corresponding direction per the time range defined in the Time Range slider.
- Click the left or right arrow on the Time Range scrollbar. The Time Range slider moves in the corresponding direction at a 1:10 ratio for the selected time range.

---

**NOTE:**

Data is compressed for display purposes only if you select a large time range or very large number of measured values. All data is displayed for smaller time ranges.

---

<table>
<thead>
<tr>
<th>Yes</th>
<th>No</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td></td>
<td>Background color of the Trend View.</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Legend position in the Trend View.</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Show/hide columns.</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Adjust column width.</td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>Move columns.</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>Series properties.</td>
</tr>
<tr>
<td></td>
<td>X</td>
<td>Axes properties.</td>
</tr>
</tbody>
</table>
Select Absolute Time Range

- You are in an active Trend View.

1. Right-click the Time Range bar and from the menu options select the Select range option.
   - The Select Date/Time dialog box displays.
2. From the Selection type drop-down list, select Absolute.
3. Click the displayed Start time.
   - The Calendar dialog box opens.
4. Enter the desired start date in the Calendar dialog field.
   - Select month and year with the symbols.
   - Click the appropriate date.
5. Click the displayed time at Start time and enter the desired start time.
6. Click the displayed End time.
   - The Calendar dialog box opens.
7. Click the displayed time at End time and enter the desired end date in the Calendar dialog box.
   - Select month and year with the symbols.
   - Click the appropriate date.
8. Click the displayed time at End time and enter the desired stop time.
9. Click OK.
   - The Select Date/Time dialog box closes and the Trend View displays the defined time range.

Select Relative Time Range from a Start Date

- You are in an active Trend View.

1. Right-click the Time Range bar.
2. Click Select range.
   - The Select Date/Time window displays.
3. Select the Relative option in the Selection type drop-down list.
4. In the Interval text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.
5. From the Start/end time drop-down list, select Starting.
6. Click the displayed date and enter the desired start date in the Calendar dialog box.
   - Select month and year with the symbols.
   - Click the appropriate date.
7. Click the displayed time and enter the desired start time.
8. Click OK.
   - The Select Date/Time dialog box closes and the Trend View displays the defined time range.
Select Relative Time Range from a Stop Date

You are in an active Trend View.

1. Right-click the Time Range bar.
2. Click Select range.
   - The Select Date/Time window displays.
3. From the Selection type drop-down list, select Relative.
4. In the Interval text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.
5. From the Start/end time drop-down list, select Ending.
6. Click the displayed date and enter the desired stop date in the Calendar dialog box.
   - Select Month/Year with the symbols.
   - Click the appropriate Date.
7. Click the displayed time and enter the desired stop time.
8. Click OK.
   - The Select Date/Time dialog box closes and the Trend View displays the defined time range.

Select Relative Time Range from a Current Date

You are in an active Trend View.

1. Right-click the Time Range bar.
2. Click Select range.
   - The Select Date/Time window displays.
3. From the Selection type drop-down list, select Relative.
4. In the Interval text field, enter a time range from 1 to X and select the corresponding time unit in the drop-down list.
5. Select the Ending now option in the Start/end time drop-down list.
6. Click Now.
7. Click OK.
   - The Select Date/Time dialog box closes and the Trend View displays the defined time range.

Select Time Range from Predefined Time Ranges

You are in an active Trend View.

1. Move the mouse cursor to the Time Range slider (light grey area).
2. Right-click the Time Range slider.
   - Predefined time ranges display.
3. Select the desired time range.
   - The time range displays with the corresponding data period in the Trend View.
NOTE:
The display calculation is always based on current visible date range. Depending on the position of the current Trend View, the starting point may not be at the start of the day.

Start/Stop Range
▷ You are in an active Trend View.
1. In the Trend View, point the mouse to the left or right end point (dark grey area) for the Time Range slider.
   ⇐ The mouse pointer changes shape and the tooltip displays.
2. Right-click the Time Range slider.
   ⇐ Predefined time ranges display.
3. Select the desired time range.
   ⇐ The time range displays with the corresponding data period in the Trend View. The display calculation is always based on current visible date range as displayed in the tooltip.

Switch between Automatic and Stop Mode
Automatic mode normally is used to analyze trend data (continuous scrolling of the graphic curves). The latest data is automatically retrieved from the system. You can change to Manual mode for a detailed analysis (scrolling off). In this case, the data is no longer updated automatically.

1. Click Stop .
   ⇐ This stops automatic data updates and suppresses the symbol to update Trend View.
2. Define the desired date range using the slider or time bar.
3. Click Refresh when the symbol is available and you want to upload the latest data from the History Database.
4. Click Run to update data on a continuous basis.

Use Compare View
The compare view is ideal for extended data analysis with time offset.
▷ You are in a Trend View and Manual mode is on.
▷ The Property window of the Trend View is closed.
▷ The time period for display is defined using the time range scrollbar (for example, 12 hours).

1. Click Stop and then click Compare View .
   ⇐ The same Trend View displays a second time.
2. Define the appropriate time/date range with the scrollbar.
3. Select time offset Forward or Backward.
4. Do one of the following:
   – Click one of the predefined offset buttons, for example 1 hour.
   – Select your own range by selecting the dark button, for example, 3 hours, and select the time offset.
   ⇐ Compare view displays with the corresponding time offset and measured values.
Use Mouse Zoom
The zoom function allows you to select a time range in the currently selected Trend View (applies as well for the comparison view) by zooming in on the X-axis and Y-axis.

▷ You are in an active Trend View and in the Stop mode.

1. Click Zoom 📊.
2. Navigate to the left zoom starting range.
   - The point changes shape and the tooltip displays the current position.
3. Drag the pointer to the right zoom end range.
   - The selected zoom range displays in the Trend View.
4. Click Zoom 📊.
   - The original time range, prior to the zoom in, displays, even if you zoom multiple times.

Select Table View
1. Click Stop ⏭.
   - The automatic data update is stopped.
2. Click table view 
   - The table opens in default view. Click the time stamp header to sort the rows by ascending or descending order.
3. Click to show or hide interpolated values.
   - Interpolated values are displayed in light-grey.
4. Click table view again 
   - The graphical Trend View re-displays.
5. Click Run ⏯️ to start the automatic data update.

NOTE: The priority displays in the table if a subsystem supports information on BACnet write priority (1-16).

Highlight Data Series Temporarily
During analysis, it is helpful to temporarily bring a certain series in the Trend View to improve the readability of the trend curve.

▷ Multiple trend curves display in the Trend View.

1. Drag the pointer to the trend curve you want to bring forth.
   - All non-selected trend curves are reduced in their display intensity.
   - The measured value, as well as time and date, are displayed in tooltip at the pointer position.
   - The quality attribute is brought forwards only when one trend curve is visible.

2. Drag the pointer to once again view all trend curves.

Hide Data Series Temporarily
▷ Multiple trend curves display in the Trend View.

1. Click Properties 🧰.
   - The menu bar displays.
2. Select the series you want to hide in Legend.
3. Click Series Properties.
4. Clear the Visible check box.
   - The menu bar is hidden.
   - The series is hidden in the Trend View.
   - The Trend data is still recorded for this series, but is no longer displayed.
5. Click Save.
6. Repeat Steps 2 through 4 for any additional series you want to hide.

**NOTE:** You can also click or on the legend to show or hide each individual trend curve.

### Remove Data Series from Trend View
- Multiple trend curves display in the Trend View.
1. Select the series you want to hide in Legend.
2. Clear the check box in the Remove column.
   - The Remove Trend Series dialog box displays.
3. Perform either of the following steps:
   - Deselect the Stop trending this object on the Management Platform check box. In this situation, the selected series is deleted from Trend View. The Trendlog object is still available in the Online Log Objects folder. All data continues to be recorded (Subscribe=On).
   - Select the Stop trending this object on the Management Platform check box. In this situation, the series and the associated Trendlog object are deleted. The Trendlog object is removed from the Online Log Objects folder. All recorded data remains available, but no new data is recorded (Subscribe = Off). The previously logged data is still available if you reuse the same data point in the Trend View. However, there is a gap in the data between delete and re-generation.
4. Click OK.
   - The trend series is removed from the current Trend View.
5. Click Save.

**NOTE:** When an object is deleted, no warning displays if a Trendlog object is used in several Trend Views. All associated data is lost in the associated Trend Views.

### 2.6.2.3 Printing Trend Data

Perform the following procedure to print trend data from Reports.

#### Print Trend Data from Reports
- You have selected an existing Report Definition in System Browser > Reports or you have created a Report Definition.
- One or more local printers are configured in the system.
1. Click the Home tab.
2. Do one of the following:
   - From the Insert group box, click the Plot group box, and select a Trends plot and drag-and-drop it onto the selected Report Definition.

**NOTE:** The cursor changes and indicates the selected plot name.
– Right-click the Report Definition and select the required type of plot from the Insert Plot option.
– Drag-and-drop the desired Trend View Definition from System Browser on the Report Definition. The Name filter of the inserted plot is set to the dropped Trend View.
  ➔ The plot placeholder is added to the Report Definition. By default, the plot is left-aligned.
  ➔ NOTE: In Run mode, this plot image is replaced by the actual data retrieved from the Report service.

3. Click the Settings tab.
5. Select PDF in the Report format list.
6. Select Printer in the Destination types list and specify the other printer details.
7. Click Add.
  ➔ The selected format and destination are added to the Output Definition list.
8. Click OK.
  ➔ The configured Report Output Definitions display in the Report Output group box and the report is printed in the PDF format on automatic execution.

2.6.2.4 Viewing and Configuring Trended Properties
You can view and configure the trended properties of trended objects that are logged in online as well as offline trends using the Manual Correction application.

Access and View Trend Data
You can access and view the trend data from any of the following:

System Browser
1. In System Browser, select Application View.
3. Drag an offline trend log object or an online trend log object whose property details are to be displayed to the Manual Correction tab.
4. From the Trended Object drop-down list, select the trended object.
5. From the Trended Properties drop-down list, select the corresponding property whose details you want to view.
6. In the Time filter section, specify the time range for which you want to view the details.
  ➔ NOTE: By default, the time range is defined for a 24-hour time period. You can fetch the latest data from the database by modifying the time period in the Time filter.
7. Click Run ➔. The values display in the Filtered Data section.

Related Items
1. In System Browser select the trended object whose property details are to be displayed in the Manual Correction tab.
  ➔ A Manual Correction link displays below the Trends group in the Related Items tab.
  ➔ NOTE: If you select more than one trended object in the System Browser, the Manual Correction link does not display in the Related Items tab.
2. Click the Manual Correction link.
   - The Manual Correction application displays in the Secondary pane and the trended object you selected displays in the Trended Object field in the Object filter section.

3. Select the corresponding property whose details are to be viewed from the Trended Properties drop-down list.

4. Specify the time range for which you want to view the details by specifying the date and time in the Time filter section. By default, the time range is defined for a 24-hour time period. You can fetch the latest data from the database by modifying the time period in the Time filter.

5. Click Run.
   - The date/time, value, unit, and status of the selected trended property displays in the Filtered Data section in a column pattern in a grid.

**Sort Entries**

- Perform any of the following steps to sort the column data:
  - To sort a column data in the ascending order, click the column header.
  - To change the sorting order to descending, click the column header a second time.

- The data displays in the sorted order.

**NOTE:** The values in the Unit column cannot be sorted.

**Apply Filters**

You can apply either custom, selection, or time filter on the trend data.

**Custom filter**

1. Navigate to the Time or Value column to which you want to apply the custom filter.

2. Click the inverted triangle icon and select Custom Filter from the menu options.
   - The Custom Filter dialog box displays.

3. Perform any one of the following steps:
   - To apply the custom filter to the Time column – Select the appropriate operator and the date/time values. You must ensure that the value of the custom filter is within the value range specified in the Time filter section.
   - To apply the custom filter on the Value column – Select the appropriate operator and specify the value in the text field.

4. Click OK.
   - The Filtered Data section refreshes to display the information matching the custom filter criteria.

**Selection filter**

You can apply the Selection filter on the Status column.

1. Navigate to the Status column on which you want to apply the selection filter and click the inverted triangle icon.

2. From the menu options, select the value corresponding to the status on which you want to filter the information and click OK.
   - NOTE: For a quick retrieval of the values in the options list, enter the text that closely matches the required status in the text field. The options list displays the matching value.

- The Filtered Data section displays the information.
Time filter
1. Navigate to the Time column and click the inverted triangle icon.
2. On the menu, position your mouse pointer over Time Filter. A sub-menu with the Hours and Minutes options displays.
3. Depending on the filtering criteria to be applied, perform any of the following steps:
   - To filter data on the basis of number of hours - Position your mouse pointer over the Hours menu and select the relevant option.
   - To filter data on the basis of number of hours - Position your mouse pointer over the Hours menu and then select the relevant option.
   - The Filtered Data section displays the information.

Add New Entries
1. Click Add .
   - NOTE: You can also add a new row by right-clicking on the row and selecting Add Trend Entry from the options.
   - The Add Trend Entry dialog box displays.
2. Complete the Date and Time, Value, and Comment fields.
3. Click OK.
4. Modify the Time filter to a range in which the date and time of the value to be added is present.
5. Click Run .
   - The Filtered Data section refreshes and a new row with the specified values is added to the grid.
   - NOTE: The comments entered are logged in the activity log.

Edit Entries
1. Select the data entry row to be modified in the Filtered Data section and click Edit .
   - The Edit Trend Entry dialog box displays.
2. Modify the value and add comments.
   - NOTE: The comments entered are logged in the activity log.
3. Click OK.
4. Click Run .
   - The Filtered Data section refreshes to display the updated value for the selected row.
   - NOTE: You can also modify a row by right-clicking the row and selecting Edit Trend Entry from the options.

Delete Entries
1. Select the entry to be deleted.
   - NOTE: Multi-select is allowed.
2. Press Delete .
   - The Delete Trend Entry dialog box displays.
3. Enter a comment and click OK.

4. Click Run.
   - The entries are deleted.

### 2.6.2.5 Additional Offline Trend Logs Procedures

Perform the following procedures to work with offline trend log objects.

#### Upload Trend Data from the System Browser

1. In System Browser, select Application View.
2. Select Applications > Trend > Offline Log Objects.
3. Select one or more trend log objects or trend log multiple objects.
   - The trend view displays as follows. The red curve indicates that the offline trend data is not yet updated. The blue curve indicates the online trend data.

   ![Trend Data Graph](image)

   - The properties of the trend log objects or trend log multiple objects display in the Extended Operation tab.

   **NOTE:** If you select more than one object, the properties display only if both are of the same type, that is, either trend log objects or trend log multiple objects.

4. Click the Extended Operation tab.
5. Perform any one of the following steps:
   - To upload the trend data related to all the trend log objects or trend log multiple objects, navigate to the Log Enable property and click Collect.
   - To upload the trend data related to a specific trend log object or trend log multiple object, expand the Log Enable property and click Collect.

   - The offline trend data from the trend log objects or trend log multiple objects is uploaded to the management station. The red curve indicates the updated Offline Trend data. The blue curve indicates the online trend data.
1. In the legend, select one or more trended objects whose associated trend data you want to upload to the management station.

2. Right-click the selected trended object and then select Display Trendlog Object in Contextual pane.

3. Click the Extended Operation tab.

   ✠ The properties of the associated trend log object display.

   NOTE: You can only view the properties of trend log objects that are of the same type. For example, if you have selected two Analog Input objects, that are associated with two individual trend log objects, the properties of the trend log objects display in the Contextual pane. However, if one trended object is associated with a trend log object and another with a trend log multiple object, the properties do not display.

4. Perform any one of the following steps:
To upload the trend data related to all the trend log objects or trend log multiple objects, navigate to the Log Enable property and click Collect. To upload the trend data related to a specific trend log object or trend log multiple object, expand the Log Enable property and click Collect.

The offline trend data from the trend log objects or trend log multiple objects is uploaded to the management station. The red curve indicates the updated Offline Trend data. The blue curve indicates the online trend data.

Create Trend Log Objects in Bulk

- You have configure rights on the BACnet configurator.
- BACnet points to be added to the trend log objects display in Edit mode. For more information, see Adding BACnet points to Edit mode or Trend View.

1. Select one or more points for which you want to create trend log objects.
2. Right-click and select Create Trend.
   - The options to configure trend log objects display. For information on the displayed options, see Edit Mode.
3. Expand the Trend Definitions expander and specify a unique name for the trendlog object.
4. From the Device drop down list, select the device on which the trend log object is to be created. To create a trend log multiple object, select the Create Trendlog Multiple checkbox.
5. Expand the Logging Type expander and specify either of the following values for the Logging Type.
   - Default from Device: The data entry is logged according to the default logging type of the device.
   - Polled: The data entry is polled periodically.
   - Triggered: The data entry is triggered when the trigger property is set to ON.
   - COV: The data entry is captured when the value of the trended property changes.
6. In the Log Interval expander, specify the time interval when the trend samples are to be collected.
7. In the Buffer Size expander specify a size for the buffer in the Buffer Size field. Select the Stop when full check box if you want to stop the collection of trend values in the buffer when the buffer reaches the specified value.

8. Expand the Start/Stop expander and specify the period for which you want to collect trend values by specifying the date and time values.

9. Click Start Creation. The results of the bulk operation display.

10. Click OK.

Assign or Replace a New Trendlog Reference
A new object reference can be added to available offline trendlog objects. In this case, the collected data must first be backed up (uploaded); only then can the new object reference be assigned. Data that is not uploaded in advance can no longer be restored after being assigned anew. This applies to trendlog and trendlog multiple objects.

- The display level for the Record count property is set as this property is not visible in the Extended Operations tab for BACnet trend log objects.
- The Reset command for the Record count property is configured.

1. In System Browser, select Application View.
2. Select Applications > Trends > Offline Log Objects > [network name] > Hardware > [automation station] > [offline trendlog object].
3. Click the Extended Operation tab.
4. Navigate to the Log Enable property and click Collect.
   NOTE: The current offline Trendlog data is uploaded to the management station before you reset the collected data.
5. Click Disable to disable the Log Enable property.
6. Navigate to the Record count property and click Reset.
7. Click the BACnet Editor tab and open the Trended Properties expander.
8. In System Browser, select the Manual navigation check box, and then drag-and-drop the required data point to the Trended Properties expander.
9. Select the property you want to record and click Send.
10. Select Applications > Trends > Offline Log Objects > [network name] > Hardware > [automation station] > [offline trendlog object].
11. Click the Extended Operation tab.
12. Navigate to the Log Enable property and click Enable.
   The Trendlog object is new configured and is ready to collect data.
   NOTE: An entry in the Event list displays if a trendlog object has an invalid address.
   The message can be suppressed by:
   Setting the Log Enable property to Disable.
   Clearing the BACnet reference.

Change Trended Properties of Objects
- You have configure rights on the BACnet configurator.
- BACnet points to be added to the trend log objects display in Edit mode. For more information, see Adding BACnet points to Edit mode or Trend View.
1. Select one or more BACnet points of the same type (for example, all analog input or analog output) for which you want to create trends on the property other than the default.

2. Right-click and select Change Property.
   - The Change Property dialog displays with the list of all the properties that can be trended.

3. Select the desired property and click OK.
   - The objects reflect with the modified property.

Modify Trend Log Objects in Bulk
1. In System Browser, select Application View.
2. Select Applications > Trends > Offline Log Objects.
3. Perform either of the following steps to add the trend log objects to the Edit mode:
   - Select the BACnet trend log objects to be modified and click Edit Trend.
   - Select the BACnet trend log objects to be modified. Then, select New Trend from the Related Items pane to open the Trends application in the Secondary pane. Click Edit Trend.
4. Select the objects to be modified, right-click, and select Modify Trend.
   - The properties of the selected objects display.
5. Perform the required updates to the trend log objects and click Start Modification.
   - The results of the bulk operation display in the Bulk Operation Details window.
   - Click OK.

Delete Trend Log Objects in Bulk
1. In System Browser, select Application View.
2. Select Applications > Trends > Offline Log Objects.
3. Perform either of the following steps to add the trend log objects to the Edit mode:
   - Select the BACnet trend log objects to be modified and click Edit Trend.
   - Select the BACnet trend log objects to be modified. Then, select the New Trend option from the Related Items pane to open the Trends application in the Secondary pane. Click Edit Trend.
4. Select the objects to be deleted, right-click and select Delete Trend.
   - A confirmation message displays.
5. Click OK.
   - The results of the bulk operation display in the Bulk Operation Details window.
6. Click OK.
   - The trend log objects are deleted from System Browser.
Add Points to Trend View or Edit mode

1. In System Browser, select Management View.

2. Navigate to Project > Field Networks > [network].

3. Perform either of the following steps to add the points to the Trend View or in the Edit mode. To add points to the Edit mode, click Edit Trend.
   - Select the Manual navigation check box in the System Browser. Select the BACnet points for which you want to create trend log objects. Drag the selected points to the Trend View or Edit mode.
   - Select the points for which you want to create trend log objects. Select the New Trend option from the Related Items pane to open the Trends application in the Secondary pane.

The BACnet points display in the Trend View or Edit mode.

2.6.2.6 Additional Predicted Trends Procedures

Perform the following procedures to work with predicted trends [→ 309].

Create a Predicted Log Object

▷ You created a trend view definition for a device whose library supports the RegularTimeSeries property. See Create a Trend View Definition.

1. In System Browser, select Application View.

2. Select Applications > Trends > Trend View Definitions > [trend definition].
   - The Trend application displays.

3. In the Operation tab, locate the Time Series Status property. Then drag and drop it to the trend viewer definition.

4. Click Save.
   - For the Time Series Status property, values and time values appear in the graph. Also, if not already present, the regular time series predicted log object is added to System Browser under Applications > Trends > Predicted Log Objects.

Delete Predicted Log Objects

▷ A trend view definition includes a device whose library supports the RegularTimeSeries property.

1. In System Browser, select Application View.

2. Select Applications > Trends > Trend View Definitions > [trend definition].
   - The trend view displays.

3. In the legend, locate the trended object whose trended properties is Time Series Status and click Remove.

4. In the Remote Trend series dialog box, select the check box Stop trending this object of the Management Platform.

5. Click OK.
   - The regular time series predicted log object is removed from System Browser.
2.7 Log Viewer

This section provides instructions for using the Log Viewer of Desigo CC. For background information, see the reference section.

2.7.1 Configuring and Printing the Log View Details

Scenario: You want to configure a log view, print, and save its details.

Reference: For background information, see Log Viewer reference.

Workflow Diagram:

Steps:

1 – Customize a Log View

1. In System Browser, select Application View.

2. Select Applications > Log Viewer. Log Viewer displays with the combined data from the Activity Log and Event Log.

3. To define the log view size proceed as follows:
   a. Navigate to the View Size property in the Extended Operation tab. This property displays the number of records in the log view.
   b. In the Value field, specify a size for the log view. The maximum value is 250,000.
   c. Click the Set button next to the Value field and thereafter click Refresh.

4. To select columns in the log view, proceed as follows:
   a. Click Select Columns: The Select Columns dialog box displays.
   b. In the Available Columns list, select the check box preceding the column names you want displayed.
   c. Click OK.

5. To sort the default displayed log view data further, proceed as follows:
   – To sort a column data in the ascending order, click the column header.
   – To change the sort order to descending, click the column header a second time.
   – To sort the column data for multiple columns, click the column header of the first column, press the CTRL key and click the column headers of subsequent columns.
   – To change the sorting order of a column press the Ctrl key and click the column header. To remove the sorting order and priority of a column, select a column on which sorting is not applied. If you hide a column having a sort
priority, the priority of other sorted columns changes. Additionally, the data in the log view is re-ordered based on the new priority. Re-selecting the hidden column from the Select Columns dialog box does not retain its sort order and priority.

- The data displays in the sorted order and a priority is assigned in case the sorting is applied to more than one columns. When you save the data as a log view definition, the sort criteria is also saved. The next time when you load the log view definition, the data with the saved sort criteria displays.

- The log view is customized as per the specified settings.

2 – Apply Filters

1. In System Browser, select Application View.
2. Select Applications > Log Viewer. Log Viewer displays with the combined data from the Activity Log and Event Log.
3. Apply the following filters according to the type of columns:
   - Non-Date Time Columns [→ 146]
   - Date Time Columns [→ 148]
4. Save the log view definition by clicking Save  
- The log view displays data according to the specified filters.

3 – Refresh the Log View

1. Perform any one of the following steps to manually refresh the data:
   - Click Refresh ː Any result filter on the log view is moved to the search filter.
   - Press F5 on the keyboard.
2. Save the log view definition by clicking Save  
- The result filters applied to the data set are converted to search filters.

4 – Print Log Grid Contents

1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
3. Click Print  
4. In the Print dialog box, select the desired printer and specify the printing configurations.
5. Click Print.
- The Log View details are printed.

NOTE:
The size of the font may vary depending on the number of columns in the log view grid.

2.7.2
2.7.3 Configuring and Printing Detailed Log

Scenario: You want to configure a detailed log and print its details.

Reference: For background information, see Log Viewer reference.

Workflow Diagram:

1. Access and View Data in Detailed Log
2. Configure the Detailed Log Parameters
3. Print Detailed Log Contents

Steps:

1 – Access and View Data in the Detailed Log

- Complete any of the sub-steps to access and view data in the Detailed Log tab by selecting either of the following:
  - (An activity or event type record from the log view) If an activity type record is selected, the latest 100 Activities and Event logs for the selected object display in the Detailed Log tab. If an event type record is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event display in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.
  - (An object from the System Browser) The latest 100 activities and events for that object display in the Detailed Log tab.
  - (An object from any application that supports secondary selection such as Graphics, Trends, Textual Viewer, Reports, or Schedules) The latest 100 Activities and Event Log records for the object display in the Detailed Log tab.
  - (An event from the Event List) The details of the selected event including the different state changes of the event and the user activities performed in context of the event are available in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.
2 – Configure the Detailed Log Parameters
You can configure the information displayed in the Detailed Log tab by selecting the required columns, removing unwanted columns, sorting entries, and condensing the displayed data by applying filters.

1. Select an activity or event type record from the log view, an object from the System Browser or any application supporting secondary selection, or an event from the event list.
   ➤ The data matching your selection displays in the Detailed Log tab.

2. Customize the displayed data as needed by performing the following:
   – Selecting Columns ➤ 145
   – Sorting Entries ➤ 146
   – Applying Filters on DateTime ➤ 156 and Non-DateTime ➤ 154 Columns
   ➤ The Detailed Log tab refreshes and displays data as per your specified parameters.

3 – Print Detailed Log Contents
➤ The Detailed Log displays the details of the activity, event or object to be printed.

1. In the Detailed Log tab toolbar, click Print.
2. In the Print dialog box, select the desired printer and select the printing configurations.
3. Click Print.
   ➤ The Detailed Log contents are printed.
2.7.4 Additional Log Viewer Procedures
Select any of the procedures for additional information on Log Viewer.

2.7.4.1 Managing Log View Definitions and Folders
This section provides information on organizing and working with log view definitions.

Export a Log View Definition
1. In System Browser, select Application View.
2. Select Applications > Log Viewer > [log view definition].
3. Click Export.
   - The Browse for Folder dialog box displays.
4. Browse for the desired location and click OK.
   - A confirmation message displays. The log view definition is exported and saved.

Import a Log View Definition
1. In System Browser, select the destination where you want to import the log view definition.
2. Click Import.
   - The File Open dialog box displays.
3. Browse to the folder where the exported log view definitions are available.
   Select the xml file to be imported and click Open.
   - A confirmation message displays and the log view definition is added.

Create Log View Folders
Log View folders enable you to organize log view definitions.
1. In System Browser, select Application View.
2. Select Applications > Log Viewer.
   - Log Viewer displays.
3. Click New Folder.
4. In the Create New Object dialog box, do the following:
   a. Enter a unique name and description.
   b. Click OK.
   - A new folder is created.

Create a New Log View Definition from an Existing One
➤ You have made modifications to an existing log view definition and want to save it as a new one.
1. Click **Save As**.

2. In the **Save Object As** dialog box, do the following:
   a. Select the destination folder for saving the new log view definition.
   b. Enter a name and description.
   c. Click **OK**.

   ☑️ The new log view definition is saved.

   **NOTE:** You cannot save a result filter condition. In order to save the filter condition, you must move the result filter to a search filter and save the configuration as a log view definition.

### Save a Log View Definition as a Report Definition

▷ Log data displays in the **Log Viewer** or the **Detailed Log** tab.

1. *(Optional)* Perform any required configurations such as applying search filters, selecting columns, and applying sorting.

2. Click **Save as Report Definition**.

3. In the **Save Object As** dialog box, do the following:
   a. Select the **Reports** folder for saving the new Report Definition.
   b. Enter a name and description.
   c. Click **OK**.

   ☑️ A report definition is created and displays. This report definition contains the **All Logs** table. All configurations applied on the log view definition such as selected columns, order of columns, sorting on columns, and the search filters are present in the **All Logs** table in the report definition.

### Delete a Log View Definition

▷ At least one log view definition is available in System Browser.

1. In System Browser, select **Application View**.

2. Select **Applications > Log Viewer > [log view definition]**.

3. Click **Delete**.

   ☑️ A confirmation message displays.

4. Click **OK**.

   ☑️ The log view definition is deleted.

### Create a Default Log View Template

A default log view template enables you to create a customized template with a specific set of columns, their position, and size. The template also contains sorting applied to the column data. Any new log view definition is always based on the default template.

There can only be one default template. You can create a new template or use the one provided by the system. When you create a new template, the existing default template is overwritten. The default template in a distributed environment is system specific. So, if there are three systems configured for a distributed environment, each system will have its own default template.

▷ Log data displays in the **Log Viewer** or the **Detailed Log** tab.
1. *(Optional)* Configure the log view by selecting, reordering, or resizing the columns. You can also apply sorting on the displayed data.

2. Click **Save as Default**.
   - A message box displays.

3. Click **Yes**.
   - The log view is saved as a default template.

**NOTE:**
View-specific columns in the log view template display in red color, if the view is deleted. You can get the details of the invalid columns by double-clicking the header text. The information displays in the **Log View Validation** message box.

If a saved log view definition contains view specific columns from a deleted view, the **Log View Validation** message box displays with details of the invalid columns when selecting the log view definition.

### 2.7.4.2 Configuring Log View Parameters

You can configure a log view definition by defining the size of the log view, specifying the columns to be displayed, applying filters on the displayed data, sorting log entries, and so on.

**Define the Log View Size**

You can define a size for the log view to display a specific number of records. This view size is system specific in a distributed environment. If there are three systems configured for a distributed environment, each system will have its own view size.

1. In System Browser, select **Application View**.
2. Select **Applications > Log Viewer**.
3. Click the **Extended Operation** tab.
   - The number of records in the log view displays in **View Size**.
4. In the **Value** field, specify a size for the log view. The maximum value is 250,000.
5. Click the **Set** button next to the **Value** field.
6. Click **Refresh**.
   - The log view refreshes.

**NOTE:** A large view size will slow down the process. In order to view and print a large amount of data, you must export the log view definition to Reports.

**Select Columns**

1. Click **Select Columns**.
   - The **Select Columns** dialog box displays. In the **Available Columns** list, the default columns are selected. These columns also display in the **Selected Columns** list of the dialog box. These columns represent the columns of the log view definition.
2. In the **Available Columns** list, select the check box preceding the column names you want displayed.
   - The **Selected Columns** list box is updated.
3. Click **OK**.
   - The log view definition is updated.
NOTE: For each view present in the system, you can add the view-specific columns (Object Location and Object Designation) to a log view from the Select Columns dialog box. If you run the log view definition from the Secondary pane and activities such as renaming a view are done in the Primary pane, the effect of these changes reflect in the log view definition only after you click Refresh.

Sort Log Entries
- You want to sort the log data that is displaying in the log view or the Detailed Log tab.
  - Use any of the following to sort the data. By default, the displayed data is sorted on the basis of the latest date and time.
    - To sort a column data in the ascending order, click the column header.
    - To change the sort order to descending, click the column header a second time.
    - To change the sort order of a column press the CTRL key and click the column header.
    - To remove the sorting order and priority of a column, select a column on which sorting is not applied.
    - To sort the column data for multiple columns, click the column header of the first column, press the CTRL key and click the column headers of subsequent columns.
    - If you hide a column having a sort priority, the priority of other sorted columns changes. Additionally, the data in the log view is re-ordered based on the new priority. Re-selecting the hidden column from the Select Columns dialog box does not retain its sort order and priority.
  - The data displays in the sorted order and a priority is assigned in case the sorting is applied to more than one columns.

Apply Filters on Non-DateTime Columns
You can apply a result filter on the data set displayed in a log view or in the Detailed Log tab using any of the following techniques. On applying a result filter on a column, a filter icon displays in the column header indicating that a filter is applied on the column.

Custom Filter
1. Right-click the data value for which you want to apply the filter.
2. Select Custom Filter.
   - The Custom Filter Dialog Box displays. If you are applying the filter on columns of the detailed log tab, the Search Filter tab is not available.
3. Click the Result Filter tab.
4. Click the Add Filter button.
   - An empty row with the Operator and Value fields displays.
5. Specify the operator by selecting values from the Operator and Value drop-down list.
   - The filter expression displays in the Filter Expression field.
6. Click OK.
   - The result filter is applied to the data set.

Quick Filter
1. Right-click the data value for which you want to apply the filter.
2. Select the Filter By option.
   - The last three filters applied on a column are listed as menu options.
3. Select any of the options on which you want to filter the data.
   - The data is filtered according to the selected option.

Selection Filter
The Selection filter is applicable for filtering ENUM type of data. See List of ENUM columns section in custom filter for a list of columns of type ENUM. Perform the following steps to apply the Selection filter:
1. Click the inverted arrow on any column displaying ENUM data.
   - The list of data entries for the column display as menu items.
2. Select the checkbox pertaining to the entry on which you want to apply the filter.
   **NOTE:** For faster retrieval of the data entries, you can type the value of the entry to be retrieved in the text box above the Selection filter.

3. Click **OK**.
   - The view displays the data filtered on the basis of the selected entry. If you select more than one data entry, the system displays the data matching either of the selected entries.

**Drag-and-Drop**
The drag-and-drop option is available only for filtering data displayed in a log view. This option is not available when you are applying filters on the data displayed in the Detailed Log tab.
- From System Browser, drag-and-drop an object that you want to set as a filter to the log view. You can also drag-and-drop multiple objects from System Browser. For this, ensure that the *Manual navigation* option in System Browser is checked.
- The log view displays the entries corresponding to the object. In case of multiple selection, the data matching either of the selected objects displays.

**NOTE:**
If you apply a result filter on a column with an existing result filter, the new filter condition replaces the older condition.

**Apply Filters on DateTime Columns**
You can apply a result filter on the columns displaying date/time data using any of the following techniques:

**Custom Filter**
1. Position your cursor over a column with date-time data, such as Date/Time.
2. Right-click and select **Custom Filter**.
   - The *Time Filter* dialog box displays. If you are applying the filter on columns of the Detailed Log tab, the Search Filter tab is not available.
3. Click the Result Filter tab.

4. Specify the appropriate date/time values in the Exact, Custom, or Relative options.
   
   **NOTE:** By default, the Unlimited option is selected in the Time Filter dialog box. If you want to view records having NULL as the value, select the Null option.

   A preview of the date/time values you specified displays in the Preview of Resulting Time Range section.

5. Click OK.
   
   The log view refreshes automatically and the data corresponding to the specified date time values displays.

   **NOTE:** If you specify a date in the Exact option, the data corresponding only to the specified date displays.

**Date Filters**

Perform the following steps to retrieve the data for the required time period. Using the Date Filters option, you can retrieve data for the current day, previous day, current week, previous week, current month, previous month, current year, or previous year.
1. Click the drop-down arrow on any column displaying date/time data, for example, Date/Time. A list of menu options displays.

2. Position your mouse pointer over Date Filters. A list of options to filter the data on the basis of the current day (Today), previous day (Yesterday), current week (This Week), previous week (Last Week), current month (This Month), previous month (Last Month), current year (This Year), or previous year (Last Year) displays.

3. Select the required option.
   - The view refreshes and displays the data according to the selected time option.

Quick Filter
Perform the following step to apply a quick filter:
- Right-click the data entry corresponding to the date time value for which you want to apply the filter and select Filter By.
- The log view refreshes and displays the entries corresponding to the selected date.

NOTE:
The last three filters applied on a column are listed as menu options that display when you right-click a data value. You can also apply a quick filter by selecting any of these options.

Apply Search Filters on Columns other than Date/Time

- Log data displays in the Log Viewer or the Detailed Log tab.

1. Right-click the data value for which you want to apply the filter.

2. From the menu options, select Custom Filter.
   - The Custom Filter Dialog Box displays.

3. Click the Search Filter tab.

4. Click the Add Filter button.
   - An empty row with the Operator and Value fields displays.

5. Select a value from the Operator drop down list. In order to specify the value, you must either select a value from the Value drop down list or type a value in the field.
   - The filter expression displays in the Filter expression field.

6. Click OK.
   - The data matching your filter condition is retrieved from the server.

Apply Search Filters on Date/Time Columns

- Log data displays in the Log Viewer or the Detailed Log tab.

1. Position your cursor over a column with date-time data, such as Date/Time.

2. Right-click and select Custom Filter.
   - The Time Filter dialog box displays.

3. Click the Search Filter tab.
4. Enter the appropriate date/time values in the Exact, Custom, or Relative options.
   
   **NOTE:** By default, the Unlimited option is selected in the Time Filter dialog box. If you want to view records having NULL as the value, select the Null option.
   
   ➤ A preview of the date/time values you specified displays in the Preview of Resulting Time Range section.

5. Click OK.

6. The log view refreshes and the data corresponding to the specified date time values displays.

**Modify Search/Result Filters on Columns other than Date/Time**

➤ Log data displays in the Log Viewer or the Detailed Log tab.
➤ You have applied a search/result filter to the log data.

1. Right-click the data value in the column of the filter to be modified and select Custom Filter.
   
   ➤ The Custom Filter dialog box displays.

2. Click the Search or Result Filter tab, depending on the filter that you want to modify.

3. Modify the filter condition.

4. Click OK.
   
   ➤ The view refreshes and the data matching the modified filter displays.

**Modify Search/Result Filters on Date/Time Columns**

➤ Log data displays in the Log Viewer or the Detailed Log tab.
➤ You have applied a search/result filter to a column displaying date time data.

1. Right-click the data value in the column pertaining to the filter to be modified and select Custom Filter.
   
   ➤ The Time Filter dialog box displays.

2. Click the Search or Result Filter tab, depending on the filter that you want to modify.

3. Modify the filter condition.

4. Click OK.
   
   ➤ The view refreshes and the data matching the modified filter displays.

**Delete Search Filters on Columns other than Date/Time**

➤ Log data displays in the Log Viewer or the Detailed Log tab.
➤ You have applied a search filter to the log data.

1. Right-click the data value in the column pertaining to the search filter to be deleted.

2. Select Custom Filter.
   
   ➤ The Custom Filter dialog box displays.

3. Click the Search Filter tab.

4. Select the check box preceding the Operator and Value fields corresponding to the search filter expression to be deleted.
5. Click **Remove Filter**.
6. Click **OK**.
   ⇢ The log view refreshes and displays all the data from the database.

### Delete Search Filters on Date/Time Columns

- Log data displays in the **Log Viewer** or the **Detailed Log** tab.
- You have applied a search filter to a column displaying date time data.

1. Right-click the data value in the column pertaining to the filter to be modified.
2. Select **Custom Filter**.
   ⇢ The **Time Filter** dialog box displays.
3. Click the **Search Filter** tab.
4. Select **Unlimited**.
5. Click **OK**.
   ⇢ The view refreshes.

### Delete Result Filters

You can delete a result filter for a column displaying date/time or non date/time values by performing any of the following:

- Click **Remove All Result Filters**.
- Click the drop-down arrow on the column header with a result filter applied and click **Remove Result Filter**.
- Right-click the column entry on which the filter is applied, and select **Remove Result Filter** from the menu options.
- Remove the selection on the checkbox for the entry on which the filter is applied and click **OK**.
- For columns displaying values other than date/time: From the **Custom Filter** dialog box, click **Remove Filter**.
  NOTE: In order to make the **Remove Filter** button available, you must select the check box preceding the **Operator** and **Value** fields corresponding to the result filter expression you want to delete.

### Move Result Filters to Search Filters

A search filter obtains the data matching your filter expression from the database, whereas a result filter filters the data matching the filter expression from the data displayed in the log view.

For example, assume you apply a result filter on the data displayed in the log view to retrieve all records with action as primary authentication. The records with action as primary authentication display. However, there are more records with action as primary authentication in the database than what displays in the log view. This is indicated by the following message: **Configured View Size reached! Refine search via Search Filter**. In this case, you must move your result filter to a search filter to obtain all the matching data from the database.

- You have applied a result filter on the data displayed in the log view.

1. Perform any of the following steps to move the result filter to a search filter.
   a. Click **Refresh**.
   b. Click the **Move to Search Filter** button in the **Custom Filter** dialog box for the column on which the result filter is applied and click **OK**.
   ⇢ The result filter is moved to a search filter and the data matching the filter condition is retrieved from the database.
NOTE: When you move a result filter on a column to a search filter, any existing search filter present on the same column is replaced.

**Revert to Saved Search Filters**

The Revert to Saved Search Filter function enables you to obtain the data provided by a previously defined search filter that is now being overwritten by a newly applied filter. For example, assume you apply a result filter on the log view to display all records of type Activity. The filter is moved to a Search filter in order to save it. You have now applied a new result filter to obtain data having Source Description as Users and have moved this to a search filter. So, the existing search filter is now replaced with the following new filter (Record Type = "Activity" AND Source Description = "USERS"). However, you want to retrieve the previously saved search filter (Record Type = "Activity").

1. Apply a result filter on any column. For example, Record Type = Activity.
   - The applied filter displays in the Filters area below the log view and the log view refreshes to display all records with Record Type as Activity.

2. Move the result filter to a search filter in order to save the filter condition.
   - The result filter is moved to a search filter and displays in the Filters area.
   - Save is enabled.

3. Save the information as a log view definition.
   - The saved log view definition is reloaded and the data matching the filter expression displays.

4. Apply a new result filter on any column. For example, Source Description is = Users.
   - The applied filter displays in the Filters area below the log view and the log view refreshes to display all records with Source Description as Users.

5. Move the result filter to a search filter.
   - The search filter is now modified and displays as follows in the Filters area.
     - (Record Type = "Activity" AND Source Description = "USERS"). Revert to Saved Search Filters is now activated.

6. Click Revert to Saved Search Filters.
   - The view refreshes and displays the data according to the previously defined search filter (Record Type = "Activity"). The filter condition is also updated in the Filters area.

**Apply Search Filters on Columns Not Present in the Log View**

Log data displays in the Log Viewer or the Detailed Log tab.

1. Click Search Filter.
   - The Search Filter dialog box displays.

2. Select a column from the Available Columns list.
   - The operators and values associated with the selected column display in the Operators and Values list.

3. Select the required operator and value from the respective lists. If values are not displayed for the selected column, type in the value.

4. Click Add.
   - The filter expression displays in the Filter Expression field.
5. Click OK.
   ➤ The log view refreshes.

Modify Search Filters on Columns Not Present in the Log View

➤ Log data displays in the Log Viewer or the Detailed Log tab.
➤ You have applied a search filter to a log view definition.

1. Click Search Filter.
   ➤ The Search Filter dialog box displays with the filter expression in the Filter Expression field.

2. Click the filter expression.
   ➤ The column, operator, and value of the condition filter expression display in their respective lists.

3. Modify the search filter expression as required.

4. Click Update.
   ➤ The updated filter expression displays in the Filter Expression field.

5. Click OK.
   ➤ The log view refreshes displaying the updated data according to the modified filter expression.

**NOTE:**
If you want to modify the search filter in a log view definition that is configured in a different language from your logged in language, you must change the filter language in the Configuration dialog box. This dialog box is accessed by clicking Configuration.

Delete Search Filters on Columns Not Present in the Log View

➤ Log data displays in the Log Viewer or the Detailed Log tab.
➤ You have applied a condition filter to a log view definition.

1. Click Search Filter.
   ➤ The Search Filter dialog box displays.

2. Delete the search filter expression from the Filter Expression field.

3. Click OK.
   ➤ The log view refreshes displaying the latest data.

2.7.4.3 Applying Filters on the Detailed Log Tab

In the Detailed Log tab, you can apply filters on date time as well as non date time columns.

Apply Filters on Non-DateTime Columns

You can apply a result filter on the data set displayed in the Detailed Log tab using any of the following techniques. When you apply a Result Filter on a column, a filter icon displays in the column header indicating that a filter is applied on the column.

Custom Filter
1. Right-click the data value for which you want to apply the filter.
2. Select **Custom Filter**.
   - The **Custom Filter Dialog Box** displays.
3. Click the **Result Filter** tab.
4. Click the **Add Filter** button.
   - An empty row with the **Operator** and **Value** fields displays.
5. Specify the operator by selecting values from the **Operator** and **Value** drop-down list.
   - The filter expression displays in the **Filter Expression** field.
6. Click **OK**.
   - The result filter is applied to the data set.

**Quick Filter**
1. Right-click the data value for which you want to apply the filter.
2. Select the **Filter By** option.
   - The last three filters applied on a column are listed as menu options that display when you right-click a data value. You can also apply a quick filter by selecting any of these options.

**Selection Filter**
The selection filter is applicable for filtering ENUM type of data. See **List of ENUM columns** section in Custom Filter [317] for a list of columns of type ENUM. Perform the following steps to apply the selection filter:
1. Click the inverted arrow on any column displaying ENUM data.
   - The list of data entries for the column display as menu items.
2. Select the checkbox pertaining to the entry on which you want to apply the filter.
   **NOTE:** For faster retrieval of the data entries, you can type the value of the entry to be retrieved in the text box above the selection filter.

3. Click **OK**.
   - The view displays the data filtered on the basis of the selected entry.
   **NOTE:** If you select more than one data entry, the system displays the data matching either of the selected entries.

---

**NOTE:**
If you apply a result filter on a column with an existing result filter, the new filter condition replaces the older condition.

---

### Apply Filters on DateTime Columns

You can apply a result filter on the columns displaying date/time data using any of the following techniques:

- Custom Filter
- Date Filters
- Quick Filter

#### Custom Filter

1. Position your cursor over a column with date-time data, such as Date/Time.

2. Right-click and select **Custom Filter**.
   - The **Time Filter** dialog box displays.
3. Click the **Result Filter** tab.

4. Specify the appropriate date/time values in the **Exact**, **Custom**, or **Relative** options.
   
   **NOTE:** By default, the **Unlimited** option is selected in the **Time Filter** dialog box. If you want to view records having NULL as the value, select the **Null** option.

   A preview of the date/time values you specified displays in the **Preview of Resulting Time Range** section.

5. Click OK.

   The **Detailed Log** refreshes automatically and the data corresponding to the specified date time values displays.

   **NOTE:** If you specify a date in the **Exact** option, the data corresponding only to the specified date displays.

**Date Filters**

Using the **Date Filters** option, you can retrieve data for the current day, previous day, current week, previous week, current month, previous month, current year, or previous year. Perform the following steps to retrieve the data for the required time period.
1. Click the drop-down arrow on any column displaying date/time data, for example, Date/Time. A list of menu options displays.

2. Position your mouse pointer over Date Filters. A list of options to filter the data on the basis of the current day (Today), previous day (Yesterday), current week (This Week), previous week (Last Week), current month (This Month), previous month (Last Month), current year (This Year), or previous year (Last Year) displays.

3. Select the required option. The Detailed Log refreshes and displays the data according to the selected time option.

Quick Filter
Perform the following step to apply a quick filter:
Right-click the data entry corresponding to the date time value for which you want to apply the filter and select Filter By. The Detailed Log refreshes and displays the entries corresponding to the selected date.

NOTE:
The last three filters applied on a column are listed as menu options that display when you right-click a data value. You can also apply a quick filter by selecting any of these options.

2.8 Address Book
This section provides instructions for common tasks related to the Desigo CC address book. For background information, see the reference [➙ 326] section.

Prerequisites:
● System Browser is in Application View.

View the Address Book
1. In System Browser, select Applications > Address Book.
   ➔ The Address Book workspace displays a list of contacts.
2. To view the details of a contact, select the contact in the list.
   ➔ The Details expander displays all the information for that contact. For more details, see Details of an Address Book Contact [➙ 328].
3. To search for a contact enter a string in the search field. For more details, see Address Book Search Field [➙ 327].

Create a New Contact
1. In the Address Book workspace, click Add recipient .
   ➔ A new contact is added to the list.
2. Select the newly-created contact.
   ➔ The Details expander displays fields for entering the contact’s information.
3. In the General expander, enter contact’s full name in the Full Name field (for example, John Doe). This value has to be unique.
4. (Optional) Specify the following settings:
   - Short Name
   - Language
   - Time Offset
5. Click Save.
   - The contact is added to the list. You can now configure the contact to receive reports or remote notifications, as needed.

Configure a Contact to Receive Reports
Reports are sent by email and addressed to individual contacts. To be able to receive a report, a contact must have at least an email address configured.

1. In the Address Book workspace, select the contact in the list.
   - The Details expander displays the contact’s information.
2. In the Devices expander, enter the contact’s full email address in the Email1 field.
3. (Optional) If you have other email addresses for that contact, you can enter them in the Email2 and Email3 fields.
   - NOTE: When you email a report, you will be able to choose from all the configured email addresses for that contact.
4. Click Save.
   - The contact’s email addresses are updated.

Configure a Contact to Receive Remote Notifications
Remote notifications can be sent by multiple methods, such as email and SMS, and are addressed to groups, not to individual contacts. To be able to receive a remote notification, a contact must be assigned to a group and have one or more valid devices configured. You can also set a preferred and fallback method.

1. In the Address Book workspace, select the contact in the list.
   - The Details expander displays the contact’s information.
2. In the Groups expander, do one of the following:
   - Select the name of an existing group from the drop-down list.
   - Enter the name of a new group you want to create directly into the empty drop-down list field.
3. Click Add.
   - The name of the group is added to the Groups box for this contact.
   - NOTE: To remove a group select it in the box and click Remove.
4. In the Devices expander, enter the methods for notifying this recipient. For example:
   - Enter the contact’s email address in the Email1 field.
   - Enter the contact’s mobile phone number in the SMS1 field.
5. In the Preferred Device expander, select which method to try first, and which to use as fallback. For example:
   - In the Preferred device drop-down list, select Email1.
   - In the Fallback device drop-down list, select SMS1.
   - NOTE: With this setting, when the system attempts to send out notifications to the contact, it will try sending an email first. If that fails, it will try sending an SMS.
6. Click Save.
   - The contact will receive remote notifications addressed any of the listed groups.
   - Any newly created groups also become available for assigning to other contacts.
Import Outlook Contacts into the Address Book

You have a CSV file containing the contacts exported from Microsoft Outlook, which meets the requirements set out in Outlook Import Rules for the Address Book [➙ 329].

1. Copy the CSV file to removable storage or to a location you can access from the Desigo CC computer.

2. In System Browser, select Application View.

3. Select Applications > Address Book.
   ❯ The Address Book workspace displays.

4. Click Import address book.

5. In the Open dialog box, browse for and select the CSV contacts file that you want to import.

6. Click Open.
   ❯ When the import procedure is complete, a message box informs you of how many new contacts were created, how many existing ones were updated, and how many were skipped owing to importing rules.

7. Click OK.
   ❯ The imported contacts are available in the Address Book workspace.

2.9 Remote Notifications

This section provides instructions for common tasks related to remote notifications in Desigo CC. For background information, see the reference section.

Prerequisites:
- System Manager is in Operating mode and System Browser is in Application View.

Send a ‘New’ (Operator-Issued) Remote Notification

You want to quickly alert all the facility operators of an event that has occurred, but no alarm-triggered remote notification was configured for that event. In this example you will directly send a notification to the recipients in the Operators group.

For background information, see New Remote Notification in the Secondary Pane [➙ 338].

- An Operators recipient group was created in the Desigo CC address book. See Configure a Contact to Receive Remote Notifications [➙ 159].
- The communication services used by the recipients in the Operators group (in this example, email and SMS) are configured.
- System Manager is in a layout that includes the Contextual pane, and the Primary pane is unlocked.

1. In Related Items, click New Remote Notification (icon or link).

2. In the Address Book area, in the Filter drop-down list, select Groups.

3. Drag-and-drop the Operators group from the Address Book area to the Recipient/Members list on the left.
   ❯ TheOperators group is added to the Recipient/Members list, with the total number of contacts in that group.

4. Compose the notification messages for email and SMS as follows:
   a. In the Device drop-down list, select E-Mail. Drag-and-drop any automatic
tags you want to use from the Message Tags list into the Subject and Body fields. You can also directly enter text. The subject line cannot be empty.

b. In the Device drop-down list, select SMS. Drag-and-drop any automatic tags you want to use from the Message Tags list into the Body field. You can also directly enter text. The maximum message length is 480 characters (divided into three messages). Longer text messages will be cut off.

5. Click Send this message.

6. The message is sent immediately and the user interface in the Secondary pane switches to the Message Status list, from where you can monitor the progress of the remote notification, and see its outcome.

7. If you want to compose another notification, click Back to configuration.

8. From here you can edit the previously sent notification, or click Clear all message data to reset all the fields and start over.

Monitor the Progress and Outcomes of Sent Notifications
You want to check the outcome of a previously-sent remote notification. The system provides a Message Status list (see Remote Notifications Message Status List) where you can review all the remote notifications sent out (whether alarm-triggered or operator-issued), and check on the progress, details, and outcome of each one.

1. In System Browser, select Applications > Remote Notifications.

   The RENO Messages tab displays. The Message Status list shows a list of all the notifications (alarm-triggered or operator-issued) that have been sent out from Desigo CC.

   NOTE: If no remote notifications have been sent out, the RENO Messages tab does not display.

2. Each notification displays on a separate (expandable) row. The topmost row shows a compact notification summary with the most important information about the notification, and an indication of its overall outcome. For example, Failed, Completed, Partially Failed, No Response.

3. Click alongside a notification to expand it and display further details about it:
   – Procedure data summary (only for alarm-triggered notifications): provides more information about the event that triggered the notification.
   – Recipients summary: lists the [recipient groups] of the notification. Alongside each group is a Status that indicates the progress/outcome of notifying that group.

4. Expand a recipient group to see more details (how many group members have responded so far, whether the group timeout is expired, and so on), the list of individual contacts in that group, and its escalation list (if configured). Alongside each contact is a Status that indicates the progress/outcome of notifying that person.

5. Expand an individual contact to see the person’s preferred and fallback devices (for example, an email address, or a mobile phone number).
   – Select a device to see the text of the notification message sent to that contact in the Message panel on the right.
Re-Send a Remote Notification from the Message Status List
You want to re-send a remote notification that was previously not completed successfully. For example, its overall outcome was Failed or Aborted. For more details, see Remote Notifications Message Status List [331].

1. In System Browser, select Applications > Remote Notifications.
   ✪ The RENO Messages tab displays. The Message Status list shows a list of all the notifications (alarm-triggered or operator-issued) that have been sent out from Desigo CC.
   NOTE: If no remote notifications have been sent out, the RENO Messages tab does not display.

2. In the Message Status list, select the remote notification that you want to re-send. (For example, test – Alarm ID:29 – Automatic).

3. Click Start RENO procedure ✪ .
   ✪ The system starts re-sending the notification. While sending is in progress, the icon is dimmed.

Start a Remote Notification from Event List
An event has occurred that triggered an alarm-triggered remote notification. The notification has Starting Mode = Manual, which means operator intervention is required for the system to start sending out the preconfigured messages.

1. In Event List, select the event that triggered the notification.

2. Click Start Remote Notifications ✅ for the event.
   ✪ The system starts sending the notification messages preconfigured for this event. The command to stop remote notifications ✅ is available for the event.

Stop a Remote Notification from Event List
Sending of a remote notification is in progress. The notification was configured with Starting Mode = Manual and Can be stopped = Yes. You now want to interrupt (halt) sending of the messages.

1. In Event List, click Stop Remote Notifications ✅ for the event.
   ✪ The system stops sending the notification messages preconfigured for this event. The command to start remote notifications ✅ is available for the event.
Stop a Remote Notification from the Message Status List

You want to interrupt sending of a remote notification that is currently in progress.

1. In the Message Status list, select the remote notification that is currently being sent (its overall outcome will display as Running).

2. Click Stop RENO procedure.

Halt the Escalation of a Remote Notification

Sending of a remote notification is in progress. You want to halt its escalation, so that the message is not sent to the escalation recipients.

1. In the Message Status list, select the remote notification that is currently being sent (its overall outcome will display as Running).

2. Click to view the details of the notification.

3. Expand Recipients to see the groups to which that notification is addressed.

4. Select the group for which you want to stop the escalation.

5. Click Stop RENO procedure escalation.

6. Repeat Steps 4 and 5 above for any other recipient groups of the notification.

2.10 Logics

This section provides instructions for working with the automation logic features of Desigo CC. For background information see the reference section.

2.10.1 Macros

This section provides instructions for common tasks related to the Desigo CC macros.

2.10.1.1 Browsing Existing Macros in the System

1. In System Browser, select Application View.

2. Select Applications > Logics > Macros.

   The macros configured in the system display in the Macros folder, and may be further organized into subfolders under it.
3. To examine a particular macro, select it in System Browser. Properties and commands for the selected macro display in the Operation tab.

2.10.1.2 Manually Executing the Project Backup Macro
You can make a backup of the project database using the predefined system macro provided for this purpose.

1. In System Browser, select Application View.
2. Select Applications > Logics > Macros > Backups > Backup Online.
3. In the Operation tab, click Execute.

The system begins backing up the project database. The default backup location is C:\GMSBackups.

2.10.1.3 Broadcasting the Same Command to all Devices on a Network
Block command macros let you simultaneously send the same command to all the devices on a specified BACnet network.

Block commands are enabled for the network in question.
1. In System Browser, select Application View.

2. Expand Applications > Logics > Macros > Block Command Macros.

   The available block command macros display underneath. The naming pattern is BLOCK_[COMMAND]_[network name]. For example, BLOCK_ACK_network1.

3. Select the block command macro you want to use.

4. In the Operation tab, click Execute.

   The command is broadcast to all the devices on the network. For example, BLOCK_ACK_network1 acknowledges all devices on network1.
2.11 Documents

This section provides instructions for viewing documents, files, web links and other resources in Desigo CC. For background information see the reference [➔ 339] section.

2.11.1 Documents

This section provides instructions for viewing relevant documents or web links in Desigo CC.

View all the Documents Configured in the System

1. In System Browser, select Application View.
2. Select Applications > Documents.
   - The document objects configured in the system display under the Documents folder. They may be further organized into subfolders.
3. To view one of the documents, select it in System Browser.
   - The contents of the document display. If the document is a PDF file allows zooming in, zooming out, and printing the document.

View a Document from Related Items

▷ You selected a system object, and the Related Items tab displays links to one or more documents related to that object.
1. In the Related Items tab, click the document you want to open.
   - The contents of the selected document display (by default) in the Secondary pane. If the Primary pane pushpin is locked —, the document displays in the Primary pane instead.
2. If there are multiple documents to consult in the Related Items tab, you can look through them using:
   - Backward or Forward.
   - The keyboard shortcuts ALT + P (previous related item) and ALT + N (next related item).

2.12 Other Applications

This section provides instructions for operating the other applications in Desigo CC. For background information see the reference [➔ 340] section.

2.12.1 Web Applications

For background information, see the reference [➔ 340] section.

2.12.1.1 Setting and Clearing Credentials

To execute (automatically or manually) and download an external web application fixed link report you must first set the relevant fixed link to be executed with user credentials.

Set User Credentials for Executing a Fixed Link

▷ System Manager is in Operating mode.
▷ You created fixed links for an external web application.
1. In System Browser, select **Application View**.
2. Select **Applications > Links > [fixed link]**.
   - The **Application Viewer** tab displays.
3. Click **Set credentials**.
4. In the **Web Viewer** dialog box, enter your user name and password.
5. Click **OK**.

**Clear Credentials for a Fixed Link**

▷ System Manager is in **Operating** mode.
▷ You set the execution credentials for an external web application fixed link and now you want to restore the default settings (no user credentials).

1. In System Browser, select **Application View**.
2. Select **Applications > Links > [fixed link]**.
   - The **Application Viewer** tab displays.
3. Click **Remove credentials**.

### 2.12.1.2 Displaying and Opening a Web Application

**Display Web Applications in the Application Viewer**

▷ System Manager is in **Operating** mode.
▷ A system object was configured to display some associated external web applications when selected.

1. In System Browser, select the system object whose external web applications you want to display (for example, Field Networks).
   - The **Application Viewer** tab displays. It may show the associated external web application or the list of the external web applications available for the selected object.
2. (Optional) If the **Application Viewer** tab displays the list of external web applications assigned to the selected object, you may want to navigate through them as follows:
   - Click the name of the desired external web application.
   - The corresponding external web application displays.
3. Click **Show** and select another application.
   - The corresponding external web application displays.

**Open a Web Application from Related Items**

▷ System Manager is in **Operating** mode.

1. In System Browser, select a system object that has an external web application associated.
   - In the **Related Items** tab, the **Web Apps** section contains any display rules of the matching external web applications for that object.
2. Click a display rule related item.
   - The corresponding external web application displays (by default) in the **Secondary** pane. If the **Primary** pane pushpin is locked, the external web application displays in the **Primary** pane instead.
2.12.1.3 Managing Fixed Links

Create a Fixed Link for a Web Application

- System Manager is in Operating mode.
- The Application Viewer tab displays the external web application for the system object selected in System Browser.
- You created one or more Links subfolders.
- You want to create a favorite fixed link to quick access this external web application.

1. Click Save As.

2. In the Save Object As dialog box, select a Links subfolder as the destination where you want to save the new external web application fixed link.
   a. Enter a name and description.
   b. Click OK.

   The fixed link object is added to System Browser.

Modify the Settings of a Web Application Fixed Link

- System Manager is in Operating mode.
- You created a fixed link for an external web application.

1. In System Browser, select Application View.

2. Select Applications > Links > [Links folder] > [fixed link].

3. Select the Extended Operation tab.

4. For each of the available parameters modify the corresponding value and click Change. For example:
   - P1 Value: Corresponds to the first parameter in the Rule Editor Output expander (for example, Report Template Value for Advanced Reporting).
   - P2 Value: Corresponds to the second parameter in the Rule Editor Output expander (for example, Format for Advanced Reporting).
   - ...
   - P10 Value

Configure Email Settings for a Fixed Link Report

You want to create an email template for a fixed link.

- You have created a Web Rule and a fixed link for any Advanced, Energy, or Pharma reports.
- You have set the User Credentials. See Related Topics for more information.
- You have configured SMTP for remote notification.
- You have a populated Address Book with email addresses and configured notifications.
- System Manager is in Operating mode.

1. In System Browser, select Application View.

2. Select Applications > Links > [fixed link] for which you want to configure the email settings.

3. From the Application Viewer toolbar, click Email Settings.
   - The Email Settings dialog box displays.

4. To add the recipients' names, in the Address Book section, do one of the following:
– In the drop-down list, select **People** or **Group**. A list of individuals or groups displays.
– Type the name or the group you want to add. The specified individual or group displays.
  **NOTE:** When you press **ENTER**, the query is temporarily saved in the drop-down list.

5. From the list of individuals or groups, use the > and < arrows to add or remove names or groups to and from the **Recipients** section.

6. In the **Subject** field, type a subject for the email, or, leave the default text.

7. In the **Body** field, type a message you want to appear in the body of the email, or, leave the default text.

8. Click **Save**.

9. To create a program or script to send an email at a scheduled time, see the **Related Topics** section.

**Related Topics**
For a related workflow, see Generating Email Attachments for Fixed Link Reports

### 2.12.2 Validation
This section provides step-by-step instructions for Validation tasks. For background information, see the reference [347] section.

#### 2.12.2.1 Completing the Validation Dialog When Four Eyes Is Enabled

- Four Eyes authentication is enabled.
- You have made changes to a validated object, and the **Validation Required** dialog box displays.
  - Do one of the following:
    - For objects with a validation profile of **Monitored**, have a supervisor with privileges enter his or her user name and password. Then click **OK**.
    - For objects with a validation profile of **Enabled**, have a supervisor with privileges enter his or her user name and password, and then enter or select a comment that explains the reason for the change. Then click **OK**.
    - For objects with a validation profile of **Supervised**, enter your user password, and then have a supervisor with privileges enter his or her user name and password. Enter or select a comment that explains the reason for the change, and then click **OK**.
  - The system records the changes in the **Log Viewer**.

#### 2.12.2.2 Completing the Validation Dialog When Four Eyes Is Not Enabled

- You have changed or commanded a validated object, and the **Validation Required** dialog box displays.
  - Do one of the following:
    - For objects with a validation profile of **Enabled**, enter or select a comment that explains the reason for the change. Then click **OK**.
    - For objects with a validation profile of **Supervised**, enter your user password, and then enter or select a comment that explains the reason for the change. Then click **OK**.
The system records the changes in the Log Viewer.
3 Operating Reference

3.1 System Manager
This section provides background information relating to the System Manager window. For related procedures, see the step-by-step [→ 22] section.

3.1.1 Overview of System Manager
This section provides reference and background information for using the System Manager window. For related procedures, see Working with System Manager [→ 22].

System Manager Workspace
System Manager is a multi-pane window for navigating, monitoring, and controlling all the components and subsystems of your site. For example, you can inspect properties and states of objects, send commands, browse the architecture of the installation, consult floor plan graphics, and so on. A typical layout has a Selection pane on the left where you can locate and select system objects from a hierarchical tree view, and multiple working panes on the right that display object properties, commands, and associated applications based on the current selection.

1 Selection pane. Typically contains System Browser, for locating and selecting system objects in a hierarchical tree view. A drop-down menu lets you switch between different tree views (for example, Management View, Application View, or other customizable views). Your selection here is propagated to the Primary pane on the right, and to the Contextual pane below it.
At the bottom of this pane, the Recently Viewed stacked tab lets you access the recent views navigation option. This lets you return to a previously visited view in the Primary pane.
Operating Reference
System Manager

2 Primary pane. Contains one or more tabs associated with the object you selected in the Selection pane. These tabs can include:
- **Textual Viewer**: Displays information about the object such as its path, status, and so on.
- **Default**: If the selected object has an associated default application (for example a graphics viewer, or a tool for reporting), it displays in this tab.

If the selected object has more than one associated application, tabs corresponding to those applications also display (for example, the Graphics Viewer displays in the Default tab while the remote notification tool displays in the RENO Messages tab).

If you have appropriate user rights, a button is available at the top of the pane to switch System Manager from Operating to Engineering mode to perform configuration tasks.

3 Secondary pane. Opens by default when you click on a related item, so that you can view it without losing the current information on the Primary and Contextual panes.

4 Contextual pane. Provides additional information, actions, and resources for the object you most recently selected (in the Selection pane, or in one of the other panes). It is divided into two parts:
- **Operation/Extended Operation** tabs (left side): Lets you inspect all the properties of the selected object, and view and execute any commands/actions available for that object.
- **Related Items** tab (middle): Provides links to additional resources, such as reports or alarm-handling procedures that are relevant to the selected object. If you click on a related item it opens by default in the Secondary pane. You can also opt to direct related items to the Primary pane instead.
- **Detailed Log** tab (right side): Lets you view a detailed history log about the selected object, and handle the log data.

System Manager Navigation Workflows
You can interact with System Manager to perform actions and change what currently displays in the other panes in a variety of ways. These include:
- Click on an object in the Selection or Secondary pane to propagate its information, properties and commands to the Primary and Contextual panes.
- Click on the secondary header of a pane to select the corresponding object in the Selection pane.
- Right-click on an object (or group of objects) and choose whether to propagate (send) its information to the Primary or Secondary pane.
- Click on an object in the Related Items tab to open it in the Secondary (or Primary) pane.
- Drag-and-drop objects from the Selection or Contextual pane to perform certain tasks.
- Click to open the Navigation bar.

Primary Navigation Workflow
The following is a typical workflow that illustrates how the different System Manager panes work together:

1. Select an object in the Selection pane (1). See Selecting an Object in System Browser [25].
   - Information and commands for that object display in the Primary pane and in the Contextual pane (2). You can immediately monitor and control the selected object.

2. Click the Primary pane to select a new object (3).
   - The Contextual pane updates to let you monitor and control the new selection.
3. Click one of the links in the Related Items list (4) to open it in the Secondary (5) (or Primary) pane. This provides additional information or resources relevant to the selected object.

4. Continue making selections, in both the Primary and Secondary pane, to immediately view the associated information and commands in the Contextual pane.

---

Drag-and-drop Workflow

The following is a typical workflow that illustrates how to associate two system objects using manual selection and drag-and-drop.

1. In the Selection pane, select the desired System Browser view (1) (see Selecting Views [28]). For example, Application View.

   The System Browser tree updates to display the selected view.

2. Navigate the tree to select the object (2) you want to work with, for example Activity Log.

3. Select the Manual Navigation check box (3) to freeze the Primary pane (in this example, Reports > Activity Log).

4. Drag and drop the selected object (4) (in this example, Address Book) to the reports area.
NOTE: System Browser supports drag-and-drop of single or multiple objects from any of the views—including the Search Result view. You can cancel a dragging operation by pressing the ESC key or by dragging the objects back to the original view (or other no-drop zone) and dropping them.

Operating and Engineering Mode

When you log onto Desigo CC, System Manager starts in Operating mode. This is the mode typically used by operators during the day-to-day running of the Desigo CC management station. Configuring the system instead requires switching over to Engineering mode.

Operating Mode

In Operating mode, you can monitor and control the facility, for example by verifying site statuses, handling alarms, checking graphics, generating reports, and so on. If you have appropriate user rights, you can also perform some limited configuration tasks (for example, editing graphics, schedules, and so on) in Operating mode.
Figure 16: System Manager - Operating Mode

1. System Manager **Operating** mode is indicated by a light blue color.

2. Depending on the object selected in System Browser, the **Primary** pane displays only the **Textual Viewer** tab or the **Textual Viewer** and other tabs. Each tab gives access to the related operating application.

3. The **Operating** button is available only if you have access rights for **Engineering** mode; otherwise, it does not display. If available, this button lets you toggle System Manager between **Operating** mode and **Engineering** mode.

**Engineering Mode**

**Engineering** mode is a feature of Desigo CC that enables authorized technicians to configure a project. In **Engineering** mode, the **Primary** pane of System Manager presents all the tools for configuring the site project, including import/export capabilities.

If you have the appropriate permission (System Management application rights set for your user group under Security), the **Primary** pane of System Manager displays an **Operating** button that you can use to switch to **Engineering** mode.

You can click the **Engineering** button to switch the system back to **Operating** mode and check whether the configurations you made work correctly.
Figure 17: System Manager - Engineering Mode

NOTE:
The application rights can only be changed in Engineering mode. So if you do not have engineering rights, these can only be enabled for you by another user who already has engineering rights. After this happens, the Operating/Engineering button will display in System Manager.

To fully configure a site project you may also require a special Engineering Mode License, which temporarily gives access to the whole software's functionality.

Navigation Bar
The Navigation bar displays at the top of System Manager and allows you to navigate the system without having to make selections in System Browser (see Browse and Select Objects with the Navigation Bar [26]). It contains a set of icons, and a Breadcrumbs path that shows your current location as a series of links separated by arrows.

The Breadcrumbs path in the Navigation bar functions like a condensed version of System Browser, without the search capabilities. The selections you make in the Breadcrumbs area are reflected in System Browser. The opposite is also true: the selections you make in System Browser are reflected in the Breadcrumbs area.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Let you quickly return to recently-viewed selections. See Revisit Recent Selections from the Navigation Bar [➙ 27].</td>
</tr>
<tr>
<td>Forward</td>
<td></td>
</tr>
<tr>
<td>History</td>
<td>Displays a list of your 20 most recently viewed selections with the current selection highlighted with a checkmark ✓ and displayed in the Primary pane.</td>
</tr>
<tr>
<td>Favorite location</td>
<td>Jumps to a user-selectable view; when you set a favorite location the system will store it and use it as the initial selection when you first open System Manager. When switching-over to a new user, that user's Favorite location will be used as the initial selection. See Set a Favorite Location in System Manager [➙ 27].</td>
</tr>
</tbody>
</table>

Recently Viewed

Recently Viewed is a navigation aid located in the Selection pane of the System Manager window. It lets you quickly return to a recently-visited view in the Primary pane. For instructions, see Revisit Recent Selections from Recently Viewed [➙ 27].

To access Recently Viewed, click its stacked tab at the bottom of the Selection pane. You will see a history of the 20 most recent views in the Primary pane, displayed as either thumbnails (snapshots) or links (3). Click a thumbnail or link (1) to jump back to that view in the Primary pane, or use scroll icons ◀ (Newer) ▶ (Older) (2) to move backward and forward among the recent views.

System Manager Troubleshooting

This section provides general troubleshooting information about System Manager.
System Manager Does Not Display
If System Manager is not currently visible in the main work area of the system screen, you can display it as follows:

1. If the Help window is currently open, close it by clicking in its title bar.
   (Otherwise, the Help window always stays in the foreground and prevents others from displaying).

   - If System Manager does not already display, do one of the following:
     - From the Windows taskbar: Click the Desigo CC taskbar icon labeled System Manager.
     - From the Desigo CC system Menu, select Active tasks and click the thumbnail of the System Manager window.
   
   NOTE: If you created additional System Manager windows—for example, System Manager(2), System Manager(3), and so on—you can access these in the same way.

System Browser Does Not Display
System Manager is open but System Browser does not display.

1. In the System Manager window header, select a pane layout that includes the Selection pane:

2. In the Selection pane footer, click the System Browser stacked tab.

Cannot Resize Any of the Panes
In the System Manager window header, check the lock pane layout icon. If it is active (undimmed), it means the layout is locked and cannot be changed.

To unlock the pane layout, click the lock pane layout icon so that it become dimmed.

3.1.2 System Browser
System Browser displays objects in the building control system through various views, which you can select from a drop-down list. System Browser also supports searching and filtering of objects, displaying names and descriptions of objects, selecting single and multiple objects, and dragging objects into Trends, Schedules, and Reports. The System Browser hierarchy updates dynamically to reflect changes at the system level.

For procedures and workflows, see the step-by-step section.

Searching and Filtering
The Search area consists of an editable Search list box, a Search button, a drop-down list arrow, a Filter Search icon, and a Save Search icon.

Searching helps you quickly find objects in the currently selected view. You can perform searches on either names or descriptions but not on a combination of both names and descriptions. To start a search, you enter a search string in the Search list box, using wildcards if desired, and then either click Search or press ENTER. See the Wildcards section for more information about them.
After the search results display, you can save the search by clicking **Save As** , entering a name in the **Save Search** field, and then clicking **Save** . The system saves the search to your own local user profile, and the search then becomes available only to you. You access saved searches by clicking the drop-down list arrow in the **Search** list box.

Filtering helps you limit the number of objects shown during a search, while also providing an efficient way to find objects without scrolling through the entire tree or without having to remember which node an object belongs to. You access the filtering fields by clicking **Filter Search** . You can then filter the objects by selecting individual or multiple building control disciplines, sub disciplines, types, sub types, or an alias. Additionally, the **Other** drop-down list box allows you to filter objects for out of scan, override protection, and validation profile settings.

Selecting the **Search within selection** check box applies your filter selections only to the current node selection in the System Browser tree. Clicking the **Search** button starts the search and displays the results of your filter selections. Search results for both the searching and filtering features are sorted by path, using grouping, and by the name within each group. For example, a search for objects located in the east wing of the 92nd floor in your building could produce results similar to the following:

```
Willis Tower\Floor 92\East Wing\n  EastWingTemp
  EastWingDailyTrend
  EastWingWeeklySchedule
  EastWingGraphic
```

**Wildcards**

Two wildcard characters are supported in System Browser—the asterisk (*) and the question mark (?). Each functions differently. The asterisk wildcard serves as a placeholder for zero or more characters. The question mark wildcard serves as a placeholder for exactly one character only. Therefore, each wildcard serves different purposes.

- ***(asterisk):** Allows you to add zero or more characters to your search criteria. For example, "a*** matches and displays, "a", "ab", "abc" and "abcd".
- **? (question mark):** Allows you to add one character to your search. For example, "ab?? matches and displays "abc", but does not match or display "a", "ab" and "abcd".

**Display Modes for Objects**

System Browser supports four modes for displaying objects. **Show Description** is the default display mode the first time you log on to the system with new credentials. After you log on, you can select your preferred mode, which the system saves for your next session. The mode you select affects the way the objects appear throughout the various panes in System Manager. The following table summarizes the four modes with display examples:
Display Modes for Objects

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Description</td>
<td>Air Handler Unit 1</td>
</tr>
<tr>
<td>Show Description [Name]</td>
<td>Air Handler Unit 1 [AHU1]</td>
</tr>
<tr>
<td>Show Name</td>
<td>AHU1</td>
</tr>
<tr>
<td>Show Name [Description]</td>
<td>AHU1 [Air Handler Unit 1]</td>
</tr>
</tbody>
</table>

Views

You can select from different views of the object types in the building control system, depending on how your system is set up. Selecting a view does not change the physical makeup of the system. The views merely represent convenient and different ways of looking at the system. Default views include Application View and Management View. The currently selected view is saved from session to session. In other words, the view that is selected when you close the software is the view that the system restores the next time you open the control software. Your last highlighted object selection in the System Browser tree, and the state of the expanded and collapsed folders, are not saved and restored from session to session.

Making Object Selections

System Browser offers you the following two methods for making objects the primary selection in System Manager:

- **Automatic Selection** (default): For selecting a single-object, you click the object, and it then automatically becomes the new primary selection in System Manager. For selecting multiple objects, you press and hold the CTRL key or the SHIFT key while highlighting the objects. Upon releasing either key, the objects become the new primary selection in System Manager.

- **Manual Selection**: First, check the Manual Navigation box, then highlight the objects in one of three ways: 1) Clicking the object, 2) Pressing and holding the CTRL key while clicking multiple objects, or 3) pressing and holding the SHIFT key while clicking the beginning and ending range of objects. To make the highlighted objects the primary selection for System Manager, you can right-click and choose Send to the Primary Pane, or click the Send button. When selecting a single object, you can also double-click the object to make it the primary selection.

Dragging-and-Dropping

System Browser supports drag-and-drop of single or multiple objects from any of the views—including the Search Result view—to Trends, Schedules, and Reports. You can cancel a dragging operation by pressing the ESC key or by dragging the objects back to the original view (or another no-drop zone) and then dropping them.

3.1.2.1 System Browser Workspace

System Browser displays objects in the building control system through various views, and also supports searching and filtering.
### System Browser Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Views List box</td>
<td>Allows you to select the view of the system by clicking the drop-down arrow.</td>
</tr>
<tr>
<td>2 Search List box</td>
<td>Allows you to search for objects in the currently selected view. You can perform searches on either names or descriptions but not on a combination of both names and descriptions. The box consists of an editable field where you enter search strings, including wildcards. You can perform a search by name or description, depending on the setting of the Display mode. You start a search by entering text and then either pressing ENTER or clicking the Search icon. The matching results display in the list area. The drop-down arrow displays a list of your saved searches.</td>
</tr>
<tr>
<td>3 Display Mode List box</td>
<td>Provides four options to display objects: Description, Description + Name, Name, and Name + Description. When you choose to display an object’s Description + Name, the description appears first, followed by the name. When you choose to display an object’s Name + Description, the name appears first, followed by the description. The option you select affects the way the object displays throughout the various panes in System Manager.</td>
</tr>
<tr>
<td>4 Manual Navigation check box</td>
<td>One of two methods for making objects the primary selection in System Manager. By default, automatic selection is enabled, which means that any object you select in System Browser automatically becomes the new primary selection for the system. If you want to scroll through the System Browser tree and highlight an object without making it the primary selection, check the Manual Navigation box, and then single-click the object. If you then decide that you want to make the highlighted selection the new primary selection, you can do one of the following:   - Right-click and select either Send to the Primary Pane, or Send to the Secondary Pane.   - Click the Send button (sends to Primary pane only)   - Double-click (for single-object selection only, and sends to Primary pane only)</td>
</tr>
</tbody>
</table>
### 3.1.3 Textual Viewer

Textual Viewer displays the details for one or more objects in the building control system. For example, after you select one or more objects from System Browser, Textual Viewer displays their common properties in list form. Your selections can be either implicit or explicit. An implicit selection occurs when you click a parent object that has child objects associated with it. In this case, Textual Viewer displays the parent object in bold, followed by the child objects beneath it. An explicit selection occurs when you click a parent object that does not have child objects associated with it. You can sort the information in the various columns by selecting the column headings, and you can rearrange the order of the columns by dragging them to the desired location. Additionally, you can use the Customize Columns tool to hide or show columns. The tool is available by right-clicking on a column heading, a row, or the scroll bars.


#### Making a New Primary Selection

Making a new primary selection in Textual Viewer is an efficient alternative to manually scrolling through the System Browser tree to look for an item. It is also quicker than performing a formal search for an object using the Search feature.

#### Using the Double-Click Function

The double-click function gives you the ability to investigate building control system information in increasing detail. For example, if you select a building in System Browser, Textual Viewer displays it, along with each of the floors of the building. When you double-click one of the floors, Textual Viewer displays the floor, along with the sensors that are installed on that floor. If you then double-click one of the sensors, Textual Viewer displays the sensor. If a graphic is associated with the sensor, a graphic displays. If not, text displays.
### Textual Viewer Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Object</td>
<td>Displays a list of objects in the system. A bolded object indicates a parent object with associated children objects.</td>
</tr>
<tr>
<td>2 Title bar</td>
<td>Displays the name of the object with the primary selection. If you select multiple objects, the name of the first object you selected will display. If you select a parent object, you implicitly select the children objects belonging to the parent as well. In this case, the parent object displays in the title bar.</td>
</tr>
<tr>
<td>3 Path</td>
<td>Displays the location of the object in the building control system.</td>
</tr>
<tr>
<td>4 Name</td>
<td>Displays the name of the object.</td>
</tr>
<tr>
<td>5 Alias</td>
<td>Displays a unique name within the system for an object.</td>
</tr>
<tr>
<td>6 Type</td>
<td>Displays the type of object selected such as Smoke Detector, Room, Graphic and so on.</td>
</tr>
<tr>
<td>7 Subtype</td>
<td>Displays the subtype of object selected such as Multi-state, Binary Input, and so on.</td>
</tr>
<tr>
<td>8 Validation Profile</td>
<td>Displays one of three scenarios for validation: Disabled, Enabled, or Supervised.</td>
</tr>
<tr>
<td>9 Out of Scan</td>
<td>Displays False, which means the communications driver is reading the object, or True, which means the communications driver is not reading the object.</td>
</tr>
<tr>
<td>10 Value</td>
<td>Displays the current value of the object.</td>
</tr>
<tr>
<td>11 Image</td>
<td>Displays an image associated with the status indicator.</td>
</tr>
<tr>
<td>12 Status</td>
<td>Displays the status of the object such as Normal, or the consolidated status of the object such as Alarm, Fault, or Technical Exclusion.</td>
</tr>
</tbody>
</table>
### 3.1.3.2 Customize Columns Dialog Box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Available Columns</td>
<td>Displays a list of columns not currently shown in Textual Viewer.</td>
</tr>
<tr>
<td>2 Movement arrows</td>
<td>Allow you to move columns to control whether they are hidden or shown.</td>
</tr>
<tr>
<td>3 Visible Columns</td>
<td>Displays a list of columns that will show in Textual Viewer.</td>
</tr>
<tr>
<td>4 Selection buttons</td>
<td>Move Up/Move Down: Allow you to rearrange the order in which columns display.</td>
</tr>
<tr>
<td></td>
<td>OK: Allows you to accept the changes you have made.</td>
</tr>
<tr>
<td></td>
<td>Cancel: Allows you to cancel changes you have made.</td>
</tr>
</tbody>
</table>

### 3.1.4 Operation

The Operation tab allows you to display and change the current state of an object's properties in your building control system. The Operation tab is designed for the most common daily tasks. Access to objects is based upon the object privileges and privilege profiles set for you by your system administrator.

For procedures or workflows, see the step-by-step [→ 31] section.

#### 3.1.4.1 Workspace

The Operation tab displays the name of the currently selected object(s), a list of properties associated with the object(s), the current value of the properties, and command buttons for initiating commands on commandable properties.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property name</td>
<td>Displays the name of one or more properties associated with the selected objects. If you select multiple objects of the same type in the system, the icon next to the property name indicates this with a triangular symbol in the lower right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change all properties for the selected objects at the same time.</td>
</tr>
<tr>
<td>Object name</td>
<td>The name of the selected object. If you selected more than one object to display, the default object name is Multi-Select.</td>
</tr>
<tr>
<td>Current value</td>
<td>Displays the current value of each property.</td>
</tr>
</tbody>
</table>
4 Command button
Displays the name of a command that you can initiate. Some commands are sent immediately after you initiate them by releasing the command button. Others require you to enter arguments before they can be sent. When a command requires arguments (additional fields requiring information to continue with the command), the property row will expand after you click the command button. You then complete the additional fields and click the appropriate button (Send, Command, Change, Ack, and so on).
Some object properties support grouping of command buttons that occupy the space of one button, with a drop-down list of your choices. The button you choose from the drop-down list becomes the new commandable button in the group.

5 Parameter
When you initiate a command that requires additional parameters, the system prompts you to enter one or more parameters prior to sending the command. You must complete all required parameters before sending the command. A parameter field that displays a red border around it means that the value for that property is invalid. If that is the case, you will need to enter a valid value before commanding the property.

6 Command Feedback area
Displays the progress and then the result of a command once you execute a command. During the command, the Command Feedback area displays Command in Progress, along with information about how many objects have been commanded and how many will be commanded all together. After a command execution is complete, successful commands display Property Name successful. Failed commands display Command failed.

7 Send button
The Send button displays only for commands that require additional arguments. Clicking this button sends a command after you have entered all required arguments.

3.1.4.2 Properties and Commanding
You change the current state of a property by commanding it. Once you command a property, the status of the command displays for the selected object. If the command fails, the reason for the failure displays so that you can take further action.

Examples of common commands:
- Acknowledge
- Change command priority
- Coldstart
- Enable/disable
- On/Off
- In service/Out of service
- Override/Release
- Reset value for equipment operating hours
- Set a new point value
- Upload

Display of Properties
Properties display in one of two ways—automatically or manually. They display automatically when a property goes into an off-normal state, and they display manually when you select an object in the system.

Why Command a Property?
You command a property to change its current state. For example, you might command to initiate an action, enable or disable a property, acknowledge or reset the status of a property, or override or release an override of a control program.
Commanding a property is also useful under these conditions:

- User action is required to manage an emergency
- When an alarm indicates a malfunctioning device
- When performing preventive maintenance
- To save energy
- When managing operating hours totalization

**Example of Commanding**

At your facility, you want to change the temperature from 68 to 73°F (20 to 22.78°C) in a conference room on your floor. Using your building control software, you send a command to change the Present Value of the Temperature Setpoint object of the room to override the normal system control.

### 3.1.4.3 Command Priorities and Priority Arrays

Some objects in your building control system use specialized command priorities to determine whether an operator or a particular control program is in control.

#### Command Priority

The Present Values of six object types in your building control system are based on a command priority and established in a hierarchy that ranks from highest (1 – Manual Life Safety) to lowest (16 - Available). The six object types are Analog Output, Analog Value, Binary Output, Binary Value, Multi-State Output, and Multi-State Value. The hierarchy helps determine which source has priority over another to change the value of an object. To command one of these object types, you—or an application—must have a command priority equal to or greater than the current command priority of the object.

#### Command Priority Array

The Command Priority Array displays commands that have been issued at various priority levels. Users and applications can set or relinquish (release) commands for a commandable object. If the Present Value of an object has a Command Priority Array, the appropriate priority level is commanded or relinquished when you execute a command. If the Present Value of an object does not have a Command Priority Array, the system overwrites the present value with the newly commanded value. You can command or relinquish any priority level that you have access to, based on your user privileges.

The following table shows the Command Priority Array:

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Priority Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Manual Life Safety</td>
</tr>
<tr>
<td>2</td>
<td>Automatic Life Safety</td>
</tr>
<tr>
<td>3</td>
<td>Available</td>
</tr>
<tr>
<td>4</td>
<td>Available</td>
</tr>
<tr>
<td>5</td>
<td>Critical Equipment Control</td>
</tr>
<tr>
<td>6</td>
<td>Minimum On/Off</td>
</tr>
<tr>
<td>7</td>
<td>Available</td>
</tr>
<tr>
<td>8</td>
<td>Manual Operator</td>
</tr>
<tr>
<td>9</td>
<td>Available</td>
</tr>
<tr>
<td>10</td>
<td>Available</td>
</tr>
<tr>
<td>11</td>
<td>Available</td>
</tr>
<tr>
<td>12</td>
<td>Available</td>
</tr>
</tbody>
</table>
3.1.4.4 Summary Status
In order to simplify the system display and highlight the most important information, the system sometimes combines properties into a single Summary Status property. The Summary Status property displays the highest priority status that is currently active for an object. For example, if an object has an active Fire Alarm and Fire Fault, the Fire Alarm would be displayed in the Summary Status.

3.1.4.5 Multiple-Object Commanding
With multiple-object commanding, you are not really commanding objects at all. Instead, you are commanding one property type, Present Value for instance, for more than one object of the same type.

If you select multiple objects of the same type, for example, Analog Output, the icon next to the property name indicates this with a triangular symbol in the lower-right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change (command) all Present Value properties for the selected objects at the same time.

In the following graphic, the system indicates that you have selected multiple objects by displaying a triangular symbol in the lower right-hand corner of the Present Value icon.

The following graphic shows that you have clicked the triangular icon. The system now displays two additional rows, which represent two selected objects of the same type.

3.1.4.6 Propagation
Propagation means relaying Common Status information up the building control system's hierarchical tree. Information that is relayed up the hierarchy as a result of a change in the Common Status of an object is called status propagation.

Propagation is based on the parent-child-grandchild model. Each object in the system can have one or more parent objects and one or more child objects. Each child in the system can simultaneously propagate multiple active Common Status properties to a parent, such as alarm, fault, or technical exclusion.

The following table shows propagation from two different viewpoints.

<table>
<thead>
<tr>
<th>Logical View of the System</th>
<th>Physical View of the System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building (parent)</td>
<td>A building node (parent)</td>
</tr>
<tr>
<td>Floor in the building (child)</td>
<td>Field panel (child)</td>
</tr>
<tr>
<td>Room on the floor (grandchild)</td>
<td>Point (grandchild)</td>
</tr>
<tr>
<td>Temperature sensor in the room (great-grandchild)</td>
<td>-</td>
</tr>
</tbody>
</table>
3.1.5 **Related Items**

This section provides reference and background information for objects that are related to system objects. For procedures or workflows, see the step-by-step [→ 32] section.

3.1.5.1 **Overview of Related Items**

The **Related Items** tab displays objects related to the currently selected object. Each related item is assigned a group name that represents the type of the object—for example, graphics, trends, reports, or schedules.

**Navigation**

You can navigate to a view of each related item by clicking on the item. For instance, if you click a management station object, such as a graphic, **Graphics Viewer** displays the referenced graphic object. If you click an external item, such as a PDF file, Adobe Reader opens with the referenced file displayed. Other items that you can access include point types, Word documents, Excel documents, and URLs.

**Display of Items**

The **Related Items** tab displays the items used for most daily operations. **Related Items** contains two sets of buttons. You can toggle the first set of buttons, **Links** and **Icons**, which allows you to switch between text views or small images of the items in the list. The **Links** view is more compact than the **Icons** view, so more related items can be displayed with this view than with the **Icons** view. The display mode that is currently selected in System Browser determines how text displays. For example, text might be displayed as description, name, description plus name, or name plus description.

The second set of buttons, **Group** and **Ungroup**, allows you to switch between categories or flat-list views of the items in the list. The **Group** view shows items arranged by object type (analog input, digital output, schedules, graphics, reports, PDFs, Word files, web links, etc.) and is expanded by default, but which you can collapse as well. When the **Group** view is collapsed, the **Links** and **Icons** views are disabled. The **Ungroup** view displays all related items without displaying their corresponding group names.

If you select one object from System Browser, **Related Items** displays all links associated with that object. If you select two or more objects from System Browser, **Related Items** displays only those links that all selected objects have in common.

For example, you select three objects in System Browser with the following links:

<table>
<thead>
<tr>
<th>Object</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>EastWingLabTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td></td>
<td>Third Floor Temperature Trend</td>
</tr>
<tr>
<td>WestWingOfficeTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td></td>
<td>Third Floor Temperature Trend</td>
</tr>
<tr>
<td>NorthWingOfficeTemp</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
</tbody>
</table>

The result of this selection is that **Related Items** displays only the Monthly Energy Consumption Report and the Third Floor Heating/Cooling Schedule links because they are common to all three objects. The Third Floor Temperature Trend link does not display because it is not common to all three selected objects. To view the Third Floor Temperature Trend link in this example, you would need to select either the EastWingLabTemp object or the WestWingLabTemp object.

The **Related Items** tab displays objects related to the currently selected object. Each related item is assigned a group name that represents the object's type—for example, graphics, reports, or schedules.
Navigation
You can navigate to a view of each related item by clicking on the item. For instance, if you click a management station object, such as a graphic, Graphics Viewer displays the referenced graphic object. If you click an external item, such as a PDF file, Adobe Reader opens with the referenced file displayed. Other items that you can access include point types, Word documents, Excel documents, and URLs.

Display of Items
The Related Items tab displays the items used for most daily operations. Related Items contains two sets of buttons. You can toggle the first set of buttons, Links and Icons, which allows you to switch between text views or small images of the items in the list. The Links view is more compact than the Icons view, so more related items can be displayed with this view than with the Icons view. The display mode that is currently selected in System Browser determines how text displays. For example, text might be displayed as description, name, description plus name, or name plus description.

The second set of buttons, Group and Ungroup, allows you to switch between categories or flat-list views of the items in the list. The Group view shows items arranged by object type (analog input, digital output, schedules, graphics, reports, PDFs, Word files, web links, etc.) and is expanded by default, but which you can collapse as well. When the Group view is collapsed, the Links and Icons views are disabled. The Ungroup view displays all related items without displaying their corresponding group names.

If you select one object from System Browser, Related Items displays all links associated with that object. If you select two or more objects from System Browser, Related Items displays only those links that all selected objects have in common.

For example, you select three objects in System Browser with the following links:

<table>
<thead>
<tr>
<th>Object</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>EastWingLab</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td>WestWingOffice</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
<tr>
<td>NorthWingOffice</td>
<td>Monthly Energy Consumption Report</td>
</tr>
<tr>
<td></td>
<td>Third Floor Heating/Cooling Schedule</td>
</tr>
</tbody>
</table>

The result of this selection is that Related Items displays only the Monthly Energy Consumption Report and the Third Floor Heating/Cooling Schedule links because they are common to all three objects.

Maintenance of User Preferences
Related Items stores the settings of the Group and Ungroup views and the Links and Icons views for each object that you interact with so that you do not need to continually adjust your settings as you navigate from one object to the next.

Deleting and Re-adding Points
Be careful about deleting and then re-adding points in your system since this can break the links in Related Items.

For example, you select a point on a graphic, and the graphic itself displays as one of the links for that point in Related Items. If you delete the point from the field panel, and then re-add it (re-import it using the Auto Discovery feature), the graphic will display the point, but the related items for the point will be lost. If you select the re-added point in System Browser, the graphic will not display.

In the case of graphics, you can restore the broken links using the Graphics Consistency Checker diagnostic tool.

If you delete points relating to camera devices, External Documents, and Management Station Schedules, your links will be permanently lost.
3.1.5.2 Related Items Workspace

Related Items allows you to switch between small images and text views of the items in the list, or between categories and flat-list views.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Links/Icons buttons</td>
<td>Clicking the Links button displays items as text links. The display mode that is currently selected in System Browser determines how text displays. For example, text will be displayed as description, name, description plus name, or name plus description. Clicking the Icons button displays items as icon links.</td>
</tr>
<tr>
<td>2 Group/Ungroup buttons</td>
<td>If text links are displayed, clicking the Group button displays text links by categories such as analog inputs, analog outputs, schedules, reports, PDFs, Word files, and Web links. If icons are displayed, clicking the Group button displays icon links by categories.</td>
</tr>
</tbody>
</table>
3.2 Graphics Viewer

This section provides background information for displaying, view, and command graphics in your facility. For related procedures or workflows, see the step-by-step section.

3.2.1 Graphics Viewer Overview

The Graphics Viewer is the component of the Graphics application that allows you to view the graphics representing your facility or equipment. It is where you can change the current state of an object’s properties from a graphic, by using the floating Status and Commands windows. You can filter your view of a graphic by discipline, section, or you can zoom in and out for greater detail or for a birds-eye overview.

For specific reference information, select from the topics below as needed:

Coverage Area Overview

Desigo CC allows you to manually associate objects to one-another. For example, you can associate a fire detector (or any other object type) to a video camera or to a document. Then, whenever the fire detector is selected in the System Browser tree, the related video camera or document displays in the Related Items tab. The Coverage Area feature provides a graphical way to achieve the same result.

Desigo CC graphics can contain cameras or monitoring devices to which objects, such as fire sensors, ceiling sprinklers, temperature sensors, etc. are associated. For example, you have a graphic of an office space that includes a camera that is monitoring the fire sensors in that room. In this example, the fire sensors monitored by the camera, are in the coverage area of the device.

The coverage area contains the monitored objects. When you move your cursor over the coverage area, a tooltip displays the coverage area's object reference with the total number of monitored objects. If you move your cursor over an object in the coverage area, a tooltip displays the object's name or description. The background color of the coverage area varies depending on the configuration of the project.

When you initially load a graphic, the coverage area of a camera is not visible in the Graphics Viewer. You must toggle the Coverage Area icon from the Graphics Viewer toolbar to view the coverage area of any monitoring devices on the graphic.

The Operation and Extended Operation tabs display the device properties when the coverage area is visible. The Related Items tab lists any coverage areas that are associated with the graphic under the heading that is named after the type of
the monitoring object. For example, if the monitoring object is a camera, the heading displays Camera in the Related Items tab.

Graphics Related Folders

Graphics related folders are displayed in the Application View and Management View of the System Browser. Existing graphics associated with your project are listed and viewed from the Application View tree, under the Graphics application.

There are three types of graphic folders: Graphic, Symbols, and Graphic Templates.

- **Application View > Graphics**: Displays all project graphics (*.CCG) files.
- **Management View > Project* > System Settings > Libraries > [Appropriate Sub-Library] > Symbols**: Displays all the related Symbols (*.CCS) files associated with the selected library.
- **Management View > Project* > System Settings > Libraries > [Appropriate Sub-Library] > Graphic Templates**: Displays all the related symbols (*.CCT) files associated with the selected library.

*If your System Browser display mode is set to Show Name, you will see Management View instead of Project.*

Objects and Navigation in Graphics

The Graphics Viewer allows you to display dynamic graphics of your building control system. Within System Manager, you navigate the various views of System Browser to select the objects you want to display in the Graphics Viewer. System Browser displays only the objects in the system that you have access to, based on your user profile and privileges.

Primary and Secondary Selections

When you select a graphics object from System Browser, the Graphics Viewer displays the representative graphic. The selected object is considered the primary selection. The object properties also display in the Operation or Extended Operation tab. The graphic that has the primary selection displays the name of the graphic and the object name according to your Display selection in the System Browser.

Additionally, the properties of the primary selection display in the Operation or Extended Operation, and the Detailed Log tabs. The Related Items tab displays objects related to the currently selected object. Each related item is assigned a group name that represents the object's type, for example, graphics, trends, reports, or schedules.
If you click a Symbol on a graphic or, the referenced object of the Symbol becomes the secondary selection, while the primary selection remains the same in System Browser. The following figure illustrates the primary selection in System Browser, Analog Output 1.

In the Graphics Viewer, the **Operation** tab changes its display to correspond to the new, secondary selection. System Browser displays the original, primary selection, to show your starting point.
When you select an object from System Browser that is associated with a graphic, the Graphics Viewer displays the representative graphic and the object’s associated Symbol on the graphic is selected. As a result, the **Operation** tab displays the object properties to correspond to the selection.

Double-clicking a Symbol on a graphic makes the referenced object associated with the Symbol the primary selection in System Browser and all workflows update accordingly.

### Operating and Engineering Modes in the Graphics Viewer

<table>
<thead>
<tr>
<th>Graphics Viewer window mode</th>
<th>Graphics Viewer application behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating</strong></td>
<td>- The Graphics Viewer displays:</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Default</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>- The <strong>Textual Viewer</strong> tab displays.</td>
</tr>
<tr>
<td></td>
<td>- Can create, open, and edit graphic files.</td>
</tr>
<tr>
<td><strong>Engineering</strong></td>
<td>- The Graphics Viewer displays:</td>
</tr>
<tr>
<td></td>
<td>- In the <strong>Graphics</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>- The <strong>Object Configurator</strong> tab displays.</td>
</tr>
<tr>
<td></td>
<td>- Can create, open, and edit graphic files.</td>
</tr>
</tbody>
</table>

**NOTE:** You must have the appropriate access rights to work in the Graphics Editor.
Point Centered Display Mode

Point Centered Display mode ensures that a selected data point or group of data points will always be centered in the Graphics Viewer.

For example, you might be required to put a data point in this mode if you are monitoring a fire system in a chemical manufacturing facility with key sensors that must always be viewed. Enabling Point Centered Display mode in such a scenario ensures that the data point does not blend in with and become lost among surrounding graphics. Or, you might be required to put the Graphics Viewer in this mode, if, for example, you are monitoring a fire system in a pharmaceutical manufacturing facility with key areas that must always be viewed. You can also enable the Group Center mode, to ensure that the parent and all children of the selected point are always selected; therefore, the group of points does not blend in with and become lost among any surrounding graphics. In Group mode, siblings are all data points with the same parent as the selected data point. Those siblings are retrieved from the currently selected view when the selection in the System Browser changes. This mean that selecting the same data point in different views, such as Logical or Management View, could return different siblings.

To implement the feature, you select a data point object in System Browser. The System Manager application then opens the Graphics Viewer and displays the point’s default graphic view, depth, and graphic associated with it. You then select the Point Centered Display mode button from the Graphics Viewer toolbar to center the point in the viewport. The feature is disabled by selecting the button again.

While in Point Centered Display mode, you cannot pan the object. However, you can select any zoom factor without affecting centering in the viewport or you can select another symbol to shift the focus to another object or Symbol.

Scopes and Graphic Objects

Scope is a grouping of system objects, or nodes with specific scope definitions used for the purpose of assigning access rights. You can create scopes and assign access rights to any of the graphic nodes in the Graphics system tree. For more information, see Scopes.

You can apply scopes to the following graphic nodes:
- Graphics
- Symbols
- Templates
- Manual and Automatic Pages

Data Point Access Privileges

Data points are integrated into a graphic by associating them with elements. These data points and elements can be evaluated by creating expressions that result in a graphic that allows you to view dynamic values of a facility, building, or piece of equipment. Data points therefore always display using the elements they are associated with.

Depending on your access rights which are set in the System Manager certain data points can be inaccessible. In this case, if one or more data points associated with an element is inaccessible, then the associated element will not display in the graphic while in Runtime mode or in the Graphics Viewer. However, the parent of an element, such as a symbol instance or a group, and any other associated children (elements), are not affected and will display on the graphic. This is considered the Hide-Rule for data points in a graphic.

The Hide-Rule does not apply to Object References and Link References since there are no COV subscriptions involved in these scenarios.

When a data point with an existing address is subscribed for COV’s, the data point’s status and value are updated automatically in the Value Simulator. If the status for the data point displays General Access Denied, the data point is inaccessible and therefore not readable for COV subscriptions.
Security and the Graphics Viewer
Access levels are the security rights users are granted to access applications and objects in the Desigo CC software. The access levels for the Graphics Viewer, Graphics Editor, and Graphics Library Browser are as follows:

Graphics Viewer
The access rights for the Graphics Viewer application define the user’s ability to display a graphic or a symbol in the Graphics Viewer and in the Graphics Editor Runtime mode.

<table>
<thead>
<tr>
<th>Graphics Viewer: Security</th>
<th>If Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>You can display a graphic in the Graphics Viewer and in the Graphics Editor Runtime mode.</td>
</tr>
</tbody>
</table>

Status and Commands Overview
The Status and Commands window displays on a graphic, and allows you to display and change the current state of an object’s properties in your building control system. Access to objects is based upon the object privileges and privilege profiles set by the system administrator.

Display of Properties on a Graphic
Properties display on a graphic in one of two ways—automatically or manually.
- They display automatically when a property goes into an off-normal state. The Status and Commands window displays the icons associated with the properties in an off-normal state on the graphic. You expand the icon view to display the detailed property information and the command options.
- The Status and Commands window displays manually when you right-click an object in a graphic that has data points associated with it. You can display multiple Status and Commands windows in Graphics.

When a Status and Command window displays on the graphic, a connection line displays between the window and its associated objects on the canvas. The connection line between the Status and Commands window and the objects remains intact, even when the window is moved around on the canvas.

Properties and commands also display in the Operation and Extended Operation tabs for the selected object.

For more information on commanding properties and priority arrays, see Command Priorities and Priority Arrays.

Summary Status
In order to simplify the system display and highlight the most important information, the system sometimes combines properties into a Summary Status property. The Summary Status displays the highest priority status that is currently active for an object. For example, if an object has an active Fire Alarm and Fire Fault, the Fire Alarm displays in the Summary Status.

More About the Status and Commands Window
The Status and Commands window is a floating view that displays over an object on the canvas, and can be moved around in the Graphics Viewer. The Status and Commands window displays a connection line to its associated objects on the canvas. The connection point of the connection line, anchors itself in the following manner:
• Non-engineered elements: The connection point aligns itself to the center of the element.
• Symbols: The connection point aligns itself to the center of the first element in the symbol, according to the element tree.
• Customized Connection Point: You can create a connection point location by drawing an ellipse where you want to anchor the connection point for the symbol. In the Ellipse Descriptor field, you can enter text stating it is an Anchor for the Connection Point. To hide the ellipse from view, either cover it up by another element (preferred method) or disable the Visible property for the element in the Property tree. In both cases, make sure that the ellipse is the first element in the Symbols element tree in the Element view.

For graphics and graphic templates only, you can specify the maximum number of connection lines to display. The default value of 65535 is used when the property Graphics > Max Connection Lines is left blank, in which case under normal circumstances all lines display with the Status and Commands window. If the actual number of connection lines associated with a Status and Commands window exceeds the number of connection lines specified in this property, then none of the lines display.

Drag-and-Drop
The Status and Commands window is a drag source for data point properties. When the Status and Commands window is expanded, you can drag a data point or one of its properties from the window to any of the drop targets in the Graphics Editor or other applications. You cannot drag-and-drop virtual data point properties, such as those properties that display No Properties or Not Available.
• Evaluation Editor: When you drop a data point property in the Expression field of the Graphics Editor’s Evaluation Editor, the current value of the property displays in the Result field for the element’s property.
• Ribbon: When you drop a data point property onto the ribbon, all the graphics associated with that data point display as tabbed graphics in the work area.
• Graphic Canvas: When you drop a data point property onto the canvas, the associated data point symbol displays on the graphic.

For a list of the drop sources in the Graphics Editor, see the Table of Graphics Drop Targets.

Tooltips
Tooltips are customizable properties that display as a yellow text box when you mouse-over an element or object on the active graphic. The text box for a tooltip contains descriptive text, the current value of the graphic object, and the names of the associated objects based on the view selected in System Browser. When you move your cursor over an object or element on the active graphic, an associated tooltip displays.

<table>
<thead>
<tr>
<th>Tooltips</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Static tooltip</td>
<td>Descriptive text entered into the tooltip property field that is associated with the general category in the Property Viewer.</td>
</tr>
<tr>
<td>2</td>
<td>Dynamic tooltip</td>
<td>Current tooltip text based on a tooltip evaluation, and the current field values. Evaluations are created in the Evaluation Editor.</td>
</tr>
<tr>
<td>3</td>
<td>Static link reference and link description</td>
<td>The name and description of the file linked to the element as entered in the Link Reference and Link Description fields from the Commands category in the Property Viewer.</td>
</tr>
<tr>
<td>4</td>
<td>Dynamic link reference and link description</td>
<td>The name and description of the associated link resulting from any evaluations on the Link Reference and Link Description fields. The text displayed depends on the current field values. Evaluations are created in the Evaluation Editor.</td>
</tr>
<tr>
<td>5</td>
<td>Data point references</td>
<td>The names of the objects and the System Browser view the name is based on. One line entry per object.</td>
</tr>
</tbody>
</table>
Zooming and Panning
The Graphics Viewer supports zooming and panning within the active graphic. Zooming allows you to magnify or reduce the graphic image, and panning allows you to move the graphic around on the canvas.

In **Zooming** mode, you can click and drag a rubber band rectangle around any area of the graphic. The rectangle represents the area that will be zoomed to full view once you release the mouse button. Pressing the **ESC** key cancels the rubber band rectangle function.

### 3.2.2 Graphics Viewer Workspace

The components that make up the **Graphics Viewer** consist of a toolbar, two views for navigating the active graphic, keyboard and mouse shortcuts, and tooltips. Review the following topics as needed:

#### Graphics Viewer Toolbar

The **Graphics Viewer** toolbar allows you to navigate to and work with graphic pages displayed in the **Graphics Viewer**. Use your cursor to select a toolbar button.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Allows you to toggle between the <strong>Graphics Viewer</strong> and the Graphics Editor. <strong>NOTE:</strong> Only displays if a Graphics Editor license is detected.</td>
</tr>
<tr>
<td><strong>Next Related Item</strong></td>
<td>Allows you to scroll to and display the next graphical related item associated with the selected data point in System Browser. Only enabled if the data point has more than one related graphical item.</td>
</tr>
<tr>
<td><strong>Previous Related Item</strong></td>
<td>Allows you to scroll to and display the previous graphical related item associated with the selected data point in System Browser. Only enabled if the data point has more than one related graphical item.</td>
</tr>
<tr>
<td><strong>Zoom In (+20%)</strong></td>
<td>Allows you to zoom in by + 20% on the active graphic with each mouse click.</td>
</tr>
<tr>
<td><strong>Zoom Out (-20%)</strong></td>
<td>Allows you to zoom out by - 20% on the active graphic with each mouse click.</td>
</tr>
<tr>
<td><strong>100%</strong></td>
<td>Displays the active graphic at 100% magnification.</td>
</tr>
<tr>
<td><strong>Home</strong></td>
<td>Returns the view of the displayed graphic to the state when the primary selection changed. For example, if the <strong>Next/Previous</strong> buttons have been used, selecting <strong>Home</strong> loads the first graphical related item.</td>
</tr>
<tr>
<td><strong>Zoom View</strong></td>
<td>Displays the Zoom view and allows you to zoom in on the active graphic by adjusting the slider.</td>
</tr>
<tr>
<td><strong>Aerial View</strong></td>
<td>Switches between Aerial View being visible or hidden in the <strong>Graphics Viewer</strong> area.</td>
</tr>
<tr>
<td><strong>Zoom Real</strong></td>
<td>Allows you to zoom in on the active graphic. To activate, click the icon. To de-activate, left-click anywhere on the graphic.</td>
</tr>
<tr>
<td><strong>Scale to fit</strong></td>
<td>Scales the graphic to fit in the viewing area. Once selected, the graphic resizes itself according to window size. Selecting the button, changing the Zoom selection, or loading another graphic, disables the feature.</td>
</tr>
<tr>
<td><strong>Point Centered display mode</strong></td>
<td>Moves the selected point to the center of the graphic.</td>
</tr>
</tbody>
</table>
Fit to Secondary Selection | Allows you to calculate the depth and the viewport from the current selection.

Depths Navigation View | Switches between Depths Navigation view being visible or hidden in the Graphics Viewer area. This view allows you to view a graphic content by depth, and by layer, or by discipline associated with a layer.

Show Status and Commands pane | Allows you to enable or disable the Status and Commands window from displaying.

Coverage Area mode | When this icon is enabled, it allows you to view the coverage areas on the graphic. When disabled, no coverage areas display on the graphic.

Page setup | Displays the Page setup view for the current graphic.

Print | Displays the Print dialog box to print the current graphic.

### Keyboard Shortcuts

Below is a list of available keyboard shortcuts you can apply to the active graphic or one of its children. A graphic is made active by clicking on the graphic. You can use a set of keyboard shortcuts to view the active graphic in the Graphics Viewer. Before applying any of the shortcuts, make sure the appropriate graphic is active by clicking on it.

<table>
<thead>
<tr>
<th>Press...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+A</td>
<td>Select all elements</td>
</tr>
<tr>
<td>HOME</td>
<td>Scroll to the left</td>
</tr>
<tr>
<td>END</td>
<td>Scroll to the right</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Scroll to the top</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>Scroll to the bottom</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Scroll up</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Scroll down</td>
</tr>
<tr>
<td>UP, LEFT, DOWN, RIGHT ARROWS</td>
<td>If not in Panning mode: Move selected elements by 1 pixel. If in Panning mode: Pan the view by 1 pixel. If modifying a line/polyline node: Move the node by 1 pixel.</td>
</tr>
<tr>
<td>CTRL+UP, CTRL+LEFT, CTRL+DOWN, CTRL+RIGHT ARROWS</td>
<td>If not in Panning mode: Move selected elements by the grid pixels. If in Panning mode: Pan the view by the grid pixels. If modifying a line/polyline node: Move the node by the grid pixels.</td>
</tr>
<tr>
<td>CTRL+0</td>
<td>Zoom = 100%</td>
</tr>
<tr>
<td>SPACEBAR</td>
<td>Activate Quick Panning mode. The previous tool mode is restored when the key is released.</td>
</tr>
<tr>
<td>MINUS SIGN</td>
<td>Zoom out (-20%)</td>
</tr>
</tbody>
</table>
### Mouse Functions

The following mouse functions are available in the active graphic once you have activated Zoom mode, either by clicking one of the zoom buttons on the toolbar or by pressing the Z-Key. You can use mouse button-wheel shortcuts to view the active graphic in the Graphics Viewer. Before applying any of the shortcuts, make sure the appropriate graphic is active by clicking on it.

<table>
<thead>
<tr>
<th>Click...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + MOUSE WHEEL</td>
<td>Zoom in and out (+ or - 20%)</td>
</tr>
<tr>
<td>LEFT MOUSE BUTTON</td>
<td>Zoom in (+20%)</td>
</tr>
<tr>
<td>RIGHT MOUSE BUTTON</td>
<td>Zoom out (-20%)</td>
</tr>
</tbody>
</table>

### Status and Commands Window

The Status and Commands window displays the following information about an object, its properties, and its status.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Icon</td>
<td>Displays the icon associated with the property type.</td>
</tr>
<tr>
<td>2 Object path and object name</td>
<td>The path and the name of the object.</td>
</tr>
<tr>
<td>3 Property name</td>
<td>Displays the name of one or more properties associated with the object the selected objects. If you select multiple objects of the same type in the system, the icon next to the property name indicates this with a triangular symbol in the lower right-hand corner. Clicking this symbol expands the table row to show all of the selected objects of the same type that share this property. You can then change all properties for the selected objects at the same time.</td>
</tr>
<tr>
<td>4 Current value</td>
<td>Displays the current value of each property.</td>
</tr>
<tr>
<td>5</td>
<td>Argument area and Progress/Result area</td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td></td>
<td>When you initiate a command that requires additional arguments, the required argument fields display for you to enter one or more arguments prior to sending the command. You must complete all required arguments before sending the command. An argument field that displays a red border around it means that the value for that property is invalid. You will need to enter a valid value before commanding the property. Displays the progress and then the result of a command, once you execute a command. During the command, the Progress/Result field displays Command in Progress, along with information about how many objects have been commanded and how many will be commanded all together. After a command execution is complete, successful commands display Success. Failed commands display the reason the command failed and, if you executed multiple commands, the number of failed commands.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| **6** | **Command area** | Displays the name of a command that you can initiate. If a command button has a triangle in the lower right-hand corner, the command has multiple buttons or options, and clicking on the triangle displays the options. Some commands are sent immediately after you initiate them by clicking on the **Command** button. Others require you to enter arguments before they can be sent. When a command requires arguments (additional fields requiring information to continue with the command), the property row will expand after you click the command button. You then complete the additional fields and click the appropriate button (**Send**, **Command**, etc.). Some object properties support grouping of command buttons under a single command button with a drop-down list of your choices. The button you choose from the drop-down list becomes the new commandable button in the group. The **Send** button displays only for commands that require additional arguments. Clicking the **Send** button sends a command after you have entered all required arguments. **Command Types:**

**Multiple Option Selection:**

Visual display of associated properties. Each slot represents a property option. If a property is selected, it is shaded. Moving your cursor over the slot allows you to view the property option; clicking on the slot allows you to select the option. |
| **7** | **Expand/Collapse button** | Allows you to expand, collapse, or close the window:

- Expands the **Status and Commands** window when icons display off-normal properties.
- Minimizes a **Status and Commands** window so that only the icons of the off-normal properties display. Closes a **Status and Commands** window completely, if there are no properties in an off-normal state. |
| **8** | **Scroll-view indicator** | Indicates whether more buttons are available, yet not visible, and where the buttons are displayed.

When you move the mouse over the scroll-view indicator, East-West cursor displays, and allows you to scroll through the commands.

- More command buttons are to the right of the last displayed button.
- More buttons are to the left of the first displayed button.
- There are more buttons on either side of the visible buttons. |
| **9** | **Scrollbar** | Displays when the window has run out of space, and allows you to scroll through the active properties. |

**Status and Commands Connection Lines**

Visibility of the connection line and its connection point are controlled as follows:

- A connection line and its connection point are only visible if the element is visible.
- An element is only visible when the layer is visible that contains the element.
- A layer is only visible if a depth is visible that contains that particular layer.
- A **Status and Commands** window is only displayed when there is at least one connection to an element.
Views
The Graphics Viewer provides you with two floating views, the Aerial View and the Graphic Navigation View, to help you navigate the active graphic. Both views can be resized and toggled to display or not, using the Graphics Viewer toolbar.

Aerial View
The Aerial View provides you with a bird’s-eye view of the active graphic at all times. The viewport rectangle, a rectangular shaped border within the Aerial View, provides a visual representation of the region that has the current focus. You can also draw a viewport rectangle in the area you would like to zoom in on, or click and drag the viewport to move to another location on the graphic.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewport Rectangle</td>
<td>Allows you to view graphics in part or as a whole.</td>
</tr>
</tbody>
</table>

Navigation View
The Graphic Navigation View allows you to customize and navigate through views of the active graphic by selecting a depth and then filtering, by discipline or by layer, which of the associated layers to display. If you choose to filter the layers by discipline, only the layers designated with that discipline display in the graphic view. Otherwise, if you filter on layers only, all the layers of the selected depth display in the Graphic Navigation View, and you can manually choose which layers will be visible in the current view of the graphic.
### Navigation View

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Selected Depth</td>
<td>Displays the active depth. Use the drop-down menu to select from a list of available depths.</td>
</tr>
<tr>
<td>2 Filtering</td>
<td>Allows you to select how to filter the layers associated with the selected depth. You can filter the layers by <strong>Discipline</strong> or by Layers.</td>
</tr>
<tr>
<td>3 Discipline Selection</td>
<td>Displays the discipline used to filter the associated layers with. Use the drop-down menu to choose from a list of available disciplines. The active graphic will only display layers designated with the selected discipline. This section is only active if you have selected to filter the depth by <strong>Discipline</strong>.</td>
</tr>
<tr>
<td>4 Layer Selection</td>
<td>Displays the list of available layers associated with the selected depth. If a layer is checked, the associated layer displays in the current graphic view. If unchecked, the layer does not display. This section is only active if you have selected to filter the selected depth of the graphic by <strong>Layer</strong>.</td>
</tr>
</tbody>
</table>

### 3.3 Alarms

This section provides reference and background information for handling events in Desigo CC. For instructions, see the step-by-step section.

#### 3.3.1 Event Handling

**How Operators are Alerted to Alarms**

Desigo CC displays all the detected alarms/events in Event List, with each one on a separate row. This is your main starting point for dealing with events. In addition:

- The Summary bar along the top of the screen provides an overview of the events in the system grouped by category. This lets you keep an eye on events even when in some Client Profiles Event List is collapsed to an event bar. A blinking indication signals when there are unprocessed events.
- An audible alert is sounded by the Desigo CC station when there are unprocessed events.
- In some Client Profiles, the highest category event is also displayed in an Event Detail bar underneath the Summary bar.

For details about these user-interface elements, see Overview of the Standard UI Client [→ 7].
Methods of Handling an Event

- Fast treatment. You can view information about events and send event-handling commands from directly inside Event List. This is the most straightforward method of handling an event. You can also send commands in the same way from the Event Detail bar, where available. For instructions, see Handling Events from Event List [➡ 40].

- Investigative treatment. To handle an event as you would in System Manager, you can open a dedicated window, with the event descriptor that displays along the top, and the object that caused the event already selected in System Browser. This feature enables you to:
  - Investigate the source of the event, check or command its properties, and so forth, using all the tools normally available in System Manager.
  - At the same time, you can send event-handling commands from the event descriptor at the top of the window, just as you would from inside Event List.
  For instructions, see Handling an Event with Investigative Treatment [➡ 44].

- Assisted treatment. If an operating procedure was configured for a specific event, the icon in the event button indicates that you can open a dedicated window, with the event descriptor displayed along the top, that provides a step-by-step checklist of actions you must complete for handling that situation. For example, these might include printing out a report, completing a form, reading a document, and so on. At the same time, you can send event-handling commands from the event descriptor at the top of the window, just as you would from inside Event List.
  For instructions, see Handling Events with Assisted Treatment [➡ 46].

Simultaneous Handling of Events by Different Operators

A Desigo CC installation can have one or more client stations from which operators monitor and respond to events.

- At any given time, you can see which operators and stations are handling an event. This information is available in the event button tooltip and in the In Process by column of the event descriptor.

- Even if an event is being handled by another operator/station, you can still also handle the same event from your own station, using any of the available methods. The only limitation is that:
  - If another operator/station is handling an event using assisted treatment, you cannot also initiate assisted treatment for that event.
  - However, you can still start investigative treatment, or send event-handling commands from within Event List.

The system continually updates the list of users who are handling the same event and removes any users who are disconnected for any reason.

Visibility of Events in the System

Your user visibility rights affect the specific events that the Summary bar and the Event List, Investigative Treatment, and Assisted Treatment windows display. If an event is generated by a point not visible to you in System Browser, it does not display on your Desigo CC station.

Validation for Event Handling

Validation might be required for commanding events. This means when an event occurs, to be able to send event-handling commands, the operator will be asked to provide a comment (Validation Profile = Enabled) or a comment and a password (Validation Profile = Supervised).
The event-handling comment that explains the reason for the action is recorded and stored in the Detail Log tab.

**Auto-Event Handling**
Desigo CC can be configured to automatically start the handling of certain events when specified conditions occur on the site. In this case, certain actions such as opening Event List or selecting the event might happen automatically, so you will not need to do them manually.

**Activity Log and Event Log**
During event treatment, entries are recorded in the History Database for the following:
- Operator’s activities relating to event handling (for example, initiating/suspending event handling, acknowledging/resetting an event, and so on). This log data is available when you generate an Activity Log report.
- Evolution of the events in the system (for example, a new event occurs in the system, an event is acknowledged/reset and so on), and progression through the operating procedure steps in assisted treatment (for example, an operating procedure is initiated or closed and so on). This log data is available when you generate an Event Log report.

For background information about Desigo CC activities and events historical data, see Log Viewer.

**Alarm Suppression**
If the alarm suppression feature is enabled on specific system objects, any events coming from those objects are suppressed in the management station. This means that any events relating to those objects will not be visible in the Summary bar and Event List, will not be available in the Event Log, and any event-based procedures (such as, event-handling procedures, reactions, or remote notifications) will not be activated. Anyway, unlike the out-of-scan feature, the objects properties are always updated even when alarm suppression is enabled.

When this feature is enabled for a specific object/subtree, it will suppress the next events that occur in the field panel. Any events detected prior to enabling this feature will remain visible in the Summary bar and Event List. When this feature is disabled for a specific object/subtree, any detected events relevant to that object/subtree display immediately in the Summary bar and Event List. You can check whether the alarm suppression is active for an object in the Alarm Suppression column (Enabled or Disabled) of the Textual Viewer. You can also filter the System Browser tree to display those system objects or generate a report of system objects affected by alarm suppression. For instructions, see Handling Alarm Suppression for System Objects [➙ 62].

When alarm suppression is present for at least a system object, the management station generates an event. Also, if alarm suppression is available for your configuration, this icon displays on the Summary bar with a tooltip that tells you the number of objects affected by alarm suppression.

### 3.3.2 Event Lamps
The events that occur in the building-control system are grouped into categories, which are color-coded by severity. Each category typically corresponds to an event lamp that displays in the Summary bar [➙ 11]. The number of lamps and their corresponding categories depends on the event schema.

Each event lamp shows the total number of events for that category, and how many of those are unprocessed (not yet acknowledged by the operator). An event lamp will also flash if there are any unprocessed events in its category.
When the Summary bar is collapsed to a slim bar, event information appears in a reduced format (event category abbreviation and the total number of events for that category), including also icons for any event timers or applied filters.

Figure 19: Event Lamp in Collapsed (Slim) Summary Bar

Figure 20: Event Lamp in Expanded Summary Bar

<table>
<thead>
<tr>
<th></th>
<th>Background color</th>
<th>Event counter</th>
<th>Event category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Indicates the category color of the event. The specific category colors employed are dependent on the event schema.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Shows the total number of events for that category present in Event List (second number), and how many of those are unprocessed (first number).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Descriptive name of the category. The specific category names employed are dependent on the event schema.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Lamp Display</th>
<th>Graphical Display</th>
<th>Background Color and Behavior</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Life Safety</td>
<td>Solid gray.</td>
<td>No events for that category.</td>
<td></td>
</tr>
<tr>
<td>Life Safety</td>
<td>Flashes from gray to the category color.</td>
<td>New events for that category have occurred in the system, and are still unprocessed.</td>
<td></td>
</tr>
<tr>
<td>Life Safety</td>
<td>Flashes from gray to the dark category color.</td>
<td>Filter by category activated. New events for that category have occurred in the system and are still unprocessed.</td>
<td></td>
</tr>
</tbody>
</table>
When you move the cursor over an event lamp, a tooltip provides the following information:

- Total number of events for this category
- Number of unprocessed (unacknowledged) events for this category
- Number of events for this category that have been acknowledged

### 3.3.3 Event List

The Event List window displays all the detected events with each one on a separate row. This window is your main starting point for dealing with events. For instructions, see the step-by-step section.

When opened, Event List displays in the main work area of the user interface [عون]. When it is closed, depending on the Client Profile Event List may be either entirely hidden or collapsed to a vertical bar down the left side of the screen.

The display of Event List is limited to 10000 event lines; if such limit is exceeded, the status bar of Event List will indicate the display limit and the total number of events detected (for example, 10000 of 50000).
### Event List Workspace

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Summary bar</td>
<td>Contains a set of event lamps that provide an overview of the events in the system. For more details, see Event Lamps [⇒ 207] and Summary Bar [⇒ 11].</td>
</tr>
<tr>
<td>2</td>
<td>Event Detail bar</td>
<td>In some configurations, prominently displays an event that requires immediate attention across the top of the screen.</td>
</tr>
</tbody>
</table>
| 3      | Title bar            | Depending on what you select, the title bar of the Event List window shows:  
  - Event List, if no event is selected in the list.  
  - Event location, if a single event is selected in the list.  
  - Number of events being processed, if multiple events are selected in the list.  
  - Details of the applied filter, if a filter is applied to the events, and no event is being processed.  
It also contains some icons to open/close the Contextual pane (6), and depending on the Client Profile, lock the layout and restore down the window. |
| 4      | Event button         | Graphic indicator of an event in the system. For more details, see the reference [⇒ 219] section.                                                                                                                                 |
| 5      | Event descriptor     | Contains the event button, event details and event-handling commands for the event currently being processed. For more details, see the reference [⇒ 215] section.                                                                 |
A contextual menu becomes available when you right-click the Event List column headers and provides you with options to customize the columns that display in Event List, and to print out the whole list of events.

**Events in Distributed Systems**

In distributed systems, to view the total number of events for an individual system, check—in the **Extended Operation** tab—the **Event Count** property of its Main Server.

### 3.3.4 Investigative Treatment Window

**Investigative Treatment Workspace**

- **Summary bar**
  - Contains a set of event lamps that provide an overview of the events in the system. For more details, see Event Lamps [➙ 207] and Summary Bar [➙ 11].

- **Event Detail bar**
  - In some configurations, prominently displays an event that requires immediate attention across the top of the screen.
## Assisted Treatment Window

### Assisted Treatment Workspace

1. **Title bar**
   - Shows the name of the *Investigative Treatment* window. It also contains some icons to open/close the *Contextual* pane (7), lock the layout and, restore down the window.

2. **Event descriptor**
   - Contains the event button, event details and event-handling commands for the event currently being processed. For more details, see the reference [>). 215 section. The background color reflects the event category color, but in a darker shade.

3. **Selection pane**
   - Contains System Browser which displays the highlighted event source.

4. **Primary pane**
   - Contains the system application (for example, *Graphics Viewer*) associated with the event source currently highlighted in System Browser.

5. **Contextual pane**
   - Displays by default and provides additional information, actions, and resources about the object that issued the event. The following tabs are available:
     - **Operation/Extended Operation**: Lets you inspect all the properties of the event source, and view and execute any commands/actions available for that object.
     - **Detailed Log**: Lets you view a detailed log of the currently selected event.
     - **Related Items**: Provides links to additional resources (for example, reports or event-handling procedures) that are relevant to the event source. If you click a related item, it opens by default in the *Secondary* pane.
1 Summary bar Contains a set of event lamps that provide an overview of the events in the system. For more details, see Event Lamps [➙ 207] and Summary Bar [➙ 11].

2 Event Detail bar In some configurations, prominently displays an event that requires immediate attention across the top of the screen.

3 Title bar Shows the name of the Assisted Treatment window. It also contains some icons to open/close the Contextual pane (7), lock the layout and, restore down the window.

4 Event descriptor Contains the event button, event details and event-handling commands for the event currently being processed. For more details, see the reference [➙ 215] section. The background color reflects the event category color, but in a darker shade. The icon in the event button indicates that the event is being processed by assisted treatment.

5 Selection pane Contains the list of operating procedure steps you must perform to process the event.

6 Primary pane The Default tab contains the system application associated with the currently selected step in the procedure.

7 Contextual pane Hidden by default. When open, it provides additional information, actions, and resources about the object that issued the event. The following tabs are available:

- **Operation/Extended Operation**: Lets you inspect all the properties of the event source, and view and execute any commands/actions available for that object.
- **Detailed Log**: Lets you view a detailed log of the currently selected event.
- **Related Items**: Provides links to additional resources (for example, reports or event-handling procedures) that are relevant to the event source. If you click a related item, it opens by default in the Secondary pane.

**Operating Procedures Steps Workspace**

When you open the Assisted Treatment window, the Selection pane on the left lists the steps of the guided procedure you must follow to handle the event. This list helps you select and carry out the steps in the correct sequence, which depends on how a procedure was configured. Additionally, depending on configuration, a step can be:

- Automatic or manual
- Mandatory or optional
- Repeatable or not repeatable
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Symbol that indicates a mandatory step.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Step identifier. This number may or may not correspond to the execution order.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Briefly describes the step type.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Depending on the step's configuration, you will see a white or gray check box:</td>
</tr>
<tr>
<td></td>
<td>• A tooltip tells you that you cannot check off the step because you have not done all the actions required to complete the step (for example, complete a remote notification procedure or fill out and save an event treatment report).</td>
</tr>
<tr>
<td></td>
<td>• A tooltip tells you that you can check off the step to mark it as completed.</td>
</tr>
<tr>
<td></td>
<td>Once you check off a step as executed, a checkmark icon displays in the place of the check box, to indicate that the step has been completed.</td>
</tr>
<tr>
<td><strong>5</strong></td>
<td>Graphically indicates the step's execution status as follows:</td>
</tr>
<tr>
<td></td>
<td>• in progress</td>
</tr>
<tr>
<td></td>
<td>• successfully executed</td>
</tr>
<tr>
<td></td>
<td>• failed</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Graphically indicates that the step is selected and the relevant application for performing that step is available in the Default tab of the Primary pane.</td>
</tr>
</tbody>
</table>

- Each step has the same color as the event's category. When you select a step, it expands and changes to a darker color to indicate that it is being executed. Once you complete a step, a graphic icon indicates the execution outcome of that step (successful or failed). 
- You must execute the first mandatory step before the following mandatory steps can be selected and executed.
Whether the steps must be executed sequentially, or may instead be freely executed in any order, depends on how the assisted-procedure was configured.

When you move your cursor over a step during the execution of an assisted procedure:
- If it turns into hand, this means that you can execute the step.
- If it turns into arrow, this means that you cannot execute the step because it is locked. This may happen if a preceding mandatory step has not been executed yet, or during the execution of sequential steps.

Once you have completed all the actions required by a step, the gray check box turns white and you can mark that step as completed.

The system provides the following details of a step in a tooltip: name, execution type (mandatory or optional), type (automatic or manual), state (unknown, successful, or failed), and notes (error message, if any). Also, once a step is executed, the name of the operator who executed the step displays in the tooltip. If a step fails, an error message displays in the tooltip or in the window status bar.

### Assisted Treatment License and Access Rights

Assisted treatment is covered by a license. If assisted treatment is not available, you can use the other event-handling methods provided by the system (fast treatment and investigative treatment). If the license is installed but later expires or is lost for any reason, assisted treatment is available only for those events that were already undergoing assisted treatment, and that have an associated operating procedure. If a new event occurs, fast treatment and investigative treatment will remain available.

In addition to the license, the availability of assisted treatment depends:
- On your user group rights. If you have no appropriate access permission, you cannot initiate assisted treatment.
- On the system configuration (that is, on whether an assisted procedure has been configured for handling a specific type of event. If there is no such procedure configured, investigative treatment is available instead.

### 3.3.6 Event Descriptor

The event descriptor is the individual row in Event List, that contains all the details about an event (for example, its cause, path, source, date and time, category, discipline, event status, source status, suggested action, available command, and so on). Each event descriptor also has an event button on the left-hand side that graphically summarizes some of the most important information about that event.

The event descriptor is your starting point for handling an event. You can send event-handling commands from directly inside the event descriptor by clicking the available command icon.

The exact appearance of the event descriptor depends on the Client Profile. Also, what columns display in the event descriptor and their order may vary depending on column customization. For instructions, see Customizing the Columns in Event List [➙ 57].

Note that:
Any changes you make to the columns in Event List will also apply to the Event Detail bar and to the Investigative Treatment and Assisted Treatment windows.

Changes to column settings will be automatically saved when you exit the Desigo CC client application, and so will persist across sessions. Note that column settings are specific to the user profile. This means that different users can have different column settings.

The following describes the columns of the event descriptor.

Event Button

Situated on the leftmost end of each event descriptor. Graphically summarizes that specific event. For more details, see the reference [→ 219] section.

You cannot move, resize, or remove the Event button column.

Cause

Description of the event followed by the condition (either numeric value or descriptive text) that caused the event. For example, Temperature too high (39°C), Fault (INACTIVE), and so on. This description changes when the event source passes from the Active to the Quiet state.

Path

Indicates the entire System Browser path of the object that issued the event. The path is expressed using names or descriptions, depending on the Display mode as well as the view selected in the System Browser drop-down list.

For BACnet Event Enrollment (EE) events, it displays the [name of the field networks] + [name of the network] to which the EE event belongs.

The following optional columns may also be available, for indicating the object's path in other ways:

- **Location** Concatenation of descriptions relating to the event source. (It follows the view selected in System Browser.)
- **Designation** Concatenation of names relating to the event source. (It follows the view selected in System Browser.)
- **Path [View]** Indicates the full path of the object in alarm in a specified System Browser view as follows:
  - Path [Management View]
  - Path [Application View]
  - Path [Logical View]
  - Path [Physical View]
  - Path [user view]

Depending on the System Browser views that are configured, multiple such columns may be available. How the path is expressed depends on the Display mode.

Message text

Text that consists of one of the following:

- For driver alarms, the most recent message that has come from the field panel at any alarm transitions.
- For workstation alarms, blank or the event cause. The same data also displays in the Information column.
Source
Indicates the object that issued the event. Whether the source name or description displays depends on the current display mode. For instructions, see Setting How Objects are Labeled in System Manager.

For workstation-based alarms, \([\text{object name}].[\text{property name}]\) displays in this column. How driver-based alarms display - \([\text{object name}]\) or \([\text{object name}].[\text{property name}]\) - depends on the specific driver.

For BACnet Event Enrollment (EE) events, the source text includes the EE instance that generated the event followed by the original source in parentheses.

The following optional columns may also be available, for indicating the event source in other ways:

- **Source Alias** Indicates a customer-assigned name used to identify the technical equipment within the building/facility.
- **Source Name** Indicates the event-source object using its name.
- **Source Description** Indicates the event-source object using its description.
  - **Source Description [view]** Indicates the event-source object using its description in a specified System Browser view. Depending on the System Browser views that are configured, multiple such columns may be available:
    - **Source [Management View]**
    - **Source [Application View]**
    - **Source [Logical View]**
    - **Source [Physical View]**
    - **Source [user view]**

In any type of Source column, you can click the \([\text{source}]\) text to jump to the event source in System Manager. For instructions, see Get More Information About the Event [ibling=42].

Counter
Counter for recurring events [ibling=225]. This column does not appear in the Investigative Treatment and Assisted Treatment windows.

Commands
Available commands for handling this event [ibling=221]. You can directly click the command icon/button to send the corresponding command.

You cannot remove or resize the Commands column.

Event Text
Displays information to operators or intervention forces relevant to the object that issued the event. Specifically, this is a custom text configured for normal and off-normal conditions.

Information
The following become visible only when the event descriptor is selected:

- **History Database** Displays the History Database dialog box for that Event ID, where you can add a note for the event. For instructions, see Log an Event Note [ibling=43].
- **Information text** Displays the information text, which indicates technical information (instructions for operators or intervention forces) about a field point. It also displays the same information shown in the Message Text column. The
intervention text may or may not be available to you. For instructions, see Get More Information About the Event [→ 42].

- (start investigative treatment) or (start assisted treatment). For instructions, see Start Investigative Treatment [→ 44] and Start Assisted Treatment [→ 47].

You cannot resize Information column.

**Event Status**
Describes the status of the event [→ 222]. For example: Unprocessed, Ready to be reset, and so on.

**Source Status**
Describes the status of the event source: Active (event source is in an off-normal condition) or Quiet (event source is back to normal).

**Date/Time**
Date and time when the event occurred. Typically, event time displays with resolution hh:mm:ss. However, in special cases, it will display with resolution hh:mm:ss:ms.

**ID**
Unique number that identifies the event. This number has an upper limit. The numbering restarts when this limit is reached.

**In Process by**
Indicates which user is processing an event. Depending on the type of Desigo CC client you are working on, one of the following may display:

- **Installed client**: [computer name]/[full name of the logged-on user]
  If the computer/user data was not specified in the configuration, [localhost]+[user’s short name] displays instead.
- **Web client or web app client**: Web Client/[Operator’s full name].

Furthermore, for recurrences [→ 225] of the same event, this column displays the entire list of computer/users that are processing that event. Depending on the Client Profile, recurring events may not be available.

**Suggested action**
Describes the next action [→ 222] the operator should take for handling the event.

**Category**
Describes the event category.
The events that occur in the building control system are grouped into categories, which are color-coded by severity. The specific category names and colors employed are dependent on the event schema.
Discipline

Describes the discipline to which the event belongs.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Discipline</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Building Automation" /></td>
<td>Building Automation</td>
</tr>
<tr>
<td><img src="image" alt="Building Infrastructure" /></td>
<td>Building Infrastructure</td>
</tr>
<tr>
<td><img src="image" alt="Energy Management" /></td>
<td>Energy Management</td>
</tr>
<tr>
<td><img src="image" alt="Fire" /></td>
<td>Fire</td>
</tr>
<tr>
<td><img src="image" alt="Management System" /></td>
<td>Management System</td>
</tr>
<tr>
<td><img src="image" alt="Notification" /></td>
<td>Notification</td>
</tr>
<tr>
<td><img src="image" alt="Security" /></td>
<td>Security</td>
</tr>
</tbody>
</table>

Tag

Lets you to tag/untag events [@61], so that you can selectively show/hide them in Event List. This button will be visible but inactive in the Event Detail bar, and the Tag column will not appear in investigative/assisted treatment.

3.3.7 Event Button

An event button is a graphic indicator that displays on the left side of an event descriptor [@215]. It graphically summarizes some of the most important information about that event.

An event button flashes until you acknowledge its associated event.

In some Client Profiles, when Event List is closed the event buttons remain still visible (as an Event bar) on the left-hand side of the screen.

1 Discipline icon Discipline [@218] of the event source.

2 Main background color of the button Event category. The events that occur in the building control system are grouped into categories, which are color-coded by severity. The specific category colors employed are dependent on the event schema.

3 Assisted treatment icon This icon is available for an event that can be handled in assisted treatment. For instructions, see Handling Events with Assisted Treatment [@46].
The background color indicates the source status, whether the event source is:
- **Active** (bar matches the background color).
- **Quiet** (bar is gray).

Next action to be taken. For more details, see Event Status and Suggested Action [➡ 222].

### Event Button and What it Tells You

<table>
<thead>
<tr>
<th>Button</th>
<th>Event Status</th>
<th>Source Status</th>
<th>Suggested Action</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Unprocessed" /></td>
<td>Unprocessed</td>
<td>Active</td>
<td>Acknowledge event</td>
<td>The event is unselected and not yet acknowledged, or you already selected the event, but you must still acknowledge it. The event button is flashing. The event lamp in the Summary bar corresponding to this category will also flash.</td>
</tr>
<tr>
<td><img src="image" alt="Unprocessed" /></td>
<td>Unprocessed</td>
<td>Quiet</td>
<td>Acknowledge event</td>
<td>The event source is back to normal.</td>
</tr>
<tr>
<td><img src="image" alt="Waiting for condition" /></td>
<td>Waiting for condition</td>
<td>Active</td>
<td>Wait for condition or Complete Operating Procedure</td>
<td>You acknowledged the event, but no further action is yet possible, and the Reset command is not available.</td>
</tr>
<tr>
<td><img src="image" alt="Ready to be Closed" /></td>
<td>Ready to be Closed</td>
<td>Active</td>
<td>Reset event</td>
<td>You already selected the event, and the Reset command is available.</td>
</tr>
<tr>
<td><img src="image" alt="Ready to be Closed" /></td>
<td>Ready to be Closed</td>
<td>Quiet</td>
<td>Reset event</td>
<td>The event source is back to normal. The Reset command is available.</td>
</tr>
<tr>
<td><img src="image" alt="Closed" /></td>
<td>Closed</td>
<td>Quiet</td>
<td>Suspend the event</td>
<td>The event was closed but is still selected. When you deselect the event, it disappears from Event List.</td>
</tr>
<tr>
<td><img src="image" alt="One of the previous event statuses" /></td>
<td>One of the previous event statuses</td>
<td>Active or Quiet</td>
<td>One of the previous suggested actions</td>
<td>The event source is in maintenance.</td>
</tr>
</tbody>
</table>
### 3.3.8 Event-Handling Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge the event</td>
<td>Available when event status = Unprocessed and suggested action = Acknowledge event.</td>
<td></td>
</tr>
</tbody>
</table>
| Reset the event          | In fast/investigative treatment: available when event status = Ready to be closed and suggested action = Close event.  
                           | In assisted treatment: available when event status = Ready to be reset and suggested action = Reset event. |                                                                      |
| Close the event          | Only for assisted treatment. Available when event status = Ready to be closed and suggested action = Close event. |                                                                      |
| Start Remote Notifications | Available only if a remote notification that can be sent/stopped by the operator was configured for the event. Operator must have application rights to start/stop remote notifications. For instructions see Start a Remote Notification from Event List [⇒ 162] and Stop a Remote Notification from Event List [⇒ 162]. |                                                                      |
| Stop Remote Notifications |                                                                             |                                                                      |
| Silence the field panel  | Available only where these commands have been configured for the field panel and event status is one of the following: Unprocessed, Waiting for condition, or Ready to be closed. |                                                                      |
| Unsilence the field panel |                                                                             |                                                                      |

**Visibility of Events and Commands**

- You cannot handle events generated by field points for which you do not have proper user privileges. Event though such events are visible to you, the related commands will not be available in Event List.

- While handling events, your ability to acknowledge, reset and/or silence/unsilence an individual field point/panel (sending an individual command) or all the panels belonging to the same network (sending block commands) depends on configuration.

- To execute the event-handling commands, (acknowledge, reset, or silence/unsilence), you must have proper user privileges, or the client station you work on must be the owner of the field panel.

- If you try to send block commands while an event filter is active, a message displays asking you to remove the filter. Deactivate the filter and send the (block) command.

**Security Rights on Event Category Commands**

The specific commands available to you for handling events belonging to different categories depend on the rights at users group or workstation level. This means that, for events belonging to the different event categories, Event List, Investigative Treatment, and Assisted Treatment windows display only the commands that you are allowed to send. For a specific event category, if you do not have rights to send one or more commands, these commands do not display on Event List, Investigative Treatment, and Assisted Treatment windows of your Desigo CC management station.
### 3.3.9 Event Status and Suggested Action

<table>
<thead>
<tr>
<th>Event Status</th>
<th>Suggested Action</th>
<th>Icon in event button</th>
<th>Fast / Investigative Treatment</th>
<th>Assisted Treatment</th>
</tr>
</thead>
</table>
| Unprocessed           | Acknowledge event        | ✔                    | The event is new and still unprocessed. This means that you either did not yet select the event, or that you selected it but did not acknowledge it yet.
|                       |                          |                      |                                        | In assisted treatment, you selected an event and the source status is back in normal condition. The Reset command is available. |
| Ready to be reset     | Reset event              | ✔                    | Not applicable                         | You selected an event and the Reset command is available. You reset an event, and all the mandatory steps of the assisted procedure were executed. The Close command is available. |
| Ready to be closed    | Reset event              | ✔                    | You acknowledged the event but cannot reset it yet. | You acknowledged the event but cannot reset it yet because you must first complete all the mandatory steps of the assisted procedure. |
| Waiting for condition | Wait for condition       |                      | -                                      | -                                                                                   |
|                       | Complete Operating       |                      | You acknowledged the event but cannot reset it yet because you must first complete all the mandatory steps of the assisted procedure. | -                                                                                   |
| Closed                | Suspend the event        | -                    | You reset the event, and the source status is back in normal condition. You can clear the event. | You closed the event and now you can clear it.                                      |

#### 3.3.9.1 Acknowledgment Models for Station-based Events

The following acknowledgment models are for station-based events:
- ACK and Reset required
- No Reset (ACK only required)
- No ACK, No Reset
- Optional ACK, No Reset
# Fast/Investigative Treatment Workflow

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACK and Reset required</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event handling not started yet (no event-handling command sent yet)</td>
<td>Unprocessed Waiting for condition Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>No Reset (ACK only required)</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>or not started yet (no command sent yet)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>No ACK, No Reset</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Waiting for condition Closed</td>
</tr>
<tr>
<td></td>
<td>or not started yet (no command sent yet)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>Optional ACK, No Reset</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>or not started yet (no command sent yet)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
</tbody>
</table>

# Assisted Treatment (with Mandatory Steps) Workflow

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACK and Reset required</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Unprocessed Waiting for condition Ready to be reset Waiting for condition (due to mandatory steps) Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Event handling not started yet (and no event-handling command sent yet)</td>
<td>Unprocessed Waiting for condition Ready to be reset Waiting for condition (due to mandatory steps) Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
<tr>
<td>No Reset (ACK only required)</td>
<td>• Event handling started (and at least one event-handling command sent)</td>
<td>Unprocessed Waiting for condition Waiting for condition (due to mandatory steps) Ready to be closed Closed</td>
</tr>
<tr>
<td></td>
<td>• Event source back to Quiet</td>
<td></td>
</tr>
</tbody>
</table>
**Assisted Treatment (Without Mandatory Steps) Workflow**

<table>
<thead>
<tr>
<th>Acknowledgment Model</th>
<th>Scenario</th>
<th>Event Status</th>
</tr>
</thead>
</table>
| ACK and Reset required | • Event handling started (and at least one event-handling command sent)  
• Event source back to Quiet | Unprocessed  
Waiting for condition (due to mandatory steps)  
Ready to be closed  
Closed |
|                      | • Event handling not started yet (and no event-handling command sent yet)  
• Event source back to Quiet | Unprocessed  
Waiting for condition  
Ready to be reset  
Ready to be closed  
Closed |
| No Reset (ACK only required) | • Event handling started (and at least one event-handling command sent)  
• Event source back to Quiet | Unprocessed  
Waiting for condition  
Ready to be closed  
Closed |
|                      | • Event handling not started yet (and no event-handling command sent yet)  
• Event source back to Quiet | Unprocessed  
Ready to be reset  
Ready to be closed  
Closed |
### 3.3.10 Event Sorting

- If there are no arrows in any of the column headers, it means the default Event List sorting is applied.
- In some Client Profiles:
  - A small up or down arrow in one of the column headers in Event List indicates that a non-default sorting order was applied. For instructions, see Changing the Sorting of Events [➙ 62].
  - In the case of recurring events [➙ 225], the sorting only applies to the parent event. Any individual recurrences of an event are always sorted by date and time in ascending order, under the parent, and you cannot change this order.

### 3.3.11 Recurring Events

A recurring event occurs when the same event source repeatedly generates the same condition. More specifically, this happens when the same property of a field point continuously switches between the active and quiet states. For instructions, see Handling Recurrences of an Event [➙ 56].

If allowed by the Client Profile, in Event List, recurring events are grouped together under a parent event, which acts as a container for them. The parent event has a **Counter** field in its event descriptor that indicates the total number of occurrences. This counter automatically increments whenever the same event recurs.

**Information Contained in the Parent Recurrent Event**

The parent event descriptor always displays the most recent recurrence of the event, (which also corresponds with the topmost recurrence of the set), along with the following summary information:

- **Event Status** of the most important recurrence (priority order is Unprocessed, Waiting for condition, then Ready to be closed)
- **Source Status** of the most recent recurrence
- **ID** of the event identified by [...] indicating the range between the first and the last recurrence (for example, 3201...3245)
- **Counter** indicating the total number of times this event has recurred.

**Children of a Recurring Event**

You can expand a recurring event by clicking its **Counter** field. The children of a recurring event display under the parent event. The children are always sorted by date and time in ascending order, irrespective of what sorting [➙ 225] is applied to Event List.
**Tags and Filters Applied to Recurring Events**

When you apply tags or filters to Event List:

- Tagging/untagging a parent event affects all its child recurrences.
- You can also separately tag/untag an individual child recurrence.
- If you tag a recurring event (parent plus all its children) and apply a *Hide tagged events* filter, a new recurrence of that event will cause only the parent event to display again, along with the new recurrence. (The other recurrences will remain hidden).
- The *Counter* field in the parent event always shows the total number of recurrences, irrespective of whether they are tagged, untagged, or filtered.
- When filtering recurring events, the filter applies only to the parent event, except for the *Filter by Tag* that also applies to any child recurrences.

**Assisted or Investigative Treatment of Recurring Events**

You can start investigative/assisted treatment of a recurring event in the same way that you would for a non-recurring event. For instructions see Handling an Event with Investigative Treatment [→ 44] and Handling Events with Assisted Treatment [→ 46].

In the case of assisted treatment, depending on configuration you may be able to follow an assisted procedure for each child recurrence separately, or there may be a single assisted procedure that applies to the entire set of recurrences.

### 3.4 Scheduling

The Schedules component of the management platform enables you to:

- Set up schedules to automate the operation of the building control site:
  Schedules are defined on a weekly and daily basis. You can specify a different hourly timetable for each day of the week. For example, you could schedule a heating system to work from 9 a.m. to 6 p.m. on Mondays and Fridays and from 8 a.m. to 8 p.m. on Tuesdays, Wednesdays, and Thursdays.

- Set up exception calendars, which can be associated to schedules: Calendars define dates (or date ranges) during which a schedule does not apply. For example, you could create a holiday calendar that overrides the regular heating schedule to reduce energy costs. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). Then you can associate one or more schedules with the calendar.

You can configure schedules and calendars to execute centrally, on the management platform as well as locally, directly on the BACnet field panel. You can set up multiple schedules and exception calendars to run at the same time.
This section provides background information on Schedules of Desigo CC. For related procedures, see the step-by-step section.

### 3.4.1 BACnet Schedules

You use BACnet scheduling to automatically command points at prescribed time intervals. You can create daily or weekly schedules for BACnet field panels. Each BACnet panel stores its own calendar and schedule objects, and a BACnet panel can store and run multiple calendars or schedules at the same time. Because BACnet schedules reside in and are executed by field panels, they run even if the management station they are associated with is not running. BACnet schedules handle only BACnet objects (management station schedules can handle both BACnet and non-BACnet object types).

You can also configure commands to control BACnet objects related to your schedules. For example, you want to create a command that turns lights on and maintains room temperature at 72°F (22.22°C) when the room is occupied. When the room is unoccupied, the command would turn lights off and maintain the room temperature at 65°F (18.33°C). In this scenario, you could create a command with an entry for Occupied/Unoccupied, save it, and then drag it from System Browser to a schedule of your choice. The schedule will determine what time the command executes, the start and end dates, and the frequency of repetition.

BACnet calendars allow you to override a scheduled event. In this sense, you can consider them as exception schedules, consisting of dates only. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). All calendars are associated with a schedule. If you want to reduce energy costs in your building during company holidays, for example, you could create a holiday calendar. On these days, your calendar might command the system to reduce the output of heating or cooling systems when the building is unoccupied.

Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

**BACnet Schedule Workspace**

This section provides an overview of the BACnet Schedule workspace.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Schedule Name</td>
<td>Displays the name of the schedule.</td>
</tr>
<tr>
<td>2 Scheduler Toolbar</td>
<td>Includes the following icons: New: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table. Save: Saves the schedule to the system. Save As: Allows you to save another instance of the schedule with a different name and description. Delete: Deletes the schedule from the system.</td>
</tr>
<tr>
<td>3 Tabs</td>
<td>Displays four tabs: Schedule Entries, Outputs, Exceptions, and Setup. Schedule Entries: Displays a list of entries for the selected date. Outputs: Outputs are objects associated with the schedule. You can drag-and-drop objects to any tab to add them to the schedule. Dropping them on a tab other than the Outputs tab makes the Outputs tab active. Selecting an object in this section sends data about the object to the Operation and Extended Operation tabs, where you can view additional information about the object and make changes to it. Double-clicking an output makes it the new primary selection. Exceptions: Displays a list of exceptions for the selected date and allows you to set the precedence of the exception, the exception period, and detailed settings for day, month, year, and the recurrence pattern. For calendar exceptions, you can choose a calendar object from a drop-down list. Adding an exception makes the Exceptions tab active. You can create an exception by right-clicking the schedule or by clicking the New button in the Exceptions tab. Setup: Displays common schedule information such as the Present Value of an object, the type of object, the default value for the object, a Release (NULL) check box, and the data type of the schedule outputs for this schedule. By default, the system automatically creates weekly schedule entries for the default state, which you can modify. The Release (NULL) check box allows you to bypass the established priority and return an object to its default value. For example, to return control to lower priority commands, check the Release (NULL) check box for the schedule default, and then create a schedule entry with the Default check box checked. This will write BACnet null to the priority slot for the schedule, returning control to the system. Within this tab, you can also select the command priority. The Present Value of some object types is based on a command priority and established in a hierarchy that ranks from highest (1 – Manual Life Safety) to lowest (16 - Available). The hierarchy determines which source has priority over another to change the value of an object. To command one of these object types, you—or an application—must have a command priority equal to or greater than the current command priority of the object. Typically, PPCL is set to priority 16, and schedules are set to priority 15. The schedule range displays a predetermined range for an object type. The first object dropped in the Schedule Output section for that type determines the range that is displayed. For example, for an analog output such as a room temperature set point, you might see a range of 69 – 75 degrees Fahrenheit (20.56 – 23.89 degrees Celsius).</td>
</tr>
<tr>
<td>4 Calendar</td>
<td>Allows you to select a day to view or create schedule entries. When first displayed or refreshed, the current day is selected by default. By default, every new schedule begins with the current date and never ends. Once a new schedule is opened, you can choose the start and end date for the schedule.</td>
</tr>
</tbody>
</table>
Schedule

When first displayed or refreshed, the current day is selected by default.

**Day tab:** Displays a schedule for the day selected in the **Date Picker**. Selecting the **Detail** check box reveals calendar entries, weekly schedule entries, and exception schedule entries. The **Day** tab also displays a horizontal time bar indicating the current time.

**Week tab:** Displays the weekly schedule. You can click any day of the week to view details. This tab also displays a horizontal time bar indicating the current time.

**NOTE:** You can schedule entries from the weekly view, however, the weekly view shows only the resulting schedule and not the details of the schedule. For more flexibility in visualizing and creating schedule entries, you can use the detail column of the daily view.

**Current Time Indicator**

Displays a light-blue bar indicating the time of day.

BACnet Calendar Workspace

This section provides an overview of the BACnet Calendar workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New Button</td>
<td>Opens a new calendar entry.</td>
</tr>
<tr>
<td>2 Applied Schedules</td>
<td>Displays a list of schedules referencing the calendar. Clicking a schedule in this section sends data about the object to either the <strong>Operation</strong> or <strong>Extended Operations</strong> tab.</td>
</tr>
<tr>
<td>3 Scheduler Toolbar</td>
<td>Includes the following icons: <strong>New:</strong> Opens a new BACnet Schedule, new Management Station Schedule, new BACnet Calendar, new Management Station Calendar or new BACnet Command Table. <strong>Save:</strong> Saves the calendar to the system. <strong>Save As:</strong> Saves another instance of the calendar with a different name and description. <strong>Delete:</strong> Deletes the calendar from the system.</td>
</tr>
<tr>
<td>4 Calendar Name</td>
<td>Displays the name of the calendar.</td>
</tr>
<tr>
<td>5 Date Picker</td>
<td>Displays a monthly calendar with entry dates highlighted. When first displayed or refreshed, the current day is selected by default.</td>
</tr>
<tr>
<td>6 Calendar Entries</td>
<td>Displays a list of entries representing a specific date, date range, or days of the week. The <strong>Advanced</strong> check box provides detailed settings for day, month, year, and the recurrence pattern.</td>
</tr>
</tbody>
</table>
BACnet Command Workspace
This section provides an overview of the BACnet Command workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New Button</td>
<td>Opens a new command table.</td>
</tr>
<tr>
<td>2 Scheduler Toolbar</td>
<td>Includes the following icons:</td>
</tr>
<tr>
<td></td>
<td>New: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, New BACnet Command Table, or New Management Station trigger.</td>
</tr>
<tr>
<td></td>
<td>Save: Saves the command object to the system.</td>
</tr>
<tr>
<td></td>
<td>Save As: Allows you to save another instance of the command object with a different name and description.</td>
</tr>
<tr>
<td></td>
<td>Delete: Deletes the command object from the system.</td>
</tr>
<tr>
<td>3 Command Name</td>
<td>Displays the name of the command.</td>
</tr>
<tr>
<td>4 Command Attributes</td>
<td>Displays the command object attribute, the panel it is associated with, the text group associated with the object, and the schedules controlling the command.</td>
</tr>
<tr>
<td>5 Command Table Action List</td>
<td>Displays command tables with additional detail when you select an entry row. The Move Up and Move Down arrows allow you to re-order entries within a command table. Further detail can be displayed by clicking the <strong>Advanced</strong> button.</td>
</tr>
</tbody>
</table>

**NOTE:**
Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

This section provides the general reference information on BACnet schedules. To get started with workflows and procedures, navigate to the step by step [68] section.

### 3.4.2 Management Station Schedules
You can create daily or weekly schedules for your management stations, and a management station can run multiple calendars or schedules at the same time. Management station schedules and calendars run only if the management station is running.

Management station schedules have only one binary output (value active or inactive). You can assign several objects to that output. For each assigned object, you can select the mode of action for the output value. Additionally, management
station schedules can process both BACnet and non-BACnet object types (BACnet schedules process only BACnet object types).

You can also create exceptions to schedules. When a management station exception is ON, it overrides the weekly schedule. When the exception is OFF, control returns to the weekly schedule.

Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

This section provides the general reference information on management station schedules. To get started with procedures, navigate to the step by step section for management station schedules.

**Weekly Management Station Schedule**

In the case of a weekly schedule, specify the Active or Inactive values only once. These values are applicable for the entire week and for the complete duration of the schedule. You create a weekly schedule from the Sub-Type drop down list in the Setup tab. In this case, the schedule will not trigger an Inactive value at mid night as an Active entry is added at 12.00 a.m from the Schedule Entries tab. The last state of the day will be retained post mid night until the next day schedule entry is triggered.

**Example 1: Active Value: 50, Inactive Value: 60:**

Time period for the schedule (Active : 12:00 a.m., Inactive : 9:00 a.m., Active : 6:00 p.m.)
In this example, the Active status of the schedule set at 6 p.m. continues till 9 a.m. the next day. There is no change of value at midnight because the active status continues as it finds the same active entry at 12.00 a.m. midnight.

<table>
<thead>
<tr>
<th>Time</th>
<th>Mon</th>
<th>Tues</th>
<th>Wed</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:00 AM</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>10:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:00 AM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6:00 PM</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>7:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:00 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:59 PM</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example 2: Active Value: 50, Inactive Value: 60:**
Time period for the schedule (Active: 9:00 a.m., Inactive: 6:00 p.m.)
In this example, the Inactive status of the schedule set at 6 p.m. continues till 9 a.m. the next day. There is no change of value at midnight. This is because the Inactive status continues as it does not find an Active entry at 12.00 a.m. midnight. If there is no entry post midnight, then it is by default considered as an Inactive state. However, if the Inactive state is to be discontinued then an Active entry is to be added at midnight.

In case of night shifts, it is recommended that you create a weekly schedule.
Daily Management Station Schedule

You can create a daily schedule from the Sub-Type drop down list in the Setup tab and specify either similar active or inactive values for all days of the week or different values for individual days from the Schedule Entries tab.

The daily schedules are treated as single day schedules that are valid till 11.59 PM. Post mid-night the next day's daily schedule is functional. For example, the daily schedule for Monday, will be functional from 12.00 AM to 11.59 PM.

The daily schedule will trigger an Inactive value at mid night. The last state of the day will not be retained post mid night until the next day schedule entry is triggered.

Consider a schedule with the time periods, Active : 12:00 a.m., In-Active : 9:00 a.m., Active : 6:00 p.m. In this case, even though the value is set to active at 6 p.m., there is a switchover from Active to Inactive at around 11:59 p.m. Post midnight at 12.00 a.m., this value changes back to Active.

Management Station Schedule Workspace

This section provides an overview of the Management Station Schedule Workspace.
### Name | Description
---|---
1 Schedule Name | Displays the name of the schedule.
2 Scheduler Toolbar | Includes the following icons:
- **New**: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table.
- **Save**: Saves the schedule to the system.
- **Save As**: Allows you to save another instance of the schedule with a different name and description.
- **Delete**: Deletes the schedule from the system.
3 Tabs | Displays four tabs: **Schedule Entries**, **Outputs**, **Exceptions**, and **Setup**.
- **Schedule Entries**: Displays a list of entries for the selected date and **Output values**. The **Output values** indicate the ON and OFF values for Daily schedules only. For weekly schedules the Output values are present in the **Setup** tab.
- **Outputs**: Outputs are objects associated with the schedule. You can drag-and-drop objects to any tab to add them to the schedule. Dropping them on a tab other than the Outputs tab makes the Outputs tab active. Selecting an object in this section sends data about the object to the Operation/Extended Operation tabs, where you can view additional information about the object and make changes to it. Double-clicking an output makes it the new primary selection.
- **Exceptions**: Displays a list of exceptions for the selected date and allows you to set the exception period, including a recurrence pattern. For calendar exceptions, you can choose a calendar object from a drop-down list. This tab also displays schedule entries and ON and OFF values. Adding an exception makes the Exceptions tab active. You can create an exception by right-clicking the schedule or by clicking the New button in the Exceptions tab.
- **Setup**: Allows you to specify the type of schedule (Weekly or Daily) that you want to create. You can specify the type of schedule by selecting either Weekly or Daily from the Sub-Type drop down list. You can also specify the start date and end date for the schedule from the Setup tab. The Any date check box next to the Start date defaults to the current date, whereas the Any date check box next to End date, defaults to an infinite date.
4 Date Picker | Allows you to select a day to view or create schedule entries. When first displayed or refreshed, the current day is selected by default. By default, every new schedule begins with the current date and never ends. Once a new schedule is opened, you can choose the start and end date for the schedule.
5 Schedule | When first displayed or refreshed, the current day is selected by default.
- **Day Tab**: Shows a schedule for the day selected in the Date Picker. Selecting the Detail check box reveals calendar entries, weekly schedule entries, and exception schedule entries. The Day tab also displays a horizontal time bar indicating the current time.
- **Week Tab**: Displays the weekly schedule. You can click any day of the week to view details. The Week tab also displays a horizontal time bar indicating the current time.
- **NOTE**: You can schedule entries from the weekly view, however, the weekly view shows only the resulting schedule and not the details of the schedule. For more flexibility in visualizing and creating schedule entries, you can use the Schedule Entries tab.
6 Current Time Indicator | Displays a light-blue bar corresponding to the time of day.
Management Station Calendar Workspace

This section provides an overview of the Management Station Calendar Workspace.

Calendars allow you to override scheduled switch commands. In this sense, you can consider calendars as exception schedules, consisting of dates only. When you create a calendar, you can choose specific dates (January 15), a date range (August 1 – 31), or a week and a day you want the exception to run (third week of the month, on Wednesday). All calendars are associated with a schedule. For example, if you want to reduce energy costs in your building during company holidays, you can create a schedule with a calendar reference exception that commands equipment into holiday mode.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 New Button</td>
<td>Opens a new calendar entry.</td>
</tr>
<tr>
<td>2 Applied Schedules</td>
<td>Displays a list of schedules referencing the calendar.</td>
</tr>
<tr>
<td>3 Scheduler Toolbar</td>
<td>Includes the following icons: New: Opens a New BACnet Schedule, New Management Station Schedule, New BACnet Calendar, New Management Station Calendar, or New BACnet Command Table. Save: Saves the calendar to the system. Save As: Allows you to save another instance of the calendar with a different name and description. Delete: Deletes the calendar from the system.</td>
</tr>
<tr>
<td>4 Calendar Name</td>
<td>Displays the name of the calendar.</td>
</tr>
<tr>
<td>5 Date Picker</td>
<td>Displays a monthly calendar with entry dates highlighted. When first displayed or refreshed, the current day is selected by default.</td>
</tr>
<tr>
<td>6 Calendar Entries</td>
<td>Displays a list of entries representing start and end dates and recurrence patterns.</td>
</tr>
</tbody>
</table>
### 3.4.3 Timeline Viewer

**Timeline Viewer** allows you to view the details of multiple management station and field panel schedules simultaneously, spanning a range of time. To do this, System Manager must be in Operating mode.

**Timeline Viewer Workspace**

This section provides an overview of the Timeline Viewer Workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Time Range Scrollbar</td>
<td>Allows you to control the date range of schedules.</td>
</tr>
<tr>
<td>2 Schedule Name</td>
<td>Displays the name of the schedule with schedule details appearing on the row below it.</td>
</tr>
<tr>
<td>3 Schedule Details</td>
<td>Hovering on an interval displays a tool tip with schedule details. Intervals also use color coding and hatch marks to provide basic information at a glance. Schedule details are view only.</td>
</tr>
</tbody>
</table>
| 4 Timeline Toolbar | Includes the following time-adjustment controls:  
**Show Today:** Allows you to return to today’s date and does not affect any preset time period you have chosen.  
**Preset Time Periods:** Allows you to choose one of six viewing options: 12 hours, 1 day, 3 days, 1 week, 2 weeks, or 1 month.  
**Zoom In:** Allows you to decrease the viewable span of the timeline (decrease the preset time periods).  
**Zoom Out:** Allows you to increase the viewable span of the timeline (increase the preset time periods). |
| 5 Date            | Displays the date you are currently viewing. The date changes when you use either the Preset Time Spans or the Time Range scrollbar. |

**Time Range Scrollbar**

The Time Range scrollbar offers another way to control the displayed time span of schedules. The shorter the time span—one day, for instance—the more detail you can view. The longer the time span—one month, for instance—the less detail you can view.

The Time Range scrollbar contains a repeat function to make working with time ranges easier. Clicking to the left or right of the slider on the scrollbar moves it in the selected direction for the corresponding time range.
Preset Time Periods
You can click the **Zoom to Preset Time Period** icon on the **Timeline Viewer** toolbar to select how much of the timeline is visible at once. The choices are 12 hours, 1 day, 3 days, 1 week, 2 weeks, or 1 month.

The **Timeline Viewer** accepts a maximum of 50 schedules. The fewer schedules you view, the more options you have with the preset time periods. The more schedules you view, the fewer options you have with the preset time periods.

**View Details in the Timeline Viewer**
By moving your cursor over an entry in the **Timeline Viewer**, you can view schedule details, but you cannot edit them. Double-clicking a schedule’s details, however, sends the selection to the **Default** tab where you can edit the schedule.

**Color Indicators**
A gray interval indicates that nothing has been scheduled for that period, and the schedule is in its default mode of operation. Other colors in the intervals indicate that something has been scheduled.

- If colors are assigned to the schedule from the text table, they will appear in the **Timeline Viewer**.
- If colors are not assigned to the schedule from the text table, they will default to blue.

**Interval Types**
Intervals are classified as one of four types:

- Default—not scheduled intervals (gray)
- Normal—scheduled intervals (solid colors)
- Exception—scheduled overrides to the normal schedule intervals (color-coded hatch marks)
- Inactive—not active interval (gray hatch marks)

This section provides the general reference information on timeline viewer. To get started with procedures, navigate to the step by step ([→ 74] section for timeline viewer.)
3.5 Reports

The main function of the reports application in Desigo CC is to collect data from the runtime system and allow you to present this data in a customized manner. This section provides background information on Reports of Desigo CC. For related procedures, see the step-by-step section.

3.5.1 Overview of Reports

A report is a formatted and organized presentation of data. The reports application lets you configure and produce a variety of reports on the functioning of the management platform. In order to view the reports application, you must have the Show privilege.

You can use reports as a reference or as a troubleshooting mechanism. Reports are helpful during system operation. For example, you can:

- View a mixed report containing:
  - A table displaying details of all active events for a floor of a building
  - A table displaying a history report of events
  - A trends plot displaying the temperature variations gathered from temperature sensors
- Export trend data for statistical analysis to:
  - An XLS file
  - A CSV file (according to the EMC requirement)
- Schedule production of a report using macros and reactions
- Send a report to someone using email, to a printer as a .pdf, or to a folder as a file
- Export and import report definitions and logos.

Following are the important reports that you can configure using the Reports application.

Objects Report
An Objects report contains an Objects table that displays the run time property values of system objects. To know the property values of any object, such as present value, high limit, low limit and so on, you must configure an Objects report. Each object has a corresponding object model associated with it. An object model specifies the properties applicable to the object type, configuration attributes of properties, and additional settings like data type of the property, text group configured for the property, commands defined for the property and so on. Each property value has configuration attributes like property name, property descriptor, unit, resolution, minimum and maximum value, and so on. For example, the Present Value property has attributes such as Unit, Resolution, Type, Descriptor and so on. The Objects report also provides information on these attributes.
The properties applicable to an object type can be displayed as columns in the Objects table by setting the appropriate display levels in the Properties expander in the Models and Functions tab. In the following screenshot, the AlarmFault and Alarm.OffNormal properties cannot display as table columns since their display levels are not set.

If a property has array attributes assigned to it, then the text entries in the text group associated with the array attributes of the property can be set as the attribute columns in the Objects table. For example, the Event_Time_Stamps property of the BACnet Analog Input object type has the TxG_BACnetEventTransitionBits Text group associated with its array attributes. You can set the text entries of the text group (To Off Normal, To Fault, To Normal) to display as columns in the Objects table.

**Activities Report**

The Activities report provides information on system activities over a period of time. For example, you can generate an Activities report to get the treatment-related information logged in the database for activities.

You can create and configure an Activities report if you want to determine the number of times the present value property of an Analog Input object has exceeded 100 in the last 24 hours. In order to monitor the change of value of any property in the activities report, you must ensure that the AL attribute for the property is selected for the respective Analog Input object. For this you must navigate to the Properties expander in Object Configurator.
Constraints
The following constraints apply to the Activities report.

- You cannot sort or apply Condition filters for the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>Error</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>DPE Name 1</td>
</tr>
<tr>
<td>Type</td>
<td>DPE Name 2</td>
</tr>
<tr>
<td>Subtype</td>
<td>Associated Object Description</td>
</tr>
<tr>
<td>Object Description</td>
<td>Associated Object Name</td>
</tr>
<tr>
<td>Object Name</td>
<td>Associated Object Designation</td>
</tr>
<tr>
<td>Object Property</td>
<td>Associated Object Location</td>
</tr>
<tr>
<td>Quality</td>
<td>Associated Object Name (Internal)</td>
</tr>
<tr>
<td>Previous Quality</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td>Object Location</td>
<td></td>
</tr>
<tr>
<td>Object Location [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Management View]</td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td></td>
</tr>
<tr>
<td>Associated Object Description</td>
<td></td>
</tr>
<tr>
<td>Associated Object Name</td>
<td></td>
</tr>
<tr>
<td>Associated Object Designation</td>
<td></td>
</tr>
<tr>
<td>Associated Object Location</td>
<td></td>
</tr>
<tr>
<td>Associated Object Name (Internal)</td>
<td></td>
</tr>
<tr>
<td>Alias [Associated Object]</td>
<td></td>
</tr>
<tr>
<td>Alias [Object]</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
</tr>
</tbody>
</table>
- When you add a Condition filter to the Activities table, you cannot apply the OR operator between two filter expressions that are located on two different columns.
- You can apply the OR operator between two filter expressions set on the same column.
- You cannot apply the NOT operator in the Condition filter for an Activities table. For example, NOT 'Action' = "Add Camera" is invalid.

**Event Details Report**
The Event Details report provides information related to events and their treatment. When you run the report, the preliminary details of the event such as Event Time, Event Category, Event Cause, Event ID, Object Description, and Object Designation display as parent records. Additional information related to the treatment of the event such as Time, Action taken, Message text, User Name, Management Station, Attachment, Value, and Previous Value display as child records. The child records display only in the Run mode. The total number of available children can be read from the **Row No** column.

The number of records that display in the child table depends on the following:
- If a Name filter with wild card characters is applied to the report or a default Name filter is applied, then the latest 1000 records display.
- If a single Name filter without any wild card characters is applied, then all records display. In this case, the **Row Number** column is empty.
- If multiple Name filters are applied, then the child table is restricted to the latest 1000 records.

You can configure an Event Details report for the following:
- Viewing event details of a particular event using Investigative Treatment.
- Viewing event details of a particular event using Assisted Treatment.
- Viewing event details for specific events using Reports. For example, you can configure an event details report to display all events of type Fault or Life Safety on an Analog Output object for a 24-hour period.

**Constraints**
The following constraints apply to the Event Details report.
- You cannot sort or apply Condition filters for the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>DPE Observer</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>Event Source</td>
</tr>
<tr>
<td>Type</td>
<td>Observer Description</td>
</tr>
<tr>
<td>Subtype</td>
<td>Observer Name</td>
</tr>
<tr>
<td>Object Description</td>
<td>Observer Designation</td>
</tr>
<tr>
<td>Object Name</td>
<td>Observer Location</td>
</tr>
<tr>
<td>Object Property</td>
<td>Observer Identifier (Internal)</td>
</tr>
<tr>
<td>Object Designation</td>
<td>Event Went</td>
</tr>
<tr>
<td>Object Designation[Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation[Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation[Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td>Object Location</td>
<td></td>
</tr>
<tr>
<td>Object Location[Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Location[Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Location[Management View]</td>
<td></td>
</tr>
<tr>
<td>Observer Description</td>
<td></td>
</tr>
</tbody>
</table>
Events Report

The Events table provides information related to events. It provides information such as Event Time, Event State, Event Category, Event Cause, Event ID, Object Description, and Object Designation.

Constraints

The following constraints apply to the Events report.

- You cannot apply the NOT operator in the Condition filter for an Event Details table.

<table>
<thead>
<tr>
<th>No Sorting</th>
<th>No Condition Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
<td>DPE Observer</td>
</tr>
<tr>
<td>DPE Observer</td>
<td>Event Source</td>
</tr>
<tr>
<td>Event Source</td>
<td>Observer Description</td>
</tr>
<tr>
<td>Subdiscipline</td>
<td>Observer Name</td>
</tr>
<tr>
<td>Type</td>
<td>Observer Designation</td>
</tr>
<tr>
<td>Subtype</td>
<td>Observer Location</td>
</tr>
<tr>
<td>Object Description</td>
<td>Observer Identifier (Internal)</td>
</tr>
<tr>
<td>Object Name</td>
<td></td>
</tr>
<tr>
<td>Object Designation</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Designation [Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Location</td>
<td></td>
</tr>
<tr>
<td>Object Location [Application View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Current View]</td>
<td></td>
</tr>
<tr>
<td>Object Location [Management View]</td>
<td></td>
</tr>
<tr>
<td>Object Identifier [Internal]</td>
<td></td>
</tr>
<tr>
<td>Object Property</td>
<td></td>
</tr>
<tr>
<td>Observer Description</td>
<td></td>
</tr>
<tr>
<td>Observer Name</td>
<td></td>
</tr>
<tr>
<td>Observer Designation</td>
<td></td>
</tr>
<tr>
<td>Observer Location</td>
<td></td>
</tr>
</tbody>
</table>
When you add a Condition filter to the Event Details table, you cannot apply the OR operator between two filter expressions set on two different columns.

You can apply the OR operator between two filter expressions set on the same column. To apply the OR operator on the same column, select the column and the operator, press SHIFT or CTRL, depending on whether you want to select values listed next to each other or away from each other and then click Add.

You cannot apply the NOT operator in the Condition filter for an Events table.

**Trends Plot**
The Trends plot provides a graphical representation of the change of value of an object over a period of time.

In order to view the change of value graphically, you must assign a Trend View Definition as a Name filter to the Plot. You cannot add a Condition filter to the Trends Plot.

For example, you can create a Trends Plot if you want to track the change of value of an Analog Input object graphically over a period of 10 hours.

**All Logs Report**
The All Logs table provides information on system activities and events.

**Constraints**
The following constraints apply to the All Logs report.

- You cannot apply sorting on the following columns:

<table>
<thead>
<tr>
<th>No Sorting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discipline</td>
</tr>
<tr>
<td>Subdiscipline</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Subtype</td>
</tr>
<tr>
<td>Source Description</td>
</tr>
<tr>
<td>Source Name</td>
</tr>
<tr>
<td>Source Designation</td>
</tr>
<tr>
<td>Source Location</td>
</tr>
<tr>
<td>Source Designation [Application View]</td>
</tr>
<tr>
<td>Source Designation [Current View]</td>
</tr>
<tr>
<td>Source Designation [Management View]</td>
</tr>
<tr>
<td>Source Location [Application View]</td>
</tr>
<tr>
<td>Source Location [Current View]</td>
</tr>
<tr>
<td>Source Location [Management View]</td>
</tr>
<tr>
<td>Source Identifier [Internal]</td>
</tr>
<tr>
<td>Property</td>
</tr>
<tr>
<td>Quality</td>
</tr>
<tr>
<td>Previous Quality</td>
</tr>
<tr>
<td>Alias [Observer]</td>
</tr>
<tr>
<td>Alias [Source]</td>
</tr>
</tbody>
</table>
• When you add a Condition filter to the All Logs table, you cannot apply the OR operator between two filter expressions set on two different columns.

• You can apply the OR operator between two filter expressions set on the same column. To apply the OR operator on the same column, select the column and the operator, press SHIFT or CTRL, depending on whether you want to select values listed next to each other or away from each other, and then click Add.

• You cannot apply the NOT operator in the Condition filter for a Log View table.

• You can only apply the Equal to (=) operator to the following columns in the Condition Filter dialog box.
  – Discipline
  – Subdiscipline
  – Type
  – Subtype
  – Source Description
  – Source Name
  – Source Designation
  – Source Location
  – Source Designation [Application View]
  – Source Designation [Current View]
  – Source Designation [Management View]
  – Source Location [Application View]
  – Source Location [Current View]
  – Source Location [Management View]
  – Source Identifier [Internal]

Reports for Operating Procedures
Reports configured in operating procedure steps allow you to view and enter Event Treatment related information when executed for a selected event from Assisted Treatment. In addition to the existing reporting elements, you can add form controls to these reports. You create and configure a report for operating procedure steps in the same way as you would create and configure any report. When executed in the context of the selected event, the report displays the event treatment related information and allows you to enter information in the form controls.

NOTE:
You cannot use trend plots and trend tables in reports for operating procedures as these elements do not display any data when the report is executed from Assisted Treatment.

You can enter information in the following scenarios:
• The event is treated for the first time; the operating procedure step is configured as repeatable and is in progress.
• You re-select the same event, for a repeatable step that is not yet complete.
If you re-select the same event with a non-repeatable step that is complete, you cannot perform activities such as editing information, sorting entries in tables, or resizing columns. You can only view and route the information to a file, email, or printer as configured in the report definition.
Information entered in the form controls can be viewed by users on different client computers for the same step in the same event. However it can be edited only if the step is configured to be repeatable.
You may need to contact the system administrator, if you face either of these issues when working with reports for operating procedures:
• The report is not executed.
• The report does not display the configured table in the Run mode.
• The report is not getting routed to the specified folder.
3.5.2 Reports Workspace
This section gives an overview of the Reports workspace.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Browser</td>
<td>Displays all the saved Report Definitions in Application View &gt; Applications &gt; Reports.</td>
</tr>
<tr>
<td>Reports Toolbar</td>
<td>Contains icons for performing various actions in Reports. Reports toolbar for operating procedures - Displays only when the report is executed for a selected event from Assisted Treatment. Contains icons for saving user input and routing information.</td>
</tr>
<tr>
<td>Reports Ribbon</td>
<td>Contains several tabs and group boxes to help you define a Report Definition. The tabs available on the ribbon are: Home [➙ 249], Filter [➙ 265], Layout [➙ 273], Data [➙ 275], and Settings [➙ 276]. NOTE: The Reports ribbon is only visible when you create a new Report Definition or select an existing one.</td>
</tr>
<tr>
<td>Report Definition</td>
<td>Displays the following: Edit mode [➙ 288]: Workspace where you configure a Report Definition. Run mode [➙ 289]: Workspace where you view an executed report.</td>
</tr>
<tr>
<td>Report Management Section</td>
<td>Displays a report snapshot and documents for the executed reports. NOTE: This section does not display when the report is executed for a selected event from Assisted Treatment.</td>
</tr>
<tr>
<td>Extended Operation Tab</td>
<td>Displays the properties of the selected Report Definition. The Execute button allows you to run a Report Definition. NOTE: You must configure a Report Output Definition for the selected Report Definition.</td>
</tr>
<tr>
<td>Related Items Tab</td>
<td>Displays the following: New Report: Opens a new Report Definition for configuration. Related Report: Displays the names of the reports related to the selected System Browser object. Show-in-Related Items Report: Displays the name of the reports that has the Show In Related Items check box selected.</td>
</tr>
</tbody>
</table>

3.5.2.1 Reports Toolbar
The Reports toolbar contains icons that help you perform reporting operations quickly. This toolbar is present in both Edit mode and Run mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>New</td>
<td>Opens a sub-menu where you can select: New Report and New Folder.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete</td>
<td>Removes the current Report Definition or Report folder and deletes its entire configuration from System Browser.</td>
</tr>
<tr>
<td>Icon</td>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>🔄</td>
<td>Save</td>
<td>Saves the configuration of the currently selected Report Definition or saves a newly created and configured Report Definition. NOTE: This command is dimmed until you modify the current Report Definition.</td>
</tr>
<tr>
<td>🔄</td>
<td>Save As</td>
<td>Saves the configuration of the currently selected Report Definition as a new Report Definition, or saves a newly created and configured Report Definition.</td>
</tr>
<tr>
<td>🔄</td>
<td>Save as Default</td>
<td>Saves the selected Report Definition as the default report template.</td>
</tr>
<tr>
<td>🕉</td>
<td>Properties</td>
<td>Shows or hides the Reports ribbon in Edit mode.</td>
</tr>
<tr>
<td>🚀</td>
<td>Run</td>
<td>Auto-closes Edit mode and executes the current Report Definition in Run mode. NOTE: You can run up to five reports simultaneously; an error message displays for any subsequent clicks of the Run or Run As icon.</td>
</tr>
<tr>
<td>🚀</td>
<td>Run As</td>
<td>Opens a sub-menu where you can select a language from a list of languages supported in Desigo CC. Languages currently supported for report execution are: en-US, fr-CA.</td>
</tr>
<tr>
<td>✄</td>
<td>Stop</td>
<td>Stops report execution of the selected Report. This command is available only while the report is running. NOTE: You can also stop the report execution using the Stop button that becomes available in the Report Management section while the report is running.</td>
</tr>
<tr>
<td>🖋</td>
<td>Edit</td>
<td>Opens the Report Definition in Edit mode. In this mode you can design the layout of a report. This command is available only in Run mode.</td>
</tr>
<tr>
<td>🖖</td>
<td>Create and view PDF</td>
<td>Starts creating PDF document for the current Report snapshot. The maximum number of pages in one PDF document is 500. When the number of pages exceeds 500, the PDF document splits into two. This process goes on until all the data in that specific report snapshot is moved to the document. The PDF creation progress for all the split PDF documents displays under the same Report snapshot in the Report Management section. When successfully created, the PDF displays in Adobe Reader in Reports. This command is available only in Run mode.</td>
</tr>
<tr>
<td>📖</td>
<td>Create and view Excel</td>
<td>Starts creating Excel document for the current Report snapshot. The maximum number of rows in an Excel document is 1,048,575 (Excel limit). When the number of rows exceeds this limit, the Excel document splits into two. The process of the Excel creation for all the split Excel documents displays under the same Report snapshot in the Report Management section. When successfully created, the Excel document displays in MS Excel in Reports. This command is available only in Run mode.</td>
</tr>
<tr>
<td>🕑</td>
<td>Report Management</td>
<td>Shows or hides the Report Management section.</td>
</tr>
<tr>
<td>📊</td>
<td>Export</td>
<td>Exports the Report Definitions as an .xml file to a selected location.</td>
</tr>
</tbody>
</table>
3.5.2.2 Home Tab

The Home tab is the main tab in Reports.

<table>
<thead>
<tr>
<th>Insert Group Box</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Insert Group Box provides the following UI components that can be added to a report:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table Group Box</th>
</tr>
</thead>
</table>
| This box lists the tables such as Objects, Activities, Events, and so on that you can add to the report. It is recommended that you have a maximum of ten tables in a single report. If you need more than ten tables, then you must create multiple reports. Tables in a Report Definition can contain a huge number of records which cannot be viewed at the same time. Reporting incorporates a paging mechanism that optimizes the number of records that display in a table. The configured height of a table in the Layout tab determines the number of records that display. Following is a list of tables that you can add to the report.
### Table Summary

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Default Columns</th>
<th>Additional Columns</th>
<th>Support/Limitations</th>
</tr>
</thead>
</table>
● For more information on the Objects table and its configurations, see Objects Report.  
● The values of filters applied on the Alias column are case sensitive.  
● Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units. |
| | ● Columns specific to scheduling objects are: - Weekly schedule - Exceptions - Commanded objects - Effective Period | ● Columns specific to Related Items objects are: - Related Items - Related Items Type | |
| | ● In addition to these columns, the Objects table also supports columns related to Object properties. For more information see Objects Report. | | |
### Active Events

- Category
- Cause
- State
- Object Designation
- Object Description
- Discipline
- Subdiscipline
- Creation Date
- Time
- Object Property
- Source Status

### Supports the following additional columns

- Alias
- Available Commands
- Customer Text
- Event ID
- Event Status Text
- In process by
- Intervention Text
- Is Maintenance
- Location
- Name
- Object Designation

#### [Application View]

- Object Designation

#### [Current View]

- Object Designation

#### [Management View]

- Object Identifier
- [Internal]
- Object Location
- Object Location

#### [Application View]

- Object Location

#### [Current View]

- Object Location

#### [Management View]

- Object Name
- Observer Source ID
- Source ID
- Suggested Action
- System Name

### Does not support the Time filter

- The values of filters applied on the Alias column are case sensitive.
- Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.
<table>
<thead>
<tr>
<th>Activities</th>
<th>Supports the following additional columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Time</td>
<td>- Alias [Associated Object]</td>
</tr>
<tr>
<td>Object Description</td>
<td>- Alias [Object]</td>
</tr>
<tr>
<td>Object Designation</td>
<td>- Associated Object Description</td>
</tr>
<tr>
<td>Action</td>
<td>- Associated Object Designation</td>
</tr>
<tr>
<td>Log Type</td>
<td>- Associated Object Location</td>
</tr>
<tr>
<td>Previous Value</td>
<td>- Associated Object Name</td>
</tr>
<tr>
<td>Value</td>
<td>- Associated Object Name [Internal]</td>
</tr>
<tr>
<td>Status</td>
<td>- Discipline</td>
</tr>
<tr>
<td>User Name</td>
<td>- Error</td>
</tr>
<tr>
<td>Management Station</td>
<td>- Object Designation</td>
</tr>
<tr>
<td>Message Text</td>
<td>[Application View]</td>
</tr>
<tr>
<td>Attachment</td>
<td>- Object Designation [Current View]</td>
</tr>
</tbody>
</table>

For more information on the Activities table, its constraints, and configurations, see Activities Report.

Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.
<table>
<thead>
<tr>
<th>Events</th>
<th>Supports the following additional columns</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Alias [Object]</td>
</tr>
<tr>
<td></td>
<td>- Alias [Observer]</td>
</tr>
<tr>
<td></td>
<td>- Discipline</td>
</tr>
<tr>
<td></td>
<td>- DPEObserver</td>
</tr>
<tr>
<td></td>
<td>- Event Message Text</td>
</tr>
<tr>
<td></td>
<td>- Event Mode</td>
</tr>
<tr>
<td></td>
<td>- Event Source</td>
</tr>
<tr>
<td></td>
<td>- Event Value</td>
</tr>
<tr>
<td></td>
<td>- Event Went</td>
</tr>
<tr>
<td></td>
<td>- Event Details</td>
</tr>
<tr>
<td></td>
<td>- Category Priority</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
</tr>
<tr>
<td></td>
<td>- Object Designation</td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
</tr>
<tr>
<td></td>
<td>- Object Identifier</td>
</tr>
<tr>
<td></td>
<td>[Internal]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Application View]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Current View]</td>
</tr>
<tr>
<td></td>
<td>- Object Location</td>
</tr>
<tr>
<td></td>
<td>[Management View]</td>
</tr>
<tr>
<td></td>
<td>- Object Name</td>
</tr>
<tr>
<td></td>
<td>- Object Property</td>
</tr>
<tr>
<td></td>
<td>- Observer Description</td>
</tr>
<tr>
<td></td>
<td>- Observer Designation</td>
</tr>
<tr>
<td></td>
<td>- Observer Location</td>
</tr>
<tr>
<td></td>
<td>- Observer Name</td>
</tr>
<tr>
<td></td>
<td>- Observer Identifier</td>
</tr>
<tr>
<td></td>
<td>[Internal]</td>
</tr>
<tr>
<td></td>
<td>- Subdiscipline</td>
</tr>
<tr>
<td></td>
<td>- Subtype</td>
</tr>
<tr>
<td></td>
<td>- Transition Time</td>
</tr>
<tr>
<td></td>
<td>- Type</td>
</tr>
<tr>
<td></td>
<td>- Unit</td>
</tr>
<tr>
<td></td>
<td>- Went Text</td>
</tr>
<tr>
<td></td>
<td>- System Name</td>
</tr>
<tr>
<td></td>
<td>- Validation Profile</td>
</tr>
<tr>
<td></td>
<td>- Object Version</td>
</tr>
</tbody>
</table>

<p>| Supports: Name, Condition, Time, and Row filter. |
| For more information on the Events table and its constraints, see Events Report. |
| The values of filters applied on the Alias [Object] column are case sensitive. |
| Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units. |</p>
<table>
<thead>
<tr>
<th>Event Details</th>
<th>Default columns displayed in the Parent table are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Time</td>
<td>Event Category</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Cause</td>
</tr>
<tr>
<td>Object Description</td>
<td>Object Designation</td>
</tr>
</tbody>
</table>

- Default columns displayed in the Parent table are:
  - Event Time
  - Event Category
  - Event Cause
  - Event ID
  - Object Description
  - Object Designation

- Supports the following additional columns:
  - Alias [Object]
  - Alias [Observer]
  - Discipline
  - DPEObserver
  - Event Message Text
  - Event Mode
  - Event Source
  - Event Value
  - Event Went
  - Event Details
  - Category Priority
  - Object Designation

- The following are the columns of a child (nested) table:
  - Time
  - Value
  - Previous Value
  - User Name
  - Management Station
  - Action
  - Attachment
  - Object Property
  - Unit
  - Validation Profile
  - Audit Trail
  - Object Version
  - Comment
  - Reference Time
  - Event Details
  - Category Priority
  - Supervisor

**NOTE:** These columns are added to the table in Run mode. In Edit mode, they are not visible, but can be selected or removed by clicking the Child tab in the Select Column dialog box.

- The values of filters applied on the Alias [Object] column are case sensitive.
- For more information on the Event Details table, its constraints, and configurations, see Event Details Report.
| BACnet Event Information | Supports the following additional columns:  
| Event Stamp Fault  
| Event Enable  
| Acked Transitions  
| Device Description  
| Event Stamp Off-Normal  
| Event Stamp Normal  
| Event Priority Off-Normal  
| Notify Type  
| Alarm State  
| Object Id  
| Event Priority Normal  
| Event Priority Fault  
| Supports only the Name and Row filter. |
| BACnet Alarm Summary | Supports the following additional columns:  
| Acked Transitions  
| Device Description  
| Alarm State  
| Object Id  
| Supports only the Name (on devices only) and Row filter. |
| BACnet Enrollment Summary | Supports the following additional columns:  
| Notification Class  
| Object Id  
| Device Description  
| Notification Class Present  
| Event Type  
| Alarm State  
| Priority  
<p>| Supports only the Name (on devices only) and Row filter. |</p>
<table>
<thead>
<tr>
<th>Trends</th>
<th>DateTime</th>
<th>Value</th>
<th>Unit</th>
<th>Quality</th>
<th>Supports the following additional columns</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Validation Profile</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Object Version</td>
</tr>
<tr>
<td></td>
<td>Supports the Name filter, Condition filter, Time filter, and Row filter. However, the Condition filter is not supported on the Object Version and Validation Profile columns.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Does not support multiple Name filters.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sorting is possible only on the DateTime column.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The information on the alias of an object (if present) displays above the column headings (Present Value, Unit, and Quality) and appears next to the object hierarchy.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Logs</td>
<td>• Event Category</td>
<td>• Supports the following additional columns</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Log Type</td>
<td>- Action Details</td>
<td>- Action Details</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Event ID</td>
<td>- Action Result</td>
<td>- Action Result</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Event Time</td>
<td>- Alert ID</td>
<td>- Alert ID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Previous Value</td>
<td>- Alias [Observer]</td>
<td>- Alias [Observer]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Event Message Text</td>
<td>- Alias [Source]</td>
<td>- Alias [Source]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Quality</td>
<td>- Attachment</td>
<td>- Attachment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Date/Time</td>
<td>- Discipline</td>
<td>- Discipline</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Record Type</td>
<td>- Event Mode</td>
<td>- Event Mode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Event Cause</td>
<td>- Event Details</td>
<td>- Event Details</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Event State</td>
<td>- Category Priority</td>
<td>- Category Priority</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Previous Quality</td>
<td>- Management Station</td>
<td>- Management Station</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Source Description</td>
<td>- Observer Description</td>
<td>- Observer Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Action</td>
<td>- Observer Designation</td>
<td>- Observer Designation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Source Property</td>
<td>- Observer Location</td>
<td>- Observer Location</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Value</td>
<td>- Observer Name</td>
<td>- Observer Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Unit</td>
<td>- Observer Identifier</td>
<td>- Observer Identifier</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Supports the Name filter, Condition, Time filter, and Row filter.**
- **For more information on the All Logs table and its constraints, see All Logs Report.**
- **The values of filters applied on the Alias [Source] column are case sensitive.**
- **Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.**
## Orphans
- Orphan Type
- Object Identifier
- Object Location
- Object Property

- Supports the following additional columns:
  - Object Designation
  - System Name

- Condition filter on the Orphan Type column is mandatory. You will not be able to retrieve data, if you do not apply the condition filter.

- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

## Orphan Activities
- Source Time
- Object Identifier
- Object Designation
- Object Property
- Log Type
- Action
- Status
- Previous Value Text
- Value Text
- User Name
- Management Station
- Message Text

- Supports the following additional columns:
  - Attachment
  - Audit Trail
  - Comment
  - Error
  - Object Location
  - Object Version
  - Previous Quality
  - Quality
  - Reference Time
  - System Name
  - Supervisor

- Supports: Condition, Time, and Row filter.

- Condition filter on the Object Identifier column is mandatory.

- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

## Orphan Events
- Event Time
- Object Identifier
- Event State
- Event Category
- Event Cause
- Event ID
- Object Designation
- Object Property
- User Name

- Supports the following additional columns:
  - Category Priority
  - Event Details
  - Event Message Text
  - Event Mode
  - Event Source
  - Event Value
  - Event Went
  - Object Location
  - System Name
  - Transition Time
  - Went Text

- Supports: Condition, Time, and Row filter.

- Condition filter on the Object Identifier column is mandatory.

- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.

## Orphan Trends
- DateTime
- Value
- Object Identifier
- Quality
- Object Location

- Supports the following additional columns:
  - Object Designation
  - System Name

- Supports: Condition, Time, and Row filter.

- Condition filter on the Object Identifier column is mandatory to fetch records of deleted trend log objects and trend log multiple objects.

- This table displays only if you have enabled the View Orphan Logs application right from the Security node in the Management View.
Select Columns Dialog Box

When you add a table to a report, you can add, remove, or delete columns from the Select Columns dialog box.

Select Columns Dialog Box Components

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent tab</strong>&lt;br&gt;Allows you to add, remove, or reorder Parent columns in the table.</td>
</tr>
<tr>
<td><strong>Object Type</strong>&lt;br&gt;(Displays only for a Point table) Lists the object collection. When an object is selected in the Object Type drop-down list, all the associated properties are listed in the Available Columns list.</td>
</tr>
<tr>
<td><strong>Type filter</strong>&lt;br&gt;(Displays only for an Objects table) Allows you to enter the object type description on which you want to filter the object types to be displayed in the Type drop-down list. For example, if you want the Type drop-down list to display all BACnet object types, enter BACnet as the type filter.</td>
</tr>
<tr>
<td><strong>Type</strong>&lt;br&gt;(Displays only for an Objects table) Displays the list of object types available in the system. You must select the object type whose columns are to be displayed in the Available columns field. <strong>NOTE:</strong> In case of a distributed system, the Type drop-down list displays the Object Models of only the current system on which the report is configured.</td>
</tr>
<tr>
<td><strong>Load</strong>&lt;br&gt;(Displays only for an Objects table) Click this button to populate the Available columns list with the columns corresponding to the selected object type in the Type list.</td>
</tr>
<tr>
<td><strong>Available columns</strong>&lt;br&gt;Displays the following information:&lt;br&gt;  - Common columns applicable to any type of object. These are listed at the top of the list. For example, Discipline, Object Name, Object Description, and so on.&lt;br&gt;  - Columns referring to properties supported by the selected object type. These are listed after the common columns and have a tree structure. When you click any such column, the tree expands and displays the attributes of the property. For example, if you click the expander of the Current_Priority property, its attributes such as Archive, Activity Log, Min, Max, Default, and so on display. <strong>NOTE:</strong> View-specific columns such as Source Location and Source Designation are dynamically added to the Available columns list when you create a new view.</td>
</tr>
<tr>
<td><strong>Selected Columns</strong>&lt;br&gt;Displays the mandatory columns of a selected table. You can add columns to the selected columns list by selecting the check box associated with each column in the Available Columns list.</td>
</tr>
<tr>
<td><strong>Select Default</strong>&lt;br&gt;Selects the default columns in the Available Columns list.</td>
</tr>
</tbody>
</table>
Clear All  | Unchecks all columns except mandatory columns. The **Selected Columns** list displays only mandatory columns.

Move Up  | Moves the selected column one step up in the **Selected Columns** list. The **Move Up** button is unavailable if you select the column on the top.

Move Down  | Moves the selected column one step down in the **Selected Columns** list. The **Move Down** button is unavailable if you select the column at bottom.

Remove  | Removes the selected column from the **Selected Columns** list.

### Sorting Data in Tables
Sorting allows you to arrange data in a table in the ascending or descending order. Sorting priority depends on the order in which the column headers are clicked. You can sort the table columns in **Edit** mode as well as in **Run** mode. If you sort the table columns in **Edit** mode, then the sorted data displays in **Run** mode according to the sort criteria specified in **Edit** mode. When sorting is applied on an executed report, data in the current snapshot is sorted.

In Activities, Events and Event Details tables, you cannot sort columns such as type, sub-type, discipline, object name, object description or object location. In Trends tables, you can only sort the **Date** column. By default, whenever you insert a Trends table there is an ascending sort on the **Date** column.

**NOTE:**
You cannot perform sorting during report execution. You can continue sorting after report execution is complete or is stopped.

### Plot Group Box
A plot displays data in a graphical view. The **Plot** group box contains different graphic elements from different data sources such as Trends and Graphics.

#### Graphics Plot
You can drag-and-drop any graphics definition or manual view port from System Browser onto a Report Definition to insert a graphics plot. This inserts a placeholder graphics plot and sets the Name filter to the dragged and dropped object.

When you execute a report containing a graphics plot, it displays the graphic image associated with the dragged and dropped object. If the object is not present in any of the graphics definitions, then an error message displays in the report management section.

Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

#### Trends Plot
You can drag-and-drop a Trend View Definition from System Browser onto a Report Definition to insert a trends plot. The system behaves the same way as when inserting a graphics plot. For more information on the Trends Plot and its configuration, see Configuring a Trends Plot [111].

Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

### Textgroup Box
Displays a label that you can add to a Report Definition. You can insert labels (Blank, Page, and Report) in the header/footer section or anywhere in the Report Definition.

Using labels, you can type text to be displayed in the Report Definition or insert keywords. By default the labels display all the languages configured in the system.
Keyword Group Box

Keywords are pre-defined templates that can be added anywhere in a Report Definition. They are replaced with actual data in Run mode and when the report document (PDF, XLS) is created.

There are two types of keywords:

- Content-specific, which can be inserted only above tables/plots. For example, content-specific keywords, such as Content Type, Name filter or Record Count, cannot be inserted in the header/footer section of a Report Definition.
- Generic, which can be inserted anywhere including the header and footer of the Report Definition

For example, you can add the Date keyword in the Report Definition header to display the date on which the report is executed.

A default report template may contain generic and content-specific keywords. Creating a new Report Definition displays generic keywords, but not the content-specific keywords. The applicable content-specific keywords are automatically inserted above an inserted table and/or plot; however certain keywords are not applicable for certain types of tables/plots. For example, if the default template contains the content-specific keyword Time Range and you insert the Active Events table in the Report Definition, the Time Range keyword will not be inserted above the Active Events table in the Report Definition as the Time filter is not applicable for the Active Events table.

The following keywords are supported by Reports:

<table>
<thead>
<tr>
<th>Content-specific Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTENT TYPE</td>
<td>Displays the name of the content provider – Alarm, Log, Reference, Objects, and Graphics.</td>
</tr>
<tr>
<td>NAME FILTER</td>
<td>Displays the Name filters set for the content provider.</td>
</tr>
<tr>
<td>CONDITION FILTER</td>
<td>Displays the Condition filter expression set for a table. In case of Plot content, this keyword remains empty.</td>
</tr>
<tr>
<td>TIME RANGE</td>
<td>Displays the Time filter set for the content provider.</td>
</tr>
<tr>
<td>CONTENT START</td>
<td>Displays the Date and Time when execution started for the content provider.</td>
</tr>
<tr>
<td>CONTENT STOP</td>
<td>Displays the Date and Time when execution completed or stopped for the content provider.</td>
</tr>
<tr>
<td>CONTENT DURATION</td>
<td>Displays the time difference between Content Start and Content Stop.</td>
</tr>
<tr>
<td>CONTENT STATE</td>
<td>Succeeded – Displays if content provider’s execution succeeds. Cancelled – Displays if content provider’s execution stops or fails.</td>
</tr>
<tr>
<td>CONTENT ERRORSTATE</td>
<td>Provides additional information about Content execution. It is independent of the Content state. The following states are possible: OK - Succeeded Errors - Errors occurred Failures - Severe errors occurred</td>
</tr>
<tr>
<td>CONTENT ERRORSTATE MESSAGE</td>
<td>Displays the error description of Content ErrorState.</td>
</tr>
<tr>
<td>CONTENT ACTIVITY</td>
<td>Displays the detailed information about the Content creation activity.</td>
</tr>
<tr>
<td>CONTENT PROGRESS</td>
<td>Displays the Content execution progress from 0% to 100%.</td>
</tr>
<tr>
<td>RECORD COUNT</td>
<td>Displays the number of records in the table.</td>
</tr>
<tr>
<td>SYSTEM NAME</td>
<td>Displays the name of the system on which the current report is present.</td>
</tr>
</tbody>
</table>
### Generic Keyword List

<table>
<thead>
<tr>
<th>Generic Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE</td>
<td>Displays the Date (format is location-dependent)</td>
</tr>
<tr>
<td>TIME</td>
<td>Displays the Time (format is location-dependent)</td>
</tr>
<tr>
<td>PAGE</td>
<td>Displays the page number when the report document (PDF) is created.</td>
</tr>
</tbody>
</table>
| PAGES            | Displays the total number of pages when the report document (PDF) is created. 
**NOTE:** Keywords Page and Pages are replaced by page numbers and total number of pages respectively only when inserted in Header or Footer of the Report Definition. |
| USER             | Displays the name of the logged-in user. |
| Desigo CC NAME   | Displays the name of the management station that created the report. |
| REPORT NAME      | Displays the name of the Report Definition. |
| REPORT DESCRIPTION | Displays the description typed for the Report Definition. |
| REPORT START     | Displays the Date and Time when report execution started. |
| REPORT STOP      | Displays the Date and time when report execution completed or stopped. |
| REPORT DURATION  | Displays the time difference between Report Start and Report Stop. |
| REPORT STATE     | Succeeded - Displays if the report execution succeeds. 
Cancelled - Displays if the report execution stops or fails. |
| REPORT ERRORSTATE | Provides additional information about report execution. It is independent of the report state. |
| REPORT ERRORSTATE MESSAGE | Displays the error description of report ErrorState. |
| REPORT ACTIVITY  | Displays detailed information about report creation activity. |
| REPORT PROGRESS  | Displays the report execution progress: 
If continuous progress is possible, a number between 0 and 100 displays 
If no continuous progress is possible, **In progress** displays. |
| REPORT SUMMARY   | Displays the summary. |
| EVENT INFORMATION | Displays information related to an event only when the report with this keyword is executed in the context of an event, for example, in Investigative Treatment or Assisted Treatment. |

### Logo Group Box

You can insert logos into a Report Definition using the Logo group box. For example, you can add your company’s logo to a report.

You can define, and change the size, position, and indentation of a logo. To insert a logo to a Report Definition, you must upload it using the **Manage Logo** dialog box.
Components of Manage Logo Dialog Box

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select logo to upload</td>
</tr>
<tr>
<td>Browse</td>
</tr>
</tbody>
</table>
| Upload                                          | Adds a new Logo to the Available Logos list.  
  NOTE: The Upload button remains unavailable until a valid path and file name is selected. |
| Thumbnail                                       | Displays the thumbnail view of an image. |
| Logo name                                       | Saves as Logo name. The Logo name must be unique. |
| Delete                                          | Deletes selected logos.  
  NOTE: The Delete button remains unavailable until a logo is selected. |
| Close                                           | Closes the Manage Logo dialog box. |

Form Controls Group Box

Form controls are controls that you can edit in Run mode. There are four form controls - Editable Field, Custom Text Selection, Text Group Selection, and Comments Table. These controls are accessed from the Form Controls group box within the Insert group box in the Home tab of Reports.

The Editable Field control displays a watermark text that enables you to perform the required action. You can change this text if you want the control to display a different text when the report is executed. These controls can also be used to provide event treatment related information in reports for operating procedures.

Following is an overview of the form controls:
Editable Field

Use the **Editable Field** control, to enter text in **Run** mode. This field does not support keywords.

Custom Text Selection

The **Custom Text Selection** control provides a drop-down list that enables you to add, modify, and delete text entries in **Edit** mode and select entries in **Run** mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add</td>
<td>Adds the text entered to the control.</td>
</tr>
<tr>
<td><img src="image" alt="Update" /></td>
<td>Update</td>
<td>Modifies an existing entry.</td>
</tr>
<tr>
<td><img src="image" alt="Flag" /></td>
<td>Flag</td>
<td>Allows you to enter text for all languages configured in the system.</td>
</tr>
</tbody>
</table>

You can add text in any of the languages configured in the system. In **Run** mode, this control displays text using the logged-in language of the user.

Text Group Selection

The **Text Group Selection** control provides a drop-down list with entries from a text group in **Run** mode. You can drag-and-drop a text group to this control in **Edit** mode and the values display in **Run** mode. However, you can add only one text group to the control. If more than one text group is added, the existing group is over written with the new group. If you add new entries, modify or delete existing entries from the associated text group, the control displays the updated values every time you run the report. If the text group is deleted, a message indicating that the group is no longer available displays.

Comments Table

The **Comments** table allows you to add, modify, and delete comments in **Run** mode. You can modify and delete your own comments by clicking **Edit**  and **Delete** that are available in **Run** mode.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation date</td>
<td>Displays the date and time stamp when comment is added</td>
</tr>
<tr>
<td>User</td>
<td>Displays the ID of the user who entered the comment</td>
</tr>
<tr>
<td>Management Station</td>
<td>Displays the workstation from where comment is added</td>
</tr>
<tr>
<td>Comment</td>
<td>Allows you to enter comments</td>
</tr>
</tbody>
</table>

Creation date, User, and Management Station are read only. These are populated with information after you enter the comments and press **ENTER**. To add a new line to the comments, press **ALT+ENTER**.
Unlike other tables, the columns in this table are fixed and you cannot perform column operations like adding, deleting, reordering, and sorting. Also, this table does not support filtering.

<table>
<thead>
<tr>
<th>Creation Date</th>
<th>User</th>
<th>Management Station</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/5/2014 6:38 PM</td>
<td>DefaultAdmin</td>
<td>PUN87101PC</td>
<td>Alarms 1</td>
</tr>
<tr>
<td>2/5/2014 6:38 PM</td>
<td>DefaultAdmin</td>
<td>PUN87101PC</td>
<td>Alarms 2</td>
</tr>
<tr>
<td>2/5/2014 6:38 PM</td>
<td>DefaultAdmin</td>
<td>PUN87101PC</td>
<td>Alarms 3</td>
</tr>
</tbody>
</table>

Figure 21:

**View Group Box**

The View group box provides the following options that determine the visibility of a report on the screen.

- **Page Width**
  - Adjusts the width of a report page to use all the available width of the Reports workspace.

- **Full Page**
  - Displays a full page to maximize the space available in the Reports workspace.

- **Original Size**
  - Displays the width of a report page in normal size.

**Options Group Box**

The Options group box provides additional options available in the Home tab:

- **Show in Related Items check box**
  - While creating a Report Definition, enable this check box to create a standard report. When you select an object from System Browser, this standard report displays as a link in the Related Items.

- **Date/time in UTC format check box**
  - Selecting this check box, the date and time you type is represented in UTC format. The following elements in Reports display date/time values:
    - Keywords (Date, Time, Report Start, Report Stop, Content Start, Content Stop)
    - Columns of the tables
    - Source Time column (Activities)
    - Alert time and Transition time (Events)
    - Creation date time (Active Events)
    - Date
    - Alert time and Alert went (for parent record of Event Details)
    - Time (for child record of Event Details)
    - Event Stamp Fault, Event Stamp Off-Normal and Event Stamp Normal (BACnet Event Information)
    - **Time filter** dialog box
    - **Condition filter** dialog box (Data in the reports can be filtered based on data time values)

- **Fixed Locale check box**
  - Selecting this check box and a locale from the corresponding list, displays the date/time and decimal separator according to the format set for the locale on the server. For example, if you select English-US as the locale, the date/time and decimal separator set for English-US on the server displays in the report.

- **Show Date/Time with milliseconds check box**
  - Selecting this check box displays the date and time values till milliseconds. When you save a report definition as a default template and select this check box, any new report definition that is created based on this template displays the date and time values till milliseconds. By default, this check box is not selected.
### 3.5.2.3 Filter Tab

The Filter tab allows you to define and apply different filters for data retrieval.

#### Name Filter

The Name filter allows you to filter data based on the Name or Description of System Browser objects. You can apply a Name filter to a table or plot.

When an Activities, Events, Active Events, BACnet Alarm Summary, BACnet Enrollment Summary, BACnet Event Information, and/or Objects table is inserted in the Report Definition, a valid Name filter “**CurrentSystemName.*:*” is added by default, where **CurrentSystemName** is the name of the system in which report definition is created or opened. This default Name filter can be replaced with a * to fetch the data from all the views of all the configured systems in a distributed environment. You can add Name filters from the Name Filter dialog box.

#### Name Filter Dialog Box

Use the Name Filter dialog box to add, edit and delete Name filter conditions. The added Name filter is also added to the Name Filter group box when the dialog box is closed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Creates a Name filter according to the object name displayed in System Browser.</td>
</tr>
<tr>
<td>Description</td>
<td>Creates a Name filter according to the object description displayed in the System Browser. A message in red displays below the Name Filter list if the filter is invalid.</td>
</tr>
<tr>
<td>Name Filter List</td>
<td>Lists all the Name filters and displays whether the applied filter is valid or not. The Name filter list contains four columns. <strong>Total no. of filters:</strong> Displays the total number of filters in the column header and displays the sequential number before each Name filter. <strong>Valid:</strong> Shows if the applied filter is valid or not (OK or question mark symbol (?) respectively). <strong>Children:</strong> Disabling this check box excludes the child nodes of the System Browser object from the Report Definition. <strong>Name filter:</strong> Displays the hierarchical path of the System Browser object.</td>
</tr>
</tbody>
</table>
Name Filter | Displays the filter that is currently selected in the Name Filter list. You can type a name into this field. The valid format for entering a Name filter is SystemName.ViewName:Hierarchy.*, where * is for displaying the child nodes of the selected object. For example, System1.Application View.Site.Building.Floor1.*.

NOTE: For a plot, you can set only one Name filter at a time.

Validate | Checks whether the applied filter is valid or not.

NOTE: Displays only for Trends Table, Trends Plot, and Graphics Plot.

Accept | Accepts the change made to a Name filter. This button is unavailable until a change is made to an existing Name filter.

New | Adds a new Name filter to the Name Filter list. This button is unavailable until a Name filter is typed in the Name field or if any existing Name filters are selected in a Name Filter list.

NOTE: When you add the Name filter for the very first time, the default Name filter CurrentSystemName.*:* is replaced.

Delete | Deletes an existing Name filter. This button is unavailable until one or more Name filters is selected in the Name Filter list.

NOTE: When all the Name filters are deleted the default Name filter CurrentSystemName.*:* is restored.

NOTE 1:
For Trends table, Trends plot, and Graphics plot no default Name filter is added. You can apply only single Name filter.

NOTE 2:
For Trends table, you can drag-and-drop Offline, Online Trend Logs, and Trend View Definitions.

Wildcard Characters in Name Filters (For Single Systems):
You can use wildcard characters ( * and ? ) in a Name filter. The following examples will help you in using these characters:

- To display the details of only Analog Output objects of a device, Dev 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev1.Local_IO.AO*". When you run the report, the details of all the Analog Output objects belonging to the Dev 1 device will display.

- To display the details of only Analog Output objects of all system devices present in System 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev*.Local_IO.AO*". When you run the report, the details of all Analog Output objects belonging to all devices in the system with names starting with Dev will display.

- To display the details of Analog Output objects with names starting from Analog Output 11 through Analog Output 19 of device Dev 1 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev1.Local_IO.AO_1?". When you run the report, the details of Analog Output objects with names starting from AO_11 through AO_19 belonging to device Dev 1 will display. The assumption here is that there is a device Dev1 in your system that has Analog Output objects with names starting from AO_11 through AO_19.

- If you want to display the details of Analog Output objects with names starting from Analog Output 11 through Analog Output 19 of all devices with names in the range of 21 through 29 in a report, specify the Name filter as "System1.ManagementView:ManagementView.FieldNetworks.BAC1.Hardware.Dev2?.Local_IO.AO_1?". When you run the report, the details of all analog output devices with names starting from AO_11 through AO_19 that are present in devices Dev21 through Dev29 will display. The assumption here is that there are devices in your system having names Dev 21 through Dev 29 and there are Analog Output objects having names AO_11 through AO_19 in those devices.
Wildcard Characters in Name Filters (For Distributed Systems)
- To display the details of all the Analog Output objects of all system devices present in all the configured systems in a distributed environment, specify the following Name filter in the report definition, “*.ManagementView:ManagementView.FieldNetworks.*.AO*”. When you run the report, the details of all the Analog Output objects belonging to all the devices in all the systems configured in a distributed environment will display. However, when you apply wild cards to a Name filter, the report execution may be slower. Therefore, if you are processing an operating procedure form, report steps, or Log Viewer on a system, reports executed on this system must have more specific Name filters to achieve optimum performance.

Condition Filter
A Condition filter defines a filter expression that is composed of one or more filter expressions.

Condition Filter Condition
A Condition filter condition is composed of:
- Column name (Condition Name)
- Operators
- Condition value

Examples of Condition Filter Expressions
The following list contains some valid Condition filter expressions:
- Status = “Alarm”
- Status = {“Alarm”; “Alarm Acked”; “Alarm Unacked”}
- Alarm Value = {12; “Text”}
- Time of last Change = “Current day”

**NOTE:**
You cannot apply the Condition filter to Plots.

The Condition filter also allows you to create complex filters and conditions using mathematical and logical operators, and wildcard characters. The following operators are supported:
- **Mathematical Operators:** Equal to (=), Not Equal to (<>), Greater than (>), Less than (<), Greater than Equal to (>=), Less than Equal to (<=), and (-) In operator
- **Logical Operators:** AND, OR, NOT
- **Wildcard Character:** Asterisk (*)

**NOTE:** The In operator (-) is used to filter data in a column that supports display of multiple values in a single cell. Following is an example of columns having the possibility to display multiple values in a single cell.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Columns with possibility to display multiple values in a single cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects</td>
<td>Related Items Type Related Items</td>
</tr>
<tr>
<td>Activities</td>
<td>Value Previous Value Quality Previous Quality</td>
</tr>
<tr>
<td>Active Events</td>
<td>Available Commands</td>
</tr>
</tbody>
</table>
### Condition Filter Syntax

When you are creating a Condition filter, you must know the data type of the property for which you want to apply the filter. Following are some examples which will help you create Condition filters without syntax errors.

1. If property displays text data, for example string or enumeration, then the value must be enclosed within double quotes.
   - `'Current_Priority' = "Priority - 16"
   - `Object Description’ = "Analog Output 1"
   - `[Event_State] = "Normal"
   - `[Present_Value] = "INACTIVE"
   **NOTE:** The values of some properties such as [Current_Priority] are referenced in text groups. Therefore, whenever you are assigning values for such properties, you must refer to the respective text groups. In order to refer to the text groups in the Management View, you must have an Engineering license. In the absence of an Engineering license, you will have to run the report to find out the appropriate values for such properties.

2. If property displays values in the date time format, then the value must be in date time format configured in Windows on the server. Date must be in the short date format, time in the long time format (24 hours).
   - `Main Value’ = 3/13/2014 16:04:25 (assuming that the date format on the server is M/d/yyyy)

3. If property displays Boolean data, for example. TRUE, FALSE, then the value must be enclosed in double quotes
   - `[Stop_When_Full] = "True"
   - `Log_Enable’ = "False"

4. If property displays numeric data, for example,. 54.11, 25, -20, then the values must be specified as follows:
   - `[Present_Value] = 54.11
   - `Present_Value’ >= 25
   **NOTE:** The decimal separator will be according to your Windows Regional and Language settings.

5. If property displays bit string, then the value must be enclosed by double quotes
   - `[Status_Flags] <- "Fault"
   - `[Event_Enable] <- "To Fault"
   - `[Limit_Enable] <- "Low Limit Enable"

The Condition filter is applicable only to Objects, Active Events, Activities, Events, Event Details, and Trends tables. When you select any of these tables, you can display the **Condition Filter** dialog box.

For the Objects table, you can add a conditional filter that specifies the acceptable age of the data on which the filter is applied. For example, if you specify 0 as the acceptable age, the filter is always applied on the latest data from the field system. If you specify 2 weeks, the age of the data with the cache is checked. If the data is older than 2 weeks it is obtained from the field system, else the data from the cache is used for filtering. This setting helps in the faster report generation.

### Condition Filter Dialog Box

This dialog box allows you to specify the condition to filter the report data. You can apply the Condition filter on all columns except columns of type date/time.
### Condition Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type filter</td>
<td>Displays only when an Objects table is selected in the Report Definition. Allows you to enter the object type description on which you want to filter the object types to be displayed in the <strong>Type</strong> drop-down list. For example, if you want the <strong>Type</strong> drop-down list to display all BACnet object types, enter BACnet as the type filter.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays only when an Objects table is selected in the Report Definition. It lists all the object types available in the system. You must select the object type whose columns are to be displayed in the <strong>Available columns</strong> list. <strong>NOTE:</strong> In case of a distributed system, the <strong>Type</strong> drop-down list displays the Object Models of only the current system on which the report is configured.</td>
</tr>
<tr>
<td>Load</td>
<td>Click this button to populate the <strong>Available columns</strong> list with the columns corresponding to the selected object type in the <strong>Type</strong> list.</td>
</tr>
</tbody>
</table>

![Condition Filter Dialog Box](image_url)
### Available columns

1) Lists all the available columns of a selected table.

For an Objects table, the columns corresponding to the object type selected in **Type** are listed.

In case of the Objects table, displays the following information:

- Common columns applicable to any type of object. These are listed at the top of the list. For example, Discipline, Object Name, Object Description, and so on.
- Columns referring to properties supported by the selected object type. These are listed after the common columns and have a tree structure. When you click any such column, the tree expands and displays the attributes of the property. For example, if you click the expander of the Current_Priority property, its attributes such as Archive, Activity Log, Min, Max, Default, and so on display.

### Operators List

Lists all the operators associated with a specific column selected in the Available Columns list.

### Values List

Lists all the values associated with a specific column selected in the Available Columns list. Moreover, you can select multiple values by pressing **CTRL** or **SHIFT** and selecting different values.

**NOTE:** Multiple values can be typed within braces {} and are separated by a semicolon (;).

### Filter expression field

Displays the filter expression. You can edit a filter expression in this field.

**NOTE:** An invalid filter expression is highlighted in red.

### Read all data from field system

Displays only when an Objects table is selected in the Report Definition. If this option is selected the objects data for filtering is always read from the field system.

### Read all data from process image

Displays only when an Objects table is selected in the Report Definition. If you select this option, the objects data is always read from the cache.

### Read data from field system older than

Displays only when an Objects table is selected in the Report Definition. It allows you to specify the acceptable age of the data on which the filter is applied. If you select this option, the value entered is compared with the age of the data in the cache. If the data in the cache is older than the value entered, it is obtained from the field system; otherwise data from the cache is used for filtering.

### New/Update

Allows you to add or update a filter expression. Update is enabled only when a valid filter expression is added or modified in the filter expression field.

### AND/OR

These are logical operators that allow you to combine filter expressions and create complex filters. This button is unavailable until a filter expression is added to the filter expression field.

### "()"

Allows you to group filter conditions, which define the order of their evaluation. These brackets are unavailable until a filter expression is added to the filter expression field.

---

1) The selected item displays below the list.

### Time Filter

The **Time Filter** group box and the dialog box launcher icon is enabled only when you select a table or plot in a Report Definition for which the Time filter is applicable.

The Time filter allows you to specify time as a filter for retrieving records.
# Time Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date time specification</td>
<td>Shows LOCAL, when the <strong>Date/Time in UTC format</strong> check box on the <strong>Home</strong> tab is not selected.</td>
</tr>
<tr>
<td>Select Column</td>
<td>Displays only when an <strong>Events</strong>, <strong>All Logs</strong>, or <strong>Activities</strong> table is selected in the Report Definition. The entries in the drop-down list depend on table selected and allow you to filter information accordingly. <strong>Events:</strong> Event Time - Time when the event occurred Event Went - Time when the event state changed Transition Time - Time when the event was closed <strong>All Logs:</strong> Date/Time – Date/Time when the activity is performed or state change of the event occurred. Event Time - Time when the event occurred Source Time - Reference Time – <strong>Activities:</strong> Source Time - Reference Time -</td>
</tr>
<tr>
<td>Exact</td>
<td>Allows you to filter data based on the exact date specified.</td>
</tr>
</tbody>
</table>
### Custom

The Custom option allows you to set the date and time as per your requirement. Selecting the Custom option enables the From/To field. The To date should always be greater than From date. If the To date is less than the From date, then the To field is highlighted in red and an error message displays on mouse-over. The From and To date should be same as the date already set in Short date on your management station. The Short Date is to be found under Short date: (Start > Control Panel > Regional and Language Options > Regional Options)

### Relative

Relative has two options: Last and Current Period.

- **Last option** allows you to filter data for the last 'x' period that you specify. For example, last 'x' hours, last 'x' months, last 'x' years, last 'x' weeks, last 'x' days, or last 'x' minutes.

- **Current Period option** allows you to filter data for the current 'x' period that you specify. For example, current 'x' hours, current 'x' months, current 'x' years, current 'x' weeks, current 'x' days, or current 'x' minutes.

For example, if the current date and time on your computer is 10/07/2014 10:35 AM and you specify any of the following:

- **1 Hour in the Last option** - The data for the 9:00 to 10:00 AM period is retrieved.
- **1 Hour in the Current Period option** - The data for the 10:00 to 11:00 AM period is retrieved.
- **1 Month in the Last option** - The data for the period June 01, 2014 to July 01, 2014 is retrieved.
- **1 Month in the Current Period option** - The data for the period July 01, 2014 to August 01, 2014 is retrieved.
- **1 Year in the Last option** - The data for the period January 01, 2013 to January 01, 2014 is retrieved.
- **1 Year in the Current Period option** - The data for the period January 01, 2014 to January 01, 2015 is retrieved.

**NOTE:** The Last and the Current Period field accepts only integer values up to 3 digits.

### Unlimited

Default selection. Allows you to retrieve all records.

### Defined By Source

This option only displays for Trend objects. It sets the date and time to what you have defined for the selected Trend View Definition.

### Null

Allows you to retrieve records with Null value.

### Preview of Resulting Time range

Displays the resulting time range for the options selected in the Time filter dialog box. For example, if the present time is 02/06/2012 4:37 PM, then for the selection current 24 hrs the Preview of Resulting Time Range displays absolute time range for this selection as follows:

- From: Sunday, February 05, 2012 5:00:00 PM
- To: Monday, February 06, 2012 5:00:00 PM.

### Row Filter

Allows you to set the maximum number of rows of a table to be displayed at runtime.

### Languages Filter

Allows you to set the language for a Report Definition. You can configure filters (Condition and Name) in the selected language.

### 3.5.2.4 Layout Tab

The **Layout** tab allows you define the format of layout elements of a Report Definition. It contains the following group boxes:
Page Setup Group Box

The Page Setup group box allows you to set the orientation, page size, and margin of the Report Definition.

Orientation

The Orientation menu contains two submenus:

- Portrait: long vertical edge
- Landscape: long horizontal edge (default)

Page Size

The Page Size menu contains several pre-configured sizes including: A3, A4, A5, Letter, and so on. The default page size is A4.

Margins

The Margins menu has four preconfigured margins with values displayed for quick selection:

- Normal (default)
- Narrow
- Moderate
- Wide

Header/Footer Group Box

The Header/Footer group box allows you to customize the width of the header/footer sections of the report. The text of the group box and values change depending on the header/footer selected in the report definition. For example, on selecting the header, the title displays as Header and vice versa.

The group box contains 3 fields in which you can specify the width of the header/footer section. The values are specified in percentage and the sum of the values in all the 3 fields is 100%. If you specify 100 in any of the fields, then the values in the other 2 fields is automatically updated to 0.

Placement Group Box

Using the Placement group box you can rearrange the position of the report elements in a Report Definition by selecting an element and using the icons: Move up, Move down, Move to top, and Move to bottom.

When there is only one element present or if there are multiple elements but none is selected, then all four icons are unavailable.

Position Group Box

The Position group box allows you to adjust the position of the layout elements of a Report Definition.
Figure 22:

### Position Group Box

<table>
<thead>
<tr>
<th>Alignment</th>
<th>Refers to the placement of objects or layout elements on the report page. The different alignments are: Left, Center, and Right.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indentation</td>
<td>Allows you to set the distance between the report page margin and the actual placement of the element.</td>
</tr>
<tr>
<td>Spacing</td>
<td>Allows you to set the space before and after the layout elements.</td>
</tr>
<tr>
<td>Width</td>
<td>Allows you to adjust the width of a layout element (logo and plot only).</td>
</tr>
<tr>
<td>Height</td>
<td>Allows you to adjust the height of a table/plot (logo and plot only).</td>
</tr>
</tbody>
</table>

### Font Group Box

The Font group box allows you to apply a font type, size, style and/or color to the layout elements such as a label or a table.

The Font group box becomes enabled only when you have inserted a label or a table in a Report Definition template while configuring a Report Definition.

### Auto-scaling Group Box

Selecting the Auto-scaling check box adjusts the column width automatically in PDF documents that are generated when you execute a report.

If the Auto-scaling check box is not selected, then the PDF may not display all table columns.
3.5.2.5 Data Tab

The Data tab allows you to specify the location from which the data is to be retrieved when you run the report. It also provides the option to define the Graphics filter.

If you have selected any of the options from the Table group box, the same option is also selected in the Condition Filter dialog box. Any change in selection reflects in the Condition Filter dialog box as well. However, if you change your selection in the Condition Filter dialog box, it does not reflect in the Table group box options of the Data tab.

<table>
<thead>
<tr>
<th>Data Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read all data from…</td>
<td>Description</td>
</tr>
<tr>
<td>Field system</td>
<td>The objects data is always read from the field system which ensures that you always get the latest data.</td>
</tr>
<tr>
<td>Process image</td>
<td>The objects data is always read from the cache which helps generating reports more quickly.</td>
</tr>
<tr>
<td>Field system older than…</td>
<td>The age of the data entered is compared to the age of the data in the cache. If the data in the cache is older than the value entered, it is obtained from the field system; otherwise the data from the cache displays.</td>
</tr>
</tbody>
</table>

Graphics Group Box

When All Related Graphics is selected, the related graphics and view ports of an object display in Run mode. To view the graphics and view ports, you must assign the object as a Name filter to the graphics plot.

3.5.2.6 Settings Tab

The Settings tab allows you to configure the output format and destination for a Report Definition.

Report Output Group Box

The Report Output group box displays the configured entries for a Report Definition.

Clicking the Dialog Launcher displays the Report Output Definition dialog box that allows you to configure the report output settings. The configured report output definitions are executed when the report definition runs automatically.
### Report Output Definition Dialog Box Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report format</td>
<td>Lists the following supported file formats.</td>
</tr>
<tr>
<td>PDF [⇒ 279]</td>
<td></td>
</tr>
<tr>
<td>Excel [⇒ 279]</td>
<td></td>
</tr>
<tr>
<td>CSV</td>
<td></td>
</tr>
<tr>
<td>XML</td>
<td>This format is available only if you have the relevant license.</td>
</tr>
<tr>
<td><strong>NOTE 1:</strong></td>
<td>According to the EMC requirement, the CSV report format is supported to export a Trends report in the CSV format. The EMC proxies have plug-ins that support converting data from CVS formats for import into EMC. The Desigo CC trend data compatible with the EMC trend data import plug-in, the CSV columns (for trends table only) are modified: Date; Data Source; Value (separated by semicolon). The EMC proxies have plug-ins that support converting data from CVS formats for import into EMC. The Desigo CC trend data compatible with the EMC trend data import plug-in, the CSV columns (for trends table only) are modified: Date; Data Source; Value (separated by semicolon).</td>
</tr>
<tr>
<td><strong>NOTE 2:</strong></td>
<td>The CSV does not support logos or plots; also Report header/footer is not present.</td>
</tr>
<tr>
<td><strong>NOTE 3:</strong></td>
<td>The CSV format applies only to exporting the Trends table.</td>
</tr>
<tr>
<td>Destination types</td>
<td>Lists all the various destination types: File [⇒ 281], Email [⇒ 282] and Printer [⇒ 285].</td>
</tr>
<tr>
<td></td>
<td>The Destination types displayed in the list depend on the type of format selected in Report format.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>When you select the Destination Type as File or Email, you can specify the name of the file that will be generated upon automatic report execution using either of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Use report name as file name</td>
</tr>
<tr>
<td></td>
<td>- Enter custom file name</td>
</tr>
<tr>
<td>Destination</td>
<td>Depending on the Destination types settings, you can configure the destination in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>- <strong>File:</strong> Configured folder name displays in the File drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Email:</strong> Email text field is populated with the pre-configured email contacts.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Printer:</strong> Available printers display in the Printer drop-down list.</td>
</tr>
</tbody>
</table>
| Use report name as file name | Default option. Becomes available only when you select the destination type as File or E-mail. In this case, the **File Name** field is populated with the selected report name and is unavailable. | 1. Use report name as file name  
2. Enter custom file name  
3. Append date/time to file name  
4. Create new/overwrite existing file  
5. Append data  
6. Change  
7. Add  
8. Output Definition List  
9. Delete
| Enter custom file name | When selected, allows you to type in the desired file name in the **File Name** text box.                                                                                                                   |
| File name              | If the file name contains special characters such as, / \ : * ? < > | "", then it is highlighted with a red border and a tool-tip displays the error message.                                                        |
| Append date/time to file name | Becomes available only when you select the destination type as File or Email. When checked, adds the date and time to the file name.                                                                 |
| Create new/overwrite existing file | Default option. Allows you to configure a new file to the configured destination when routing reports. If the file does not exist, a new file is created, existing files are overwritten. |
| Append data            | Adds the currently executing report data to the existing file with the same file name and file type present at the destination. If there is no such file, a new file will be created.                           |
| **NOTE 1:**            | This option only applies to PDFs.                                                                                                                                                                           |
| **NOTE 2:**            | In case of an existing split PDF document, if the Append data check box is selected, the number of available pages in the previous split document is ignored and, a new split document is created in the same folder with an incremental number. |
| Change                 | Allows you to modify an existing Report Output Definition entry.                                                                                                                                           |
| Add                    | Adds a Report Output definition entry to the Output Definition list.                                                                                                                                       |
| **NOTE:**              | This button is unavailable if the Destinations drop-down list is empty.                                                                                                                                     |
| Output Definition List  | Displays the existing Report Output Definition entries.                                                                                                                                                    |
| Delete                 | Deletes the selected Report Output Definition.                                                                                                                                                              |
PDF Report Format

After executing a Report Definition manually or automatically, you can view and save the report as a PDF document. A PDF document contains all the report elements of the Report Definition with output data and sorting applied. It also displays the special formatting applied to Report Definition elements (such as tables, plots, keywords, and so on). The PDF document can have a maximum of 500 pages, however if the number of pages exceeds 500 the document splits into two. You can add digital signatures or watermark text on the generated pdf reports using the Adobe Acrobat DC software (not included).

You can either view the PDF document or the split documents in the Report Management section under the Report snapshot when you generate the report manually or you can locate them in the folder configured in the Report Output Definition dialog box when you generate the report automatically.

Reports do not support TrueType collections for PDF generation. To generate a PDF document for Asian languages, you must select TrueType fonts which support Asian characters in the Report Definition, for example, Arial Unicode MS.

If the PDF document generated for operating procedure does not display any data, ensure the following:

- Check the applied filters and make corrections (if required)
- A graphics containing the object in the event is available

<table>
<thead>
<tr>
<th>Event Time</th>
<th>Event State</th>
<th>Event Category</th>
<th>Event Cause</th>
<th>Event ID</th>
<th>Object Description</th>
<th>Object Designation</th>
<th>User Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/22/2013 2:01:42 AM</td>
<td>Alarm closed</td>
<td>Status</td>
<td>HDB Scheduler (Enabled - Timeout)</td>
<td>18</td>
<td>History Database</td>
<td>System Management</td>
<td>root</td>
</tr>
<tr>
<td>10/22/2013 2:01:42 AM</td>
<td>Alarm set to normal</td>
<td>Fault</td>
<td>Video Services, Fault (Unreachable)</td>
<td>17</td>
<td>Video Manager</td>
<td>System Management</td>
<td>root</td>
</tr>
<tr>
<td>10/22/2013 2:01:42 AM</td>
<td>To alarm</td>
<td>Status</td>
<td>HDB Scheduler (Enabled - Timeout)</td>
<td>18</td>
<td>History Database</td>
<td>System Management</td>
<td>root</td>
</tr>
</tbody>
</table>

Excel Report Format

After executing a Report Definition manually or automatically, you can view and save the report as an Excel (XLSX) document. This enables you to perform any calculations (if required) on the Excel document by applying Excel formulas. You can either view the Excel document in the Report Management section under the Report snapshot when you generate the report manually or you can locate them in the folder configured in the Report Output Definition dialog box when you generate the report automatically. If the size of the document exceeds the Excel maximum of 1000 worksheets or 1,048,575 rows, a new Excel file is created for the next set of records.

An Excel document contains all of the reporting elements of the Report Definition with output data and user-defined configuration. Form Controls in the report definition are not present in the Excel document. Any special formatting applied to the Report Definition elements are not retained in the Excel document.

If you have multiple tables or plots in a report definition, the generated Excel document displays the details of each table or plot in a separate worksheet. Each worksheet also displays information on other reporting elements such as keywords and logos in the report definition. Each column in the worksheet has a combo box that corresponds to a table column that enables you to perform analysis on the table data. In case of an Event Details table the generated Excel document does not have any combo boxes as the data displays parent and child records.

However, if you remove the child columns from the Select Columns dialog box, run
the report, and then generate the Excel document, only the parent records display and the columns display a combo box that enables you to perform data analysis.

In order to perform analysis on a specific set of columns in a table, you can add a PivotTable or chart to the generated Excel document and set this document as a template to the report definition having this table. When you run the report and generate the Excel document, information related to the columns you added to the PivotTable or chart displays in a separate worksheet.

The PivotTable or chart in the template must have columns of only those tables that are present in the report definition. For example, if you have a report definition with an All Logs table, the PivotTable or chart in the Excel document that is set as a template to this definition must have columns specific to the All Logs table only.

In case of an Event Details table, you must remove all the child columns for the PivotTable to be displayed.
In case of a distributed system, the process of generating the PDF or XLS documents will stop if you switch over to a different system. During this process, if the document is likely to be split into multiple documents, then the pending documents will not be available. You can decide whether you want to proceed with the document generation process by confirming to the dialog box options that display when you switch over to a different system.

**File Destination Type**

Before you save a file at a specific location in your local management station, you must configure the output folder paths in the Report Output Folders Configuration dialog box. You can launch this dialog box from the Report Output Definition dialog box.

After configuration, you can view and select these output folder paths in the Report Output Definition dialog box.
Report Output Folders Configuration Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Alias</td>
<td>Displays the name of the destination folder. When you select <strong>File</strong> in the <strong>Destination Type</strong> field, this name will be displayed in the <strong>File</strong> drop-down list of the <strong>Destination</strong> list of the <strong>Report Output Definition</strong> dialog box.</td>
</tr>
<tr>
<td>Folder Path</td>
<td>Displays the folder path that you have selected using the <strong>Browse</strong> button. You can configure a maximum of 100 folder paths. An error message displays if the number of folder path exceeds 100.</td>
</tr>
<tr>
<td>Browse</td>
<td>Helps you to locate the destination folder. You can also create a new folder at a desired location. <strong>NOTE:</strong> If you do not have the required permission on the selected folder, an error message displays.</td>
</tr>
<tr>
<td>Folder Description</td>
<td><em>(Optional)</em> Describes the contents of a folder.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds the Folder Alias, Folder Path, and Folder Description in the <strong>List of folders for Report Output</strong>. This button is unavailable until all the mandatory fields are filled.</td>
</tr>
<tr>
<td>List of Folders for Report Output</td>
<td>Displays list of configured output folders. On selecting a configured output folder, the <strong>Folder Alias, Folder Path, and Folder Description</strong> fields are populated.</td>
</tr>
<tr>
<td>Change</td>
<td>Modifies an existing output folder configuration in the list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a selected entry from the list. This button remains unavailable until an output folder is selected in the <strong>List of Folders for Report Output</strong>. If you try to delete an entry which is used in any other Report Definition, a confirmation message displays.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears all the fields that are populated when you select an output folder entry in the <strong>List of Folders for Report Output</strong>.</td>
</tr>
</tbody>
</table>
Destination Type - Email

The Report Output Definition dialog box allows you to send a report via email. You can send all documents in one mail or configure the number of documents to be sent per email. The default is one document per email.

Before sending an email you must configure the mail server.

The Email Contacts dialog box displays when you select the destination type as Email and then click the Select Contacts button. This dialog box allows you to choose and filter from the list of all recipients having email addresses configured in the Contacts selection list.
### Field Description

**Contacts selection:** Shows the names of the configured contacts in the Address Book followed by their email address in brackets. This list is sorted alphabetically.

**NOTE:** A recipient may have up to three different email addresses configured.

**Filter List Entries:** Allows you to type in a filter. For example, if you type the letter “A”, the recipient list displays all the contacts starting with the letter A.

### Automatic Update of Configured Email Addresses

The Output Definition list in the Report Output Definition dialog box and Contacts selection list in the Email Contacts dialog box updates automatically, if you change or delete the email address of a particular recipient in Address Book.
<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>A recipient email address is changed in the <strong>Address Book</strong></td>
<td>The new email address reflects in the Output Definition list in the <strong>Report Output Definition</strong> dialog box and Contacts section list in the <strong>Email Contacts</strong> dialog box.</td>
</tr>
<tr>
<td>A listed email address of the configured contact is deleted in the <strong>Address Book</strong></td>
<td>The list of email addresses in the Output Definition list in the <strong>Report Output Definition</strong> dialog box displays in red. On moving your mouse pointer over the text, the following tooltip message displays. One or more email addresses are invalid. Select the correct email address. Report will not be sent to the invalid email addresses. <strong>On selecting the report output definition</strong>, the email addresses configured in the definition display in the <strong>Destination</strong> field. The deleted email address displays as <strong>Unknown object</strong>. In order to remove the unknown object from the list, you must select a valid email address from the <strong>Select contacts</strong> dialog box.</td>
</tr>
<tr>
<td>The report is run by clicking the <strong>Execute</strong> button in the <strong>Extended Operation</strong> tab</td>
<td>Report is routed to the valid email addresses configured in the report output definition.</td>
</tr>
<tr>
<td>A recipient is deleted from the <strong>Address Book</strong></td>
<td>The list of email addresses in the <strong>Output Definition</strong> list in the <strong>Report Output Definition</strong> dialog box displays in red. On moving your mouse pointer over the text, the following tooltip message displays. One or more email addresses are invalid. Select the correct email address. Report will not be sent to the invalid email addresses. <strong>On selecting the report output definition</strong>, the email addresses configured in the definition display in the <strong>Destination</strong> field as <strong>Unknown objects</strong>.</td>
</tr>
</tbody>
</table>

**Destination Type – Printer**

The **Report Output Definition** dialog box allows you to send a Report Output Definition to a printer.

You can print all or the first 100 (default) pages. You can edit the default and enter the number of pages to be printed. Currently only PDF report format is supported for printing. To print a PDF report format on a printer, you must configure a server printer.

The document to be printed depends on the sorting you applied to the columns of a table.
3.5.2.7 Report Management Section

The Report Management section displays the Report execution status, such as PDF/XLS document creation status, during Report execution. The Report execution/generation mode is called Run mode. It also provides quick and easy navigation to different Report snapshots. When you select a snapshot in the Report Management section, it displays in Reports.

If you have executed a report and both, a PDF and Excel document are generated from it, you can quickly switch between the two using the Report Management section.

The Reports toolbar has a toggle icon called Report Management, which shows or hides the Report Management section. This section is visible at the bottom of the Reports window.

The Report snapshot of an executed Report Definition in the Report Management section is available until the user logs out. The snapshots in the Report Management section are displayed in a hierarchical manner. For example, if you execute a Report and then view it as a PDF or Excel (XLS) document, then in the Report Management section, the first entry is of Report execution and the second entry is the PDF/XLS creation as displayed in the following image.
You can also monitor the PDF/XLS document creation progress and stop it by using the Stop button. However, if you stop the PDF/XLS document creation when it is in progress, the consecutive split document creation will also be stopped.

You can delete the split document by using the Delete button or all the documents by deleting the Report snapshot entry.

The entry of each split document in a Report Management section is a child of the entry for the Report snapshot. Selecting any document entry, displays the document linked to that entry in Reports.

NOTE:
This section does not display when the report is executed for a selected event from Assisted Treatment.

3.5.2.8 Related Items Tab

The Related Items tab displays New Report, Related Report, and Show-in Related Items Report as a link or icon on selection of a System Browser object.

New Report

This report is always available for quick access to a new Report Definition (as a link or icon) in the Related Items tab upon selection of a System Browser object. On clicking the New Report link/icon, a new Report Definition opens in the Secondary pane (if the Primary pane is unlocked – pushpin horizontal). This Report Definition, by default, contains the Objects table with the Name filter set to the selected object in System Browser. If you select a Trend View Definition/Graphic Definition in System Browser and click the New Report link/icon, then the Report Definition contains a trend plot/graphics plot with the Name filter set to the selected Trend View Definition/Graphic Definition. If multiple objects are selected in System Browser, such as Graphics Definitions, Trend Definitions or BACnet devices/points and you click the New Report link/icon in the Related Items tab, all the selected
objects are set as Name filters for the Objects table (no graphics plot, trends plot). You can then configure and run this report as usual.

**Related Report**

If the selected System Browser object is defined as a Name filter in a report, then this report becomes a related report for that object and displays as a link/icon in the Related Items tab. On clicking this link/icon, the related report runs. During the related report execution, the data is retrieved according to the Name filter set for the report element in the Report Definition. The Name filter set in the report element is not replaced by the selected System Browser object. For example, if an Event Details report is present in the Related Items tab, it can be run for the selected event in the Event List.

**NOTE:**

Ensure that in a Report Definition, you have set the complete path of the system object as the Name filter (without any wild cards). If a wild card (‘?’ or ‘*’) is used in the Name filter, then this Report Definition is not set as a related report and does not display in the Related Items tab.

**Show in Related Items Report**

When you select a System Browser object, the reports having Show In Related Items check box selected are displayed (as a link/icon) in the Related Items tab. On clicking the link/icon, the report executes. During the report execution, the Name filter is set to the path of the selected object in System Browser. If a Name filter was configured in the report, it is replaced with the path of the selected object.

### 3.5.3 Reports Modes

Reports operates in two modes:

**Edit Mode**

When you create a new Report Definition, it opens in Edit mode (default mode). Edit mode allows you to design the layout of a report, delete a report, and so on.

You can also display/hide the Reports ribbon using the Properties icon.

**NOTE:**

You can switch to Run mode by clicking the Run icon or Run As icon in the Reports toolbar.
Run Mode
The Run mode executes a Report Definition and displays the data retrieved from Reports and other services. Following are the characteristics of the Run mode:

- The ribbon disappears.
- Keywords are replaced by actual data.
- No element can be added or deleted in this mode.
- The layout elements are populated with data.
- You can perform the following activities:
  - Sorting (ascending or descending) or changing column width.
  - Selecting rows in tables.
  - Entering text in the Editable Field control.
  - Selecting text entries from the Custom Text Selection control or values of a text group from the Text Group Selection control.
  - Adding, modifying, and deleting comments from the Comments table.
- The Stop icon or the Stop button in the Report Management section stops the execution of a Report Definition.
- In Run mode, when you move the cursor over a table/plot, a tooltip displays the applicable filter and the number of records (only for tables). The number of records tooltip is helpful in deciding the destination type, for example, Printer.
- You can toggle to Edit mode by clicking Edit on the Reports toolbar. If you perform sorting in Run mode and then switch to Edit mode, the Select Edit Option dialog box displays asking whether you want to save or discard the changes you made in the Run mode, or to create a new Report Definition based on the changes.

NOTE:
When you select Control Panel > Region and Language > Additional Settings, you can configure local settings for the following fields:
- numeric (including decimal symbol, no. of digits after decimal)
- short date
- short time
The report workspace specifications, such as page size/margin or table width/height, also change according to the local settings.
3.5.4 Report Workpanes

You can work with reports in the following panes:

**Primary Pane**

In the Primary pane, you can view and work with all types of reports and perform activities including, but not limited, to the following:

- Create and configure a Report Definition by:
  - Adding various report elements
  - Configuring filters
  - Applying formatting
- Locate and Modify a Report Definition
- Run a selected Report Definition
- View report execution status, document creation status, and so on during report execution
- Display generated report in Run mode
- View a report as a PDF or XLS
- Export/Import a Report Definition
- Route a report to:
  - Folders as files (PDF/XLS)
  - Email recipients as a file attachment (PDF/XLS)
  - Local printers (PDF only)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Report Definition</td>
<td>Location of Report Definition and Report folders in the Application View of</td>
</tr>
<tr>
<td>Selection</td>
<td>System Browser.</td>
</tr>
<tr>
<td>2 Report Execution</td>
<td>Reports toolbar containing Report Definition execution command icons: Run</td>
</tr>
<tr>
<td></td>
<td>or Run As</td>
</tr>
<tr>
<td>3 Executed Report Display</td>
<td>Location of executed Report Definition. NOTE: This displays in Run mode.</td>
</tr>
<tr>
<td>4 Report Management</td>
<td>Status details of the executed or currently running Report Definition.</td>
</tr>
<tr>
<td>5 Report Definition</td>
<td>Properties (Last Run, Summary Status, and Show in Related Items) displayed</td>
</tr>
<tr>
<td>Properties</td>
<td>in the Extended Operation tab.</td>
</tr>
</tbody>
</table>
Secondary Pane

If the Primary pane is unlocked (horizontal pushpin icon -●), then you can work with the following three additional report types in the Secondary pane:

- Related Report: Opens the report related to the selected System Browser object.
- Show in Related Items Report: Opens a report with the Show in Related Items check box selected.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Point Selection</td>
<td>Location of Point in the Application View or Management View of System Browser.</td>
</tr>
<tr>
<td>2 Report Definition Selection</td>
<td>Report Definition selected in the Related Items tab.</td>
</tr>
<tr>
<td>3 Executed Report Display</td>
<td>Location of selected Report Definition—before and after execution—with command toolbar to execute the Report Definition located on the left side of the Secondary pane. NOTE: Executed Report Definitions display in Run Mode.</td>
</tr>
<tr>
<td>4 Report Management</td>
<td>Status details of the executed or currently running Report Definition.</td>
</tr>
<tr>
<td>5 Report Definition Properties</td>
<td>Properties (Last Run, Summary Status, and Show in Related Items) displayed in the Extended Operation tab.</td>
</tr>
</tbody>
</table>

Contextual Pane – Extended Operation Tab

You can generate a selected report automatically by clicking Execute in the Extended Operations tab of the Contextual pane.
### 3.6 Trends

The Trends application allows you to work with trends that are recurring samples of data. These data samples can be taken at regular time intervals or whenever there is a change in a value of an object by a prescribed amount. Some examples of data samples in trending include the following:

- Collecting the room temperature after every 10 minutes.
- Sensitivity reading of smoke detectors once per week.

Trends are of two types, online and offline. Online trends record real-time values from your plant and display them graphically in a Trend View. Offline trends data is used for the longer-term storage and retrieval of historical data for the analysis of entire plants or single processes.

You can add, modify, and delete values of trended properties of trended objects that are logged in online as well as offline trends through the Manual Correction application.

You can use Trend Views in two ways in the management station:

- During operation, trend data recorded in real-time and saved to the trend database (management station is online).
- Trend data is recorded in the automation station (management station is offline) and periodically loaded to the management station trend database.
- You can display the trend data in the Trend Viewer any time, even if the management station is not connected to the site (no real-time data available).

The Trends application is covered by a license. In order to access the Trends application, you must ensure that the Trends license is available in your system.

#### Record Trend Data

You can record trend data using either of the following methods:

- **Change-of-value (COV)**
  The change-of-value method allows you to record new data when the data point value changes. No value is recorded or transmitted if the value does not change over an extended period of time. Database acquisition of several data points in a Trend View is asynchronous.

- **Interval-based**
  The interval-based method is applicable to record offline trend data. It allows you to record current data as soon as the timestamp is reached. The data values are recorded without impacting a defined COV property.
Trends in Distributed System

When working with trends in a distributed environment, you must understand the details of the following applicable conditions:

- **System Name** column - A column named System Name has been added as an additional column to the Trends application. It displays the name of the system to which the source object belongs. You can select this column by right-clicking the column header on the legend and selecting System Name from the menu options.

- A Trend log multiple object cannot have objects from multiple systems.

- A Trend log or Trend log multiple object can be created only on that system where the selected trended object belongs.

- You can create a Trend View Definition with objects from multiple systems.

This section provides background information on Trends of Desigo CC. For related procedures, see the step-by-step section.

### 3.6.1 Trends Workspace

Trends are divided into the following main elements:
Operating Reference
Trends

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 System Browser</td>
<td>Displays available Trendlog objects, as well as created Trend Views.</td>
</tr>
<tr>
<td>2 Configuration</td>
<td>Displays buttons for commonly used commands (New, Save, Print, zoom).</td>
</tr>
<tr>
<td>3 Compare view</td>
<td>Allows you to compare measured values from the same Trend View.</td>
</tr>
<tr>
<td>4 Trend View</td>
<td>The range which can be displayed and processed for online and offline trend data in chart form. These Trend Views are saved independently of the trend data.</td>
</tr>
<tr>
<td>5 Key</td>
<td>Displays information on data points that are displayed graphically in the Trend View.</td>
</tr>
</tbody>
</table>

System Browser
The following nodes display in the Trends folder in the System Browser:

**Manual Correction:** Link that opens the Manual Correction application.

**Offline Trend Log Objects:** Lists all the offline Trendlog objects available in the automation station for a project.

**Online Trend Objects:** Lists all available online Trendlog objects. An online Trendlog object is created when you define a series and save it in a Trend View definition. However, this Trendlog object is available only on the management station. No Trendlog object is created in the automation station.

**Trend View Definitions:** Lists all the Trend View definitions. A Trend View definition includes all the properties required for a graphical display of the Trend View and series. A Trend View definition does not contain process values, but only one reference to the corresponding series (Trendlog objects).
## Trends Toolbar
The Trends toolbar allows you to perform the following operations:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Trend</td>
<td>Toggles between the Edit Trend mode and the View Trend mode.</td>
</tr>
<tr>
<td>Start Creation</td>
<td>Starts creating the trend logs depending on the configuration specified in the Edit Trend mode.</td>
</tr>
<tr>
<td>New Trend</td>
<td>Opens a new Trend View.</td>
</tr>
<tr>
<td>New Folder</td>
<td>Creates a new folder.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the current Trend View.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current Trend View.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the Trend View under a new name.</td>
</tr>
<tr>
<td>Save as user default</td>
<td>Saves the Trend View definition as a new user default.</td>
</tr>
<tr>
<td>Properties</td>
<td>Opens the properties dialog box for chart, axes, legends, and series.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops trend logging.</td>
</tr>
<tr>
<td>Run</td>
<td>Starts trend logging.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the Trend View.</td>
</tr>
<tr>
<td>Compare view</td>
<td>Opens the same Trend View a second time.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Allows you select a time range in the currently selected Trend View by effectively zooming in on the X-axis and Y-axis.</td>
</tr>
<tr>
<td>Time bar</td>
<td>Shows/hides the time bar.</td>
</tr>
<tr>
<td>Table view</td>
<td>Switches from graphical Trend View to a table view.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the Trend View Definition and saves it in a CSV file format.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the Trend View.</td>
</tr>
<tr>
<td>Show legend / Hide legend</td>
<td>Shows/Hides the legend. This button is disabled when you display the trend in the table view.</td>
</tr>
</tbody>
</table>
## Chart Properties

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Hides/shows the grid for the Trend View or displays it with horizontal or vertical lines.</td>
</tr>
<tr>
<td>Background</td>
<td>Hides/shows the background color as well as pattern for Trend View. Allows you to define or select the background from a predefined set of colors.</td>
</tr>
<tr>
<td>Titles</td>
<td>A descriptive name required for each Trend View. The name entered displays on the Trend View. You can also add your own title to the left and right axis of the Trend View.</td>
</tr>
<tr>
<td>Maximum displayed samples per series</td>
<td>Specifies how many values are displayed in a Trend series during the defined Trend View period. This setting directly determines if Trend View displays the values in a reduced view (For more information, see Data Point Key, Reduced values). <strong>NOTE:</strong> A maximum of 2000 values can be displayed in a Trend series during the defined Trend View period.</td>
</tr>
<tr>
<td>Advanced display if chart stopped</td>
<td>Displays quality attributes, markers, and values, even for cleared check boxes, if the open Trend View is updates continuously. This means that updating the values takes longer.</td>
</tr>
</tbody>
</table>

## Axis Properties

Allows you to specify the settings for the X and Y axis.

Each chart can display a left and right Y-axis independent of each other. Series can be selectively assigned and scaled to either axis, by default or manually. Scaling is set to automatic by default. This means that the range is defined by the highest amplitude of all displayed series, with analog data types attached to the left axis and digital data types to the right axis. When a single Trend View contains several digital data types, these are shown one above the other with an offset. When a single Trend View contains several digital data types, these are shown one above the other with an offset.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Y Left</td>
<td>Displays the title on the left side of the Trend View. <strong>Auto Scale:</strong> A minimum and maximum range must be defined if auto scale is disabled.</td>
</tr>
<tr>
<td>Title X</td>
<td>Displays the title below the Trend View.</td>
</tr>
<tr>
<td>Title Y Right</td>
<td>Displays the title on the right side of the Trend View. <strong>Auto Scale:</strong> A minimum and maximum range must be defined if auto scale is disabled.</td>
</tr>
</tbody>
</table>
NOTE:
Automatic/manual scaling properties act on both main and comparative view. Automatic scaling is temporarily disabled when switching to **Zoom** mode.

### Legend Properties

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend</td>
<td>The position can be left, right, above, or below the Trend View. Under a comparison view, the legend always displays on the right.</td>
</tr>
</tbody>
</table>

### Series Properties

Series properties allow you to define the individual series for the corresponding properties in Trend View.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Properties</td>
<td>Defines the appropriate property type, form and color, as well as the property for the series.</td>
</tr>
<tr>
<td>Visible</td>
<td>Displays the trend curve if this check box is selected.</td>
</tr>
<tr>
<td>Show Markers</td>
<td>Defines the corresponding property type, and size, as well as the corresponding property for the series. The markers are only displayed in the trend curve if this check box is selected. The X-axis is always the time axis. The diagram display is calculated to correspond to the selected time line.</td>
</tr>
<tr>
<td>Show Values</td>
<td>Displays numerically each measured value for the read value if this check box is selected. Values may overlap (unreadable) in the Trend View for intensive measured recorded values or a time range that is too large. In this case, select a smaller time range or switch to display values.</td>
</tr>
<tr>
<td>Show Quality Icons</td>
<td>The Trend View can display a number of state attributes, referred to as quality attributes, along with the trend data. These enable you to identify problems with the data point being recorded, and assist with the diagnosis of plant conditions.</td>
</tr>
</tbody>
</table>
Colors:
You can assign a color to the Trend View (background color) or to each individual series (line). You can choose between:
- Predefined set of colors.
- Custom colors.

Time Bar Scrollbar
The Time bar consists of a vertical bar and a time/date field. The time bar can be dragged anywhere on the time axis. The data legend below the Trend View shows the value for a point. The most recent value with information related to the point, date/time, quality displays at the intersection of the time bar and the graph representing the point.
Compare View
The Compare View allows you to compare and analyze the data of trended objects over a period of time. The Trend View below the first view is the current Trend View that serves as the basis for the first view which is the compare view. Any changes to the time range in the current Trend View are reflected in the comparative Trend View. You can link the same or another Trend View for data analysis that applies the same X-axis for the time range to both Trend Views. Using the pre-defined time ranges present in the comparative Trend View, you can select the time range for which you want to display the data in the comparative view.

In order to view the trend data in a compare view, you must stop the Trend View and hide its properties.

Same Trend View
This type of comparison is especially useful when analyzing the data for individual components, such as a room temperature for a room. The time offset allows you to easily check how the corresponding measured value behaves at the same time of day.

NOTE 1:
The legend displays the last left measured value in the time bar.

NOTE 2:
In the legend, the displayed value is not displayed based on the intersection of the time bar and trend curve. Instead, the time/date display is based on the time bar position.
Trend View

The Trend View consists of a chart area where series are viewed and manipulated. All the main elements such as the axes, scaling, titles and colors can be configured in Trend View properties (by taking over defaults or changing the current Trend View).

### Description

1. Displays the title of the current Trend View.

2, 11. Displays and highlights the selected trend curve in Trend View.

   **NOTE:** To display a change of value on a binary value, an additional dotted zero line displays at State 1 or One.

3, 12. Displays unselected trend curves as collapsed curves.

4. Displays the time bar. The time bar can be dragged anywhere on the time axis. The data legend at the bottom of the Trend View displays the value or state valid at the point where the bar intersects with the series. When the time bar is hidden, the legend displays the last correct value for the Trend View.

5. Displays the present measured value for the series at the cursor. The current measured value in a graphic curve is displayed by moving the mouse pointer to the desired position. The precise measured points can be better displayed by enabling the marker for the series.

6. Displays the Y-axis with the appropriate scaling. Each chart can display a left and right Y-axis independent of each other. Data series can be selectively assigned and scaled to either axis (by default or manually).

7. Legend header.

8. **Online:** Current value from the automation station.

   **Offline Trend:** The values are displayed as a function of the time bar [3].

9. Displays time or date range display across the entire selected display range.

10. Displays time range scrollbar.

11. Displays time and/or date display for the grid.

12. Displays time range display between grid sections.

### Legend

The legend for the series contains information on the given data point in the Trend View. When you launch the Trends application, the legend displays at the bottom by default.

You can resize the legend using the horizontal splitter. The option to resize is available only if the legend is positioned at the top or bottom. On selecting a new Trend View, the legend retains its size depending on the last resize.
### Data Point Key

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series source.</td>
<td>Indicates if the displayed data is recorded by the management station data (online) or a field device (offline).</td>
</tr>
<tr>
<td>Trended Object</td>
<td>Displays the object names for the Trendlog object.</td>
</tr>
<tr>
<td>Trended Property</td>
<td>Displays the trended property name for the object.</td>
</tr>
<tr>
<td>Alias</td>
<td>Displays the alias name for the object.</td>
</tr>
<tr>
<td>Unit</td>
<td>Physical unit for the data point.</td>
</tr>
<tr>
<td>Value</td>
<td>Displays the last displayed current value (unless the time bar is in use. In this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time for the most recent value (unless the time bar is used; in this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date for the most recent value (unless the time bar is used; in this case, the value is displayed at the intersection).</td>
</tr>
<tr>
<td>Reduced</td>
<td>When this symbol displays, not all values for this series are displayed in the Trend View (dependent on the displayed time period).</td>
</tr>
<tr>
<td>Y-axis</td>
<td>Indicates the Y-axis where the point is scaled.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected trend value from the Trend View.</td>
</tr>
<tr>
<td>Show/hide</td>
<td>Temporarily shows/hides the trend curve in the Trend View.</td>
</tr>
<tr>
<td>System Name</td>
<td>Displays the system name of the trended object. The system name enables you to identify the origin of the trended objects in a distributed environment.</td>
</tr>
</tbody>
</table>

#### Reduced Display

Displays a maximum of two values per interval. The interval is calculated based on the set sample rate for the Trend View (Trend Chart Properties).

- 1 interval = Max. displayed samples per series/2.
  - Example 1: 100/2 = 50 intervals
  - Example 2: 400/2 = 200 intervals

A reduced display can also occur with just a few values, for example, when the values are recorded within a short interval. With the reduced display, minimum and maximum values always display.
Quality Attributes

The Trend View can display a number of state attributes, referred to as quality attributes, along with the trend data. These enable you to identify problems with the data point being recorded, and assist with the diagnosis of plant conditions. With the reduced display, not all quality attributes can be displayed. In order to display all quality attributes, limit the time period. Only the highest priority displays in the Trend View if several states are active. The priority sequence in the previous quality attributes table is read in descending order (highest to lowest priority). The following table describes these quality attributes:

<table>
<thead>
<tr>
<th>Quality Attributes</th>
<th>Symbol</th>
<th>BACnet</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRIVER_FAILED</td>
<td>(Bit=1)</td>
<td>No connection</td>
<td>Indicates that no connection exists to the logged data point.</td>
<td></td>
</tr>
<tr>
<td>DRIVER_FAILED</td>
<td>(Bit=0)</td>
<td>Connected</td>
<td>Indicates that the connection exists to the data point.</td>
<td></td>
</tr>
<tr>
<td>ERROR_IN_LOG</td>
<td></td>
<td>Error</td>
<td>Indicates an error in the Trendlog object.</td>
<td></td>
</tr>
<tr>
<td>T_LOG_ENABLE</td>
<td>(Bit=0)</td>
<td>Trend disabled</td>
<td>Indicates that the Trendlog object is disabled.</td>
<td></td>
</tr>
<tr>
<td>T_LOG_ENABLE</td>
<td>(Bit=1)</td>
<td>Trend enabled</td>
<td>Indicates that the Trendlog object is enabled.</td>
<td></td>
</tr>
<tr>
<td>T_PURGED</td>
<td></td>
<td>Buffer deleted</td>
<td>Indicates that the buffer in the Trendlog object is deleted.</td>
<td></td>
</tr>
<tr>
<td>T_ROLLOVER</td>
<td></td>
<td>Buffer full</td>
<td>Indicates that the Trendlog buffer is full.</td>
<td></td>
</tr>
<tr>
<td>T_TIME_SHIFT</td>
<td></td>
<td>Time change</td>
<td>Indicates that the time in the automation station was changed (displayed in table only).</td>
<td></td>
</tr>
<tr>
<td>LOG_INTERRUPTED</td>
<td></td>
<td>Power fail</td>
<td>Indicates that the automation station has been set to state Log_interrupted in the trend buffer (for example: in the event of a power outage, application program stop, change of data point log type). This may cause trend data from not being logged.</td>
<td></td>
</tr>
<tr>
<td>OUT_OF_SERVICE</td>
<td>(Bit=1)</td>
<td>Out of Service</td>
<td>Indicates that the <strong>Out of Service</strong> property is switched on.</td>
<td></td>
</tr>
<tr>
<td>OUT_OF_SERVICE</td>
<td>(Bit=0)</td>
<td>Out of Service is normal</td>
<td>Indicates that the <strong>Out of Service</strong> property is switched off.</td>
<td></td>
</tr>
<tr>
<td>FAULT</td>
<td>(Bit=1)</td>
<td>Trendlog object error</td>
<td>Indicates that a data point error exists in the Trendlog object (values may not be usable for follow-on evaluation).</td>
<td></td>
</tr>
<tr>
<td>FAULT</td>
<td>(Bit=0)</td>
<td>Return from Trendlog error</td>
<td>Indicates that the data point error returns to the normal state.</td>
<td></td>
</tr>
<tr>
<td>ALARM</td>
<td>(Bit=1)</td>
<td>In alarm state</td>
<td>Indicates that the data point is in the alarm state.</td>
<td></td>
</tr>
<tr>
<td>ALARM</td>
<td>(Bit=0)</td>
<td>Return from the alarm state</td>
<td>Indicates that the data point has returned from the alarm state.</td>
<td></td>
</tr>
<tr>
<td>OVERRIDDEN</td>
<td>(Bit=1)</td>
<td>Into override (module)</td>
<td>Indicates that the data point on a module is overridden.</td>
<td></td>
</tr>
<tr>
<td>OVERRIDDEN</td>
<td>(Bit=0)</td>
<td>Return from overridden (module)</td>
<td>Indicates that the data point's override on the module is removed.</td>
<td></td>
</tr>
</tbody>
</table>
NOTE:
Quality attributes can only be evaluated if this function supports the corresponding subsystem. An alarm setup on the management station does not possess quality attributes. Therefore, an alarm cannot display an alarm bell in the Trend View.

Table View
The table view offers a view that differs from the standard view where curves are displayed as series. Each series displays as a column in the data grid. The first column (right) shows the time stamp. The column displays by merging all time stamps for all values in each series. It is displayed at an accuracy of 1 second. In order to view the trend data in a table view, you must stop the Trend View.
Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.

Description

1 Timestamp for measurement.
2 Sorts values by ascending or descending timestamp.
3 Displays the trended object along with the property and alias of the object. It also displays the corresponding color of the trended object in the graphical view.
4 Displays the values in a reduced manner and with a red background if a long time frame is selected in the Trend View.
5 Displays the quality attribute with measured value, except Normal.
6 Displays interpolated values when this function is active. NOTE: The priority is displayed in the table if a subsystem supports information on BACnet write priority (1–16).
7 Shows/hides the interpolated values.

There are two display types in table view:
- **Normal view**: The corresponding cell has a value or is empty.
- **Interpolated view**: The corresponding cell is empty and shows a linear interpolated value based on previous current and subsequent current selection.

NOTE:
The table view only shows values as per the graphical time range. These values are exported during data export.
Edit Trend Mode
The Edit Trend mode provides options to operate on multiple BACnet trend log objects in a single click. If you have to create, modify, or delete multiple BACnet trend log objects, then performing this procedure on individual objects requires a huge engineering effort. Therefore, in order to overcome this difficulty, there are options provided in the Edit Trend mode that enable you to create, modify, and delete the multiple BACnet trend log objects in a single click. In this mode, you can only work with BACnet points and BACnet trend log objects.

You must have the Configure application right on the Trends application and BACnet Configurator to be able to work with the Edit Trend mode.

When you are in the Edit Trend mode, only the Edit Trend and New buttons are available.

The Edit Trend mode allows you to perform the following tasks:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Trend [→ 135]</td>
<td>Allows you to create multiple BACnet trend log objects in a single click. This menu option is available depending on the following:</td>
</tr>
<tr>
<td></td>
<td>● The selected BACnet points belong to the same system and subsystem.</td>
</tr>
<tr>
<td></td>
<td>● The selected BACnet points are not BACnet trend log objects or BACnet trend log multiple objects.</td>
</tr>
<tr>
<td>Modify Trend [→ 137]</td>
<td>Allows you to modify the multiple BACnet trend log objects or multiple BACnet trend log multiple objects in a single click. This menu option is available depending on the following:</td>
</tr>
<tr>
<td></td>
<td>● The selected objects are either BACnet trend log objects or BACnet trend log multiple objects that belong to the same system and subsystem.</td>
</tr>
<tr>
<td></td>
<td>● The selected objects are not BACnet points.</td>
</tr>
<tr>
<td>Delete Trend [→ 137]</td>
<td>Allows you to delete the multiple BACnet trend log objects or BACnet trend log multiple objects. This menu option is available depending on the following:</td>
</tr>
<tr>
<td></td>
<td>● The selected objects are BACnet trend log objects belonging to any system or subsystem.</td>
</tr>
<tr>
<td>Change Property [→ 136]</td>
<td>Allows you to change the default property of the selected BACnet points. This menu option is available depending on the following:</td>
</tr>
<tr>
<td></td>
<td>● The selected BACnet points are of the same type and belong to the same system and subsystem.</td>
</tr>
<tr>
<td></td>
<td>● The selected objects are not trend log objects or trend log multiple objects.</td>
</tr>
</tbody>
</table>
### Trend Definitions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trendlog Name</td>
<td>Specify a unique name for the trend log object.</td>
</tr>
<tr>
<td>Device</td>
<td>The device on which the trend log object is to be created. While selecting</td>
</tr>
<tr>
<td></td>
<td>the device, you must ensure the following: 1. The device belongs to the</td>
</tr>
<tr>
<td></td>
<td>same subsystem as that of the BACnet point selected for the trend log</td>
</tr>
<tr>
<td></td>
<td>creation. 2. The device belongs to the same network and the same driver as</td>
</tr>
<tr>
<td></td>
<td>that of the BACnet point selected for the trend log creation.</td>
</tr>
<tr>
<td>Create Trend Log</td>
<td>Multiple Check this box if you want to create trend log multiple object for</td>
</tr>
<tr>
<td></td>
<td>all the selected points.</td>
</tr>
</tbody>
</table>

### Logging Type

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default from Device</td>
<td>The data entry is logged according to the default logging type of the device.</td>
</tr>
<tr>
<td>Polled</td>
<td>The data entry is polled periodically.</td>
</tr>
<tr>
<td>Triggered</td>
<td>The data entry is triggered when the trigger property is set to ON.</td>
</tr>
<tr>
<td>COV</td>
<td>The data entry is captured when the value of the trended property changes.</td>
</tr>
</tbody>
</table>

### Log Interval

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Interval</td>
<td>This setting will be available only when the Logging Type is set to Polled.</td>
</tr>
<tr>
<td></td>
<td>Specify the time interval when the trend samples are to be collected.</td>
</tr>
<tr>
<td></td>
<td>You can either select any one of the specified interval values or can specify a</td>
</tr>
<tr>
<td></td>
<td>custom value for the log interval.</td>
</tr>
</tbody>
</table>

### Buffer Size

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffer Size</td>
<td>Specify the maximum number of records that can be stored in the buffer.</td>
</tr>
<tr>
<td>Stop when full</td>
<td>Indicates whether or not the logging of records in the buffer should stop</td>
</tr>
<tr>
<td></td>
<td>when the buffer is full. If this box is checked, the logging of records in</td>
</tr>
<tr>
<td></td>
<td>the buffer will stop when the number of records in the buffer reaches the</td>
</tr>
<tr>
<td></td>
<td>buffer size.</td>
</tr>
</tbody>
</table>

### Start/Stop

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop</td>
<td>Specify the start and end date/time when you want to start and end the</td>
</tr>
<tr>
<td></td>
<td>recording of trend values.</td>
</tr>
</tbody>
</table>

### 3.6.2 Manual Correction

The Manual Correction application allows you to add, modify, and delete values of trended properties of trended objects that are logged in online as well as offline trends. The trend information such as date/time, value, status, and unit information pertaining to only a single trended property displays in a tabular form in the **Filtered Data** section. By default, the data is displayed for a time period of one day. However, you can select the desired time range to fetch the latest data. You can apply further sorting and filtering on the displayed data to get a more precise data set.
### Manual Correction Workspace

**Name** | **Description**  
--- | ---  
1 Manual Correction toolbar | Contains buttons for performing various actions on the Manual Correction application.  
2 Trended Object | Displays the object whose property details are to be modified.  
3 Trended Properties | Displays the trended properties of the trended object. If the object has multiple trended properties and is referenced in online as well as offline trends, then the multiple properties along with the names of the offline trends in which the object is referenced display.  
4 Time Filter | Allows you to specify the time series for which you want to display the data.  
5 Filtered Data | Displays information of the selected trended property of the object.  

### Manual Correction Toolbar

The **Manual Correction** toolbar allows you to perform the following operations:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| | Run | Displays the data for the selected trended object property.  
| | Add | Displays the **Add Trend Entry** dialog box to add new entries to the **Filtered Data** section. This button is disabled when you select multiple entries in the Filtered Data structure.  
| | Edit | Displays the **Edit Trend Entry** dialog box with the details of the selected entry to be modified.  
| | Delete | Displays the **Delete Trend Entry** dialog box for deleting the selected entry or entries from the **Filtered Data** section.  

### Filtered Data

The **Filtered Data** section displays the information on the trended data in a columnar pattern in a tabular structure. Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.
3.6.3 Offline Trends

Offline trend data is used for the long-term storage and retrieval of historical data for the analysis of entire plants or single processes. With offline trends, data is recorded directly in the automation station. You can retrieve the data as needed or automation stations can automatically upload the data. Offline trend data can be recorded and saved by Trendlog objects within the automation and control system even when the management station is not connected. The recorded data can then be saved in the trend database. Offline trend data can be retrieved and displayed in the trends.

You can create an offline trend to assign the outside temperature to the Trendlog object in the automation station if you want to calculate energy consumption and need the outside air temperature series for measured values. You can then manually or automatically (periodically) upload the recorded temperature data to store in the management station.
### Phase 1: Record Offline Trend Data

Trend data is saved locally to the Trendlog object in the automation station.

### Phase 2: Upload Offline Trend Data

Trend data is uploaded if:
- The maximum buffer size is reached.
- The number of defined entries is reached.
- Manually triggered by the management station.

You can create and delete BACnet objects without engineering tools from the applicable manufacturer. The corresponding BACnet function must be supported by the automation station from the given manufacturer.

**NOTE:**
Trendlog or Trendlog multiple objects that are created permanently with the engineering tool cannot be deleted from the Management Platform. In the image above, the Trendlog within the solid black box represents the Trendlog created with the engineering tool. The Trendlog within the blue dashed box represents the Trendlog created on the Management Platform and which can be deleted.
3.6.4 Online Trends

Online trends record real-time values from your plant and display them graphically in a Trend View. The data values are sent to the trend application upon each change of value. The measured values are temporary and can be stored for later queries continuously in the Trend database using online Trend log objects. Online trends can be used for real-time visualization of one or more process variables, usually for analysis or diagnosis.

You can create an online trend in situations where the room temperature is too low and record the temperature data for a specific time period. You can further analyze the measured values in a trend curve directly on the management station.

### Record Online Trend Data

<table>
<thead>
<tr>
<th>Automation Station</th>
<th>Trend DB</th>
<th>Management Station</th>
</tr>
</thead>
<tbody>
<tr>
<td>64°F</td>
<td>64°F</td>
<td>Trend data are uploaded continuously to the management station and are not saved in the automation station.</td>
</tr>
</tbody>
</table>

### NOTE:

An uninterrupted site connection with the management station is required. Measured values may be irretrievably lost when the site is interrupted during data recording. Therefore, online trend is not well suited for long-term secure data recording.

3.6.5 Predicted Trends

Desigo CC can use time series to predict future values. For example, predicting weather for the upcoming days by reading weather forecast data from a weather service. Predicted future values display in a graph using the Trends application. Many predicted trends can be combined with other trended objects/properties. Also, forecast data can be combined with the values of the same parameter saved in the history database, as well as, can be compared with real-time data. For instructions, see Additional Predicted Trends Procedures [→ 138].

3.6.6 Trend Data Storage

Recorded trend data can be stored in three different locations:

- **Offline Trendlog Objects:** Offline trend data is saved in the automation station.
- **Online Trendlog Objects:** Contains the online trend data recorded and saved in the management station.
- **Archived Trend Database (not in version 2.0):** Contains all recorded trend data moved previously to the archive database.
Offline Trendlog Objects
Offline trend data can be recorded and saved by Trendlog objects within the automation and control system even when the management station is not connected. The recorded data can then be saved in the trend database. Offline trend data can be retrieved and displayed in the trends.

Online Trendlog Objects
Data recorded by online trending and saved to the trend database (for example, using save continuously) can be retrieved and displayed in the trends. Online Trendlog objects record data also when the Trend View is closed.

Database Storage Capacity
In the database, 10 GB is saved for the SQL Server Express and 250 GB of historical data for SQL-Server. Once 90% of the database size is reached, 10% of the oldest data entries are deleted. This 10% of data always refers to the entire time axis for the collected data. Therefore, it cannot be exactly determined how many entries or the database size that is actually deleted. Additional incoming entries are rejected if the 10% of data entries cannot be deleted before reaching 98% of the database size.

The data amount is comprised of the following:
- System activities
- Alarm messages
- Trend data

Change to Daylight Savings Time
- Date and time data is saved in UTC format. Entries are in double for one hour when setting back to normal time. In this case, the curve displays using both values. When switching to daylight savings time, no value displays in this hour and the displayed line is straight between the two measured values.
- A system message `Anomaly` is generated when changing times that must be acknowledged.
3.7 Log Viewer

The main function of the Log Viewer is to present you the historical data of all system activities and events without having to create and configure a report from the reports application.

This section provides background information on Log Viewer. For related procedures, see the step-by-step section.

3.7.1 Overview of Log Viewer

The Log Viewer application allows you to view the historical data related to system activities and events directly without creating and configuring a report from the Reports application.

The information related to all the system activities and events displays in a tabular format. You can create a subset of this information by applying the necessary configurations such as filters, identifying the columns to display, specifying the number of records to display, and other settings, such as resizing the column width or re-ordering the columns.

Once configured, this information can be saved as a log view definition that can be used later. When you access the log view definition at a later date, the latest data, according to the configurations that you have applied to the definition, displays.

When you save the data as a log view definition that has sorting applied, the sort criteria is also saved. The next time when you load the log view definition, the data with the saved sort criteria displays.

In a distributed system, the data from all the systems displays in the log view grid.

You can view log data using any of the following procedures:

- Selecting the Log Viewer root node, a log view folder, or a saved log view definition from the System Browser.
- Selecting an object from System Browser: This displays the Activity and Event Log records for the selected object in the Detailed Log tab.
- Selecting an object from any application such as Graphics, Trends, Textual Viewer, or Reports: This displays the latest 100 Activity and Event Log records for the object in the Detailed Log tab.
- Selecting an Activity type or Event type record in the log view: When you select an Activity type record from a log view, the latest 100 Activity and Event Logs for the selected object display in the Detailed Log tab. However, if an Event type record is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the Detailed Log tab.
- Selecting an event from Event List: Displays information about the object involved in the event in the Detailed Log tab.

However, if you have selected more than one object, the Detailed Log tab does not display any information.
NOTE:
When you select the Log Viewer root node, a log view folder, or a saved log view definition from System Browser, you may see the following message above the log view table: Configured View Size reached! Refine search via Search Filter. This means that there are more records in the database than can be displayed in the defined view size. In order to view such records you must either specify filters or modify existing filters.

Default Columns in a Log View
The following table lists the default columns that display in the Log Viewer. In addition to these columns, you can add other columns from the Select Columns dialog box.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Displays the name of the system to which the source object belongs. This is particularly helpful when working with a distributed environment, where you have data displaying from multiple systems.</td>
<td>Event ID</td>
<td>ID associated with the event.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time when the activity is performed or state change of event occurred.</td>
<td>Log Type</td>
<td>The Desigo CC application where the activity, such as event printing or commanding is performed.</td>
</tr>
<tr>
<td>Source Description</td>
<td>Description of the source object associated with the activity or event.</td>
<td>Action</td>
<td>Nature of the activity performed by the source object. For example, for a Users object type, the value of the Action field could be Login, Primary Authentication and so on.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Type of information displayed. This information can be of type Activity or Event.</td>
<td>Value</td>
<td>New value of the Source Property when an activity is performed.</td>
</tr>
<tr>
<td>Source Property</td>
<td>Name of the property associated with the source object on change of which the activity or event occurred.</td>
<td>Quality</td>
<td>Quality of the new value.</td>
</tr>
<tr>
<td>Event Message Text</td>
<td>Event message text associated with the source object.</td>
<td>Previous Value</td>
<td>Previous value of the Source Property when an activity is performed.</td>
</tr>
<tr>
<td>Event Category</td>
<td>Category of the event.</td>
<td>Previous Quality</td>
<td>Quality of previous value.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Date/Time of the occurrence of the event.</td>
<td>Unit</td>
<td>Unit of measurement of value of source property.</td>
</tr>
<tr>
<td>Event State</td>
<td>State of the event.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Cause</td>
<td>Reason that triggered the event.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE:
Values are displayed as per value scaled units (if configured). See Value Scale Units.
### Additional Columns in a Log View

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Details</td>
<td>Additional descriptive information of the activity performed.</td>
</tr>
<tr>
<td>Action Result</td>
<td>Status of a user activity. Possible values are Succeeded, Partially Succeeded, Failed, Unknown.</td>
</tr>
<tr>
<td>Attachment</td>
<td>Displays the link to the report output document that is created when performing the Operating Procedure Steps such as alarm printout, report, or treatment form.</td>
</tr>
<tr>
<td>Event mode</td>
<td>Mode in which the event is generated. Possible values are Normal and Maintenance.</td>
</tr>
<tr>
<td>Management Station</td>
<td>Displays the host name of the Desigo CC client from where the activity is performed.</td>
</tr>
<tr>
<td>Alias [Source]</td>
<td>Alias of the source object.</td>
</tr>
<tr>
<td>Source Designation</td>
<td>Default hierarchy of the source object composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Application View]</td>
<td>Hierarchy of the source object from Application View composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Current View]</td>
<td>Hierarchy of the source object from the currently selected view in the System Browser composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Designation [Management View]</td>
<td>Hierarchy of the source object from Management View composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Identifier [Internal]</td>
<td>Internal ID associated with the source object.</td>
</tr>
<tr>
<td>Source Location</td>
<td>Default hierarchy of the source object composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Location [Application View]</td>
<td>Hierarchy of the source object from the Application View composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Location [Current View]</td>
<td>Hierarchy of the source object from the currently selected view in the System Browser composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Location [Management View]</td>
<td>Hierarchy of the source object from Management View composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Source Name</td>
<td>Name of the source object.</td>
</tr>
<tr>
<td>Observer Description</td>
<td>Description of the event enrollment object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Observer Property</td>
<td>Name of the property associated with the event enrollment object on change of which the activity or event occurred.</td>
</tr>
<tr>
<td>Observer Designation</td>
<td>Default hierarchy of the event enrollment object composed using the names of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Observer Location</td>
<td>Default hierarchy of the event enrollment object composed using the description of the nodes present in the hierarchy.</td>
</tr>
<tr>
<td>Observer Name</td>
<td>Name of the Event Enrollment Object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Observer Identifier [Internal]</td>
<td>Internal Id for the Event Enrollment Object that monitors the source BACnet object.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Discipline of the source object (for example, Building Automation).</td>
</tr>
</tbody>
</table>
### Subdiscipline
Subdiscipline of the source object (for example, Communication for management platform discipline).

### Type
Type of the source object (for example, network).

### Subtype
Subtype of the source object (for example, BACnet for type Network).

### Alert ID
Internal unique ID associated with an event.

### User
Name of the user performing the activity or treating the event.

### Validation Profile
Validation profile associated with the source object.

### Audit Trail
Displays Audit Trail if the validated object creates an activity log. However, if an activity log is created by a non validated object, then this column displays Activity.

### Object Version
Displays the version number of the validated object. The version number is incremented each time you perform an activity on the validated object. In case of a non validated object the Object Version column does not display any value.

### Comment
Validation comment entered.

### Reference Time
Displays the original time stamp of the record that is added, modified, or deleted using the Manual Correction snap-in.

### Event Details
Message text associated with the event.

### Category Priority
Priority associated with the event.

### Supervisor
Name/ID of the supervisor who is designated as the second approver to approve the "Regulated" and "Monitored" validation states before the command or configuration change is executed on the selected object.

#### 3.7.2 Log Viewer Workspace
The Log Viewer workspace provides information on the user interface elements of the Log Viewer application.
Operating Reference
Log Viewer

### Log Viewer Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 System Browser</td>
<td>Displays all the saved Log View definitions in Application View &gt; Applications &gt; Log Viewer.</td>
</tr>
<tr>
<td>2 Log Viewer toolbar [⇒ 315]</td>
<td>Contains buttons for performing various actions in Log Viewer.</td>
</tr>
<tr>
<td>3 Log View</td>
<td>Displays the combined data from the Activity Log and Event Log. By clicking the drop-down arrow, a menu with the following options displays: Hide Column - Hides the column. Select Column - Displays the Select Columns dialog box. Remove Filters - Removes any online filters (if applied) on the column. Custom Filter - Displays the Custom Filter dialog box. Selection Filter - Applies only if the column displays ENUM data. Displays a list of data entries for the column. See the List of ENUM columns section in Custom Filter [⇒ 317] for a list of columns of type ENUM. Date Filters - Applies only if the column displays date/time data. Allows you to filter data on the basis of date and time.</td>
</tr>
<tr>
<td>4 Detailed Log tab [⇒ 324]</td>
<td>Displays information related to system activities and events.</td>
</tr>
</tbody>
</table>

### Log Viewer Toolbar

The Log Viewer toolbar allows you to perform the following operations:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[New Folder [⇒ 143]]</td>
<td>Creates a new folder below the Log Viewer root node.</td>
</tr>
</tbody>
</table>
| ![Save icon] | Saves a newly created and configured log view definition or changes in the configuration of the currently selected log view definition.  
**NOTE:** This command is available only after you perform some operation on the displayed log view data. This command is not available if a result filter is applied to the log view. In order to enable this button, you must move the result filter to a search filter. |
| ![Save as icon] | Saves the configuration of the currently selected log view definition as a new log view definition. |
| ![Save as Default icon] | Saves the log view as a default template. |
| ![Save as Report Definition [⇒ 144]] | Saves the configuration of a log view definition such as search filters, column selection, sorting as a report definition. |
| ![Delete [⇒ 144]] | Deletes the currently selected log view definition or a folder below the Log Viewer root node. Deleting the folder also removes its contents. |
| ![Refresh icon] | Refreshes the data displayed in a log view definition, Log Viewer root node, or a log view folder. |
| ![Export [⇒ 143]] | Exports the log view definition and saves it in an xml file format. |
| ![Import [⇒ 143]] | Imports a log view definition. |
| ![Select Columns [⇒ 145]] | Displays the Select Columns dialog box that allows you to select the columns to display in the log view. |
| ![Search Filter [⇒ 153]] | Displays the Search Filter dialog box that allows you to view a search filter condition and specify a filter condition on the columns that are not present in the log view. |
| ![Remove all Result Filters icon] | Removes all the result filters applied on the log data. |
Revert to Saved Search Filters [→ 153] | Returns to the previously applied search filter.
---|---
Stop Execution | Stops the execution of a log view.
Configuration | Displays the Configuration dialog box that allows you to perform the following:
  - Display the date and time values in the log view till milliseconds by selecting the **Show Date/Time with milliseconds** check box.
  - Specify the filter language for modifying a search filter. This is essential when you are accessing a log view definition that is configured in a different language.
Print | Displays the **Print** dialog box that allows you to print the log data.

**Select Columns Dialog Box**

The **Select Columns** dialog box allows you to add, remove, or reorder columns in a log view. You can access this dialog box using any of the following methods:

- Clicking the **Select Column** icon.
- Clicking the **Select Column** icon in the **Detailed Log** tab.
- Clicking the drop-down arrow on a column header and selecting the **Select Column** menu option.
- Right-clicking a column entry and selecting **Select Column** menu option.

---

### Select Columns Dialog Box Components

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent tab</td>
<td>Allows you to add, remove, or reorder parent columns in the log view.</td>
</tr>
<tr>
<td>Available Columns</td>
<td>Displays all the columns associated with the log view. <strong>NOTE:</strong> View specific columns such as <strong>Source Location</strong> and <strong>Source Designation</strong> are dynamically added to the <strong>Available Columns</strong> list when you create a new view.</td>
</tr>
<tr>
<td>Selected Columns</td>
<td>Displays the default columns of a log view. You can add columns to the selected columns list by selecting the check box associated with each column in the <strong>Available Columns</strong> list.</td>
</tr>
<tr>
<td>Operating Reference Log Viewer</td>
<td></td>
</tr>
</tbody>
</table>

Select Default | Selects the default columns in the Available Columns list. |
Select All | Selects all the columns in the Available Columns list. |
Clear All | Clears all the columns in the Available Columns list. |
Move Up | Moves the selected column one step up in the Selected Columns list. The Move Up button is unavailable if you select the column on the top. |
Move Down | Moves the selected column one step down in the Selected Columns list. The Move Down button is unavailable if you select the column at bottom. |
Remove | Removes the selected column from the Selected Columns list. |

Custom Filter

A custom filter allows you to define a filter expression from which you can filter data according to your specific requirements.

Custom Filter Condition

A custom filter condition is composed of:
- Column name (Condition Name)
- Operators
- Condition value

Examples of Custom Filter Expressions

The following list contains some valid custom filter expressions:

- Event Category = "Life Safety"
- Event Category = ("Status"; "Life Safety"; "Supervisory")

The custom filter also allows you to create complex filters and conditions using mathematical and logical operators, and wildcard characters. The following operators are supported:

<table>
<thead>
<tr>
<th>Mathematical Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enum Columns</strong></td>
</tr>
<tr>
<td><strong>Numeric Columns</strong></td>
</tr>
<tr>
<td><strong>Text Columns</strong></td>
</tr>
<tr>
<td><strong>Variant Columns</strong></td>
</tr>
<tr>
<td><strong>CNS Columns</strong></td>
</tr>
<tr>
<td><strong>View Specific Columns</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Logical Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AND</strong></td>
</tr>
<tr>
<td><strong>OR</strong></td>
</tr>
</tbody>
</table>

- Wildcard Character: Asterisk (*)
List of ENUM columns
- Subtype
- Type
- Subdiscipline
- Discipline
- Record Type
- Action Result
- Event Mode
- Event Category
- Event State
- Log Type
- Action
- Quality
- Previous Quality

Custom Filter Syntax
To create a custom filter, you must know the data type of the column for which you want to apply the filter. The following examples should help you create custom filters without syntax errors.

1. If column displays text data, for example string or enumeration, then the value must be enclosed within double quotes.
   - ‘Source Description’ = “Analog Output 1”
   - ‘Event Mode’ = “Normal”
   - ‘Value’ = "True"
   - ‘Previous Quality’ = "#COM"

2. If column displays date time value, then the value must be in date time format configured in Windows on the server. Date must be in the short date format, time in the long time format (24 hours).
   - ‘Date/Time’ = 3/13/2014 16:04:25 (assuming that the date format on the server is M/D/YYYY)
   - ‘Value’ = 07/24/2014 11:52:00

3. If column displays boolean data, such as TRUE or FALSE, the value must be enclosed in double quotes.
   - ‘Previous Value’ = "True"
   - ‘Value’ = “False"

4. If column displays numeric data, for example, 54.11, 25, -20, and so on, then the values must be specified as follows:
   - ‘Value’ = 54.11
     NOTE: The decimal separator must be according to your Windows Regional and Language settings.

5. If column displays bit string, then the value must be enclosed in double quotes.
   - ‘Quality’ = “Out of service”

6. Specify time values in a 24-hour clock format. For example, to specify the Source Time as 2.00 PM, type 14.00.

Types of Custom Filters
There are two types of custom filters that are applied to the log data:

Result filter: The result filter enables you to filter data from the displayed data set in the log view. You cannot save a result filter condition. In order to save the filter condition, you must move the result filter to a search filter and then save the configuration as a log view definition. You can apply a result filter from the Custom Filter dialog box, Quick filter, Selection filter, and using drag-and-drop.

Search filter: The search filter enables you to obtain the data matching the filter expression from the database. Any modification or addition to the search filter, refreshes the log view automatically, so that all the data matching the search filter is obtained from the database. To preserve the search filters, you must save the
settings as a log view definition. Using the search filter, you can filter the data for the columns that are present in the log view.

You can also apply a search filter if you need to filter the data for a column that is not present in the log view. The combined search filter is always available in the Search Filter dialog box.

For example, you can apply a result filter on the log data to retrieve all records with Source Description as "Analog Input 1". However, in order to save the filter condition, you must move the result filter to a search filter.

**Custom Filter Dialog Box - For columns other than date/time**

The Custom Filter dialog box allows you to define result and search filter expressions on a particular column. You can access this dialog box by either:

- Clicking the dropdown arrow on a column heading displaying non date/time values and selecting Custom Filter.
- Right-clicking a log view entry displaying non date/time data and selecting Custom Filter.

![Custom Filter Dialog Box](image)

<table>
<thead>
<tr>
<th>Custom Filter Dialog Box Components</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>Result Filter</td>
<td>Allows you to specify a result filter.</td>
</tr>
</tbody>
</table>
| Search Filter                       | Allows you to specify a search filter.  
**NOTE:** The Search Filter tab does not display when the Custom Filter dialog box is accessed from the Detailed Log tab in the Contextual Pane. |
| Operator                            | Lists the mathematical operators. The list of operators displayed in this box depends on the column type. |
| Value                               | Allows you to specify values. Depending on the column type, you can either select a value from the drop-down list or enter a value in the text field. |
| Add Filter                          | Adds a new filter expression row with the Operator and Value fields to the Custom Filter dialog box. |
Remove Filter | Removes the filter set on the particular column.

NOTE: In order to enable the Remove Filter button, you must select the check box preceding the Operator and Value fields corresponding to the result filter expression to be deleted.

AND | This is a logical operator that allows you to combine filter expressions and create complex filters. This button is available only when you add a new filter expression row and select the check boxes preceding the Operator drop-down list in the filter expression rows.

OR | This is a logical operator that allows you to combine filter expressions and create complex filters. This button is available only when you add a new filter expression row and select the check boxes preceding the Operator drop-down list in the filter expression rows.

Move to Search Filter | Displays only when the Result Filter tab is selected. Allows you to move the result filter to a search filter.

Filter expression field | Displays the filter expression. In case of multiple filter expressions, the OR operator is applied by default.

Time Filter Dialog Box

This dialog box allows you to define result and search filter expressions on a particular date/time column. You can access this dialog box using any of the following methods:

- Clicking the drop-down arrow on a column heading displaying date/time values, positioning your cursor over Date Filters and then selecting Custom Filter.
- Right-clicking a log view entry displaying date/time data and selecting Custom Filter.
### Time Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result Filter</td>
<td>Allows you to specify a result filter.</td>
</tr>
<tr>
<td>Search Filter</td>
<td>Allows you to specify a search filter. NOTE: The Search Filter tab does not display when the Time Filter dialog box is accessed from the Detailed Log tab in the Contextual Pane.</td>
</tr>
<tr>
<td>Exact</td>
<td>Allows you to filter data based on the exact date specified.</td>
</tr>
<tr>
<td>Custom</td>
<td>This option allows you to set the date and time as per your requirement. Selecting the Custom option enables the From and To fields. The To date should always be greater than From date. If the To date is less than the From date, then the To field is highlighted in red color and an error message displays when you move your cursor over the field.</td>
</tr>
</tbody>
</table>
Relative

Relative has two options: Last and Current Period. The Last option allows you to filter data for the last ‘x’ (where x stands for a number) period that you specified. Valid periods are hours, months, years, weeks, days, or minutes.

The Current Period option allows you to filter data for the current x period. Valid periods are current x hours, months, years, weeks, days, or minutes. For example, if the current date and time on your computer is 10/07/2014 10:35 AM and you specify any of the following:
- 1 Hour in Last - The data for the 9:00 to 10:00 AM period is retrieved.
- 1 Hour in Current Period - The data for the 10:00 to 11:00 AM period is retrieved.
- 1 Month in Last - The data for the period June 01, 2017 to July 01, 2017 is retrieved.
- 1 Month in Current Period - The data for the period July 01, 2017 to August 01, 2014 is retrieved.
- 1 Year in Last - The data for the period January 01, 2016 to January 01, 2017 is retrieved.
- 1 Year in Current Period - The data for the period January 01, 2017 to January 01, 2018 is retrieved.

NOTE: The Last and the Current Period fields accept only integer values up to three digits.

Unlimited

Default selection. Allows you to retrieve all records.

Null

Allows you to retrieve records with Null value.

Move to Search Filter

Displays only when the Result Filter tab is selected. Allows you to move the result filter to a search filter.

Preview of Resulting Time range

Displays the resulting time range for the options selected in the Time Filter dialog box. For example, if the present time is 08/07/2014 10:35 AM, then for the current 1 hour selection, the Preview of Resulting Time Range displays the following:
From: Tuesday, July 08, 2014 10:00:00 AM
To: Tuesday, July 08, 2014 11:00:00 AM

Search Filter Dialog Box

The Search Filter dialog box allows you to view a search filter condition and specify a filter condition on the columns that are not present in the log view. It also allows you to view, modify, and delete a combined search filter expression. You can apply the search filter on all columns except columns of type date and time.
### Search Filter Dialog Box Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Columns¹</td>
<td>Lists all the available columns from the Activities and Events Log.</td>
</tr>
<tr>
<td>Operators¹</td>
<td>Lists all the operators associated with a specific column selected in Available Columns.</td>
</tr>
<tr>
<td>Values¹</td>
<td>Lists all the values associated with a specific column selected in the Available Columns list. You can also select multiple values by pressing CTRL or SHIFT and selecting multiple values. <strong>NOTE:</strong> Multiple values can be typed within braces {} and separated by a semicolon (;).</td>
</tr>
<tr>
<td>Filter expression field</td>
<td>Displays the filter expression. You can edit a filter expression in this field. <strong>NOTE:</strong> An invalid filter expression displays in red.</td>
</tr>
<tr>
<td>Add/Update</td>
<td>Allows you to add or update a filter expression. <strong>Update</strong> is enabled only when a valid filter expression is added or modified in the <strong>Filter expression</strong> field.</td>
</tr>
<tr>
<td>And</td>
<td>This is a logical operator that allows you to combine filter expressions and create complex filters. This button is unavailable until a filter expression is added to the <strong>Filter expression</strong> field.</td>
</tr>
<tr>
<td>&quot;()&quot;</td>
<td>Allows you to group filter conditions, which define the order of their evaluation. These brackets are unavailable until a filter expression is added to the <strong>Filter expression</strong> field.</td>
</tr>
</tbody>
</table>

¹ The selected item displays below the list
You can view information related to system activities and events through the **Detailed Log** tab.

The information displayed in the **Detailed Log** tab is related to the following:

- **An object selected from System Browser:** When you select an object from the System Browser, the Detailed Log tab displays the latest 100 activities for that object.

- **An object is selected from any application, such as Graphics, Trends, Textual Viewer, or Reports:** If you select an object from any application, the Detailed Log tab displays the latest 100 activities and event log records for the object.

- **An activity or event type record is selected from the log view:** When you select an activity type record from a log view, the latest 100 activities and event logs for the selected object display in the Detailed Log tab. However, if an event type record is selected, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are displayed in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.

- **Event handling:** When you select an event from the Event List, the details of the selected event including the different state changes of the event and the user activities performed in context of the event are available in the Detailed Log tab of Event List, Investigative Treatment, and Assisted Treatment windows.

The **Detailed Log** tab however, does not display any information if you have selected more than one object.

You can customize the information displayed in the **Detailed Log** tab by

- Applying result filters on columns other than Date/Time
- Applying result filters on Date/Time columns
- Selecting columns to be displayed
- Hiding columns
- Sorting log entries
- Reordering and resizing Columns

By default, the following information displays for activity and event type data in the **Detailed Log** tab.

**NOTE:**
Values are displayed as per value scaled units (if configured). For more information, see Value Scale Units.
You can also save the settings in the **Detailed Log** tab as default template. For example, you can create individual customized templates for displaying activity and event information by specifying the respective columns, their order and size, and by applying sorting on the data displayed. Filters applied are not retained in the default template.

In a Distributed System, the **Detailed Log** tab displays the default template of the system that is associated with the currently selected object.
### 3.8 Address Book

This section provides reference and background information relevant to the Desigo CC address book. For related procedures, see the step-by-step section.

#### 3.8.1 Overview of Address Book

The Desigo CC address book stores a list of contacts (called recipients) which the system can use for sending out remote notifications or for emailing reports.

The contacts you add to the address book do not have to be Desigo CC users. This is an entirely separate list.

You can view and edit the address book in both Operating and Engineering mode. For instructions, see the step-by-step section.

#### Address Book Workspace

The address book is accessed in the Application View of System Browser, at the path Applications > Address Book.

The left panel shows the list of contacts already configured in the address book. The Details expanders on the right displays the details of the currently selected contact. For more information about these fields, see Details of an Address Book Contact [→ 328], below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SaveAsDefault</td>
<td>Saves the selected columns in the Detailed Log tab as a default template.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the data displayed in the Detailed Log tab.</td>
</tr>
<tr>
<td>Stop Execution</td>
<td>Stops the execution of the log view in the Detailed Log tab.</td>
</tr>
<tr>
<td>Select Columns</td>
<td>Displays the Select Columns dialog box that allows you to select the columns to display in the Detailed Log tab.</td>
</tr>
<tr>
<td>Remove all Result Filters</td>
<td>Removes all the result filters applied to the log data in the Detailed Log tab.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Displays the Configuration dialog box that allows you to display the date and time values in the Detailed Log tab till milliseconds.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays the Print dialog box that allows you to print the log data displayed in the Detailed Log tab.</td>
</tr>
</tbody>
</table>
Address Book Toolbar Controls

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Recipient" /></td>
<td>Save any changes made to the details of the currently selected contact.</td>
</tr>
<tr>
<td><img src="image" alt="Add Recipient" /></td>
<td>Add a new contact to the address book.</td>
</tr>
<tr>
<td><img src="image" alt="Remove Recipient" /></td>
<td>Delete the currently selected contact.</td>
</tr>
<tr>
<td><img src="image" alt="Remove All Recipients" /></td>
<td>Clear the entire address book.</td>
</tr>
<tr>
<td><img src="image" alt="Import Address Book" /></td>
<td>Import a CSV contacts file exported from Microsoft Outlook.</td>
</tr>
<tr>
<td><img src="image" alt="Search in the address book" /></td>
<td>To search for contacts in the address book. Type some characters in the search field For more details, see Address Book Search Field [➙ 327].</td>
</tr>
</tbody>
</table>

**NOTE:**
If you accidentally delete a contact or clear the address book, you can recover by exiting the Address Book workspace without saving the changes made. To do this, select a different node in System Browser, and when prompted Unsaved data. Do you want to save the data before leaving this page? Click No.

Address Book Search Field

When the address book contains many entries, you can use the search feature to help you find a specific contact.

- To run a new search, in the Search field at the top, start typing in some letters/characters contained in the following fields: contact's Full Name, Groups, or Preferred/Fallback Device.
  - As you type, the contact list is filtered to show only the contacts that match the entered characters.
• To repeat a recent search, or to quickly filter by groups, click the **Search**-field drop-down list to display a list of your **Recent Searches**, along with a list of the configured **Groups** (under **Saved Searches**).
  
  - Click a search in the list to repeat it.
  - Click x alongside a search to remove it from the list.

• To clear a search, click X alongside the search field to remove the filter and display the full contact list again.

**Details of an Address Book Contact**

When you select a contact in the **Address Book**, the **Details** expanders displays all the information about that individual.

**General Expander**

• **Full Name**: For example, John Doe. This value must be unique.

• **Short Name**: Optional nickname or initials for the contact.

• **Language**: Default is English (U.S.).

• **Time Offset**: User’s time offset with respect to Desigo CC server time. Default is 0 (no time offset). This settings will also be reflected in the remote notification message tailoring time tag values.

**Groups Expander**

Here you can optionally assign a contact to one or more **Groups** (for example, Operator, Administrator, and so on).

**NOTE**: Groups are required for remote notifications, which are addressed to recipient groups, not to individuals. You do not need groups for reports, which can instead be emailed to individual contacts.

The **Groups** expander shows any groups to which the selected contact is already assigned.

• To assign a contact to an existing group, you must select the group name from the drop-down list and click **Add**. (The drop-down list shows only the groups to which the contact does not already belong.)

• To remove a contact from a group, you must select the group name in the field and click **Remove**. If all contacts are removed from a group (the group becomes empty) the group itself is eliminated, and no longer displays in the drop-down list.

• To create a new group and assign it to the contact, you must type a new group name directly into the empty drop-down list field, click **Add**, and click **Save**. This group will then become available in the drop-down list for other contacts as well.

• To rename a group, select the group from the **Groups** expander, you must type its name in the drop-down list field, click **Update**, and click **Save**. The group will be renamed for all the contacts that use it.

**Devices Expander**

Here you can specify one or more devices, that is, methods which can be used for contacting that person, such as email addresses, mobile phone numbers for SMS messages, and/or a pager number:

• **Email**: you can specify up to three email addresses.

• **SMS**: you can specify up to two mobile phone numbers for SMS messages.

• **Number/Provider**: Depending on the pager service configured, you must specify a pager number only or a pager number and provider.
NOTE:
Reports can be sent by email. Remote notifications can be sent by email, SMS, and/or pager. For each of these communication methods to work, the corresponding service (email, SMS or pager) needs to be configured on the Desigo CC server station.

Preferred Device Expander

- **Preferred Device**: This is the first method of contacting the person to be tried. By default, it is set to the first email address that you configured in the Devices expander. You can select a different preferred device from the drop-down list.

- **Fallback Device**: This is the method that will be used if sending a message to the preferred device fails. It has to use a different service from the preferred device. For example, if the preferred device is an email address, the fallback cannot be a different email address. It has to be an SMS number or a pager number.

NOTE:
The preferred and fallback device settings are used only by remote notifications. When you email a report you can choose from all the email addresses entered for each contact.

Outlook Import Rules for the Address Book

The Desigo CC address book can import CSV contacts files exported from Microsoft Outlook 2003 and 2007 but only in English language.

If a CSV file is not already available, you can export contacts from Microsoft Outlook into a CSV file as follows:


- In Microsoft Outlook, select **File > Import and Export > Export to a File > Comma-Separated Values** and then choose a location on disk and a name for the file (for example, myContacts.csv).
  - The CSV file is created in the specified location.

Once you have obtained an exported CSV file, you can check it by opening it in a text editor. You should see:

- A multi-line text file where each line contains values separated by commas.

- The first row contains the field headers, while the succeeding rows contain the data, one contact per row.

The fields in the **Address Book** workspace are populated with data from the CSV file as follows:

- **Preferred Device**, The contact’s first valid email address in the CSV file is set as the preferred device. If there is no valid email address, a mobile phone number or pager is taken as the preferred device. If there is no valid email, SMS number, or pager number, then the contact is skipped (not added to the address book).

- **SMS**, Phone numbers in the CSV file can contain the following special characters:
  - A plus sign (+) as a prefix to the number; during import this character is replaced by two zeros (00).
  - An empty space, a hyphen (-), or a comma (,) between digits; during import these characters are removed.
Remote Notifications

This section provides background information for remote notifications in Desigo CC. For related procedures see the step-by-step section.

3.9.1 Overview of Remote Notifications

Desigo CC has the capability to send out remote notification (RENO) messages—delivered, for example, using email, SMS or pagers—to one or more groups of contacts (recipients).

Remote notifications can be of two types:

- **Alarm-triggered notifications**: Messages preconfigured in the system to be sent out when certain alarms occur in the building control site. These alarm-triggered notifications are set up in **Engineering** mode. Also, they can be configured to be sent out by the system either with (manual sending) or without (automatic sending) operator intervention.

- **New (operator issued) notifications**: Messages composed and sent on the initiative of the operator. These operator-issued notifications are instead always sent with operator intervention (manual sending). They are not tied to any triggering event, and can be sent out at any time in **Operating** mode.

Operators can interact with remote notifications in the following ways:

- **Start, Stop, or Resend a Remote Notification** (Alarm-Triggered or Operator-Issued)
- **Monitor the Progress and Outcome of Sent Notifications** (Alarm-Triggered or Operator-Issued)
- **Enable or Disable an Alarm-Triggered Remote Notification**

**Location of Remote Notifications**

Alarm-triggered remote notification objects are located under **Applications > Remote Notifications** in the **Application View** of System Browser.

**Recipients of a Remote Notification**

Remote Notifications (whether alarm-triggered or operator-issued) can be addressed to one or more recipient groups (for example, supervisors, operators) selected from the Desigo CC Overview of Address Book [326]. These recipients do not necessarily have to be Desigo CC users.
For each individual contact, the address book stores a preferred device (email address, mobile phone number, or pager number) that can be used to contact that person, and optionally also a fallback device.

Desigo CC will attempt to send the notification to all the members of each recipient group, using the preferred and (if available) fallback devices configured in the address book. (It will try the preferred device first and, if that fails, it will try the fallback device).

For sending to succeed it is necessary for the corresponding system services (for email, sms, or pager communication) to be configured.

Replies from Recipients and Escalation Rules
Depending on how a remote notification is configured, it may or may not require a response from the recipients of the message.

How Recipients can Reply to a Remote Notification
When the recipients receive a remote notification message (via email, SMS, or pager) they can acknowledge the notification by replying to the message in the following ways.

- Email: reply to the email message without adding any additional text.
- SMS: reply to the SMS in one of the following ways:
  - Paste and send back the received text message, including the numeric code at the end of the received text message.
  - Send a text message that contains the numeric code included at the end of the received text message.
- Pager: notification acknowledge is not supported.

NOTE:
Replying to a remote notification message only acknowledges the notification. It is not the same thing as acknowledging the event, which is instead done by sending an Acknowledge command from Event List (see Send Alarm Handling Commands [41]).

Remote Notification Event Log
When working with remote notifications, entries are recorded in the History Database tracking the progress of remote notifications (such as, remote notification devices status error, remote notification creation/deletion or start/stop, and so on).

3.9.2 RENO Messages
In Operating mode, when you work with remote notifications, the RENO Messages tab displays.

Remote Notifications Message Status List
The system provides a Message Status list where operators can review all the remote notifications sent out (whether alarm-triggered or operator-issued), and check on the progress, details, and outcome of each one. From here, it is also possible to resend notifications, and if desired abort or halt the escalation of ongoing ones.

Accessing the Message Status List
In some cases the message status list displays automatically, for example, after you send an operator-issued notification. You can also access it manually in a variety of ways.
Cases where the Message Status list opens automatically:

- After sending an operator-issued remote notification the Message Status list displays in the Secondary pane.
- When executing the RENO step in an assisted treatment procedure the Message Status list displays in the Assisted Treatment window.

Ways to manually access the Message Status list (System Manager must be in Operating mode):

- View all remote notification sent:
  - In System Browser, select Application View.
  - Select Applications > Remote Notifications.

- View all operator-issued (new) remote notifications sent:
  - In System Browser, select Management View.
  - Select Project > System Settings > Related Items Templates > New Remote Notification.

- View the remote notifications triggered by a point currently in alarm:
  - Select the point in alarm in System Browser. (You can do this by double-clicking the event source in the event descriptor of the alarm that triggered the notification.)
Information Provided in the Message Status List

In the Message Status list, each notification displays on a separate (expandable) row. The topmost row shows a compact notification summary with the most important information about the notification. See the tables below for a detailed key to the information provided in the Message Status panel.
### Compact Notification Summary

*(information in unexpanded/topmost row)*

For new (operator-issued) notifications:
[type of sending (always manual)] – [date and time] – [overall RENO outcome]

For alarm-triggered notifications:

<table>
<thead>
<tr>
<th>Type of sending</th>
<th>For alarm-triggered notifications, can be automatic or manual depending on configuration. For operator-issued notifications is always manual.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date and time</td>
<td>Full date and time when the notification was sent.</td>
</tr>
<tr>
<td>Name</td>
<td>Name assigned to the alarm-triggered notification in the System Browser tree.</td>
</tr>
<tr>
<td>Alarm ID</td>
<td>Event ID of the alarm that triggered the notification.</td>
</tr>
</tbody>
</table>
| Overall RENO outcome | *Initialized.* The system is preparing to send the remote notification messages.  
|                  | *Running.* The remote notification is in progress. The system has started sending messages to recipients.  
|                  | *Completed.* The remote notification was successful. Depending on configuration, this may mean only that the messages were successfully sent, or also that the required responses from recipients were received.  
|                  | *Partially failed.* The remote notification was successfully sent, but at least one recipient group failed to meet its response threshold.  
|                  | *No response.* The remote notification messages were sent, but none of the recipient groups met its response threshold.  
|                  | *Failed.* The system was unable to send the notification messages.  
|                  | *Aborted.* The operator stopped the remote notification, or halted its escalation.                                 |

### Procedure Data Summary
*(displays for alarm-triggered remote notifications only)*

<table>
<thead>
<tr>
<th>Type</th>
<th>Type of message sending (Manual/Automatic).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting in</td>
<td>For automatic notifications, the time left before the remote notification message is sent (delay).</td>
</tr>
</tbody>
</table>
| Trigger | Details about the condition that triggered the notification:  
|         | **Trigger:** Type of trigger (for example, Alarm)  
|         | **Category:** Event category  
|         | **Date:** Date the alarm occurred  
|         | **Time:** time the alarm occurred  
|         | **Alarm ID:** Event identifier (for example, Alarm ID 44)  
|         | **Point state:** Point state that triggered the notification *(Genuine, or All, or Maintenance)*. |
| Source | Details about the source of the event that triggered the notification:  
|         | **Source:** Field object in alarm  
|         | **Location:** Path of the field object in the System Browser tree)  
|         | **Discipline:** Event discipline  
|         | **Sub-discipline**  
|         | **Type**  
|         | **Sub-type** |
### Recipients Summary

The first level of the recipients’ summary shows a list of the recipient groups configured for the remote notification. You can expand each recipient group to see further details about that group and its members.

Information shown for each recipient group:

- **[group name]** – **[group threshold/replies/timeout]** - **[group status]** - **[list of group members]** – **[escalation summary]**

<table>
<thead>
<tr>
<th>Group name</th>
<th>Name of the recipient group (for example, supervisors or administrators), selected from system address book, to which the notification was addressed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group replies</td>
<td>How many group members have replied so far to the notification.</td>
</tr>
<tr>
<td>Group threshold</td>
<td>The minimum required number of replies required for this group. For example, Replies: 1/2 means that at least one of the two recipients belonging to the group must reply for this message to be considered acknowledged.</td>
</tr>
<tr>
<td>Group timeout</td>
<td>The time limit for receiving the required number of replies from this group. (Processing displays in the interval of time before the timeout expires.)</td>
</tr>
<tr>
<td>Group Status</td>
<td>Notification status of the group as a whole (see Status <a href="#">$page 336</a>, below, for a key to the possible values).</td>
</tr>
<tr>
<td>List of group members</td>
<td>List of the individual contacts in the group. You can expand each individual contact to display that person’s:</td>
</tr>
<tr>
<td></td>
<td>● Name</td>
</tr>
<tr>
<td></td>
<td>● Preferred (PR) and fallback (FB) devices</td>
</tr>
<tr>
<td></td>
<td>● Individual notification status (see Status <a href="#">page 336</a>, below, for a key to possible values)</td>
</tr>
<tr>
<td></td>
<td>Cancelled is the status that displays when you stop the escalation.</td>
</tr>
</tbody>
</table>

**Escalation**

An additional summary that displays only if the group has escalation rules. See below for details.

### Escalation Summary

The escalation summary under a group displays only if the group has escalation rules configured.

Information shown for the group’s escalation:

- **[escalation threshold/replies]** – **[escalation status]** - **[list of escalation recipients]**

<table>
<thead>
<tr>
<th>Escalation replies</th>
<th>How many escalation recipients have replied within their individual timeout.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation threshold</td>
<td>The minimum required number of replies required from escalation recipients.</td>
</tr>
<tr>
<td>Escalation Status</td>
<td>Outcome of the escalation as a whole (see Status <a href="#">page 336</a>, below, for a key to possible values).</td>
</tr>
<tr>
<td>List of escalation recipients</td>
<td>List of the individual contacts configured as escalation recipients for this group. You can expand each contact to see that person’s:</td>
</tr>
<tr>
<td></td>
<td>● Name</td>
</tr>
<tr>
<td></td>
<td>● Preferred (PR) and fallback (FB) devices</td>
</tr>
<tr>
<td></td>
<td>● Timeout for replying. (Pending is indicated in the interval of time before timeout expires.)</td>
</tr>
<tr>
<td></td>
<td>● Individual notification status (see Status <a href="#">page 336</a>, below, for a key to possible values)</td>
</tr>
</tbody>
</table>

Click a PR or FB device to see the actual message sent in the panel on the right.
### Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty</td>
<td>The remote notification has not started yet.</td>
</tr>
<tr>
<td>Running</td>
<td>The remote notification is in progress.</td>
</tr>
<tr>
<td>Pending</td>
<td>The message has been sent to the designated recipients and the system is awaiting a reply (the timeout for a response has not yet elapsed).</td>
</tr>
<tr>
<td>Acknowledged</td>
<td>The designated recipients replied within the timeout. In the case of a group it mean that the group reached its response threshold within the timeout.</td>
</tr>
<tr>
<td>Not reachable</td>
<td>The system failed to send the message to both the preferred and fallback device.</td>
</tr>
<tr>
<td>Timed out</td>
<td>The system did not receive the replies at all. In particular:</td>
</tr>
<tr>
<td></td>
<td>- For an individual contact: the person did not reply within the timeout.</td>
</tr>
<tr>
<td></td>
<td>- For a group: the group failed to reach its response threshold within the timeout.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The operator stopped the remote notification.</td>
</tr>
<tr>
<td>Stop</td>
<td>The operator halted the escalation of the remote notification.</td>
</tr>
</tbody>
</table>

### RENO Messages Toolbar Controls

In Operating mode, when you work with remote notifications, the RENO Messages toolbar is available. It allows you to start, stop, and clear remote notifications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Alarm-based notifications</th>
<th>New notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start RENO procedure</td>
<td>Start sending or re-sending the currently selected remote notification. The icon is dimmed while sending is in progress.</td>
<td>Start re-sending the new (operator-issued) notification.</td>
</tr>
<tr>
<td>Stop RENO procedure</td>
<td>Stop the remote notification that is currently in progress. If successful, the remote notification overall outcome becomes Aborted; the status of pending recipients becomes Cancelled. Notifications can only be stopped if they are configured to be stopped. Remote notifications with manual sending can be stopped while they are in progress. Notifications with automatic sending can only be stopped during the time delay before they start.</td>
<td>Stop monitoring the message status of new (operator-issued) notification.</td>
</tr>
<tr>
<td>Stop RENO procedure escalation</td>
<td>Stop the escalation for the currently selected recipient group: If the group does not reach its threshold of required responses, any escalation does not start. The status of the groups and recipients involved becomes Stop. If there is more than one recipient group with an escalation list, to stop all escalations you must select each group in turn and repeat this step to disable its escalation. This command is not available if an escalation has already started.</td>
<td></td>
</tr>
<tr>
<td>Clear manual procedure</td>
<td>n.a.</td>
<td>Only available for new (operator-issued) remote notifications in the Secondary pane. Remove the selected notification from the list.</td>
</tr>
<tr>
<td>Back to configuration</td>
<td>n.a.</td>
<td>Only available for new (operator-issued). Go back and compose another message.</td>
</tr>
</tbody>
</table>
## Message Status Summary

<table>
<thead>
<tr>
<th>Situation</th>
<th>Status</th>
<th>Groups</th>
<th>Recipients</th>
</tr>
</thead>
<tbody>
<tr>
<td>The remote notification is initialized, but has not yet started.</td>
<td>Initialized</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>The remote notification is automatic and time-delayed, and the operator stops it before it starts.</td>
<td>Aborted</td>
<td>Cancelled</td>
<td>Cancelled</td>
</tr>
<tr>
<td>The remote notification has started (regardless of whether it is automatic or manual). Some recipients have replied and other replies are pending (the system is still waiting for them to reply because they have not yet timed out).</td>
<td>Running</td>
<td>Pending</td>
<td>Acknowledged</td>
</tr>
<tr>
<td>The system is evaluating the final outcome of the notification. No escalation for a group is pending.</td>
<td>Running</td>
<td>Processing</td>
<td>Pending</td>
</tr>
<tr>
<td>Some recipients have replied and other replies are pending. An escalation threshold (either first or second level) for a group has been reached within the timeout. Other escalation groups are still pending.</td>
<td>Running</td>
<td>Acknowledged</td>
<td>Acknowledged</td>
</tr>
<tr>
<td>Some recipients have replied, some are still pending, and others have timed out. The groups' thresholds have not been reached. The groups' timeouts are expired. Some second-level recipients did not reply and it is no longer possible to reach the groups thresholds. Other escalation groups are still pending.</td>
<td>Running</td>
<td>Timed out</td>
<td>Acknowledged</td>
</tr>
<tr>
<td>No replies are required for a group and its recipients.</td>
<td>Running</td>
<td>Sent</td>
<td>Sent</td>
</tr>
</tbody>
</table>
The operator has stopped the manual remote notification.
The status of the recipients that replied does not change.
The status of the recipients that did not reply within the timeout does not change.
The status of the recipients that replied after the remote notification is aborted changes to Acknowledged.

<table>
<thead>
<tr>
<th>Aborted</th>
<th>Cancelled</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Timed out</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cancelled</td>
</tr>
</tbody>
</table>

No replies are required for a group and the related recipients.
Some recipients have replied; other recipients have timed out, and others still need to reply.
All the groups have reached their response thresholds.

<table>
<thead>
<tr>
<th>Completed</th>
<th>Acknowledged</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sent</td>
<td>Timed out</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sent</td>
</tr>
</tbody>
</table>

Some recipients have replied, other recipients have timed out, and others need to reply.
At least one group did not reach its threshold within the timeout.
No escalation group is pending.
No replies are required for a group and its recipients.

<table>
<thead>
<tr>
<th>Partially failed</th>
<th>Acknowledged</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Timed out</td>
<td>Timed out</td>
</tr>
<tr>
<td></td>
<td>Sent</td>
<td>Pending</td>
</tr>
</tbody>
</table>

The system successfully sent at least one message to the mail server but none of the recipient groups reached their reply threshold (different from 0).
No escalation group is pending.

<table>
<thead>
<tr>
<th>No Response</th>
<th>Timed out</th>
<th>Timed out</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Acknowledged</td>
<td></td>
</tr>
</tbody>
</table>

For any reason, the system fails in sending all the messages to the mail server.

<table>
<thead>
<tr>
<th>Failed</th>
<th>Not Reachable</th>
<th>Not Reachable</th>
</tr>
</thead>
</table>

One or more recipients have replied after the timeout.

<table>
<thead>
<tr>
<th>Completed</th>
<th>Acknowledged</th>
<th>Acknowledged</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partially failed</td>
<td>Timed out</td>
<td>after timeout</td>
</tr>
<tr>
<td>Failed</td>
<td>Sent</td>
<td></td>
</tr>
</tbody>
</table>

### 3.9.3 New Remote Notification in the Secondary Pane

You can open RENO Message in the Secondary pane, and can switch to the New Remote Notification workspace. Here you can compose a message, define the recipients, and send an operator-issued remote notification, that is, one that is not triggered by an alarm.
Figure 26: New Remote Notification – Edit Mode

**New Remote Notification Toolbar Controls**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send this message</td>
<td>Send a new operator-issued remote notification.</td>
</tr>
<tr>
<td>Clear all message data</td>
<td>Clear all fields for the current new operator-issued remote notification</td>
</tr>
</tbody>
</table>
3.10 Documents
This section provides background information on viewing documents, files, web links or other resources in Desigo CC. For related procedures see the step-by-step section.

3.11 Other Applications
This section provides background information for operating the other applications in Desigo CC. For related procedures, see the step-by-step section.

3.11.1 Web Applications
The management workstation can be configured to host and integrate external web applications so that when certain objects are selected in System Browser, the associated applications display according to specific rules.
For procedures or workflows, see the Engineering step-by-step and the Operations step-by-step section.

Display Rules
Display rules can be configured for a management workstation project as well as in exportable libraries.
- In a project, display rules are located under Project > System Settings > Client Settings > Web Applications in the Management View of System Browser. They may be further organized into subfolders under the main Web Applications folder.
- In libraries, display rules are located under Project > System Settings > Libraries > [L1-Headquarter or L2-Region or L3-Country or L4-Project > [Library] > [Web Applications] folder in the Management View of System Browser.

Related Items for Web Applications
When you select a system object in System Browser, the external web application displays corresponding to the first rule configured for that object. However, you can select any of its fixed links in the Related Items tab. This causes the corresponding external web application to display in the Secondary pane.
When you select an external web application from the Related Items tab:
- If that external web application is not already displayed, it will display in the Secondary pane with the parameters of the associated object.
- If that external web application is already displayed, this action will be considered only a change of state of the external web.
- If that application is currently displayed. This means that the same external web application will display in the Secondary pane but with the parameters of the associated object.
Other system objects can also be configured as related items of external web applications fixed links: for example, if you associate an external web application fixed link to a graphic, selecting that fixed link in System Browser, the Related Items tab will include the link to that graphic.

Fixed Links
In the Application Viewer tab, when an external web application displays, you can click Save As and save a favorite link. Later you can quickly access this external web application that matches a frequently used display rule.
These fixed links to external web applications are located under Applications > Links > [links folder] in the System Browser Application View. They must be organized into subfolders under the main Links folder.
When you select an external web application fixed link:

- The corresponding external web application displays the current data (including event information of the associated point).

Regardless of the number of parameters included in the XML configuration file, the **Extended Operation** tab only displays a maximum of ten parameters that you can modify. An error informs you if the data you modified is invalid.

For procedures and workflows, see Generating Email Attachments for Fixed Link Reports.

### Generating and Emailing Fixed Link Reports

You can generate and email an external web application fixed link report:

- Manually, from the **Operation** tab. The **Application Name** property lets you set the parameters to execute the external web application fixed link report.
- Automatically, as the output of a reaction. You can then schedule a download or email of a Web Application Fixed Link report. You will set an external web application fixed link as the target object of the output of a reaction and specify any Time & Organization Mode conditions that will trigger the report execution.
- When a specific script is started.

Before an external Web Application Fixed Link report can be executed (automatically or manually), you must set the user credentials for that fixed link.

After the report is executed, the corresponding file (PDF, XLSX, or DOCX) can be downloaded and saved in the specified directory on the local client machine. Also, if configured, an email can be sent immediately or at a scheduled time to a list of established recipients.

#### Default Email without Email Subject and Body

Below is a sample of an email using the default settings. Otherwise, a subject and text can be added to the body of the email.

<table>
<thead>
<tr>
<th>Cc:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Subject:** Link8, 20 Sep 2017 15:21:55

**Attachments:** ![Link8_20-Sep-2017_15-21-55.PDF (334 KB)](attachment)

Wednesday, 20 September 2017
The report Link8_20-Sep-2017_15-21-55.PDF has been executed successfully.

### Library References

In **Engineering** mode, when authorized experts (with appropriate access rights) select an existing Web Applications library folder or start configuring a new one the **Rule Editor** displays and lets you configure display rules at library level. Only one library folder of this type can be created per library.

#### NOTE:

Only Headquarter experts and Customer Support are authorized to modify the external web application display rules library at **L1-Headquarter** level.

The customization of **L1-Headquarter** to a lower level is not supported by external web application display rules libraries.

Depending on the allowed customization level, authorized experts can create and modify external web applications libraries at **L2-Region**, **L3-Country**, or **L4-Project** level.
Web Links Library Block

Web Links is the library block that serves as a support library for setting the XML configuration file for an external web application. You can create multiple library blocks of this type per library.

NOTE:
Only Headquarter experts and Customer Support are authorized to modify the web links at L1-Headquarter level. The customization of L1-Headquarter to a lower level is not supported by web links. Depending on the allowed customization level, authorized experts can create and modify web links at L2-Region, L3-Country, or L4-Project level.

You can set the external web application XML configuration file from the Extended Operation tab.

3.11.1.1 Application Viewer

For procedures or workflows, see the step-by-step [166] section.

Overview of Application Viewer

To interact with discipline-specific systems, external web applications that are integrated in the software can display in the Application Viewer tab, depending on the display rules that have been configured. Both Internet Explorer™ 11 and Essential Objects WebBrowser based on Google Chrome™ are supported viewers.

How Web Applications Display

If only one rule matches the selection in System Browser, the Application Viewer tab will display the corresponding external web application.

If multiple rules match the selection in System Browser, the Application Viewer tab will display a list of all the available applications from which you can select the one to display.

Applications display in alphabetical order. Each application is identified by a name. When you click Show you can select the external web application to display. The menu shows a maximum of 10 items in the list. By clicking See more..., you return to the Application Viewer tab which again presents the complete list of applications. You cannot change the order of the applications in the list.

If you change your selection in System Browser and the reference objects have the same external web application, the Application Viewer tab will refresh and display the corresponding application, but with the parameter values of the second object selected.

If an external web application supports the single sign-on feature, logon is not required when you select it.
Application Viewer Workspace

Application Viewer Toolbar

The Application Viewer toolbar allows you to work with fixed web application links.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Show all</td>
<td>Select external web application to display. The menu displays a maximum of 10 items in the list.</td>
</tr>
<tr>
<td></td>
<td>Set Execution Credentials</td>
<td>Set the execution policy for a script.</td>
</tr>
<tr>
<td></td>
<td>Clear Execution Credentials</td>
<td>Clear the execution credentials.</td>
</tr>
<tr>
<td></td>
<td>Email Settings</td>
<td>Configure the email template settings to send a fixed link report.</td>
</tr>
<tr>
<td></td>
<td>Reset Zoom</td>
<td>Sets the dashboard aspect zoom to 100 percent.</td>
</tr>
</tbody>
</table>

3.11.1.2 Rule Editor

For procedures or workflows, see the step-by-step section.

Overview of Rule Editor

The Rule Editor allows you to configure the settings for the selected display rule in System Browser. The Rule Editor tab displays in Engineering mode, when you select one of the following:

- Rule Root Library Block
- Existing display rule in a library
**Rule Editor Workspace**

The Rule Editor workspace consists of the Rule Editor pane and the Rule Editor toolbar.

![Rule Editor Workspace Image]

**General Settings**

When you configure a display rule for an external web application, the **General Settings** expander lets you modify the description of the purpose of this rule. In **Operating** mode, this information will help the user to choose which external web application to work with in case of rules multiple matching.

![General Settings Image]

**Triggers**

When you configure a display rule for an external web application, the **Triggers** expander lets you set the combination of conditions that will trigger the display rule.

![Triggers Image]

- Each condition occupies one row.
- You add a new condition (row), by clicking **Add**. This creates a new row with the fields set to **All**.
- You drag-and-drop (link) one or more nodes from System Browser to the **Path** field. This creates a new row with the **Path** field automatically set based on the linked objects.
- To remove a row, select it and click **Delete**.
- Within each row, you can define what criteria an external web application must match to make that condition true.
- All the criteria you specify on a row must be met for that condition to be true (AND logic between columns). These criteria are described in detail below.

**Path.** This field specifies the target objects affected by the external web application. The row will be true for external web applications affecting the specified target objects that also match any other criteria specified in the row.

- To set or change the **Path** field of a row, drag-and-drop (link) one or more nodes from System Browser. If the **Path** field is already populated, a popup menu displays where you can select one of the following:
  - **Add new elements:** The linked objects are added to the **Path** field. Any new objects will be appended to the existing ones.
  - **Add new elements and subtrees:** The linked objects and their subtrees are added to the **Path** field. Any new object subtrees will be appended to the existing ones.
- **Replace Existing Filter**: The linked objects will replace the existing ones in the Path field.
- **Add New Filter**: Creates a new row with the linked objects added to the Path field of the new row, and all the other fields set to All.
- **Cancel Operation**: Operation is canceled.

- In the Path field you can also:
  - Click the drop-down list to view all the linked objects.
  - Click the x next to an object to remove it.
  - Use the search box to filter the objects in the drop-down list. Note that the search box does not accept wildcards.
  - Move your cursor over an object, and an asterisk (*) in the tooltip will indicate that the object includes subtrees.

**Managed Type**, This field defines the application that will display when the target object is selected in System Browser. You can filter by one of the available values that are inherited from the object model configuration.

**Discipline/Subdiscipline, and Type/Subtype**, You can use the equals (=) or not equals (≠) operators to filter by:
- The Discipline/Subdiscipline of the target object.
- The Type/Subtype of the target object.

The row will be true for external web applications affecting the specified target objects that also match any further criteria (managed type, discipline/subdiscipline, type/subtype, function) specified here.

**Function**, This field specifies any functions associated to the target objects. You can filter by one of the available values that are inherited from the object configuration.

The following reference table describes how function settings affect triggers:

<table>
<thead>
<tr>
<th>Function setting in the Triggers expander</th>
<th>Function for the selected system object</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>No function.</td>
<td>The trigger is valid.</td>
</tr>
<tr>
<td>All</td>
<td>For example, Area</td>
<td>The trigger is valid.</td>
</tr>
<tr>
<td>For example, Area</td>
<td>No function.</td>
<td>The trigger is invalid.</td>
</tr>
<tr>
<td>For example, Area</td>
<td>For example, Area</td>
<td>The trigger is valid.</td>
</tr>
<tr>
<td>For example, Area</td>
<td>For example, Buzzer</td>
<td>The trigger is invalid.</td>
</tr>
</tbody>
</table>

**Output**

This section allows you to configure the display rules for an external web application.

The select the Application used to launch

When you configure a display rule for an external web application the **Output** expander lets you define the application that will be affected by the rule.

Select application, based on application the parameters display.
### Advanced Settings

This section allows you to enter a fully qualified URL that is not dependent on an XML file. A fully qualified URL contains the http:// or https:/ protocol. This setting overrides an XML file.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select an application associated with the URL.</td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Report Template</td>
<td></td>
</tr>
</tbody>
</table>

#### Rule Editor Toolbar

In **Engineering** mode, when you select a display rule or folder, the Rule Editor toolbar is available in the Primary pane. This allows you to create, save, and delete display rules and folders.

<table>
<thead>
<tr>
<th>Selection in System Browser</th>
<th>[Engineering mode]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule object</td>
<td>Rule folder or subfolder</td>
</tr>
<tr>
<td>New</td>
<td>n.a.</td>
</tr>
<tr>
<td></td>
<td>Create a new subfolder under the currently selected one.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the changes made to the current rule.</td>
</tr>
<tr>
<td></td>
<td>n.a.</td>
</tr>
<tr>
<td>Save As</td>
<td>Save the currently selected rule with a different name. You can use this to create a new rule from an existing one.</td>
</tr>
<tr>
<td></td>
<td>Create a new rule.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the currently selected rule.</td>
</tr>
<tr>
<td></td>
<td>Delete the currently selected rule subfolder and any rules contained inside it. (You cannot delete the main Web Applications folder).</td>
</tr>
</tbody>
</table>
3.11.2 Validation

The Validation feature is designed for projects in critical environments and helps protect against inadvertent changes that might damage system functions. For procedures or workflows, see the step-by-step [➡️ 169] section.

When you change or command a validated object in the management station, the Validation Required dialog box might display, depending on several factors such as the configured validation profile, the configuration of Four Eyes, and the requirement of a comment. See the following table for more detail.

<table>
<thead>
<tr>
<th>Validation Profile</th>
<th>Required User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Four Eyes Not Enabled</td>
<td>Four Eyes Enabled</td>
</tr>
<tr>
<td>Disabled</td>
<td>No input</td>
</tr>
<tr>
<td>Monitored</td>
<td>No input</td>
</tr>
<tr>
<td>Enabled</td>
<td>Comment</td>
</tr>
<tr>
<td>Supervised</td>
<td>User password</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
</tr>
</tbody>
</table>

**Additional Information for Four Eyes Authentication**

- Approval must occur on the same client machine on which the change or command was initiated.
- Supervisors are limited to those designated as a supervisor by an administrator in the user or user group configuration.
- Supervisor approval can be initiated by any designated approver as long as the approver also has access to command that object.
- Supervisor must be a different user.

**Log Viewer**

Once you accept the entries to the Validation Required dialog box, the system records the changes, which you can review in the Log Viewer. The log serves as an audit trail record to achieve regulatory compliance for validation.

**Object Version**

The object version number will increment (increase) if a validated object is modified or commanded, depending on the scenario. Modifications or commanding of configuration attributes or properties will increment the object version. Modifications or commanding of status attributes or properties will not increment the object version.
Examples
The object version will change when modifying or commanding a configuration property like the High Alarm Limit or Discipline.
The object version will not change when commanding the Present Value property.

Validation Indicator
When you select a validated object in the system, a visual indicator displays next to the object name in the Operation and Extended Operation tabs.

Four Eyes Not Enabled – Examples of Validation Required Dialog Boxes
This section and the next section show two dialog boxes for each validation profile. The first dialog box requires a user-entered comment. The second dialog box requires a selection from a predefined list of comments. The actual dialog box that displays when you change or command a validated object depends on how validation is configured for the object. If predefined comments were not configured, you will see the first dialog box. If predefined comments were configured, you will see something similar to the second dialog box.

Enabled Validation Profile

Supervised Validation Profile
Four Eyes Enabled – Examples of Validation Required Dialog Boxes

Monitored Validation Profile

Enabled Validation Profile
Supervised Validation Profile